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Safety Precautions 
 
For your safety and protection of the Voice Sense QWERTY, please read 
and abide by the following safety precautions. 

 
1. The input voltage of the AC adapter is 100V - 240V, and the output 

is DC 5V / 2A. 
 

2. When the Voice Sense QWERTY is shipped, the battery may be 
packaged separate from the unit to avoid damage. When you use 
the Voice Sense for the first time, you may need to open the 
package, remove the battery, and insert it into the battery slot On 
the underside of the unit. (see section 1, introduction, for more 
details on inserting the battery.) It is possible that the dealer or 
distributor from whom you purchased the Voice Sense QWERTY 
has already done this for you. The battery may not be fully charged 
when it is shipped. Before you use the Voice Sense QWERTY, you 
should ensure the battery is fully charged.  
 

3. When you use the Voice Sense QWERTY with the battery for the 
first time, the battery status may not be displayed accurately. To 
avoid this, leave the Voice Sense QWERTY connected to the AC 
adapter for about six hours with the unit turned on. If you want to 
use the Voice Sense QWERTY immediately, you may use it while it 
is charging. 
 

4.  If you want or need to remove the battery from the unit, power the 
unit off, and then remove the battery. If the unit is connected to AC 
power, before re-inserting the battery in to the unit, make certain 
that the power is off. 
There is a risk of explosion if the battery is replaced by an incorrect 
type. Please make certain to use only battery packs produced 
specifically for the Voice Sense QWERTY by HIMS. Please dispose 
of used batteries according to the instructions. 
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5. When you are using the Voice Sense QWERTY on battery power, 

the status of the remaining battery power is announced when the 
battery charge is low. When the battery’s charge falls below 15 
percent, connect the AC adapter to the unit for recharging. If the 
remaining battery charge drops to five percent, and the unit is not 
connected to the AC adapter, the Voice Sense QWERTY shuts 
down one minute after the announcement of the battery’s status. 
The amount of battery life per charge varies depending on the 
options you have set and the number and type of tasks you are 
running. 
 

6. Your Voice Sense QWERTY needs to be handled with care. The 
Voice Sense QWERTY is a very delicate machine. Please handle 
the unit in a proper, careful manner. The Voice Sense QWERTY is 
very sensitive to dust. Make sure to keep the Voice Sense 
QWERTY away from dusty environments. 
 

7. You should register your Voice Sense QWERTY in order to ensure 
further maintenance, service, and upgrade information. Please visit 
www.hims-inc.com, to register your information. If you have any 
trouble when registering your information, please contact the dealer 
from whom you purchased your Voice Sense QWERTY for help. 
 

8. Do not take apart the Voice Sense QWERTY yourself. Do not have 
anyone else who is not authorized by HIMS take apart the Voice 
Sense QWERTY. If an unqualified person disassembles the unit, 
serious damage may occur to the Voice Sense QWERTY. If an 
unauthorized person disassembles the Voice Sense QWERTY, the 
unit is excluded from any free maintenance, and the warranty 
becomes void. If any liquid or external force damages the unit, it 
may also be excluded from free maintenance, even if the damage 
occurs during the warranty period. 
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9. Do not leave your Voice Sense QWERTY in closed or high 
temperature environments such as inside a car on a hot summer 
day, as the battery attached to the Voice Sense QWERTY may be 
damaged or catch fire. Please do not let your Voice Sense 
QWERTY remain in such environments for long periods of time. 
 

10. Thank you for using the Voice Sense QWERTY. We value any 
comments or suggestions you have for our product. If you have any 
complaints or suggestions, please provide us with your comments 
on our website. We will improve our product based on your 
comments and suggestions. 

 
11. To prevent possible damage to your hearing, do not listen to audio 

at high volume levels for long periods. 
 

12. This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. 
 
Operation is subject to the following two conditions. 

1) This device may not cause harmful interference, and 
2) This device must accept any interference received, including 

interference that may cause undesired operation. 
 
This equipment can generate, use and radiate radio frequency 
energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference 
will not occur in a particular installation.  
 
If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
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- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that 
to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 
 
IMPORTANT NOTE: 
FCC RF Radiation Exposure Statement: 
This equipment complies with FCC RF radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with a minimum distance of 20 cm between 
the radiator and your body. This transmitter must not be co-located 
or operating in conjunction with any other antenna or transmitter. 
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Congratulations on the purchase of your Voice Sense QWERTY! The Voice 
Sense QWERTY is capable of doing everything that an ordinary PDA can 
do, and more – all without the need for a screen!  

 
I. Your Voice Sense QWERTY packing box should contain the 
following items: 
 
1) Voice Sense QWERTY 
2) Battery 
3) Carrying Case 
4) AC adapter 
5) USB Cable  
6) Earbuds 
7) Documentation CD 
8) Braille Commands Summary 

 
II. How to use this manual 
 
Before using the Voice Sense QWERTY, you should read the entire 
manual to familiarize yourself with the functions of the Voice Sense 
QWERTY. The Voice Sense QWERTY contains many programs with a 
variety of functions, thus, reading the entire manual will allow you to 
operate the unit to its fullest potential.  
 
In this manual you will see references to hot keys and shortcut keys. These 
keys refer to ways to access menus and functions quickly by using a 
combination of keystrokes. Please note that not all hot keys and shortcut 
keys will work from every location on the Voice Sense QWERTY. Some hot 
keys and shortcut keys are program specific, thus, they require that you be 
within a specific program for them to work. 
 
This user manual notes how to press hot keys and shortcut keys in the 
following manner: Keys that are to be pressed at the same time are 
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separated by a – (dash). When you see “FN-b”, this means that you should 
press Function and the letter b simultaneously. 
 
If you are unable to find a solution to a problem within the manual, or if you 
need assistance with the Voice Sense QWERTY, please email us at 
support@hims-inc.com.  You may also visit us on the web at www.hims-
inc.com; or, you can call us at 512-837-2000. 
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1. Introduction 
1.1 What	  is	  the	  Voice	  Sense	  QWERTY?	  
	  

The Voice Sense QWERTY is a voice note taker developed and 
manufactured by HIMS, for people who are blind and visually impaired. The 
Voice Sense QWERTY has a variety of powerful capabilities, including the 
following. 

	  

1. Use the Word Processor, and the QWERTY keyboard, to create 
Braille or text documents in multiple languages. 

2. Print your text documents using any compatible Bluetooth or USB ink 
printer. 

3. Create hard copy Braille documents by connecting the unit to a Braille 
embosser. 

4. Open Microsoft Word documents, and read them with speech.  
5. Send email messages to sighted colleagues and friends while reading 

incoming email messages on the go. 
6. Create a schedule of important appointments with the Schedule 

Manager and set alarms to alert you to these appointments. 
7. Input contact information for colleagues, friends, and family into the 

Address Manager. 
8. Surf the Internet with the Voice Sense QWERTY's Web Browser.  
9. Listen to music, audio books, your own personal recordings, or even 

videos with the Voice Sense QWERTY's integrated media player. 
10. Listen to and record FM radio content. 
11. Calculate algebraic equations, trigonometric functions, and other 

scientific calculations with the built-in calculator. 
12. View the flashdisk of the Voice Sense QWERTY as a USB drive on 

your computer and transfer files.  
13. Copy, move, and delete files on the Voice Sense QWERTY with its 

intuitive, Windows-like File Manager. 
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14. Adjust the volume, speed, pitch and language of the speech on the 
fly.  

15. Use the Database Manager to create your own Database for storing 
important information. 

16. Use MSN messenger, Google Talk, and Twitter to keep up with 
what's happening and stay in touch with friends, family, and 
colleagues.  

17. Use the Internal GPS and compass along with the included Google 
Maps application to plan and save routes and navigate on the go.  

18. Share files with other people and other devices using Dropbox. 
19. Download news and podcasts with the included RSS reader. 

	  

1.2	  Hardware	  

	  

To get the most from your Voice Sense QWERTY, it is important to 
become oriented to the buttons and ports on your Voice Sense QWERTY 
as well as learning their functions.  

This section explains the hardware configuration of the Voice Sense 
QWERTY. The Voice Sense QWERTY is 10 inches long by 6.1 inches 
wide by 1.9 inches high. The bottom of the unit contains rubber feet in 
order to prevent slipping while you are using it. Place the Voice Sense 
QWERTY on a desk or table top with the Braille display nearest you. Its 
shape resembles a thin, flat, rectangular box. This section of the manual 
describes each side of the Voice Sense QWERTY and the basic function(s) 
of each button and port. We will discuss the panels in the following order: 
top panel, right panel, left panel, rear panel, and front panel. 

	  

1.2.1	  The	  Top	  Panel	  
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The majority of the top face of the unit is taken up with the QWERTY 
keyboard. This keyboard is somewhat similar to a laptop keyboard, with the 
top row containing Escape and F1-F11 as well as the left and right 
brackets, insert, and Delete. The bottom row contains Function, control, 
Windows, Alt, Brauve, Space, Alt, Apostrophe, and Equals, as well as the 
arrows. The remainder of the keyboard contains letters, numbers, and 
punctuation similar to standard keyboard conventions. Use “FN-Up arrow” 
for “Page Up”, and “Fn-Down arrow” for “Page Down”. “Fn-Left arrow” and 
“Fn-right arrow” function as “Home” and “End”. 

 

If you are unsure of the function of any of the QWERTY keyboard keys, 
when the unit is powered on, you can enter a “Key Help mode” by pressing 
“Control-Escape”. Press any key or key combination to learn its function. 
Press “Control-Escape” once more to exit “Key Help Mode”. 

 

There are tactile dot markings on the keys in each row where your index 
fingers should be placed for ease of orientation. There are also tactile 
markings on the casing of the Voice Sense QWERTY surrounding the 
keyboard to help you more easily locate important keys. These markings 
are placed above “F1”, “F5”, and “F9”; and also to the left of “Tab” and to 
the right of “Backspace”. 

 

Near the top center of the unit's top panel, is a liquid crystal display (LCD). 
The LCD displays the output of the unit visually so that a sighted person 
can see what is shown on the Voice Sense QWERTY. STEREO speakers 
are located one on each side of the LCD for audio output. 

	  

1.2.2	  The	  Right	  Panel	  
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On the right panel, there are 3 ports. The port nearest the front of the unit is 
the USB OTG port. You can connect your Voice Sense QWERTY to a 
personal computer via this USB port, and transfer files to and from the 
computer, or synchronize your calendar and contacts with Outlook. 
Behind the USB OTG port is a full-sized USB host port. Use this port to 
connect a USB thumb drive for auxiliary storage. 
The port closest to the rear of the right panel is the AC adapter jack. To 
charge the unit's battery or use the Voice Sense QWERTY on AC power, 
plug the small, round end of the AC adapter in to this jack, and plug the 
larger box-like end in to a standard AC electrical outlet. 

	  

1.2.3	  The	  Left	  Panel	  

	  

The left panel of the Voice Sense QWERTY contains a single slot near the 
front of the unit. This is the "SD" slot, used for housing an SD (secure 
digital) card in the unit for additional storage.  

	  

1.2.4	  The	  Rear	  Panel	  

	  

Near the left of the rear panel, is the local area network (LAN) port. If you 
connect the Voice Sense QWERTY to an Ethernet interface, you can 
connect to the Internet, allowing you to browse websites as well as send 
and receive e-mail. 
 

Near the right of the rear panel is a small, round recess, with a dot-like 
button inside it. This is the "RESET" button. If your unit is not responding 
properly, you can press this button to force a soft reboot of the unit. NOTE: 
do NOT press the "RESET" button for more than 5 seconds. It takes about 
fifteen seconds for your unit to complete the reboot process.  
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If you hold down “F5” with the "RESET" button, while the power is on, the 
Voice Sense QWERTY reboots without speech. 

	  

1.2.5	  The	  Front	  Panel	  

	  

On the far left of the front panel, is a 3-position slide switch. This is the key 
"Lock" switch. This switch is explained in more detail in the next chapter. 
To the right of the key lock switch is the stereo microphone jack, used for 
connecting an external microphone or line level recording source. To the 
right of the microphone jack is the stereo headphone jack. To the right of 
the headphone jack is another 3-position slide switch. This is the "Media 
Mode" switch, and determines which type of media the media buttons 
control. This switch is explained in more detail in the next section. 

 

To the right of the "Media Mode" switch, are five buttons of varying shapes. 
These buttons control media playback. As explained above, the type of 
content controlled by these buttons depends on the position of the "Media 
Mode" switch. These buttons can control media playback, DAISY playback, 
or the FM radio. These five buttons are explained further in the FM Radio, 
Daisy and Media chapters of this manual. 

To the right of the media buttons is the on/off switch. To turn on the unit, 
push the switch to the right. To turn off the unit,repeat this action. 

 

Congratulations! You are now familiar with the basic functions of the 
buttons and ports of the Voice Sense QWERTY. The rest of this manual 
discusses each function in greater detail to help you maximize the potential 
of your Voice Sense QWERTY. 
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1.3	  Hardware	  Specifications	  	  

1) Operating system: Windows CE 5.0. 
2) Flash memory: 4GB. 
3) RAM: 128MB. 
4)  Auxiliary storage: SD memory or USB flash drive.  
5) CPU: Intel PXA270. 
6) Battery: Lithium Ion (detachable), backup battery and clock-battery 

installed. 
7) Keyboard: QWERTY keyboard. 
8) Additional buttons and switches: key lock switch, audio mode switch, 

reset button, 5 audio buttons. 
9) Video output: Built-in LCD. 
10) Network: 10/100 based Ethernet. 
11) Wireless: WLAN (IEEE802.11 b/g), Bluetooth 
12)  Interface: USB OTG, USB master, SD slot 
13) Sound: Internal stereo speakers, stereo headphone jack. 
14) Voice recording: Internal microphone, external stereo microphone 

jack. 
15) Sensors: Internal GPS and digital compass. 

	  

1.4	  Memory	  on	  the	  Voice	  Sense	  QWERTY	  

	  

The Voice Sense QWERTY has 128MB of RAM (random access memory) 
and 4GB of flash memory. The flash memory is where permanently-saved 
data is stored. The RAM is memory reserved for running programs. RAM is 
a temporary storage area for any program files that are running or any 
currently open documents. The data in the RAM area disappears if your 
battery depletes, and the AC adapter is not connected. The RAM data also 
disappears when Voice Sense QWERTY reboots for any reason. This 
means, if you have an open document which you have not saved, the 
unsaved data disappears. 
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2. Basic Functions of the Voice Sense QWERTY 
 
2.1 How to Enter Commands 
 
The commands used to operate the Voice Sense QWERTY are comprised 
of various combinations of the input and modifier keys. In this user manual, 
the “-“(dash) is used to indicate that keys should be pressed 
simultaneously. For example, "Alt-F4" indicates that the user should press 
"Alt" and "F4" at the same time. This manual also contains expressions like 
"Ctrl-c". This means that the Ctrl button with letter ‘c’ should be pressed 
and released simultaneously.  
 
If you are in a menu or dialog, and your cursor is placed on the command 
you want to execute, you can execute most commands by pressing "Enter". 
If you want to cancel the execution of a command, and return to your 
previous location, press "Alt-F4”. "Alt-F4" is a very important command to 
remember, as it allows you to abort programs and menus if you have 
pressed keys accidentally. 
 
2.1.1 Basic Alerts and Messages 
There are instances where the Voice Sense QWERTY alerts you to events 
for which you have asked it to notify you. For example, by default, the 
Voice Sense QWERTY checks the Schedule Manager when you power on, 
and notifies you of any appointments scheduled for that day.  When you 
are notified of an appointment, you can interact with the Schedule Manager 
as you normally would. To exit the Schedule Manager, press "Alt-F4" or 
"Esc," and you are returned to your previous location.   
If you do not want to be alerted of "today's schedule" when you turn on the 
Voice Sense QWERTY, you can turn off the "Check today's schedule" 
option in the "Global Options" dialog. (See chapter 3) 
When you turn on the Voice Sense QWERTY, you are returned to the 
same location at which you turned the unit off. The Voice Sense QWERTY 
announces the name of the running program and your current position or 
status.  If you turn off the Voice Sense QWERTY while using the Word 
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Processor, when you power on, it announces the program name, file name, 
input mode and file protection status.  
When you connect the AC adapter to the Voice Sense QWERTY, the Voice 
Sense QWERTY speaks the message "AC adapter connected”. When you 
disconnect it, the Voice Sense QWERTY says, "AC adaptor disconnected”. 
 
2.2 Menu Concepts  
 
menus on the Voice Sense QWERTY provide you with a list of programs, 
actions, or options from which you can select. If a menu item has a 
submenu, selecting it brings up another list of choices. 
Moving among the menu items is very simple. 
 
When using a program on the Voice Sense QWERTY, press “Alt” to bring 
up its menu. Press the "Up" scroll key or “Up arrow” to move to the 
previous item, and press the "Down" scroll key or “Down arrow” to move to 
the next item.  
To move to the first item in the menu, press “Ctrl-Fn-Left arrow”. To move 
to the last item in the menu, press “Ctrl-Fn-Right arrow”. The corresponding 
menu name is displayed on the Braille display (When connected to 
SyncBraille), and the menu name is spoken through the TTS (text to 
speech) engine. To repeat the name of the menu item, press "Fn-r".  
 
You can also quickly jump to and execute a menu item by pressing the 
menu item's shortcut key, usually the first letter of the item name. Often 
menu items can also be executed instantly, directly from your current 
position in the program,  with a hotkey, enabling you to perform the desired 
action without accessing the menus. 
Shortcut keys are displayed in parentheses following the menu names. 
Hotkeys generally consist of a modifier such as “Alt”, “Control”, or “fn” 
pressed simultaneously with a letter or function key. These are displayed 
following the shortcut keys. 
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For example, if you are in the Word Processor, and press “Alt”, then press 
"Enter" on "File," you hear "New (n) pull down Control-n". The word "New" 
is the menu option. You would press the letter "n" to jump to "New" from 
within the "File" menu. Press "Control-n" to access the "New" document 
command from anywhere in the Word Processor. The n is the shortcut key 
and "Control-n" is the hotkey. It is important to note that some hotkey 
commands are global, thus will work from anywhere on the unit, and some 
are program specific. For example, if you want to activate the "new 
document" option in the Word Processor. You cannot press "Control-n" 
from the "Program" menu to activate this option. You must be in the Word 
Processor for "Control-n" to activate the "new document" command.  
 
When you are placed on an item you want to execute, press "Enter". If the 
item you chose has a submenu or dialog, pressing "Enter" opens the 
submenu or dialog. If the item you chose is a command, pressing "Enter 
activates the command. This is referred to as "selection”.  
When a menu item activates a submenu, the right direction arrow sign (->)   
is displayed after the name of the corresponding menu on the Braille 
display (When connected to SyncBraille) and the Voice Sense QWERTY 
announces "pull down" after the menu item name. If the menu item is a 
dialog box, the ellipsis sign (...) is displayed after the menu item name on 
the Braille display (When connected to SyncBraille). The Voice Sense 
QWERTY also speaks the message, "common dialog”. 
 
Let's begin going through the various menus. First, turn the unit on by 
pushing the power switch to the right. Now, bring up the "Program" menu 
by pressing the “Windows” key. The "Program" menu is the main menu of 
the Voice Sense QWERTY. You can access all of the programming, option 
settings, utilities, and help from this menu.  
The "Program" menu consists of 3 programs: File Manager, Word 
Processor, and E-mail; and 9 sub menus: Media, Organizer, Web Tools, 
Social networking, Extras, Games, Utilities, Settings, and Help. If you 
choose to install add-ons such as our free Bible program or programs 
developed by third party developers for the Sense notetakers, the 
“Programs” menu appears between “Games” and “Utilities”. 
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The first item in the "Program" menu is "File Manager". If “Down arrow” is 
pressed, the next menu item is displayed and spoken. Pressing “down 
arrow” repeatedly, continues your navigational progress down the list of 
items in the "Program" menu. When you reach the bottom of the list, the 
"Help" menu item is displayed as it is the last item in the "Program" menu.  
 
You could also jump quickly to the "Help" menu item by pressing “Ctrl-Fn-
Right arrow” when "File Manager" is displayed. Press “Ctrl-Fn-Left arrow”, 
and the Voice Sense QWERTY jumps back to the top item in the "Program" 
menu and again speaks and displays "File Manager".  As explained above, 
to execute a submenu or program from the "Program" menu, press "Enter". 
If you are in a submenu, and wish to return to the main "Program" menu, 
press "Esc”. 
 
The “Media” menu contains the “Media Player”, “FM Radio”, and “DAISY 
Player”.  
The “Orgamizer” menu contains the “Address Manager”, “Schedule 
Manager”, and “Database Manager”.  
The “Web Tools” menu contains the “Web Browser”, “Quick Browser”, 
“Google Search”, and “RSS Reader”.  
The “Social Networking” menu contains “Twitter”, “Google Talk”, and 
“Sense Chat”.  
The “Extras” menu contains the optional “Sense Dictionary”, “BookShare 
Download”, “Google Maps”, “Sense Navigation” (optional), and “Dropbox”.  
The “Games” menu contains the “Sense Dice Game” and the “Sense Brain 
Game”.  
The “Utilities” menu contains the “Calculator”, “Display time and Date”, 
“Display Compass Heading”, “Wake Up Alarm”, “Calendar”, “Stopwatch”, 
“Terminal For Screen reader”, “Display Network Status”, “Display Power 
status”, “Format”, “Sleep Timer”, and “Upgrade Voice Sense Firmware”. 
The “Settings” menu contains “Set Time and Date”, “Setup Internet”, 
“Bluetooth Manager”, “Pronunciation Dictionary”, “Menu Manager”, 
“Backup/Restore Personalized Settings”, “Change device Name”, and 
“Global Options”. 
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Finally, the “Help” menu contains the various sections of the User Manual 
as well as an “Information” section containing general information about 
your Voice Sense, such as firmware version, Mac address, and the key 
number used for authorizing playback of content from digital talking book 
libraries. 
For more information on a specific program, please see the section of this 
user manual related to that program. 
 
The “Windows” key command for accessing the "Program" menu is an 
example of a global hotkey. This means that pressing the “Windows” key 
key takes you to the "Program" menu immediately from anywhere on the 
Voice Sense QWERTY, whether you are in a submenu, a file, a dialog or 
an application. When you press “Windows” key, you are always placed at 
the top of the "Program" menu; and File Manager, is displayed and spoken. 
There are also global quick launch commands for every program on the 
unit, mostly comprised of either the Windows or Caps Lock  key and a letter. 
These quick launch commands will immediately launch their associated 
application from anywhere on the Voice Sense QWERTY. See section 2.16 
for a complete list of the quick launch commands. 
2.2.1 Control Symbols  
 
The Voice Sense QWERTY uses several control symbols to note the type 
of information being displayed: examples are list items, menus, and edit 
boxes. These symbols can appear "Before" or "After" the text, or the 
appearance of this information may be set to "off". The way this information 
is displayed is determined by the "Control information" setting in the "Global 
Options" dialog. The default value is set to "Before”. Note: In the Web 
Browser, the control symbols are displayed even if the "Control information" 
is set to "off". 
AS explained above, the control symbol appears before or after the text of 
the control. For example, if "Control information" is set to "before", and you 
bring up the Word Processor's program menu, The Voice Sense displays, 
"MN File (f) pull down". 
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The following table shows the types of controls and the symbols that are 
used to indicate them. 
 
 

Name Symbol Comments 
Menu MN It means the menu that has 

submenus. 
Menu item MI It means the menu that does not 

have a submenu. 
List item LI The item name after this symbol 

represents the name of the item 
in any list. 
(Ex: “LI database” or “LI 
sample.txt” in the “file list” of the 
file manager) 

Edit box EB The item name after this symbol 
represents the edit box name. 
You can find the edit box after 
the edit box name. In the web 
browser, the symbol “EB” may 
be followed by an edit box 
without an edit box name. Edit 
boxes that begin with the symbol 
“EB” are one line. 
(Ex: “EB Last name: (cursor)” in 
the address manager program or 
“EB (cursor)”  

Multi edit box MEB This also represents the edit 
box. But you can type in more 
than one line in the edit box. 
(Ex: “MEB Subject: (cursor)” in 
the e-mail program) 

 
Computer edit 

 
CE 

It means there is an edit box in 
which you must input ASCII 
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box Braille. 
The edit box after this symbol 
only allows ASCII Braille to be 
entered. 
(Ex: “CE To: (cursor) “ in the 
email program) 

Combo box CB It represents the combo box in 
which you can choose an item 
by pressing the up scroll button 
or the down scroll button. 
(Ex: “CB Type: *.*” in the “Open 
dialog box” of the word 
processor program) 

Edit combo box ECB You can choose the desired item 
by pressing the up or down scroll 
button, or by directly typing in the 
item name. 
(Ex: “ECB File name: (cursor) “ 
in the “Open dialog box” of the 
word processor program) 

Prompt button PB PB follows any question in which 
you have to choose “Yes” or 
“No”. You can toggle between 
“Yes” and “No” by pressing the 
“Space” or the “Backspace” key.  
(Ex: When you exit from the 
word processor, “PB Save: Yes”)  

Static box ST ST is followed by the current 
status. 
(Ex: “ST noname.hbl/insert 
mode/write” in the word 
processor program) 

Link LN It notes a link on a web page. 
Anchor ANC It notes an anchor on a web 
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page. 
Radio button 
 

RB 
 

It represents a radio button, 
which allows you to choose an 
item by pressing the up scroll 
button, down scroll button, 
space, or Backspace. Also it 
cycles between items when 
pressing this key. 
(Ex: “RB Attribute: Write” in the 
“Information dialog box” of the 
file manager) 

Radio button 
select 

SRB It means that the radio button is 
selected in the web browser 

Radio button 
unselect 

URB It means that the radio button is 
not selected in the web browser. 

Check box check SCHB It means that the check box is 
selected. 

Check box 
uncheck 

UCHB It means that the check box is 
not selected.  

 
Note: Links, anchors, and radio buttons are controls that are only used in 
the Web Browser.  
 
The symbols enable you to understand what type of input control or menu 
you are working with. For example, if "MN," "MI," or "LI" are displayed, you 
know you can move from one item to the previous and next items by 
pressing the "Up" and “Down" scroll keys or the “Up arrow” or “Down arrow”. 
If "ECB," "EB," "CB," or "MEB" are displayed, you know you are in an input 
area where you must type the desired text. If "BT" is displayed, you can 
press "Enter" to activate the "button". 
 
2.3 Using Function 
 
As described previously, the “Function key" is on the bottom left of the 
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keyboard, just to the right of “Control”. The "Function key" is often 
abbreviated as "Fn". The “Function” key is often used in conjunction with 
other keyboard keys for additional navigation. For example, press “Fn” and 
“Up arrow”, for “Page up” and press “Fn” and “Down arrow”, for “Page 
down”. Press “Fn” with “Right arrow”, for “Fn-Right arrow” and “Fn” with 
“Left arrow”, for “Fn-Left arrow”.  
 
Press “Fn” and “Insert”, “to turn Num lock on/off. When Num Lock is on, the 
following keys are used to type the associated numbers/symbols below:  
M: 0 
J: 1  
K: 2 
L: 3 
U: 4 
I: 5  
O: 6 
7: 7 
8: 8 
 9: 9 
0: *  
;: + 
.: . 
/: / 
 
2.4 The AC Power Supply and the Battery Pack  
 
It is often useful to know the remaining battery power on the Voice Sense 
QWERTY so you can determine how much time you have before you must 
change the battery or connect to AC power. If the remaining battery power 
falls below 15 percent, the Voice Sense QWERTY indicates the battery 
power is low.  
 
To check the battery power status, press "Fn-b". The unit displays the 
following 2 items: 
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1. Battery power level 
2. Power source (battery, AC power or USB cable) 
 
The battery power level represents the percentage of the remaining battery 
power. The power source indicates whether the unit is being operated 
using the battery or the AC power supply, or is being charged via the USB 
cable. If the battery power level drops below 15 percent, the Voice Sense 
QWERTY displays the battery status on the Braille display (When 
connected to SyncBraille), and it announces that the battery has less than 
15 percent of its power remaining. If the battery power level falls below five 
percent, the Voice Sense QWERTY gives you a warning indicating that 
your battery power level is under five percent, and the Voice Sense 
QWERTY will be automatically turned off in one minute, unless you 
connect it to an AC power supply. 
Let's explore the detachable battery pack. When the Voice Sense 
QWERTY is shipped, the battery pack is not installed. This is done to 
prevent damage during shipping. When you insert the battery in to the 
Voice Sense QWERTY for the first time, the unit may display an inaccurate 
battery power level. Before using the Voice Sense QWERTY for the first 
time, please charge the battery for at least two and a half hours. You may 
use the unit during the initial charge, however, it is recommended if you do, 
that the unit remain connected to AC power for at least three hours to fully 
charge the battery.  
When you remove the battery from the Voice Sense QWERTY, make sure 
your unit is turned off; especially when the AC power adapter is not 
connected. If you remove the battery while the unit is on and AC power is 
not connected, you will lose all data stored in RAM, including open 
documents, emails, and contacts or appointments that have not been 
backed up. If you remove the battery, and do not have the Voice Sense 
QWERTY connected to AC power, the data stored in RAM remains for 
about 1 hour. To save your RAM data the Voice Sense QWERTY must be 
connected to an AC power adapter or battery pack within an hour; or this 
data is lost. 
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2.5 Basic Explanation of Disks, folders, and files 
 
Think of the flash memory on the Voice Sense QWERTY as being like a big 
bookshelf in a library. You can create partitions on a bookshelf to organize 
books into categories. Think of the "folders" on the Voice Sense QWERTY 
as being similar to these categorical partitions. The books in each section 
can be compared to the "files" on the Voice Sense QWERTY. You can 
save files into any folder at your discretion. If you create meaningful folder 
names and properly organize your files into them, it will make for easier 
retrieval of files when you need to access them later. 
When the Voice Sense QWERTY is shipped from the factory, the name 
given to the flash memory in the Voice Sense QWERTY is "flashdisk". You 
can create folders on this "flashdisk" in any way that you prefer. 
You can also expand your available storage by adding additional storage 
devices, such as a Secure Digital card or USB flash drive. The Secure 
Digital card is named, "sd". A USB flash drive appears as "USB”. If you 
decide to add either of these storage devices, you can create folders, and 
save files on them just as you can the flashdisk.  
 
2.6 Controlling the Volume, Speed, and Pitch of the 
TTS  
 
You can change the volume, speed, and pitch of the voice used on the 
Voice Sense QWERTY. Press "F6" to increase the volume. Press "Shift-
F6" to decrease the volume. Press "F7" to increase the speech rate. Press 
"Shift-F7" to decrease the speech rate. Press "F8" to raise the pitch and 
"Shift-F8" to lower it.  
When you press any of the above key combinations, the Voice Sense 
QWERTY announces the status of its volume, rate, or pitch. The changes 
in the characteristics of the voice remain in effect until you change them 
again, or a hard reset is performed either manually or due to lack of power 
to the unit for an extended period of time. 
 
Note: the volume of the voice is controlled independent of the master 
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volume on the unit, thus, you can adjust it above or below the volume of the 
system sounds, media playback, etc using the Voice volume control 
described above. You can control the master volume or “Main Volume” of 
the unit using “Windows-Shift-F6” to lower it and “Windows-F6” to raise it.  
 
You can also control the rate of the foreign language TTS voice 
independent of the main speech rate. You can adjust the TTS for other 
languages, the “Sub Voice rate”, in the “Global Options” dialog. 
 
2.7 Using Speech and Braille  
 
When using the Voice Sense QWERTY, you can choose to read using 
Braille only or speech only. You can also use both Braille and speech 
simultaneously. However, you cannot turn off both Braille and speech as 
you would have no method of receiving information from the Voice Sense 
QWERTY. Use "F5" to toggle the speech on and off. Press "F4" to toggle 
the Braille on and off. Note: Braille and speech can only be toggled in this 
manner when the unit is connected to the SyncBraille. Please refer to 
section 3.8.2.1 in this user manual for more information. 
 
2.8 Entering Text  
 
When you use the word processor on the Voice Sense QWERTY, 
In addition to entering normal US English letters, you can also use your 
QWERTY keyboard to enter foreign language text and Braille.  
 
While European alphabets contain many of the same letters as does US 
English, there are a few exceptions, most notably, the use of accented 
vowels. When entering foreign language text, you can create the accented 
vowels by pressing “` (grave accent)” in conjunction with the vowel you 
want to accent. For example to create an é, type “`-e”.  
 
When you choose Braille as your document type when creating a 
document, the Voice Sense QWERTY automatically changes to a keyboard 
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layout that allows you to use QWERTY letters to input Braille dots. “F” 
corresponds to dot 1 and “D” corresponds to dot 2, “S” corresponds to dot 3, 
“J” corresponds to dot 4, “K” corresponds to dot 5, “L” corresponds to dot 6 
in the Voice Sense QWERTY Keyboard. To type a capital letter, type dot 6-
L in front of the character. 
For example, when you input ‘sea’ in the Braille Document, press “D-S-J” to 
create “s” (dot 2-3-4). Then, press “F-K” to create “e” (dot 1-5) and press “F” 
to create “a” (dot 1). 
 
2.8.1 Inputting/searching for Control characters 
Control characters are codes in a character set, which do not in themselves 
represent written symbols in computing. For example, all entries in the 
ASCII table below code 32 such as Form Feed (FF), TAB, and Carriage 
Return (CR). You can input and search for control characters in Braille 
documents. 
 
2.8.1.1 Inputting Control characters 
 
Control characters can only be entered in Braille documents. To enter 
control characters in Braille documents, follow these steps.  
 
(1) From within a Braille document, press "Ctrl-Space". "Control character" 
is announced to alert you to the fact that the next character you enter 
should be a control character.  
(2) Enter the control character. For example: "l" for Form Feed (FF) or "i" 
for TAB in alphabetical order.  
(3) The control character is entered into the Braille document. 
 
2.8.1.2 Searching for a Control character 
 
You can also search for control characters in Braille documents. To search 
for a control character, follow these steps. 
 
(1) From within a Braille document, press "Ctrl-f". 
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(2) "Text to find" is displayed. 
(3) Press "Fn-Space” and "control character" is announced.  
(4) Enter the control character for which you want to search.  
(5) Press "Enter" to search for the control character. 
 
2.9 Multi Tasking 
 
Unique to the Sense notetakers is their ability to run up to seven tasks at 
once. The ability to run multiple applications simultaneously is referred to 
as multi-tasking. For example, you can work with the Word Processor while 
listening to music, and place calculations into a document at the same time.  
 
To use the example of the Word Processor and Media Player, open the 
Media Player and play a music file. While the audio is playing, press the 
"win " key to bring up the "Program" menu and launch the Word Processor. 
 
 
You cannot run more than seven applications at the same time. If you try to 
run a program that is currently running, The Voice Sense QWERTY does 
not open a new instance of the program, but rather, returns you to the 
instance of the program that is already running. For example, while working 
with a document called "Notes" you decide to execute the "File Manager”. 
Next, you navigate to a document called "journal" in the file list and press 
"Enter”. The Word Processor does not load a second time, but rather, 
"journal" is opened in the same instance of the Word Processor in which 
"notes" is already loaded. You can switch among multiple open documents 
in a single instance of the Word Processor. Use "Tab" or "shift-tab" to cycle 
forward or backward through the currently open documents. Switching 
documents is explained in more detail in section 5, which covers the Word 
Processor. 
 
To switch between currently running programs press "Fn-F10" to open the 
Task List. The Task List shows all the currently running programs in list 
form. To return to any application, simply navigate to it and press "Enter".  
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You can use "Alt-tab" to immediately cycle among all running programs 
without opening the Task List. If you are running three programs and are in 
the second program, pressing "Alt" and "Tab" moves you to the third 
program. If you press "Alt-Tab" again, you are placed in the first program. 
In the above case, if you were to press "Alt-F4" to close the currently open 
program, you are then placed in the previous program. However, if there is 
only one program running, pressing "Alt-F4" closes the program and places 
you in the "Program" menu.  
 
If you have pressed “Windows” key to bring up the "Program" menu, or "Fn-
F10" to open the Task List and you decide not to access a different 
application, you can press "Esc” to return to your previous location on the 
unit. 
 
2.10 Switching Media Modes 
 
The media buttons on the front panel perform different functions according 
to the location of the "Media Mode" switch.  
If you slide the "Media Mode" switch to the left-most position, the Voice 
Sense QWERTY announces, "radio mode" and the media buttons control 
operation of the FM Radio. If you place the "Media Mode" switch in the 
center position, the Voice Sense QWERTY says, "DAISY mode" and the 
media buttons control playback of Daisy content. If you slide the "Media 
Mode" switch to the right-most position, the Voice Sense QWERTY 
announces, "media mode" and the media buttons control media playback. 
 
It is very important to pay attention to the position of the "Media Mode" 
switch to achieve desired operation of the media buttons. For example, if 
you are using the Media Player, if the "Media Mode" switch is placed in the 
left-most position, the media buttons on the front panel control operation of 
the FM Radio even though your focus is in the Media Player. More detailed 
explanations of the functions of the Media buttons is given in the FM Radio, 
Daisy Player, and Media Player sections in this manual. 
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2.11 Switching Key lock 
 
You can disable the keys on the Voice Sense QWERTY to prevent the 
accidental pressing of keys using the key "Lock" switch on the front panel. 
When the key "Lock" switch is placed in the left-most position, Voice Sense 
QWERTY announces, "all keys locked". This means all keys on the unit are 
disabled including the on/off switch. If the key "Lock" switch is placed in the 
center position, Voice Sense QWERTY says, "top panel locked". This 
means you can continue to use the buttons and switches on the front panel 
(media mode switch, media buttons and on/off switch), however, you 
cannot use any of the keys on the top face of the unit. If the key "Lock" 
switch is placed in the right-most position, Voice Sense QWERTY 
announces, "unlocked". This indicates all keys are operational (QWERTY 
keyboard, media buttons, scroll keys, function keys, Media Mode switch 
and On/Off switch). 
Note: the "RESET" button is always operational, regardless of location of 
the key "Lock" switch. 
 
If you want to lock and unlock only the keys on the front media panel, you 
can do this by pressing the “Back” and “Forward” media buttons 
simultaneously. If you press “Back-Forward” the unit announces “Media 
keys locked”, and the media panel does not respond to key presses. If you 
press the keys again, the unit announces “Media keys unlocked”, and the 
media buttons are again operational.  
 
2.12 Print Spool 
 
The Voice Sense QWERTY has a print spool function. This function 
enables the Voice Sense QWERTY to do other tasks while printing to an 
ink-printer or Braille embosser. For example, if you send data to your 
printer or embosser, you are immediately returned to where you were 
before the print command was executed. If you want to check the Print 
Spool dialog box after you have given the print command, press "Fn-Ctrl-p" 
or “Alt-shift-p”.  A dialog box appears with three controls: a list containing 
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information about files that are being printed, a "Cancel" button, and a 
"Close" button. You can cycle through the three controls by pressing “Tab” 
or "shift-tab”. In the information list, you can move among the items by 
pressing “down arrow” or “up arrow”. If you open the dialog box when 
nothing is printing, "no items" appears in the list and only the "Close" button 
is available. 
While printing, the information list contains the following: "running program 
name," "printing file name," "printer type," "the number of copies," and 
either "printing" or "ready”. For example, let's assume that we are printing 
one copy of "sample.txt" from the Word Processor. The info list displays, 
"program: Word Processor, file: sample.txt, printer, copy: 1, printing”. If you 
are using a Braille embosser, "embosser" appears instead of "printer”. If 
nothing is printing but, (the printer is waiting), "ready" is displayed instead 
of "printing”. If you print something from the E-mail program, 
"emailtemp.txt," is displayed instead of the file name. If you are printing 
from the Address Manager, or the Schedule Manager, the message, 
"prn_ggtimegg.txt" is shown. 
 
If you focus on a file in the info list, pressing "Enter" on "Cancel" cancels 
the printing of that file. If you tab to "Close," and press "Enter" the Print 
Spool dialog box is closed. Pressing "Alt-F4" also closes the Print Spool 
dialog. 
 
2.13 One-Handed Mode 
 
Voice Sense QWERTY provides a One-handed mode for users restricted 
to the use of one hand for Braille input. To turn on/off one-handed mode, 
Press “Fn-h”. You can also turn One-handed mode on or off in the "Global 
Options" dialog.  
When One-handed mode is on, use the following methods to input text:  
To select all the contents of a file: 

1) Press “Ctrl”. The unit acts as though “Control” is being held down. 
2) And press “a”. Then, all text is selected. 
3) “When you press “a”, it deactivates the holding of “Control”.  
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Display power status 

1) Press “FN”. The unit acts as though “Fn” is held down. 
2) And press “b”. Then, power status is checked. 
3) “Fn” is no longer modifying future key presses. 

 
In other words, in “One-handed Mode”, modifier keys, when pressed by the 
user, are added to the next key press as though they are being held down. 
When the hot key is entered, all modifiers are canceled. 
The operation of the scroll keys, function keys, and media buttons remains 
the same as in normal mode.  
If One-handed mode is on, the Voice Sense QWERTY announces this 
each time it is powered on, as well as how to return to normal operation.  
 
2.14 Using Typing Mode 
 
While you are typing in a document, you may wish to turn off the navigation 
keys, especially if you type very fast as you may accidentally navigate 
when you intend to enter text. To turn on "Typing Mode", follow these steps: 
(1) Press "Fn-Ctrl-t", from within a document. 
(2) "Start typing mode" is announced and displayed. 
 
If you press “Ctrl-ESC” while executing the “Typing Mode”, it will be entered 
as “Ctrl” and “ESC” instead of executing the “Key help mode”. 
To cancel "Typing Mode", follow these steps: 
1) Press “Fn-Ctrl-t” while using “Typing Mode”. 
2) Voice Sense QWERTY displays and announces, “End typing mode”. 
 
After canceling “Typing Mode”, “Key help mode” is executed when you 
press “Ctrl-ESC”. 
 
2.15 Common Hotkeys 
 
1. Open the program menu: Win key 
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2. Execute a program in the program menu Win key-"shortcut key" (varies 
for each program) 

3. Bring up the Task list: Fn-F10 
4. Switch to previous program: Alt-shift-tab 
5. Switch to next program: Alt-Tab 
6. Open program specific menu: Alt 
7. Exit: Alt-F4 
8. Escape: ESC 
9. Move to the next control in a dialog box: Tab  

10.  Move to the previous control in a dialog box: Shift-tab  
11. Move to the previous character: Left arrow 
12. Move to the next character: Right arrow 
13. Move to the previous line/item: Up arrow 
14. Move to the next line/item: Down arrow 
15. Move to the beginning of line/item: Home 
16. Move to the end of line/item: End 
17. Move to the top of a document or list: Ctrl-Home 
18. Move to the bottom of a document or list: Ctrl-End 
19. Move to the previous page or to the first item of the previous 32-item 

group: Fn-Up arrow  
20. Move to the next page or to the first item of the next 32-item group: Fn-

Down arrow 
21. Scroll left: Up scroll button 
22. Scroll right: Down scroll button 
23. Move the cursor to each cell or move to an item: The corresponding 

cursor routing key 
24. Read the current item again: Fn-r 
25. Say current time: Fn-t 
26. Display power status: Fn-b 
27. Open the "Global Options": F10 
28. Online help: F1 
29. Check software version: Fn-v only from the Voice Sense QWERTY 

"Program" menu”. 
30. Display Network Status: Fn-n from the Voice Sense QWERTY 

"Program" menu 
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31. Increase the voice volume: F6 
32. Decrease the voice volume: Shift-F6 
33. Increase the voice rate: F7 
34. Decrease the voice rate: Shift-F7 
35. Increase the voice pitch: F8 
36. Decrease the voice pitch: Shift-F8 
37. Bluetooth on/off: F9 
38. Wireless LAN on/off: F11 
39. Ethernet port on/off: Fn-F11 

 
2.16 Quick Launch Commands 
 
Use the following commands to launch their associated applications from 
anywhere on the Voice Sense QWERTY. 
 
Use the Windows key in combination with each letter to launch the 
following applications: 
Address Manager: A.  
Web Browser: B. 
sense Chat: C. 
DAISY Player: D. 
Email: E. 
File Manager: F. 
Google Talk: G. 
Help: H. 
Twitter: I. 
BookShare Download: K. 
Media Player: M.  
RSS reader : N.  
DropBox: O. 
google Maps: P.  
Quick Browser: Q. 
FM Radio: R. 
Schedule Manager: S. 
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Database Manager: T. 
Google search: U.  
Sense Navigation: V. 
Word Processor: W. 
 
Use Caps Lock in combination with each letter to launch the applications 
below: 
Wake up alarm: A. 
Bluetooth Manager: B. 
Calculator: C. 
Sense Dice game: D. 
Format: F. 
Sense Brain Game: G. 
setup Internet: I. 
Backup/Restore Personalized Settings: K. 
Calendar: L. 
Menu manager: M. 
Pronunciation Dictionary: P. 
terminal for Screen Reader: S. 
Set Time & Date: T. 
Upgrade BrailleSense: U. 
Stopwatch: W. 
 
Other Quick Commands: 
Display Time and Date: Fn-T. 
Display Network Status: Fn-N. 
Display Power Status: FN-B. 
Change device Name: Control-Win-E. 
Open sleep Timer: Fn-J. 
Open Global options: F10. 
Open Sense Dictionary: Control-Windows-D. 
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3. CUSTOMIZING YOUR NOTETAKER 
When you receive your notetaker, one of the first things you will want to do is 
to configure it to act the way you want it to. The “Settings” menu on the 
Voice Sense QWERTY allows you to configure and customize your 
notetaker to meet your specific needs and preferences. This menu allows 
you to set your time and date, establish Internet and Bluetooth connections, 
customize the rate and volume of your TTS, adjust how things are 
announced and displayed, and many other options and settings on the unit. 
To open the “Settings” menu, press “Windows” to bring up the main menu. 
Press the DOWN arrow until you reach “Settings” and press “Enter”. Or, just 
press “s” from the main menu to quickly jump to and open the “Settings” 
menu. 
 
The “Settings” menu contains 8 items: “Set Time and Date”, “Setup Internet”, 
“Bluetooth Manager”, “Pronunciation Dictionary”, “Menu Manager”, 
“Backup/Restore Personalized Settings”, “Change Device Name”, and 
“Global Options”. The following sections will discuss each of these items in 
detail. 
 
3.1 Set Time and Date 

 
To set the Voice Sense QWERTY's internal clock, press "Enter" on "Set 
Time and Date" in the "Settings" menu.  You can find it by navigating the 
"Settings" menu with “up arrow” or “down arrow” Or press "t" to open the "set 
time and date" dialog from the menu. You can launch the “Set Time and 
Date” dialog from anywhere on the unit by pressing “Caps Lock-T”. 
 
The set time and date is a dialog, consisting of the following: "Time zone", 
"Use Daylight Savings", "Time format", "Time", "Date", "Synchronize with 
time server", a "Confirm" button, and a "Cancel" button. You can move 
among these items by pressing “Tab” or "shift-tab". 
When you activate "Set Time and Date" for the first time, you will likely see 
"Time zone? Pacific Time (US & Canada); Tijuana (GMPT-08:00)" as this is 
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the default. You can review the "time zone" list by pressing “down arrow” or 
“up arrow”, or by typing the first letter of time zones or represented cities. 
Select your time zone, and move to the next item by pressing “Tab”.  
 
The "Use Daylight Savings" check box displays according to "Time zone". If 
daylight savings time is used in the selected time zone, this item is displayed. 
If it is not used, this item is not displayed. You can check and uncheck this 
item using "Space". 
 
The next item is "Time format", the options for which are 12 hour and 24 
hour time. You can toggle between the two using “up arrow” or “down arrow”.  
Move to "Time" by pressing “Tab”. Use this option to set the clock's time. If 
you select 12 hour clock in the "Time format", A.M. or P.M. is displayed after 
the hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. by 
pressing "Fn-x". In the 24 hour clock setting, you can type a 24-hour time 
regardless of A.M. or P.M. When typing the time, separate the hour and 
minute using a space or a colon.  
 
Move to "Date" by pressing “Tab”. Type the "Date" month, date, and year  as 
mm/dd/yyyy. Use 2 digits for the month, 2 digits for the day, and 4 digits for 
the year, separating them by a space or a slash.  
The next item is "Synchronize with time server", used to synchronize time 
and date with a time server on the Internet. This function is extremely useful 
when the date and time of Voice Sense QWERTY is faster or slower than 
the current time. To execute this function, your Voice Sense QWERTY must 
be connected to the Internet. When connected, press "Enter" on the 
"Synchronize with time server" button. After synchronization, it displays the 
synchronized time in the "Time" edit combo box. The synchronized date is 
also displayed in the "Date" edit combo box. 
 
To save your settings, press “Tab”, to the "confirm" button and press "Enter" 
you are returned to "Set Time and Date" in the "Settings" menu. Or, when 
you have completed entering all of the information simply press "Enter". 
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3.2 Setup Internet 
 
The "Setup internet" function is used to configure your Voice Sense 
QWERTY to use various connection types to access the Internet. The "Setup 
internet" utility contains the following connection options: "LAN", "Wireless 
LAN", "Bluetooth DUN", "and ADSL". You can move among the four items by 
pressing “down arrow” or “up arrow”. The "LAN" setup should be used if you 
are connecting to the Internet via a Ethernet network or router. If you wish to 
connect to a mobile network via a cell phone or other Bluetooth modem, 
choose the “Bluetooth DUN” connection. The "ADSL" setup should be used if 
you are connecting to the Internet via a DSL modem. To connect to the 
Internet via a wireless network, use the "Wireless LAN" option.  
To activate "Setup internet", press "Enter" on "Setup internet" in the 
"Settings" menu, or press "I" from the menu. You can launch the “setup 
Internet” menu from anywhere on the unit by pressing “Caps Lock-I”. 
Or, if the PC on which the Active Sync program is installed is connected to 
the Internet, and the Voice Sense QWERTY is connected to that PC, you 
can also connect the Voice Sense QWERTY to the Internet via that 
connection. 
 
The various connection types are explained in greater detail in the following 
sections. 
 

3.2.1 LAN Setup 
 
Before attempting to set up a LAN connection, connect one end of a LAN 
cable to the Voice Sense QWERTY and the other to a router or direct LAN 
connection to the Internet. ALSO, be sure the Ethernet port is turned on in 
the "Global Options" dialog. You can toggle the Ethernet port on and off from 
anywhere on Voice Sense QWERTY using "Fn-F11". From the list of 
connection options in "Set up Internet", navigate to "LAN" and press "Enter".  
"Setup IP: Automatic" is displayed. If your service provider does not require 
you to use a static IP address, simply press "Enter" on this option for 
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automatic setup. For the automatic setup, your host server should provide 
DHCP service (Dynamic Host Configuration Protocol). 
 
To set up your IP configuration manually, move to "Manual" by pressing “up 
arrow”, and press "Enter". The following settings are displayed: "IP", "Subnet 
mask", "Gateway", and "Primary DNS". These settings require specific 
numeric addresses. Please contact your Internet service provider for the 
correct addresses. Use “up arrow” and “down arrow” to move among the 
settings. When you have entered the information for each item, press "Enter" 
to save the settings. The unit announces, "Setting completed". And you are 
returned to "Setup internet". Your Internet connection should be active, thus 
allowing you to use E-mail, the Social Networking programs, or the Web 
browser. 
 

3.2.2 Setup Wireless LAN 
 
Before setting up a Wireless LAN connection, be sure wireless is turned on 
in the "Global Options" dialog. You can toggle wireless on and off  from 
anywhere on the Voice Sense QWERTY using "F11". To connect to a 
wireless network, navigate to the "Wireless LAN" option in the connection 
types list under "Setup Internet" and press "Enter".  
The "Wireless LAN" dialog consists of the "access points" list, "Advanced" 
button and "Close" button. You can move among these controls by pressing 
“Tab” or "shift-tab". If wireless is not turned on, the "access points" list 
displays "no items".  
 
When wireless is on, this list shows the wireless "access points" (networks) 
in range of your notetaker. The "Access points" list displays the "access 
point name", "encryption", and "sensitivity" of each item. (Ex: linksys, 
encryption: WEP, sensitivity: good.) If there is more than one access point in 
the list, you can move among them by pressing “up arrow” or “down arrow”. 
Move to the "access point" to which you want to connect, and press "Enter". 
If the access point has no encryption, the Voice Sense QWERTY announces, 
"Connecting to (access point name)". If connection is successful, the 
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connected sound is heard. If the network is encrypted and requires a 
network key, when you press "Enter" on the access point, the "Network key" 
edit box is displayed. Type the network key in the edit box and press "Enter". 
If your settings are correct, the unit says, "Completed setting profile" and the 
connected sound is heard.  
 
The "Advanced" common dialog is used to modify an existing profile, 
manually add a new profile, or check the settings of an existing profile. If you 
press "Enter" on the "Advanced" button while wireless LAN is turned off, "no 
items" is displayed. Pressing "Enter" on the "advanced" button, while 
wireless LAN is turned on, displays a list of the wireless profiles saved on the 
Voice Sense QWERTY.  
The "Advanced" dialog has 5 controls. You can navigate among these 
controls by pressing “Tab” or "shift-tab". The "Advanced" common dialog 
contains the "profile list", "Connect" button, "Add" common dialog button, 
"Remove" button, "Properties" common dialog button, and "Close" button.  
 
1. "Profile list": The list of profiles you have added. You can move through 
the list by pressing “down arrow” or “up arrow”. 
 
2. "Connect" button: Used to connect to the selected wireless profile.  
 
3. "Add" common dialog button: Used to manually add a profile, specifically 
where an SSID is hidden, and thus does not appear in the "access points" 
list. "Add common dialog" contains 10 controls. 
1) "Setup IP: Automatic" combo box: You can switch between automatic and 
manual by pressing “down arrow” or “up arrow”. If you select "Manual", you 
must enter your IP address, subnet mask, gateway IP address, and DNS IP 
address. You can move among these computer edit boxes by pressing 
“down arrow” or “up arrow”. Press “Tab” to move to the next control. 
2) "Network name (SSID)" computer edit box: Type the network ID in the 
computer edit box. 
3) "Network mode" combo box: You can select among "Infrastructure", and 
"802.11 ad-hoc" mode by pressing “up arrow” or “down arrow”. 
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4) "Network authentication mode" combo box: Select among "Open", 
"Shared", "WPA-PSK", and "WPA2-PSK" by pressing “up arrow” or “down 
arrow”. 
5) "Data encryption" combo box: Select the data encryption method by 
pressing “up arrow” or “down arrow”. If you select "Open" or "Shared" in 
network authentication mode, you can choose among "Disable" and "WEP". 
And if you select "WPA-PSK" or "WPA2-PSK" in network authentication 
mode, either "AES" or "TKIP" can be selected in the "Data encryption" 
combo box. 
6) "The key is provided automatically" check box: If the "access point" does 
not provide a key for users automatically, uncheck this check box by 
pressing "Space". The default is checked.  
7) "Network key" computer edit box: This is a computer edit box to type the 
network key if the key is not provided automatically. 
8) "Key index" edit box: This is an edit box to type the key number of the 
wireless access point that matches the network key input. 
9) "Confirm" button: Pressing this button applies the changes. 
10) "Cancel" button: You can press this button to cancel the setup. 
 
Note:  
1) If "Data encryption" has been set as "disabled", press "Tab" and you are 
taken directly to the "Confirm" button.  
2) "Network key" and "Key index" is displayed only if you uncheck "The key 
is provided automatically". 
 
4. "Remove" button: To delete a profile item in the profile list, select the 
profile item you wish to delete, and press "r" or navigate to the "Remove" 
button by pressing “Tab”, and press "Enter" on the "Remove" button. 
 
5. "Properties" common dialog button: To get information about a selected 
profile item in the profile list, press "Enter" on the "Properties" common 
dialog button after focusing on a profile item.  By using “Tab”. You can 
reconfirm the information for each profile. You can also modify the 
information in the "Properties". 
To exit the "Advance" dialog, press "Esc" or "Alt-F4". 
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3.2.3 Bluetooth DUN setup 

 
From the list of connection types under the "Setup internet" option in the 
"Utilities" menu, move to “Bluetooth DUN” by pressing “up arrow” or "down 
arrow," and press "Enter”.  

The Bluetooth DUN setup dialog contains the following: "connect list", 
"Default", "Add", "Modify", "Delete", and "Close". You can move among 
these controls by pressing “Tab” or "shift-tab". You can move among the 
items in each control by pressing “down arrow” or “up arrow”. 

The "connect list" contains previously added connection configurations. You 
can move among these by pressing “down arrow” or “up arrow”. 
The "Default" is to set the default connection to use when connecting 
viaBluetooth DUN. To set a connection as the default, move to the "connect 
list", and navigate to "Default" by pressing “Tab”", and press "Enter". 
"Add" is a dialog for creating a Bluetooth DUN connection configuration. It 
contains "connection settings list", a "Confirm" button, and a "Cancel" button. 
You can move among these by pressing “Tab” or "shift-tab". The "connection 
settings list" contains "Connect name", “Bluetooth device”, "Connect number", 
"ID", "Password", and "Modem speed". In the "Connect name" edit box, type 
the host name or something that clearly identifies this connection to you. In 
the "Connect number" edit box, type the number of the host. Choose the 
appropriate Bluetooth device from the “Bluetooth Device” combo box. If the 
connection requires an ID and password, enter these in the appropriate edit 
boxes. If the connection does not require an ID and password, leave these 
blank. In the "Modem speed", combo box, select one from the list by 
pressing "Backspace" or "Space". When you have entered all of the 
necessary information, press "Enter" to save the connection configuration. If 
you do not want to save, you can cancel by moving to "Cancel" using “Tab”, 
and press "Enter" on it. 
 
"Modify" is used to change the information in a given connection 
configuration. You can do this by moving to the connection you want to 
modify and pressing "Enter". You can also press “Tab” to navigate to 
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"Modify" and press "Enter". Or, you can press "Control -m" on the "Connect 
name" in the "connect list". "Modify" contains the same items as the "Add" 
dialog, and you navigate and set the values in the same way. 
 
To delete an item, move to the connection you want to delete, and press 
"Enter" on the "delete" button.  Or, you can delete an item by pressing "Del" 
on the connection you wish to delete.  
To exit the “Bluetooth DUN setup", press "Alt-F4", or press “Tab” to move to 
the "Close" button and press "Enter".  
 

3.2.4 ADSL Setup 
 
To connect the Voice Sense QWERTY to the Internet via a DSL connection, 
use the ADSL connection option in "Set up Internet". Before configuring the 
connection, connect one end of a LAN cable to the Voice Sense QWERTY's 
LAN port and the other end to a DSL modem. Be sure the Ethernet port is 
turned on in the "Global Options" dialog. From the connection types list 
under "Setup Internet", navigate to "ADSL" and press "Enter".  
The ADSL configuration dialog contains the following controls: connect list, 
default, add, modify, delete, and close. You can move among the controls by 
pressing “Tab” or "shift-tab". Within each control, you can move among the 
items by pressing “down arrow” or “up arrow”. 
The "connect list" contains the names of previously added connection 
configurations. Select one by pressing "Enter" on it. Use the "Default" button , 
to set one of the configurations as the default ADSL connection.  
Use the "Add" button to create a new ADSL connection configuration. The 
"Add" dialog has three controls: a settings list, a "Confirm" button, and a 
"Cancel" button. You can move among the three controls by pressing “Tab” 
or "shift-tab".  
 
The settings list contains the following: Connect name, ID, and Password. 
You can move among the settings by pressing '“down arrow” or “up arrow”. 
In the "Connect name" edit box, type the server host name or something that 
identifies this connection to you. In the "ID" and "Password" edit boxes, type 
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the information. After entering the necessary information, press "Enter" to 
save the connection settings, or tab to the "Confirm" button and press 
"Enter". To cancel creation of the connection configuration, tab to the 
"Cancel" button and press "Enter", or press "Alt-F4".   
 
Use the "Modify" button to change the information in a given connection 
configuration. To modify a connection, select the connect name you want to 
modify from the list, and press "Enter" on the "Modify" button. Or, press "Ctrl-
m" on the connection you wish to modify. The "Modify" dialog contains the 
same items as "Add", and you navigate and enter information the same way. 
 
To delete a connection configuration from the list, select the connect name 
you want to delete from the list, and press "Enter" on the "delete" button. Or, 
press "Delete" on the connection name you want to delete. 
To exit the ADSL setup, press "Alt-F4", or press "Enter" on the "Close" 
button. 
 
3.3 Bluetooth Manager 

 
The Voice Sense QWERTY is Bluetooth capable, or rather, you can connect 
the Voice Sense QWERTY to various devices such as keyboards, printers, 
audio devices, and other computers without the need for cables. . Bluetooth 
is the latest in wireless technology and enables wireless connectivity via a 
Personal Area Network (PAN). Unlike a traditional Wireless Local Area 
Network (WLAN), these networks are limited to approximately 30 feet or 
less. Bluetooth enables users to exchange various types of information over 
this wireless connection.  
 
To use Bluetooth with the Voice Sense QWERTY, you must first turn the 
Bluetooth option "On" in the "Global Options" dialog. You can also toggle 
Bluetooth on/off from anywhere on the unit using "F9".   
You can use Bluetooth to transfer files from the Voice Sense QWERTY to a 
computer, use your computer's Internet connection, or use the Voice Sense 
QWERTY as a wireless Braille display for a computer or smart phone. Note: 
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to use the Voice Sense QWERTY as a wireless Braille display, you must be 
running a screen readers such as Window-Eyes, Supernova, or VoiceOver. 
Please note that Bluetooth is an evolving standard, and the functionality may 
vary, depending on the operating system that you are using. 
The Voice Sense QWERTY uses the built-in Bluetooth Manager program to 
manage Bluetooth functionality. You can access the Bluetooth Manager in 
several ways. To access Bluetooth Manager from the program menu, press 
“up arrow” or “down arrow” to navigate toSettings, then press “Enter”. In the 
“Settings” menu, navigate to “Bluetooth Manager”, and Press “Enter” to 
activate it. You can also press "Caps Lock-B" to open the Bluetooth Manager 
from anywhere on the unit.  
 

3.3.1 Bluetooth Device List 
 
When the Bluetooth Manager is activated, it begins scanning for other 
Bluetooth devices that are in range, and the services available from the other 
Bluetooth devices. For example, if you have a computer with Bluetooth 
enabled nearby, the Voice Sense QWERTY attempts to find it. It may take 
30 to 40 seconds to discover all of the Bluetooth devices in range. The Voice 
Sense QWERTY announces and displays, "Scanning for devices. Please 
wait..”.. Progress beeps are heard during the scanning process, and full cells 
are filled in on the Braille display (When connected to SyncBraille) to indicate 
scanning progress.  
When a Bluetooth device is detected, the Voice Sense QWERTY announces 
"found (Bluetooth device name)". Note: while the Voice Sense QWERTY is 
scanning for Bluetooth devices, it cannot respond to key presses. In addition, 
you may not cancel the scan once it has begun, but must wait for its 
completion before the Voice Sense QWERTY returns to normal operation.   
If Bluetooth is turned "Off", or if the Voice Sense QWERTY does not 
recognize the Bluetooth radio, the Voice Sense QWERTY announces, 
"Bluetooth not activated", and  exits the Bluetooth Manager. 
 
When the scanning process completes, you are placed in the Bluetooth 
Device List. If the Voice Sense QWERTY has found other Bluetooth devices 
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in range, they are displayed as "device name (untrusted (or trusted)) xx/yy" 
where xx is the number at which the device appears in the list, and yy is the 
total number of devices. "Trusted" indicates that the service has been 
authenticated, "untrusted" indicates the service has not been authenticated. 
If there are no other Bluetooth devices in range, the Voice Sense QWERTY 
announces, "no items". You can press “up arrow” or “down arrow” to move 
through the list. To select a device from the list, press "Enter" on the device 
name. 
If the Bluetooth device is trusted, settings for connecting the device are 
automatically saved in the Voice Sense QWERTY. If you want to delete this 
information, press "Del" on the Bluetooth device name in the Bluetooth 
Device List. The Voice Sense QWERTY announces, "Device settings 
removed". Removal of the settings applies only to the current device. 
From the Bluetooth Device List, you can access the menu by pressing “Alt” 
or by pressing "F2". The "Bluetooth Device List menu" contains "Rescan For 
Devices", "Device Name", "Delete Pair Information", and "Exit". You can 
navigate among the menu items using “up arrow” or “down arrow”. 
The first menu item is "Rescan For Devices". This option initiates a new scan 
for other Bluetooth devices. To activate this item, press “Alt” and press 
"Enter" on "Rescan For Devices". You can also access this option by 
pressing "r" from within the Bluetooth Device List menu, or you can activate it 
directly by pressing "Ctrl-r". 
You can access the next item in the menu by pressing “Alt” and “up arrow” or 
“down arrow” until you reach "Device Name", and press "Enter". You can 
also press "n" from within the menu to activate the "Device Name" option. 
You can access it directly by pressing "Ctrl-n".  
This item allows you to specify the device name given to the Voice Sense 
QWERTY. The default name for the Bluetooth device name is 
"VoiceSenseQwerty".  When you activate this option, you are placed in a 
computer edit box that contains your current device name. To modify the 
name, type the new name and press "Enter". After entering the new name, 
you should close all programs and reset the Voice Sense QWERTY by 
pressing the "Reset" button on the rear panel of the unit. To cancel your 
changes, press "Esc". You are returned to the Bluetooth Device List. 
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The next menu item is "Delete Pair Information". This item allows you to 
remove the connection settings for the current device. To activate this item, 
press “Alt” and press "Enter" on "Delete Pair Information". You can also 
access this option by pressing "d" from within the menu, or you can activate 
it directly by pressing "Del". 
The next item in the Bluetooth Device List menu is the “Exit” item. This item 
will exit the Bluetooth manager program. To activate this item, press “Alt” 
and then press “Up arrow” or “Down arrow” to navigate to “Exit”. Then, press 
“Enter” on “Exit”. You can also access the item while in the menu by 
pressing “z” while you are in the Bluetooth Device List menu or at any time 
without opening the menu by pressing “Alt-F4”. 
 

3.3.2 Bluetooth Service List 
 
When you locate a Bluetooth device to which you'd like to connect, press “up 
arrow” or “down arrow” to navigate to the device in the Bluetooth Device List, 
and press "Enter" on the device name. The unit announces, "Scanning for 
services. Please wait…". Please note The Voice Sense QWERTY does not 
respond to key presses during the scanning process.  
The Voice Sense QWERTY supports the following Bluetooth services: LAN, 
FTP, ActiveSync, Serial port, USB port, headset, and Bluetooth DUN. To 
access any of these functions, be sure that the remote Bluetooth device is in 
Discoverable mode, and that the service you wish to access is enabled on 
that device. It is possible to have certain services enabled on your remote 
Bluetooth device, while disabling others. For example, you could have LAN 
and FTP enabled, while having ActiveSync and Serial Port disabled. The 
Voice Sense QWERTY only sees and displays services which are enabled 
on your remote device, even if others are available.  
When the Voice Sense QWERTY has found all of the available services, the 
services are displayed in a list in the following format: "service name xx/yy" 
where xx is the number at which the service appears in the list, and yy is the 
total number of available services. You can move through the available 
services by pressing “up arrow” or “down arrow”. Press "Backspace" to 
return to the Bluetooth Device List. 
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From the Bluetooth Service List, you can access the menu by pressing “Alt” 
or by pressing "F2". The "Bluetooth Service List menu" contains "Device 
Name", "Open FTP", "Disconnect" and "Exit". You can navigate the menu 
items using “up arrow” or “down arrow”. 
The "Device Name" and "Exit" options in the "Bluetooth Service List" menu 
are the same as those in the "Bluetooth Device List" menu.  
The "Open FTP" menu item allows you to quickly open a direct FTP 
connection with a remote Bluetooth device without accessing the Device and 
Service lists. However, you must have connected the FTP service previously 
for the Voice Sense QWERTY to allow you to transfer files. If you have not 
connected the FTP service, and you activate this function, the unit 
announces, "FTP service disconnected".  
You can access "Open FTP" by pressing “Alt” then use “up arrow” or “down 
arrow” to navigate to "Open FTP" and press "Enter". The Voice Sense 
QWERTY says, "Connecting service". You can also activate it by pressing "t" 
from within the menu, or by pressing "Ctrl-t" directly from the Bluetooth 
Service List. Connecting various Bluetooth services is covered in more detail 
later in this chapter. 
The "Disconnect" menu item allows you to disconnect services with other 
Bluetooth devices. You can access this item by pressing “Alt” and “up arrow” 
or “down arrow” to navigate to "disconnect". Press "Enter" to activate it. You 
can also activate this item from within the menu by pressing "d". Or you can 
activate it directly from the Bluetooth Service List by pressing "Ctrl-d". 
To disconnect a service, press “up arrow” or “down arrow” to navigate to the 
service in the Bluetooth Service List and execute the "Disconnect" 
command. 
If there are no services connected and you activate this function, the unit 
says, "There is no service connected". 
 

3.3.2.1 Connecting  a Service 
 
To authenticate a service and connect to it, press "Enter" on the service. The 
Voice Sense QWERTY announces, "Connecting service". You are then 
prompted for a "PIN code:" This edit box only appears when you have not 
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previously connected to a service, and a pin code is required by the device. 
You can exit the edit box or delete text you have typed by pressing "Alt-F4", 
and you are returned to the Bluetooth Service List. 
When you finish typing the pin code, press "Enter". The unit announces, 
"Please wait for authentication". If the remote device is setup correctly, and 
has not been set up to allow this device to always connect, the remote 
device also asks for a pin code. Please be sure to enter the same pin code 
on both devices. If the remote Bluetooth device pin code matches the pin 
code on the Voice Sense QWERTY, the service should authenticate. If 
connection is successful, the unit announces, "PIN code authentication 
accepted".  
You are then prompted, "Please wait. Access permission". If the remote 
Bluetooth device does not give access permission, the unit says, 
"Connection failed", and you are returned to the Bluetooth Services List. If 
the remote Bluetooth device gives you access permission, the Voice Sense 
QWERTY says "Connection succeeded". If the connection succeeds, 
"Connected" is displayed after the service in the Bluetooth Service List. 
Some services may be connected without inputting a pin code depending on 
the Remote Bluetooth device settings. 
When you are connected to a service, you can press "Ctrl-d" to disconnect 
the service. The Voice Sense QWERTY says, "Service disconnected", and 
you are returned to the Bluetooth Service List.  
If you connect to the FTP service, a list of files and folders on the remote 
Bluetooth device is displayed. The rest of this chapter discusses each 
service in detail. 
 

3.3.2.2 LAN Service 
 
You can use the LAN service to access the Internet via your computer's 
Internet connection. If you connect this service, you can use the Web 
browser and email program, as if you were connected to the Internet via 
Ethernet or wireless LAN. Before you can connect to the LAN service on a 
remote Bluetooth device, the device must be configured for Internet 
Connection Sharing (ICS). If ICS is not properly setup, you cannot connect 
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to the Internet using the LAN service. For information on how to setup ICS 
for your remote Bluetooth device, please refer to the documentation that 
came with your Bluetooth adapter. Setting up ICS requires knowledge of 
network architecture, so it may be a good idea to contact a local network 
technician or your network administrator for help with setting up ICS. 
 

3.3.2.3 FTP Service 
 
This service works similarly to using FTP on the Internet. It allows you to 
transfer folders and files to and from the remote Bluetooth device. When 
referring to the FTP service, we will refer to the file/folder list on the remote 
Bluetooth device as the "remote folder list" and the file/folder list on the Voice 
Sense QWERTY as the "local folder list". 
After you have successfully connected to the FTP service, the Bluetooth 
Manager places you in the remote folder list. The remote folder list displayed 
is determined by the remote Bluetooth device. Typically, this folder is called 
the Bluetooth Exchange Folder, but you should check your remote Bluetooth 
device documentation for definitive information.  
You can interact with the remote folder list in much the same way as you 
interact with files and folders in the File Manager. With the FTP service, you 
can perform the following functions: 
1. Copy 
2. Paste 
3. Send To 
4. Retrieve File 
5. New Folder 
6. Delete File/Folder 
7. Open Local Folder. If you press "Enter" on this option, you are taken to the 
local folder list. If you are in the local folder list, this menu option changes to 
"Move to remote folder". 
8. Select All 
9. Information 
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In the next few sections, we will discuss the various FTP functions. Please 
note that while sending data to and from the remote Bluetooth device, the 
remote Bluetooth device may still need to give access permission to the 
Voice Sense QWERTY. Please consult the documentation for the remote 
Bluetooth device for details. 
 

3.3.2.3.1 Copy and Paste 
 
These functions allow you to copy and paste files between the local folder 
and the remote folder. 
Use the following steps to copy files from a local folder to the remote folder: 
 
1) From the remote folder list, press “Alt” to open the FTP menu. Press “up 
arrow” or “down arrow” to navigate to "Open Local Folder", and press 
"Enter". You can also press "o" while in the menu, or you can press “Ctrl-o” 
to open the local folder directly from the remote folder list. After activating 
this function, the unit says, "Opening Local Folder", and you are placed  in 
the Disk list that appears in File Manager. You are placed on "flashdisk" by 
default, but if you have an SD card or USB memory stick inserted, you can 
navigate to them by pressing “up arrow” or “down arrow”. 
2) As when navigating in the File Manager, you can access a disk by 
pressing "Enter" on it. Use the same navigation keys as in the File Manager 
to navigate the local folder. Note that you cannot select folders. You can only 
select files. If you try to select a folder, the Voice Sense QWERTY says, 
"Deactivated". 
3) Once you have selected files by pressing "Space", you can copy them by 
pressing “Alt”, and navigate to "Copy" by pressing “up arrow” or “down 
arrow”, and press "Enter". Or, you can press "Ctrl-c".  
4) After you have activated the copy command, Voice Sense QWERTY 
announces, "Copying" and "Open Remote Folder". You are then returned to 
the remote folder list. 
5) In the remote folder list, navigate to the folder where you want to paste the 
file. Press "Ctrl-v". Or, you can press “Alt”, and use “up arrow” or “down 
arrow” to navigate to the "Paste" function, and press "Enter". If the file is 
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larger than 300 KB, progress messages are spoken each time an additional 
10% is completed. If the file is less than 300 KB, only progress beeps are 
heard.  
6) When the file is pasted successfully, the Voice Sense QWERTY displays 
the message, "xxx file pasted", where xxx is the name of the file. If the file is 
not pasted successfully, "xxx file not pasted" is displayed. After the file is 
pasted successfully, the unit also announces, "Paste completed", and you 
are returned to the remote folder list. 
 
Use the following steps to copy a file from the remote folder list to the local 
folder list: 
 
1) Navigate the remote folder, just as you would in the File Manager. For 
information on how to navigate the File Manager, please refer to chapter 4 in 
this manual. 
2) Select the files that you want to copy by pressing "Space", you can open 
the FTP menu by pressing “Alt”, and use “up arrow” or “down arrow” to 
navigate to "Copy", and press "Enter". You can also activate this function by 
pressing "Ctrl-c". Note that you can only copy files, you cannot copy folders, 
to send to the local folder. 
3) After you have activated the "Copy" function, the Disk list appears as it 
does in the File Manager. You are placed on "flashdisk" by default. However, 
if you have an SD card or USB memory stick inserted, you can navigate to 
those disks by pressing “up arrow” or “down arrow”.  
4) After entering a disk, open the menu by pressing “Alt”. Then, move to 
"Paste" with “up arrow” or “down arrow”, and press "Enter". You can also 
activate this function by pressing "Ctrl-v". If the file is larger than 300 KB, 
progress messages are spoken each time an additional 10% is completed. If 
the file is less than 300 KB, only progress beeps are heard.  
5) When the file is pasted successfully, Voice Sense QWERTY displays the 
message, "xxx file pasted", where xxx is the name of the file. If the file is not 
pasted successfully, "xxx file not pasted" is displayed. After the file is pasted 
successfully, the unit also announces, "Paste completed", and you are 
returned to the local folder list. 
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3.3.2.3.2 Send To 
 
This function allows you to send files from the local folder list to the remote 
folder list. Note: this option is only available in the local folder list. This is 
very similar to the copy and paste function with a couple of notable 
differences. One difference is that you do not have to paste the file to the 
remote folder. It is done as soon as you activate the "Send To" function. 
ANOTHER difference is that when you activate this function, the file can only 
be sent to the root of the remote folder list. To copy a file using the "Send 
To" function, follow these steps: 
 
1) Press “Alt” from the remote folder list to open the menu. Then, press “up 
arrow” or “down arrow” to move to "Open Local Folder", and press "Enter". 
You can also activate this function directly from the "remote folder list" by 
pressing “Ctrl-o”. 
2) After you have activated the "Send To" function, the disk list appears as it 
does in the File Manager. You are placed on "flashdisk" by default. However, 
if you have an SD card or USB memory stick inserted, you can navigate to 
those disks by pressing “up arrow” or “down arrow”. Please refer to chapter 4 
in this manual for information on file and folder navigation. 
3) Select a file by navigating to it and pressing "Space". Note: you can select 
only files; folders cannot be selected. 
4) After you have selected a file, press “Alt”, and press “up arrow” or “down 
arrow” to move to "Send To", and press "Enter". Or, you can press “Ctrl-s” to 
activate the "Send To" function directly. 
5) As with copying and pasting, progress beeps are heard during the send 
process. If the file is larger than 300 KB, progress messages are spoken 
each time an additional 10% is completed. If the file is less than 300 KB, only 
the progress beeps are heard. When the transfer is complete, the unit 
announces, "xxx file sent", where xxx is the name of the file. If the file does 
not transfer, the unit says, "xxx file not sent". When all selected files are 
transferred, the Voice Sense QWERTY announces, "Successfully sent", and 
you are returned to the remote folder list. 
 



75 
 

3.3.2.3.3 Retrieve File 
 
The "Retrieve File" function allows you to retrieve a file from the remote 
folder list, and move it to the local folder. This function is only available from 
the remote folder list. When using this function, all retrieved files are saved 
to the "flashdisk/download" folder. Use the following steps to retrieve a file:  
1) Navigate the remote folder list using the same commands as in the File 
Manager (see chapter 4).  
2) PRESS "Space" to select the file you want to retrieve. Note that you can 
select only files, not folders. 
3) After selecting the file, press “Alt” to open the menu, and use “up arrow” or 
“down arrow” to move to "Retrieve File", and press "Enter". You can also 
activate this function directly by pressing "Ctrl-r". 
4) As with copying and pasting, progress beeps are heard. If the file is larger 
than 300 KB, progress messages are also spoken each time an additional 
10% is completed. If the file is less than 300 KB, only progress beeps are 
heard. When the transfer is complete, the unit announces, "xxx file 
retrieved", where xxx is the name of the file. If the file does not transfer, 
Voice Sense QWERTY says, "xxx file not retrieved". When all of the selected 
files are transferred, the message "Retrieve completed" is spoken, and you 
are returned to the remote folder list. 
 

3.3.2.3.4 New Folder 
 
The "New Folder" function allows you to create a new folder in either the 
local folder list or the remote folder list. Use the following steps to create a 
new folder:  
 
1) With the FTP service connected, from either the local or remote folder list, 
navigate to the folder in which you want to create a new folder. Move 
between the "remote folder list" and "local folder list" by pressing “Ctrl-o”. 
Use normal folder and file navigation commands to move among the items in 
the folder list.  
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2) Press “Alt” to open the menu, and use “up arrow” or “down arrow” to 
navigate to "New Folder", and press "Enter". Or, you can activate the "New 
Folder" function directly from the folder list by pressing "Ctrl-f".  
3) An edit box appears and the unit prompts, "New folder name:". Type the 
new folder name using ASCII characters, and press "Enter". If the folder is 
created successfully, the Voice Sense QWERTY says, "xxx folder created", 
where xxx is the name of the folder. You are then returned to your previous 
location: either the remote or local folder list. 
4) To cancel the folder creation, press "Alt-F4", and you are returned to the 
previous list. 
 

3.3.2.3.5 Delete File/Folder 
 
This function allows you to delete files or folders from the remote or local 
folder list. Note that if a folder contains sub-folders, you cannot delete the 
folder. To delete a file or folder, do the following:  
 
1) With the FTP service connected, navigate to the local or remote folder list, 
and select the file(s) or folder(s) you want to delete using "Space". You can 
move between the "remote folder list" and "local folder list" by pressing “Ctrl-
o”. 
 
2) After selecting the file(s) or folder(s) you want to delete, press “Alt”, use 
“up arrow” or “down arrow” to move to "Delete File/Folder", and press 
"Enter". You can also activate the "Delete" function directly by pressing 
"Del". 
3) If the file(s) or folder(s) are deleted successfully, "Delete completed" is 
spoken. 
 

3.3.2.3.6 Information 
 
This function allows you to obtain information about files or folders located in 
the remote or local folder list. You can obtain file or folder information by 
following these steps: 
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1) With the FTP service connected, navigate to the local or remote folder list, 
and select the file or folder about which you want information.  
2) Press “Alt” to open the menu, use “up arrow” or “down arrow” to move to 
"Information", and press "Enter". Or, you can activate the "Information" 
function directly from the folder list by pressing "Ctrl-i". 
3) The "Information dialog box" appears. The dialog box contains "Type", 
"Size", "Date", "Attribute (except for folders)", and "Close". You can move 
among these controls by pressing “Tab” or "shift-tab". If you select multiple 
files, the "Information" dialog displays the number of selected files and  total 
size. 
 

3.3.2.4 ActiveSync Service 
 
This service offers the same functionality as connecting the Voice Sense 
QWERTY to a computer via USB and using ActiveSync. If the connection to 
the ActiveSync service is successful, you will hear the chime indicating 
ActiveSync is successfully connected. As with all of the Bluetooth services, 
the remote Bluetooth device may need to authorize the Voice Sense 
QWERTY. You are then returned to the Bluetooth Service list. As with using 
ActiveSync via USB, you can copy and paste files from the Voice Sense 
QWERTY from the remote Bluetooth device to the Voice Sense QWERTY 
and vice versa. 
 
To disconnect the service, press "Ctrl-d" from the Bluetooth Manager. The 
Voice Sense QWERTY says, "Service disconnected", and you are returned 
to the Bluetooth Service list.  
You cannot use ActiveSync via USB and Bluetooth at the same time. If the 
remote Bluetooth device is connected via USB and using ActiveSync, you 
must terminate the USB ActiveSync connection on the remote Bluetooth 
device in order to use the ActiveSync service via Bluetooth. 

 
3.3.2.5 Serial Port 
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If you connect this service, you should not connect to other Bluetooth 
services. The Serial Port service allows you to use your Voice Sense 
QWERTY as a wireless Terminal for screen reader via Bluetooth. Note: you 
must be using Window-Eyes, SuperNova, VoiceOver, or another compatible 
screen reader to use the Voice Sense as a wirelessterminal for screen 
reader. To use the Voice Sense QWERTY as a wireless Bluetooth keyboard 
with Window-Eyes or iPhone or iPad, please reference the following 
sections.  If you are using another screen reader than those addressed 
below, please contact HIMS by e-mail at support@hims-inc.com.  
 

3.3.2.5.1 Setting up the Voice Sense to Work as a Bluetooth 
terminal with Window-Eyes 

 
The following steps will walk you through setting up the Voice Sense 
QWERTY to work as a Bluetooth terminal with the Window-Eyes screen 
reader from GW Micro. These instructions assume that you already have 
Bluetooth installed on your computer. The following instructions also assume 
that you are running Window-Eyes 5.5, or higher, and at least Windows XP, 
Service Pack 2. Before you begin, make sure that your Voice Sense is 
turned on. Although it may not be necessary, you should close all running 
applications on the Voice Sense QWERTY, and be placed in the Program 
menu for best results. If you have more than one Voice Sense, make sure 
that only the Voice Sense that you want to configure is turned on. 
 

3.3.2.5.2 Setting up the Computer 
 
1) Navigate to the Bluetooth icon in the System Tray. You may do this in 
Windows XP by pressing "windows key-b", and use the Right or Left Arrow 
Keys until you reach the Bluetooth icon. Then, press the "context menu key". 
Note that if you don't have the Bluetooth icon in the System Tray, you may 
have to change the settings for the Bluetooth icon to appear. Go to the 
Windows Control Panel, Bluetooth Devices, Options, and check the check 
box that says "Show the Bluetooth Icon in the Notification Area". 
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2) Press the "up or down arrow" keys until you get to "Open Bluetooth 
settings". 
3) Press "Enter". 
4) Select the Device tab control. You may need to press Ctrl-Tab in order to 
select this tab control. 
5) Tab to the Add button. 
6) Press "Enter". 
7) Press "Space" to check the checkbox for "My device is setup and ready to 
be found". 
8) Press enter". 
9) The XP machine will find the Voice Sense, and it will be called "Windows 
CE". Remember that the Voice Sense QWERTY must be turned on in order 
to be found as mentioned above. If you forgot to turn the Voice Sense on, 
leave it turned on, exit the Bluetooth settings, and start at step number 1 
above. 
10) Press the "down arrow" key to focus Windows CE. 
11) Tab to the Next button. 
12) Press "Enter". 
13) Press "down arrow" to focus the radio button, "Let me choose my own 
passkey". Focus will automatically be put in the edit box, and you may hear a 
tool tip that says, "We recommend using a passkey that is 8 to 16 digits 
long". You should type your passkey here. For example, you might type, 
"1111". 
14) Press "Enter". Windows will then begin exchanging the passkeys, and a 
new dialog will appear on the computer. 
15) The Voice Sense QWERTY will then ask for the passkey by saying, 
"Computer Edit Box PIN code:" Using the same passkey that was typed in to 
the computer, type in the same passkey on the Voice Sense QWERTY and 
press "Enter". 
16) The computer should display the message, "Found new hardware" and 
the final dialog should appear on the computer. Remember that you can 
press "ctrl-shift-w" to have the entire dialog read using Window-Eyes. The 
dialog should display that the Bluetooth device was successfully set up. It is 
very important to note the COM ports for the outgoing COM port and the 
incoming COM port. For example, the outgoing COM port may be COM 5, 
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and the incoming COM port may be COM 6. Do not be surprised if your 
COM ports are not set to COM 5 and COM 6. The COM ports used can vary 
from computer to computer. 
17) Press "tab" to get to the Finish button, and press "Enter" to activate it. 
18) You will then be taken back to the Bluetooth device settings dialog. 
Press Ctrl-Tab twice to focus the COM ports tab control. 
19) Press "tab" to get to the list of COM ports, and press the Down Arrow to 
move through the list of COM ports to make sure that they match the COM 
ports that were mentioned when you completed the Bluetooth device wizard. 
You should hear your first COM port, then the direction, and the name. After 
you press "down" Arrow again, you should hear the next COM port, the 
direction, and name. For example, when you press the "down arrow" key the 
first time, you might hear, "COM 5 Outgoing Windows CE Blue Tooth Serial". 
When you press the "down arrow" key a second time, you might hear, "COM 
6 Incoming Windows CE". 
20) Tab to the OK button, and press Enter. 
You have now setup the Voice Sense QWERTY and the computer. 
However, you must properly setup Window-Eyes in order to use the Voice 
Sense QWERTY as a Bluetooth terminal. 
 

3.3.2.5.3 Setting up Window-Eyes 
 
1) Press "ctrl-backslash" to open the Window-Eyes Control Panel. 
2) Press "alt-f" to open the File menu. 
3) Press the "up arrow", or "down arrow" to move to Select Braille Display, 
and press "Enter". Or, just press B to open the Select Braille Display dialog 
without using the Arrow Keys. 
4) Press the "down arrow" or the letter b until you hear Voice Sense. 
5) Press "tab" to get to the COM port list box 
6) Select the COM port that was given as the outgoing COM port when you 
setup the computer to interact with the Voice Sense via Bluetooth. 
7) Press "Enter" 
Now that you have set up Window-Eyes, you need to return to the Voice 
Sense QWERTY to finish the setup.  
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3.3.2.5.4 Setting up the Voice Sense QWERTY 

 
1) Press "Windows" to get to the Program menu. 
2) Press UP or DOWN arrow to get to the Utilities menu, or just press the 
letter u". 
3) Press "Enter". 
4) Press UP or DOWN arrow to get to Terminal for screen reader, and press" 
enter". 
5) Press UP or DOWN arrow to get to Bluetooth Serial Port, and press 
"Enter". 
The Voice Sense QWERTY should be connected as a Bluetooth keyboard 
terminal. To exit Terminal Mode, press “Alt-X". Please note that "F1" on the 
Voice Sense still takes you to the Program menu as you can continue to 
multi-task while in Terminal Mode. This enables you to use the applications 
on the Voice Sense at the same time, and be able to switch back to using 
the Voice Sense as a Bluetooth Braille display. 
 

3.3.2.5.5 Using Voice Sense QWERTY as a Keyboard with 
iPhone, iPad, or iPod 

 
Use the following instructions to connect the Voice Sense QWERTY as a 
Bluetooth keyboard terminal with your iPhone, iPad, or iPod. Note: You must 
be running IOS 4.2 or higher on your i-device in order to use the Voice 
Sense as a Bluetooth keyboard with VoiceOver. These instructions refer to 
the iPhone, however, they apply to all compatible i-devices: iPhone 3Gs and 
higher, iPad, and iPod Touch 3G and later. 
 
On the Voice Sense QWERTY: 
1) Turn Bluetooth on using "F9". 
2) From the Program menu, press u to access the "Utilities" menu, then 
press s to execute Terminal for Screen reader.  
3) Choose "Bluetooth Serial" as your connection type and pres "Enter". 
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4) Voice Sense QWERTY displays "connecting" soon followed by "Terminal 
Mode" 
 
On the I-Phone: 
1) Navigate to Settings/General/Accessibility/VoiceOver/Braille. 
2) If Bluetooth is not activated on the I-Phone, it will prompt you to do this. 
WHEN Bluetooth is activated, the I-Phone searches for devices. 
3) The Voice Sense should appear in the list of available Braille devices. 
4) Double tap the "Voice Sense QWERTY" in the Braille devices list. 
5) You are asked for a pin code. Enter any 4 digit code of your choosing. 
6) Double tap the "Pair" button. 
   
Returning to the Voice Sense QWERTY: 
The Voice Sense asks for a pin code. Enter the same pin code you entered 
into the iPhone and press Enter. 
 
You should hear a chime on the iPhone, and the text displayed on the 
iPhone should now be navigable with your Voice Sense QWERTY keyboard. 
 
For information on operating the iPhone using the Voice Sense as a 
Terminal, please refer to Apple's accessibility website at 
www.apple.com/accessibility  
 
To exit "Terminal for Screen reader" press “Alt-X”. 

 
3.3.2.6 Bluetooth keyboard service 

 
You can use this service to connect a Bluetooth keyboard to your Voice 
Sense QWERTY.  
Before you try to use this service, please be sure the Bluetooth keyboard is 
turned on and in Bluetooth range. 
Use the following steps to connect to a Bluetooth keyboard: 
1) Navigate to the Bluetooth keyboard in the Bluetooth Device List and press 
"Enter".  
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2) "Keyboard" should be displayed in the list of available services.  
3) Press "Enter" on the "Keyboard" service. 
4) If the keyboard requires a PIN code you are prompted to enter it. Some 
devices do not require a PIN code, in which case, you are not prompted to 
enter one.  
5) IF you are prompted, input the PIN code on the Voice Sense QWERTY 
and press "Enter". If the keyboard requires a PIN code, you must also input 
the PIN code on the Bluetooth Keyboard. (You should be able to locate PIN 
code information for the Bluetooth keyboard in the documentation that came 
with it.) 
 

3.3.2.7 Bluetooth Printer service 
 
You can use this service to print documents from the Voice Sense QWERTY 
via a Bluetooth enabled printer.  
Follow these steps to connect to a Bluetooth enabled printer: 
1) Press "F9" to turn on Bluetooth. 
2) Execute "Bluetooth" Manager from the "Program" menu. 
3) The Voice Sense QWERTY scans for Bluetooth devices.  
4) Press “up arrow” or “down arrow” to navigate to the Bluetooth enabled 
printer in the Bluetooth Devices List. 
5) Press "Enter". 
6) The Voice Sense QWERTY scans for available services. 
7) PRESS “up arrow” or “down arrow” to navigate to the "Printer" service. 
8) Press "Enter"  
9) The printer should connect to Voice Sense QWERTY. 
 

3.3.2.8 Using Multiple Services  
 
You can use the LAN, FTP, and ActiveSync Bluetooth services 
simultaneously. However, if you plan to use any of these services at the 
same time, you should connect the FTP service before connecting the LAN 
and ActiveSync services. If you do not connect the FTP service first, you 
may experience problems. If you are using the Serial  
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Port service, you should not connect to any other Bluetooth services. 
 

3.3.3 Hot keys in Bluetooth Manager 
 

Scann for Bluetooth device: Ctrl-r 
Connect to device: Enter on the device name 
Connect to service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device settings in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move to remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: Del 
Information: Ctrl-i 

 
3.4 Pronunciation Dictionary 

 
The "Pronunciation dictionary" is used to modify how Voice Sense QWERTY 
pronounces specified words as defined by your entries into the dictionary.  
You can open it by pressing "p" from the "Settings" menu. You can also 
launch the “Pronunciation Dictionary” from anywhere on the unit by pressing 
“Caps Lock-p”. 
The "Pronunciation dictionary" is composed of the list, "Add Word" button, 
"Modify Word" button, "Delete Word" button and "Close" button. You can 
move among these controls by pressing “Tab” or "shift-tab".  
The list is shown as "word: xx ?yy" where "xx" is the original word and "yy" is 
the alternative pronunciation. For example, if you wanted to hear "Who" 
pronounced as "world health organization" and you added the word to the 



85 
 

pronunciation dictionary, it is listed as "word: WHO ?world health 
organization". You can move up or down through items in the pronunciation 
dictionary by pressing “up arrow” or “down arrow”. You can also click the 
cursor routing key corresponding to the item position you want to focus. For 
example, if there are 10 items in the list and you want to focus the 5th item, 
you can click the 5th cursor routing key and your focus is placed on the 5th 
item on the list. The pronunciation dictionary does not list entries in 
alphabetical order, but rather, in the order they were added to the dictionary.  
To add a new word, press "Enter" on the "Add Word" button or you can 
press "	  Alt-i ". You are prompted to, "Add entry:" Type the word for which you 
want to change the pronunciation and press “Tab” to "Replacement:" Type 
the letters that produce the alternative pronunciation you desire. Press 
"Enter" or press “Tab” to move to the "Confirm" button and press "Enter". 
The word is added, and the focus is returned to the "Add Word" button.  To 
cancel this modification, press "Enter" on the "Cancel" button or press "Esc" 
or press "Alt-F4". 
 
To modify a stored entry, navigate to the item you want to modify. Move to 
the "Modify Word" button by pressing “Tab”, and press "Enter". Or when the 
entry is focused, press “Alt”. You are prompted to, "Modify entry: (focused 
word)". Press “Tab” and you are placed in the "Replacement: (new 
pronunciation)" edit box. Type the new replacement pronunciation text and 
press "Enter". Or press “Tab” again to move to the "Confirm" button and 
press "Enter". The word is modified and the focus is returned to the "Modify 
Word" button. To cancel this modification, press "Enter" on the "Cancel" 
button or press "Esc" or press "Alt-F4". 
To delete a stored entry, navigate to the entry you want to delete. Move to 
the "Delete word" button by pressing “Tab”, and press "Enter". Or, press 
"Del" on the item you want to delete. You are prompted, "Delete? Yes". If 
you are sure you want to delete the item, press "Enter". If not, press "Space" 
to change to "No" and press "Enter". 
To exit the "Pronunciation dictionary", you can press "Enter" on the "Close" 
button or press "Alt-F4". 
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3.5 Menu manager 
 

3.5 Menu Manager	  	  

Using the Menu manager on the Voice Sense QWERTY, you can manage 
what menus and/or programs are displayed in the Main Menu or sub 
menus. You can show or hide almost any program in the Main Menu with a 
few exceptions. You may not hide the File manager, the Menu Manager 
itself, or the "Programs" menu which only appears if external programs are 
installed.	  	  

To execute the "Menu manager", follow these steps:	  	  

(1) From the "program" menu, press "S" or "Enter" on the ""Settings"" menu.	  	  

(2) Press the short cut key, M or "Enter" on "Menu manager".	  	  

(3) The "Menu manager'" dialog is displayed.	  	  

You can also launch the "Menu Manager" from anywhere on the unit by 
pressing "Caps Lock-M".	  	  

The dialog of the "Menu manager" consists of the following items:	  	  

1) The menu/program list	  	  

2) "Modify Menu Name" button (Only appears when cursor is placed on a 
menu)	  	  

3) Confirm button	  	  

4) Cancel button	  	  

To navigate among the programs, press the Up or Down arrow.	  	  

Press "Tab" or "Shift-tab" to navigate to the "Confirm" and "Cancel" buttons.	  	  

When placed on a menu such as "Media" or "Web Tools", you do not have 
the option of showing or hiding the item. Menus are displayed if they have 
programs accessible inside them. If you have chosen to hide all the 
programs in a given menu, this menu will not be displayed. When your 
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cursor is placed on a menu, you have the option of renaming the item. To 
rename a menu item, follow these steps:	  	  

i. Navigate to the menu you wish to rename.	  	  

II. Tab to "Modify Menu Name", and press "Enter".	  	  

IIi. Voice Sense prompts, "Menu Name", and you are placed in an edit box 
in to which you can type the new menu name.	  	  

IV. When you have typed the new name in to the edit box, press "Enter", or 
tab to "Confirm" and press "Enter".	  	  

To hide unused programs on the Voice Sense QWERTY, press "Space" on 
each of the programs you wish to hide in the list. Press "Enter" to save your 
settings, or tab to "Confirm" and press "Enter". You must reset the Voice 
Sense QWERTY using the "Reset" button on the back of the unit for these 
settings to take effect. When the Voice Sense QWERTY reboots, the 
programs you chose to hide are no longer displayed.	  	  

To unhide the programs, return to the "Menu Manager" dialog, and press 
"Space" on the programs you wish to unhide, and press "Enter" to save the 
settings. Press "Reset" once again, and the programs reappear in the 
menus after the unit reboots.	  	  

 
3.6 Backup/Restore Personalized settings 

 
"Backup/Restore Personalized settings" is a utility used to backup/restore 
the option settings for each program in the Voice Sense QWERTY all at 
once. You can run this utility by pressing "k" from the "Settings" menu. You 
can also launch the “Backup/Restore Personalized Settings” dialog from 
anywhere on the unit by pressing “Caps Lock-K”.  
 
The "backup/restore" dialog contains: the "program option check box list", a 
"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" 
button. You can move among the check boxes in the "program option check 
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box list", by pressing “up arrow” or “down arrow”. You can move among the 
controls in the dialog by pressing “Tab” or "shift-tab".  
The "program option check box list" contains "Options settings", "File 
manager options", "Word processor options", "Address manager options", 
"Schedule manager options", "Media player options", "Web browser options", 
"E-mail options", “DAISY Player options”, “Radio options”, "Bluetooth 
manager options", "Social Networking options", "Database manager options" 
and “BookShare Download options”. 
 
In this list, move to the program options you want to backup or restore and 
check the item by pressing "Space". You can uncheck a checked item by 
pressing "Space" again. To select all of the program options in the list, press 
"Enter" on the "Select all" button or press “Control-a”.  
After selecting all the options you want to backup or restore, press "Enter" on 
the "Backup" or "Restore" button. If you select the "Backup" button, you are 
prompted to select a path for storing the backup file. Navigate to the folder in 
which to store the backup files using normal file/folder navigation commands. 
Select the folder or disk in which to store the backup by pressing "Space", 
and press "Enter" to start the backup process.  
 
Each of these options has its own backup file. This means that if you backup 
options for 5 programs, it generates 5 backup files.  
If you select the "Restore" button, you are prompted for the path from which 
to restore backup files. Again, use normal file and folder navigation to select 
the folder containing your backup files. If you select a folder in which there is 
no backup, you receive a message indicating there is no backup option file. 
To restore your settings, select the folder containing the backup files by 
pressing "Space", then press "Enter" to initiate the restore process. 
If you hard reset your Voice Sense QWERTY, or its battery is fully 
discharged, the main option settings and settings for each program are 
initialized to the default values. If you have created a backup of your settings,  
you can restore the option settings after the hard reset. 
 
You can also activate the “Backup” and “Restore” buttons using “Control-b” 
and “Control-r” respectively. 
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3.7 Change device Name 
 
The “Change device Name” function allows you to change the Bluetooth 
name of your unit. By default, the Voice Sense is named something like 
“Voice Sense035”. You may wish to give it a more personalized name in 
order to identify it more easily when pairing with another device. This is 
especially important when using “Sense Chat” as you’ll be pairing 2 Sense 
notetakers, and it is important to know which is which.  
You can access the “Change device Name” dialog by navigating to the 
“Settings” menu, then to “Change Device Name”. You can also launch the 
“Change device Name” dialog from anywhere on the unit by pressing 
“Control-Win-E”. 
The “Change device Name’ dialog consists of 3 controls: a “Device Name” 
edit box, a “Confirm” button, and a “Cancel” button. Use “Tab” and “Shift-tab” 
to move among the controls. 
To change your device name, type a new name in the edit box and press 
“Enter”. Or, after typing the new name, tab to “confirm” and press “Enter”. If 
you decide you do not wish to change your device name, tab to the “Cancel” 
button and press “Enter”, or press “Escape”. 
Once you have changed your device name, it is necessary to reset the unit 
for the change to take effect. Reset the unit by pressing the  small round 
button on the back. The next time you use another device to search for 
Bluetooth devices, your Voice Sense should appear under your new name. 
 
3.8 Global Options 
	  

The "Global Options" on the Voice Sense QWERTY is a large dialog box 
for controlling many preferences/settings. You can access "Global Options" 
by pressing “Windows” key to get to the main menu, and navigating to 
“Settings” and pressing “Enter”.  Navigate to "Global Options" by pressing 
“down arrow” or “up arrow”. Press "Enter" to open the "Global options” 
dialog. You can also open the “Global Options from anywhere on the 
notetaker by pressing “F10”. 
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You can navigate among the items in "Global Options" using “up arrow” and  
“down arrow” or using the scroll keys.  You can also use shortcut keys to 
quickly move to specific items in the "Global Options" dialog. You can toggle 
an option on or off or cycle through the available values of a setting with the 
"space" or "Backspace" keys. 
Many of the Global Options also have global hotkeys allowing you to  adjust 
these settings from anywhere on the unit. You can view the shortcut and 
hotkey for an option by placing your cursor on it and pressing “Function-Z”. 
 
To save the changes you've made to the "Global Options" settings, press 
"Enter". When you press "Enter" to save the settings, the Voice Sense 
QWERTY says, "Saved options," and you are returned to the place on the 
notetaker from which you entered the "Global Options". To cancel without 
saving changes, press the "Esc" key or "Alt-F4". The Voice Sense QWERTY 
announces, "Canceled saving options".  
 
From the options list, you can also use “Tab” or "shift-tab" to navigate to the 
"Confirm" and "Cancel" buttons. If you want to save your settings, press 
"Enter" on the "Confirm" button. If you do not want to save changes, press 
"Enter" on the "Cancel" button. 
 
Before we go in to detail about each option, let's first go through a brief 
overview of what appears in the "Global Options" dialog. 
 
 

3.8.1 Global Options Overview 
 
The "Global Options" dialog contains various settings that can be changed in 
the Voice Sense QWERTY.  As stated above, you can open "Global 
Options" from anywhere on the unit by pressing “F10”. The "Global Options" 
dialog contains five groups, making it easy to jump to a particular section in 
the very long list of settings present in the dialog. 
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1. Braille settings (includes Braille display, Braille cursor, eight dot mode, 

view/input grade, Braille Code and message display time)  
2. Voice settings (includes language, voice, punctuation level, keyboard 

echo, capitalization alert, numbers, abbreviations, voice volume, voice 
rate, voice pitch, Main Volume, Sub Voice Rate, and scroll voice) 

3. Display settings (flip LCD display, LCD font size, and video display) 
4. Print settings (includes printer port and print paper size) 
5. General settings (includes audio alerts, play power on/off sound, Switch 

Function and Control, Switch Command and Alt, left scroll buttons, right 
scroll buttons, skip empty lines, control information, hide passwords, hot 
key information, announce shortcut keys, power saving mode, power 
saving kick in, check today's schedule, one-handed mode, Automatic 
spell-check, default document type, default Browser, Automatically 
synchronize with time server, progress indicator, Bluetooth, wireless 
LAN, Ethernet port, and mass-storage device mode.) 

 
You can navigate among the five groups by pressing "page down or "page 
up”. When you navigate to a particular group, you are placed at the location 
in "Global Options" where that group of options begins. Though the "Global 
Options" dialog is divided into groups for ease of navigation, it is actually one 
long continuous list of settings. As explained above, you can move between 
items in the "list" by pressing "up arrow” or "down arrow”. You can change 
the setting for each option by pressing "Space" or "Backspace".  
 
Note: in addition to navigating by group, you may also use shortcut keys to 
jump to specific settings in the "Global Options" dialog. However, it should 
also be noted that often, the same shortcut key is used for multiple options. 
Thus, as is the case when using first letter navigation, pressing a shortcut 
key moves the focus to the first setting that matches the shortcut key, 
pressing the key again moves to the next setting that matches that shortcut 
key. If there are no more settings matching the shortcut key, the Voice 
Sense QWERTY wraps around to the first match. 
 



92 
 

As stated above, many items in "Global Options" also have global hot keys. 
This means you can use this hot key from anywhere on the unit to instantly 
modify that particular setting without bringing up the "Global Options" dialog.   
 

3.8.2 Global Options in Detail 
 
Let's take a look at each setting in the "Global Options" dialog in more detail.  
 

3.8.2.1 Braille Cursor 
Note: This option is only available when connected to SyncBraille. 

Use this setting to define how you want the Braille cursor to appear on the 
Braille display (When connected to SyncBraille). By default the cursor is set 
to "Always up". Press "Space" to change the cursor to "Blinking," and again 
to turn the cursor "Off".  

 
Use "c" to jump quickly to this option.  
 
Note that the Braille cursor can appear in 3 different forms: 
1. "Dots 7-8" 
2. Blinking "dots 7-8" 
3. Blinking "dots 1-2-3-4-5-6-7-8" 
 
The blinking "dots 7-8" is displayed when you are using "overwrite mode" in 
the word processor. The blinking "dots 1-2-3-4-5-6-7-8" appears when you 
are selecting text to denote the end of the selection. 
 
In all other situations, the cursor is displayed as "dots 7-8". 
 

3.8.2.2 Eight Dot Mode 
 
Note: this option is only available when connected to SyncBraille. 
You can choose to use 6-dot-Braille or 8-dot-Braille mode when entering 
ASCII text. The shortcut key is "e". By default 8-dot-Braille is set to off. 
WHEN your cursor is placed on this option, you can turn on 8-dot-Braille 
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mode by pressing "Space". You can toggle this option on/off by pressing 
"FN-F4" from anywhere. 
 

3.8.2.3 View Braille Grade  
 
This option lets you choose what grade of Braille you want to use when 
viewing text.  The shortcut key is "g". The available settings are 
Uncontracted Braille, Contracted Braille, and Computer Braille. You can 
cycle among the settings by pressing "Space". You can press "Fn-g" to cycle 
through the Braille grades from any location on the Voice Sense QWERTY.   
 

3.8.2.4 Braille Code 
 
The Braille code setting defines the rules by which Braille is translated to text 
and vice versa. The Voice Sense QWERTY offers 3 English Braille codes as 
well as entry of Spanish, French, Italian, and German Braille. Thus the 
Braille code can be set to use "US", “UK”, "UEBC", (Unified English Braille 
Code) or "Spanish”, “French”, “German”, or “Italian".  

 
The original intent of the UEBC was to explore the possibility of bringing 
together three of the official Braille codes that are used for Braille in English-
speaking countries for various purposes, viz.: literary material (English 
Braille, American Edition), mathematics and scientific notation (Nemeth 
Code), and computer notation (Computer Braille Code).  
 
Choosing one of the other 4 languages allows you to input Braille according 
to that language’s Braille rules, and read documents created in that 
language using the associated Braille translation. The Braille language also 
affects, lists, combo boxes, and edit boxes. Buttons and static boxes are not 
affected by the change in Braille language. 
 
The short cut key used to jump to the Braille code option is "c". The default 
setting is "US". Use "Space" to change to "”UK”, UEBC" or "Spanish", 
“French”, “Italian”, or “German”.  
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You can cycle through all the available Braille codes from anywhere on the 
unit using “Windows-Alt-b”. 
 
Note: If you change the Braille Code option while you are editing Braille in 
the Word Processor, the meaning of the Braille in your current document will 
be changed to reflect the current Braille Code setting. To avoid this problem, 
the Braille Code option should be changed before launching the Word 
Processor. 
 

3.8.2.5 Message Display Time 
 
This option defines how the Voice Sense QWERTY deals with system 
messages. You can set the unit to ignore system messages, to stand by until 
you press a key, or, if the Braille display (When connected to SyncBraille) is 
on, you can define how long the message remains on the display before 
automatically disappearing. Use "m" to quickly jump to this item in "Global 
Options".  
 
The available settings are "Stand by," "Ignore", and display times of 1 to 10 
seconds. The default setting is "3 seconds". Use "Space" to increase the 
message display time by one second and "Backspace" to decrease the 
message display time by one second.  If you read the message before the 
display time has elapsed, you can clear the message by pressing any key.  
 
Set the unit to standby mode by pressing "Space" until you reach "Stand by". 
In this mode, the message remains indefinitely until you press a key.  If you 
choose "Ignore," messages are ignored and do not appear on the display.  
 

3.8.2.6 Language 
 
The Voice Sense QWERTY can output speech in US English, Mexican 
Spanish, French, German, and Italian. You can change the Text-to-Speech 
(TTS) engine using the "Language" setting in the "Global Options" dialog.  
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When you change the language of the text to speech engine using this 
setting, menu items, prompts, and static boxes are not affected and remain 
spoken in English. However, list items, combo boxes, and all edit boxes and 
multi-edit boxes, such as documents or e-mail messages, are spoken and 
text is entered using the language chosen with the “Language” setting.  
 
When text is entered using a given language, the language attribute is 
attached to that text, and whenever it is encountered on the unit, it is spoken 
using the TTS of the language in which it was created. You can change the 
language associated with a certain block of text using the “Edit Language 
Attribute” function described in section 5.2.15 of this manual. 

 
The shortcut for jumping quickly to the "Language" setting is "l". Press 
"Space" to toggle the TTS voice between "English", "Spanish", “French”, 
“German”, and “Italian”.  
 
Note: you can change the language from anywhere on the unit by pressing 
"Alt-Windows-v". 
 

3.8.2.7 Voice 
Note: This option only appears when connected to SyncBraille. 
This option allows you to toggle the Voice Sense QWERTY voice on and off. 
This option can only be used if the SyncBraille Braille display is connected 
as the speech cannot be disabled if there is no braille output. The shortcut 
key is "v". By default the voice is set to on. You can change the status of the 
voice by pressing '"Space". You can toggle the voice on and off from 
anywhere on the Voice Sense QWERTY by pressing "F5".  
 

3.8.2.8 Punctuation Level 
 
Use this setting to choose how you want the Voice Sense QWERTY to read 
punctuation marks. The shortcut key is "p". The available options are "All," 
"Off", "Punctuation," and "Symbol". The default setting is "Off", thus, by 
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default, the Voice Sense QWERTY speaks no punctuation marks or symbols. 
Use "Space" to cycle through the four settings. If you select "All", the Voice 
Sense QWERTY speaks all punctuation marks and symbols. When the 
option is set to "Punctuation", the Voice Sense QWERTY speaks 
punctuation marks; when the "Symbol" option is chosen it speaks all symbols 
and no punctuation marks.  
 

3.8.2.9 Keyboard Echo 
 
With this option, you can define what the Voice Sense QWERTY speaks as 
you type. The shortcut key is "k". The setting values are "On with characters 
and words," "On with characters," "On with words," and "Off". The default is 
"On with characters and words," thus each keystroke is announced and each 
word is spoken when "Space" is pressed. If you select "On with characters," 
each keystroke is announced as you type it. If you select the "On with words" 
option, each word is spoken after "Space" is pressed. You can cycle through 
the options by pressing "Space".  
 

3.8.2.10 Capitalization alert 
 
Use this option to choose how the Voice Sense QWERTY alerts you that a 
character is capitalized, either when typing or when navigating a document 
or edit box by character using “Left arrow” or “Right arrow”. The shortcut 
key is "u". The setting values are "Off", "Say cap," and "Pitch". The default 
value is "Pitch". If you select the default, when you encounter a capital letter, 
the pitch of the voice is raised to indicate it. If you select "Off", the voice 
remains the same regardless of upper or lower case. And if you select the 
"say cap," option, "cap" is spoken before the letter to indicate capitalization. 
For example, when you encounter the capital letter "V," Voice Sense 
QWERTY speaks "cap v". 
 

3.8.2.11 Numbers 
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This option defines how you want the Voice Sense QWERTY to speak 
numbers. The shortcut key is "n". The default value is "On". If "numbers" is 
set to "On", "2007" is read as "two thousand seven". If "numbers" is set to 
"Off", numbers are spoken as digits, and "2007" is read as "two zero zero 
seven". You can change the value by pressing "Space". 
 

3.8.2.12 Abbreviations 
 
You can turn the translation of acronyms on/off on Voice Sense QWERTY. 
Use "a", to jump quickly to the "Abbreviations" option in the "Global Options" 
dialog. If "Abbreviations" is set to "On", when the Voice Sense QWERTY 
encounters "Ala" it speaks "Alabama". But if "Abbreviations" is set to 'Off', it 
speaks "Ala".  
 

3.8.2.13 Voice Volume 
 
Use this option to set the volume level of the voice on the Voice Sense 
QWERTY. The shortcut key is "l”. The volume level can be set using values 
1 to 21, with 1 being the lowest volume level and 21 being the highest. Use 
"Space" to increase the volume by 1 increment, and "Backspace" to 
decrease it.  
 
From anywhere on the Voice Sense QWERTY, you can increase the volume 
with "F6" and decrease it with "Shift-F6". 
 

3.8.2.14 Voice Rate 
 
This option controls the rate of the speech on Voice Sense QWERTY. The 
shortcut key is "r". You can set the rate using values 1 to 12, with 1 being the 
slowest, and 12 being the fastest. Press "Space" to increase the rate of 
speech by one increment, and "Backspace" to decrease it.  
 
From anywhere on the Voice Sense QWERTY, you can increase the speech 
rate using "F7" and you can decrease it with "Shift-F7".  
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3.8.2.15 Voice Pitch 

 
Use this option to control the pitch of the voice on the Voice Sense 
QWERTY. The shortcut key is "t". The available values are 1 to 10, with 1 
being the lowest pitch and 10 being the highest.  Use "Space" to increase 
the voice pitch one level, and "Backspace" to decrease it.   
 
From anywhere on Voice Sense QWERTY, you can increase the pitch by 
pressing "F8" and decrease it by pressing "Shift-F8". 
 

3.8.2.16 Sub Voice Rate 
	  

The Sub Voice rate option controls the rate of the voice used to output 
speech in languages other than English. The values range from levels 1 to 
12, with the default set to 8. Use “Space” to increase the Sub Voice rate and 
“Backspace” to decrease it. The shortcut key is “r”.  
You can adjust the Sub Voice rate from anywhere on the Voice Sense 
QWERTY using “Windows-F7” to increase it and “Shift-Windows-F7” to 
decrease it. 
 

3.8.2.17 Main Volume 
	  

Use the Main Volume option to control the master volume of the unit. 
Adjusting the Main volume changes the level of both system audio as well as 
TTS. The available values are 1 to 21. Use “Space” to increase the Main 
Volume and “Backspace” to decrease it. The shortcut is “v”. You can also 
adjust the main volume from anywhere on the unit by pressing “Windows-
Shift-F6” to decrease it, and “Windows-F6” to increase it. 
 

3.8.2.18 Scroll Voice 
 
Note: this option is only available when connected to SyncBraille. 
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Use this setting to choose whether you want the Voice Sense QWERTY to 
speak while using the scroll buttons as you read. The shortcut key is "s" with 
the default set to "Off". The default setting (Off) means the Voice Sense 
QWERTY does not speak when you use the scroll keys to move through a 
document. Set this option to "On" if you would like to hear the Voice Sense 
QWERTY speak text as you scroll through it. Use "Space" to toggle the 
option on/off.  

3.8.2.19 LCD 
 
This option controls the status of the LCD screen. If you turn the LCD screen 
on, sighted people can view what is displayed on the Voice Sense Qwerty. 
The shortcut key is "l " with the default set to "Off". You can choose to turn 
the LCD "On", "Off", or "On with backlight". You can cycle between the three 
options by pressing "Space". 

 
3.8.2.20 Flip LCD display 

 
Note: This option is displayed only when Voice Sense QWERTY is 
connected to the external LCD accessory. 
 
The Voice Sense QWERTY gives you the option of viewing the text on the 
LCD screen in normal or reverse orientation. By default, "flip LCD" is set to 
"Off", meaning the text is shown in normal orientation. If the option is set to 
"On", the text is in reverse orientation so that someone across the table can 
view the display in the correct orientation from "his/her position. You can 
toggle the value on/off using "Space".  
 
This is a useful tool for teachers or parents wanting to view a student's work, 
or for communicating with deaf-blind users.    
 

3.8.2.21 LCD Font Size 
 
Note: This option is displayed only when Voice Sense QWERTY is 
connected to the external LCD accessory. 
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Use this setting to change the font size of the text on your LCD. The shortcut 
key is "f". The default is set to 19. The font size can be set using values 12 to 
20. Use "Space" to increase the font 1 size, and "Backspace" to decrease it. 
If you have the font size set to 20, and you increase the font by one size, the 
font wraps around to 12. If your font size is 12, and you decrease the font by 
one size, the font wraps around to 20. 
 

3.8.2.22 Printer Port 
 
Use this option to define which port is used to send information to your 
printer when printing a document. The shortcut key is "p". The default is set 
to "USB". You can also choose to print via a parallel or Bluetooth printer. Use 
"Space" to cycle among the 3 options. 
 
Note: if you want to use a parallel printer, you must use a USB to parallel 
adapter and connect the printer to the USB port on the Voice Sense 
QWERTY.   
 

3.8.2.23 Print Paper Size 
 
This option allows you to select the size of the paper that an ink printer is 
using so the document is scaled correctly when printing. To jump quickly to 
this option, use "s". You can adjust the size by pressing "Space". The 
available sizes are "Letter" (8.5 inches by 11 inches) and "Legal" (8.5 inches 
by 14 inches.) 
 

3.8.2.24 Audio alerts 
 
Use this setting to choose whether the Voice Sense QWERTY alerts you to 
various events using audio signals,. The shortcut key is "a". Audio alerts are 
useful if the speech on the Voice Sense QWERTY is turned off. By default, 
"Audio alerts" are turned "On". When "Audio alerts" are set to “beep”, you 
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hear a beeping sound when you type keystrokes that are not acceptable in 
your current context on the Voice Sense.  
If you don't want to hear a warning or alert, , press "Space" until you reach 
the "Off" setting. 

 
3.8.2.25 Play Power On/Off Sound 

 
Use this option to choose whether you hear the power on/off sound when 
you turn on/off the Voice Sense QWERTY. The shortcut key is "s". The 
default for this option is set to "On".  
If you want the Voice Sense QWERTY to power on/off silently, press 
"Space" to turn "Off" "Play power on/off sound". 
 

3.8.2.26 Skip Empty Lines 
 
You can choose to have the Voice Sense QWERTY alert you to a blank line 
by announcing "Blank" as you encounter empty lines while scrolling through 
a document or you can choose to have the unit skip empty lines. The 
shortcut key is "e" and the default is set to "Off".  Use "Space" to toggle the 
option on/off.   
 

3.8.2.27 Control Information 
 
Use this setting to determine where information is announced regarding the 
type of control on which you are currently located, a list item, menu, combo 
box, etc. The short cut key is "i" and the default is set to "After". To toggle 
"Control information" between before, after and off, press "space. 
 
If you select "Before," control information, such as "list item", or "combo box" 
is spoken before a menu/list item or form control. If you select "After," control 
information is announced after the item or control. If you have control 
information set to "Off", control information is not displayed or spoken. 
Note: if Control Information is set to anything other than “Off”, it always 
appears in Braille before the control.  
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Note that if you are using the Web browser the control symbols are 
displayed even if the "Control information" option is set to "Off".   

 
3.8.2.28 Hide passwords 

 
When you enter a password in a computer edit box, The Voice Sense 
QWERTY can either display an asterisk, *(dots 1-6) or the actual password 
as you type it.  
 
The short cut key is "p" and the default is set to "On". This means passwords 
are hidden, and thus will be shown using asterisks. To show passwords as 
you type them, use "Space" to toggle this setting to "Off".  
 

3.8.2.29 Hot Key Information 
 
As described previously, hot keys are keystrokes used to immediately 
access or activate an item, such as a menu, or a particular item in a list. Use 
this option to define how hot key information is announced. The short cut key 
is "h" and default is set to “On”. The setting values are “On,” and “Off”. You 
can cycle through each of the options by pressing “Space”.   
 
If you select "On", the "Open" option in the File Menu of the Word Processor 
is announced, "Open (o) Ctrl-o". 	  And if you select “Off,” you can’t hear the 
hot key information. 
 

3.8.2.30 Announce shortcut keys 
 
The "Announce shortcut keys" option lets you choose whether the Voice 
Sense QWERTY speaks the shortcut key for a function. The shortcut key for 
this option is "s" and the default is set to "On". For example, if you press "F2" 
to bring up the program menu in the Word Processor, you may hear, "File (f) 
pull down". In this case, the shortcut key for accessing the Word Processor's 
"File" menu is the letter "f". If you do not wish to hear the shortcut keys 
announced, toggle "Announce shortcut keys" off by pressing "Space". 
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3.8.2.31 Power Saving Mode 

 
Use this option to set the Voice Sense QWERTY to save power by 
automatically shutting down after a certain period of time. The shortcut key is 
"p". The default setting is set to "On". Use "Space" to cycle through the 
available values: "On", "Off", and "Message". If you never want your Voice 
Sense QWERTY to shut down automatically, set the option to "Off". If you 
set the option to "Message," The Voice Sense QWERTY gives you a 
warning message that says "power on" to remind you the unit is still powered 
on after 10, 20, or 30 minutes of inactivity (depending on the setting that you 
choose for power saving kick in).  
 
Note: this option is available only when the AC adaptor is not connected to 
the unit. In other words, even if this option is set to "On", if the AC adaptor is 
connected to the unit, the unit does not enter Power Save Mode, even when 
the "Power saving kick in" time has elapsed. 
 

3.8.2.32 Power Saving Kick In 
 
Use this option to set the time of inactivity before entering Power Save Mode. 
The shortcut key is "k" with the default set to "After 10 minutes". This means 
the Voice Sense QWERTY enters power saving mode when you have not 
used the Voice Sense QWERTY for 10 minutes. Use "Space" to cycle 
through the available settings: 10 minutes, 20 minutes, and 30 minutes. 
 

3.8.2.33 Check Today's Schedule 
 
In the "Schedule manager" (which you will learn about later), you can keep 
track of your appointments using the Voice Sense QWERTY. YOU can set 
the Voice Sense QWERTY to check today's schedule for appointments each 
time you turn it on. The short cut key for this option is "s". To toggle this 
option on/off, press "Space". 
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3.8.2.34 One-Handed Mode 
 
This option allows users with only the use of one hand to use the Voice 
Sense QWERTY in a specific mode adapted for that purpose. The shortcut 
key is "h". The default setting is "Off". Use "Space" to toggle one-handed 
mode on/off. For detailed information about one-handed mode, refer to "2.14 
One-Handed Mode". 
 
Note: If this option is set to “On" when you connect a USB keyboard, it is 
automatically turned off when the keyboard is connected. The option returns 
to its previous state when the USB keyboard is disconnected from the unit.  
 

3.8.2.35 Automatic spell-check 
 
Use this option to set whether the Voice Sense QWERTY automatically 
checks spelling as you type in "multi line edit boxes" in programs such as the 
schedule manager, address manager, e-mail messages, the word processor, 
etc. The short cut key for this option is "c". 
By default this option is set to "Off", thus spelling is not automatically 
checked as you type. Press "Space" to toggle automatic spell checking 
on/off.  
 
If the option is "On", and you enter a misspelled word, Voice Sense 
QWERTY emits a beep sound to indicate a misspelling. This beep sounds 
even if audio alerts are turned off. 
 

3.8.2.36 Default Document Type 
 
This option is used to set the default document type for new documents you 
create using the word processor on the Voice Sense QWERTY. The shortcut 
key for this option is "q". By default, "Text document" is selected as the 
default file type.  
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You can choose "Sense document", "Braille document," or "Text document" 
as your default document type.  Press "Space" to cycle through the three 
options. 
 
Note: When you connect a USB QWERTY keyboard to the Voice Sense 
QWERTY, this option is automatically set to "Text document". When the 
USB keyboard is disconnected, the default document type is returned to 
whatever it was set to before the USB keyboard was connected. 
 

3.8.2.37 Default Browser 
This option allows you to set whether to use the original Sense Web Browser 
or the newer Quick Browser as your default browser for opening web pages 
from programs such as E-mail, RSS, Google Search, and Twitter.  
The shortcut key for this option is “B”. By default, this option is set to the 
original “Web Browser”. Press “Space” to toggle between the “Web Browser” 
and “Quick Browser”. 

 
3.8.2.38 Automatically synchronize with time server 

 
If you have the "Automatically synchronize with time server" option turned on, 
the date and time is synchronize with an internet time server automatically 
each time the Voice Sense QWERTY is connected to internet. Using this 
feature, you can ensure the accuracy of the time on the Voice Sense 
QWERTY by synchronizing with an atomic clock via the internet.  
 
The shortcut key is "t". The default setting is "ON". Use "Space" to toggle 
time server synchronization on/off.   
 

3.8.2.39 Progress indicator 
 
The progress indicator setting defines how the progress of opening a 
document, copying files or opening a webpage is indicated. The shortcut key 
is "p”. You can choose among "Silent," (no progress indication) "Beep," 
(continuous beeps while the task is performed) and "Message" (progress is 
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shown as a percentage).  By default, progress indication is set to "Message". 
Press "Space" to cycle through the three settings,  
 

3.8.2.40 Bluetooth 
 
Use this option to turn Bluetooth on or off. The shortcut key for this option is 
"b". Toggle Bluetooth on/off by pressing "Space". By default, it is set to "Off". 
You can toggle Bluetooth on and off from anywhere on Voice Sense 
QWERTY by pressing "F9".  
 
Note: you must turn Bluetooth on to connect to Bluetooth enabled devices. It 
is recommended that you turn Bluetooth off when it is not in use to save 
battery power. 
 

3.8.2.41 Wireless LAN 
 
Use this setting to turn Wireless LAN on or off. The shortcut key for this 
option is "w". You can toggle wireless on/off by pressing "Space". By default, 
it is set to "Off". You can toggle it on and off from anywhere on Voice Sense 
QWERTY by pressing "F11"  
 
Note: you must turn Wireless LAN on before connecting to a wireless 
network or to the internet via a wireless router. It is recommended that you 
turn wireless off when not in use to save battery power. 
 

3.8.2.42 Ethernet port 
 
Use this setting to turn the Ethernet port on or off. The shortcut key for this 
option is "l". You can toggle Ethernet on/off by pressing "Space". By default, 
it is set to "On". You can toggle it on and off from anywhere on the Voice 
Sense QWERTY by pressing "Fn-F11"  
 
Note: to save battery power, turn this option off when you are not using 
Ethernet connectivity. 
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3.8.2.43 Mass-storage device mode 

 
Mass Storage Device Mode enables the drives on your Voice Sense 
QWERTY to be viewed as removable storage devices on a PC when 
 connected via USB. The shortcut key for this option is "d" with the default 
set to "On". Use "Space" to toggle this option on/off.  
 
If Mass Storage Device Mode is turned off, the Voice Sense QWERTY can 
be connected to the PC as a Windows Mobile device and accessed using 
Microsoft ActiveSync or Windows Mobile Device Center for synchronization 
of calendar and contacts with Outlook. 
 
When you have finished modifying settings in the "Global Options" dialog, 
press "Enter" to save the settings. You can also “Tab” or "shift-tab" to the 
"Confirm" button, and press "Enter". If you do not want to save the settings, 
“Tab” or "shift-tab" to the "Cancel" button, and press "Enter". You can also 
cancel saving the settings by pressing "Alt-F4" or "Esc". 
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4. File Manager 
 
4.1 Overview 

 
The functionality and structure of the "File Manager" on the Voice Sense 
QWERTY is very similar to "Windows Explorer" on a personal computer. To 
run the "File Manager", press "f" from the "program" menu or press "Enter" 
when your cursor is placed on "File Manager". You can also launch the “File 
Manager” from anywhere on the unit by pressing “Windows-F”. 
The "File Manager" contains 2 basic areas: an "address window" and a "file 
list". When you first open the "File Manager", you are placed in the drive list. 
By default, you are placed on the internal flash drive, named "flashdisk". You 
can use the “up arrow” or “down arrow” or the scroll buttons to navigate the 
items in the drive list. Press "Enter" on the drive you want to open. The Voice 
Sense QWERTY then displays the list of the files/folders on the drive you 
have opened. 
When you press “Tab” or "shift-tab" on the "file list," you enter the "address 
window". The "address window" contains the path of the current directory or 
file.  
For your convenience, the "File Manager" contains both menus and hot keys, 
allowing you to easily activate items in the program with a single keystroke 
as well as access and select a function through the menus even if you have 
not memorized the associated keystroke. YOU can bring up the menus by 
pressing “Alt”.  
WARNING!! The Voice Sense QWERTY makes it possible to format the 
flashdisk to solve corruption problems and/or start over with a clean internal 
drive. Formatting the flashdisk erases everything on the flashdisk. Be 
extremely cautious when executing this command. If you execute this 
command, you will lose all of your data. You will NOT be able to retrieve this 
data once the command is executed. To format the flashdisk, press and hold 
" Fn-f”. While holding down these keys, quickly press and release the reset 
button. Continue holding "Fn-f" until you hear the "format start" 
announcement. 
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4.1.1 Navigating the File List 
 
The "File Manager" contains two kinds of lists: the "file list" and the "menu 
list", or rather, the list of items contained in the "File Manager" menu. The 
menus in the Voice Sense QWERTY wrap. This means, when you reach the 
end of the list of items in a menu, the Voice Sense QWERTY automatically 
brings you back to the top of the list when you press “down arrow”. However, 
when you reach the end of a "file list," the Voice Sense QWERTY remains at 
the end of the list, even if you press “down arrow”. The following is a list of 
the keystrokes used for navigating lists: 
 
1. Move to previous item: Up arrow or up scroll button 
2. Move to next item: Down arrow or down scroll button 
3. Move to the beginning of a list: Ctrl-Home 
4. Move to the end of a list: Ctrl-End 
 
The following keystrokes are valid only in a "file list". 
 
1. Jump to folder or file list: Ctrl-Down arrow 
2. Move between file list and address window: Tab / shift-tab 
3. Enter the selected folder or open the selected file: Enter 
4. Move back a level in the folder structure: Backspace 
5. Jump to the drive list: Shift-Backspace 
6. Move to the previous group of 32 items: Fn-Up arrow 
7. Move to the next group of 32 items: Fn-down arrow 
8. Jump to a file or folder by pressing the first character of the folder or file 
name. You must use ASCII characters. 
 

4.1.2 Selecting folders and files 
 
1. Select individual items "Space": * is displayed in front of the item to denote 
its selection. Pressing "Space" again on the selected folder or file cancels 
the selection. 
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2. Continuous selection (“Ctrl-b”): This selects all of the items from the point 
where this command is executed to the item where the cursor is located. * 
appears in front of the selected items. 
3. Select all (“Ctrl-a”): This selects all the files and folders in the current list. 
You can use navigation keys to move among the selected items to check 
their selection status. You can cancel selections or reselect de-selected 
items by pressing "Space". When the "Select All" command is executed, the 
Voice Sense QWERTY says the number of selected files, and * appears in 
front of the selected files on the Braille display (When connected to 
SyncBraille).  
 

4.1.3 Cancel / Exit 
 
Cancel (“ESC”): This command will cancel a function. 
Exit (“Alt-F4”): This will cancel or stop a selected function or exit the program. 
 
4.2 Working with Files and Folders 

 
When you open the "File Manager," the list of available drives is displayed. 
Navigate to the drive you wish to access, and press "Enter" to open it. The 
Voice Sense QWERTY displays the list of folders and files on that drive. The 
items in quotation marks are folders, and the items without quotation marks 
are files.  
The items in the list are followed by numbers, such as 1/5 or 2/5. The 
numbers following the items indicate an item's placement in the list and the 
total number of items in the list. For example, "database 1/5," indicates 
"database" is the first folder in a list containing five items. 
 
 
 

4.2.1 Selecting drives 
 
When you open the "File Manager," the first item in the list is "flashdisk". If 
an SD card or USB flash drive is inserted, it also appears in this list. 
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Navigate to and select a drive by using the up and down arrows or the scroll 
buttons. After selecting your desired drive, press "Enter" to open it.  
 

4.2.2 Entering and Exiting Folders 
 
There are several ways to open a folder. You can utilize the menu to open a 
specific folder. 
1) Bring up the menu by pressing “Alt”. Select the "Open" option from the list 
and press "Enter".  
2) You can also press the hot key “Ctrl-o” to activate the "Open" command 
and open the desired folder. 
3) Finally, as described above, you can simply press "Enter" on the selected 
folder. 
To exit the current folder, use the "Backspace" key. You are returned to the 
previous level in the folder structure.  
 

4.2.3 Opening a File 
 
You can open a file by pressing "Enter" on the selected item. You can also 
use “Ctrl-o” to open a file or folder. The Voice Sense QWERTY automatically 
loads the appropriate application or program to open the chosen file.  
You can also open a file by using the menu. Press “Alt” to open the menu. 
Then, press the letter "o" or press "Enter" on "Open". 
The Voice Sense QWERTY supports the following file formats:  
 
1. Document files: hbl, brl, txt, HPF, brf, rtf, doc/docx, PPT/PPTX, PDF and 
unprotected EPUB files are supported in the Word Processor.  
2. Web formats: url, and html files are supported by the Web browser.  
3. Media formats: ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, wma, 
wmv and flac files are supported by the Media Player.  
4. DAISY books, including those from BookShare, NLS, and Open Library 
are supported by the DAISY player.  
5. zip and EML files are supported directly from the “File Manager”. 
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If you press "Enter" on a file type other than those mentioned above, the 
"Open With" dialog box appears, because the file type is not associated with 
a program. You can also bring up the "Open With" dialog box using the 
menu. By using the "Open With" menu option, you can open the currently 
selected file with a program other than the one originally associated with that 
file type. First, press “Alt” to bring up the menu. Navigate to "Open With," and 
press "Enter". You can jump quickly to this option in the menu by pressing 
"e". You can also open the dialog box by pressing "Ctrl-h" from the file list.  
This dialog box consists of the "Open With" list, the "adopt" list, a "Confirm" 
button, and a "Cancel" button. You can move between these elements by 
pressing “Tab” or "shift-tab". Within the list, you can select the next item by 
pressing "down arrow” and the previous item by pressing “up arrow”. 
When the dialog box opens, "Open with: Word processor" is displayed. In 
this list, you can select a program, the Word Processor, Media Player, or 
Web Browser. Pressing “down arrow” selects the next program, and “up 
arrow” selects the previous program. Once you have selected the program 
with which to open the file type, press “Tab” to move to the "adopt" list. If you 
have selected the Word Processor, pressing “Tab” takes you to an additional 
list called "Open mode". Using this list, you can specify whether the file is 
opened as a Braille file or a text file. Press “down arrow” or “up arrow” to 
select one of the two file types, then press “Tab” to move to the "Apply to" 
radio button. Use this radio button, to specify whether only the currently 
selected file or all of the files with the same file extension are opened with 
the specified program. After setting your preference, press "Enter" or “Tab” 
to move to the "Confirm" button, and then press "Enter" to apply the settings. 
If you have specified a program that does not support the file type, nothing is 
displayed or played after the program is launched. 
If you activate the "Open With" menu after focusing on folders that have 
DAISY or media files, the associated program, DAISY or Media Player is 
displayed. If you activate the "Open With" menu, and encounter a folder that 
does not have the DAISY info file (discinfo.html or ncc.html), the DAISY 
Player is not displayed as an associated program. You can play all of the 
files after selecting either the DAISY or Media Player. 
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4.2.4 Send To 
 
You can use this option to copy files and folders to different drives such as a 
flash drive, USB flash drive (also known as USB stick memory), or an SD 
card. After selecting files and folders, open the menu with “Alt”, and choose 
the "Send To" option. When you press "Enter" on "Send To", the Voice 
Sense QWERTY displays the list of drives that you can send your files or 
folders to. You can choose a destination drive by using the “Up arrow” or 
“Down arrow” or up and down scroll buttons. Pressing "Enter" on the desired 
drive starts the copying of the selected files and folders to the selected drive. 
You can activate the "Send To" option by pressing “Ctrl-s” from the file list.  
 

4.2.5 Copy / Move 
 
"Copy" leaves the selected files and folders in their original locations, and 
creates copies of them in your chosen destinations. "Move" removes the 
selected files and folders from their original locations, and moves them to the 
new locations you have chosen. 
Use the copy/move function as follows: 
1. Select the files and folders you wish to copy.  
2. Open the menu, and choose "Copy" from the list to copy the selected files 
and folders. You can execute the "Copy" command directly from the file list 
by pressing "Control -c". If you want to move the selected files and folders, 
choose "Cut" from the menu. Use "Control-x" to execute the "Cut" command 
directly from the file list. When the "Copy" or "Cut" command is executed, the 
Voice Sense QWERTY returns to the file list. 
3. Navigate to the destination folder. 
4. Open the menu, and choose "Paste". Press "Enter" on "Paste," and your 
selected files and folders are copied or moved. You can press "Control-v" to 
execute the "paste" command directly from the file list.  
If the destination folder is the same as the source folder, the Voice Sense 
QWERTY attaches "Copy1" to your original file names. If the same files are 
copied into the same folder a second time, the Voice Sense QWERTY 
attaches "Copy2" to the original file names.  
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If your destination folder has the same name as the file you are copying, the 
Voice Sense QWERTY prompts "File xxx already exists. Overwrite? Yes". 
Press "Enter" if you want to replace the file. If you do not want to overwrite 
the file, select "No," and press "Enter". When "No" is selected, the "Paste" 
function is canceled. 
 

4.2.6 Delete Files or Folders 
 
To delete files or folders, navigate to the folders or files you want to delete, 
and select them. Open the menu by pressing “Alt” and choose the "Delete" 
option. Press "Enter" on "Delete" to complete the deletion of the selected 
files and folders. You can also press the letter "d" after opening the menu to 
delete the selected items. You can also delete selected files or folders by 
using hot keys. “Del” is the hotkey assigned to perform the delete function. 
When you delete only one file or one folder, it is not necessary to use the 
select function. Instead, simply navigate to the file or folder you want to 
delete, and use one of the methods previously described to delete the file or 
folder. 
 

4.2.7 Rename 
 
You can change the name of a file or folder by using this function. To change 
the name of a file or folder, move to the file or folder you wish to rename. 
Open the menu by using “Alt” choose "Rename" from the menu list and 
press "Enter", or press "r" to activate the "Rename" function quickly. You can 
also use the hot key "Control-r" to activate the "Rename" function directly 
from the file list. The Voice Sense QWERTY asks for a new name. On the 
Braille display (When connected to SyncBraille), "New file (or folder) name: 
(current file/folder name)" appears. You must type the new file/folder name in 
ASCII characters. Press "Enter" after entering a new file name to complete 
the renaming process.  
You cannot use the following characters in a file name or folder: “|, \, <, 
>, ?, :, *” 
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4.2.8 New Document 
 
Use this option to create a new document. There are several ways to access 
this function. You can open the menu by pressing “Alt”, navigate to "New 
Document" and press "Enter". Or, you can open the menu and press "n". 
The hot key for this option in the "File Manager" is "Ctrl-n".  
When the new document function is activated, the Voice Sense QWERTY 
displays "File type: text (txt)". You can create two types of documents: text 
files and Braille files. You can use the down arrow to select the "Braille (brl)" 
file format. When you press "Enter" on either "text (txt)" or "Braille (brl)," the 
Voice Sense QWERTY displays "New document name: New Document0.txt" 
or "New Document0.brl". "New Document0.xxx" is the default file name 
based on the file type you have chosen. The number after the new document 
increases by one whenever you create a new document for which you do not 
specify a name. You can also type in the document name you prefer and 
press "Enter". The new document you named is created. “|, \, <, >, ?, :, *” 
characters cannot be used when creating a file name. 
 

4.2.9 New Folder 
 
Use this option to create a new sub-folder under the current folder. Open the 
menu in the "File Manager" by pressing “Alt” and select "New Folder" from 
the menu list. Press "Enter" on "New Folder" to activate this function. You 
can use the letter "f" to jump the new folder option in the menu. "Alt-f" is the 
hot key that you use to access this feature directly from the file list. 
The Voice Sense QWERTY prompts, "New folder name:,". Enter your 
preferred new folder name in ASCII, and press "Enter". Your new folder is 
created.   
When creating a new folder name, you cannot use the following characters: 
"|, \, <, >, ?, :, *” 
 

4.2.10 File Conversion 
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The "File conversion" function on the Voice Sense QWERTY is similar to the 
"Save As" function in the Word Processor. This feature converts files to 
different file formats. The Voice Sense QWERTY file conversion feature 
supports the following file formats: "Sense Word (hbl)," "Text (txt)," and 
"Braille (brl)". 
The Voice Sense QWERTY can convert a single file or multiple files at once 
to your preferred file format. Select files using the file selection method 
described previously. After selecting the files you want to convert, open the 
menu by pressing “Alt”. Navigate to the "File Conversion" option, and press 
"Enter". You can also use the letter "t” to jump to the file conversion option 
from within the menu. Use "Ctrl-t" to execute the "File Conversion" command 
directly from the file list.   
The Voice Sense QWERTY prompts you to choose the preferred file format. 
Use the “up arrow” or “down arrow” to select the desired file format. When 
you press "Enter" on the file format you want, the Voice Sense QWERTY 
begins converting files to the file format you have chosen. The Voice Sense 
QWERTY keeps the original file names for the files you have converted, 
except for the file name extension which reflects the new file type. If a file 
with the same name and extension already exists, "date" and "time" are 
added to the file name.  
 

4.2.11 Select All 
 
This feature selects all the files and folders in the current list. You can 
access this feature from the menu, or by using a shortcut key. Press “Alt” to 
open the menu. Press the down arrow (“down arrow”) to navigate to "Select 
All". Press "Enter" to execute the "Select All" function. You can use the letter 
"a" to jump to and execute "Select All" from within the menu. Use "Ctrl-a" to 
select all the files and folders in the current list without entering the menu. 
When "Select All" is activated, the Voice Sense QWERTY says, "x objects 
selected". The Voice Sense QWERTY then returns to the file list.  
A * appears in front of each file name you have selected. You can cancel the 
selection of a file or folder by pressing "Space". This feature is a convenient 
method for selecting multiple files for copying, cutting, or deleting.  
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4.2.12 Search for File 

 
Use the "Search for File" function to locate a file or folder for which you know 
all or part of the name, but not the location. You can press "Alt” to open the 
menu and move to "Search for File," and press "Enter". Or use b to jump to 
and execute the search function from within the menu. You can press "Ctrl-f" 
to activate this function directly from the file list. The Voice Sense QWERTY 
displays the "file for find" dialog box.  
The dialog box consists of the "edit box for entering the text of the name to 
search", a "combo box to select a drive", "check box enabling to choose 
whether or not to search sub-folders", a "search button", a "cancel button" 
and the results list. You can use “Tab” or "shift-tab" to move through the 
controls. 
When you activate the file search, the unit prompts "File for find:" and you 
are placed on the edit box for entering the file name to search". Type all or 
part of the file name and press "Enter". Voice Sense QWERTY searches for 
all files containing the text you entered. When the file search is complete, 
you are placed in the results list.  
You can navigate among the items in the results list with the “Up arrow” or 
“Down arrow”. If you press "Enter" on a file, you are placed on the path 
where the file is stored and the file search dialog box is closed. You can 
open the file by pressing "Enter" on the file name again. 
If you want to search for a file on another drive, after typing the file name,  
press “Tab” to move to the "target disk" combo box. You can press “Up 
arrow” or “Down arrow” to navigate to a different drive. If you press "Enter" 
either on a specific drive or on the "Search button," Voice Sense QWERTY 
searches that drive for files matching the text you entered in the edit box.  
The drive list displays all storage devices currently connected to the Voice 
Sense QWERTY. If there are many files in a drive, it can take some time to 
perform a search. While the search is being performed, "searching" is 
displayed to alert you to the fact that the search is active.   
If you want to search the root of a drive excluding sub-folders, press “Tab” to 
move to the "Search sub-folders" check box. Press "Space" to uncheck this 
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option, and press "Enter". By default, Voice Sense QWERTY includes sub-
folders when you search for files.  
 

4.2.13 Sort Files  
 
This option is used to specify the order in which files and folders are 
displayed in the file list. Press “Alt” to bring up the menu. Navigate to "Sort 
Files By," and press "Enter". Or, press (g" from within the menu to jump to 
and execute this option. You can access this feature directly from the file list 
by pressing "Ctrl-g"  
Files and folders can be sorted according to the following: "Name," "Size," 
"Extension," and "Date and Time". You can move among these items by 
pressing “down arrow” or “up arrow”. Press "Enter" after selecting the sorting 
criterion, and files and folders are displayed in the specified order. If you 
select "Name" or "Extension," the list is sorted in ascending order, and if you 
select "Size" or "Date and Time," the list is sorted in descending order. By 
default, files and folders in the file list are sorted by "Name" with folders 
appearing at the top of the list, and files appearing at the bottom. Once you 
have chosen how you want your file and folder lists sorted, the option is 
stored so that files are sorted according to your preference each time you 
open the "File Manager". 
 

4.2.14 Set File Info 
 
This item is used to set what kind of information is displayed for each item in 
the file list. Press “Alt” to bring up the menu. Navigate to "Set File Info," and 
press "Enter". Or press "i" to quickly access this item from within the menu. 
You can access this feature directly from the file list by pressing "Ctrl-i"   
Use this option to select the information to be displayed for each item in a list. 
The available options are, "Name," "Name, Size," and "Name, Size, Date 
and Time". You can move among these items by pressing "down arrow or 
“up arrow”. Press "Enter" after selecting the information to be displayed, and 
the file list is updated, showing all the information you specified. By default, 
only names are displayed in the "file list". If you have selected "Name, Size," 
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the name and size of files are displayed. However, for folders, size is not 
displayed. This option is stored and remains in effect until a hard reset is 
performed.  
 

4.2.15 Display only Files of Type 
 
This is used to specify what type of files are displayed in the file list. Press 
“Alt” to bring up the menu. Navigate to "Display only Files Of Type," and 
press "Enter". Or press w to quickly access this option from within the menu. 
You can also access this feature directly from the file list by pressing "Ctrl-w"  
Choose which files are displayed by selecting one of the following items: "All 
Files," "Sense Word Files," "MS Word Files," "Text Files," "Braille files," 
"HTML Files," "URL Files," "Media Files," and "Wave Files". You can move 
among these items by pressing “down arrow” or “up arrow”. Press "Enter" 
after selecting the file type you want, and only the files of the specified type 
are displayed in the file list. Folders are displayed no matter which type you 
have specified. By default, all files are displayed in the file list. This setting 
remains in effect only until you close the "File Manager," so all the files are 
displayed once again on restart of the "File Manager". 
 

4.2.16 Zip 
 
With this function, you can compress files and folders into a zip file. 
Compressing a file makes the total file size smaller, making it easier to email, 
or to save space on a storage device. To use the "Zip" function, follow these 
steps: 
 
1) Select the files or folders you want to compress in the "file list" by using 
one of the methods described previously. 
2) Open the menu by pressing “Alt”," and press "Enter" on "Zip". Or, from 
within the menu, press "z". You can also activate this function directly from 
the file list by pressing "Ctrl-z". 
3) Voice Sense QWERTY prompts, "Zip filename: (default filename.zip)". 
"Default filename" is the file name that is used for the compressed file if you 
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try to compress only one file or folder. If you try to compress several files or 
folders, the default name is the folder name that contains the files and 
folders. 
4) Press "Enter" (or Tab to "Confirm" and press "Enter", and the zip file is 
created in the current directory. If you want to change the name of the zip file, 
you can modify the default by using the cursor keys or type in a new name. If 
you want to cancel, press "Esc" or "Alt-F4". Or, Tab to "Cancel" and press 
"Enter".  
 

4.2.17 Unzip 
 
The "Unzip" function allows you to unzip (or decompress) a zip file, 
regardless of whether it was created on Voice Sense QWERTY or a PC. To 
activate the "Unzip" function, use the following steps: 
1) After selecting a zip file, open the menu with “Alt”, and press "Enter" on 
"Unzip". Or, press "u" from within the menu. You can also activate this 
function directly from the file list by pressing "Ctrl-u" when placed on a zip file. 
2) Voice Sense QWERTY prompts, "Unzip to folder name: (default folder 
name)". The default folder name is the same as the compressed file name. 
For example, if you unzip a file called "test.zip," "unzip folder name: test" is 
displayed. 
3) Press "Enter," or move to "Confirm" by pressing “Tab” and press "Enter". 
The Voice Sense QWERTY unzips the files to the default folder. If you want 
to change the default folder name, you can modify the default folder name. 
Or, you can type a new name. If you want to cancel, press "Esc" or "Alt-F4". 
You can also move to the "Cancel" button by pressing “Tab”, and press 
"Enter".  
Note: You can also initiate the unzip process simply by pressing "Enter" on a 
zip file. 
 

4.2.18 Information 
 
Use this option to query The Voice Sense QWERTY for information about 
files and folders (the file/folder’s properties). The information feature in the 
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"File Manager" provides you with information about the file type, file size, the 
date and time of the file or folder's creation, and whether the file/folder is 
protected. Press “Alt” to open the menu. Navigate to "Information" and press 
"Enter". Use the letter "P" to open the "Information" feature quickly from 
within the "menu". "Alt-Enter" is the hot key for this option. You can use this 
hot key to access this feature directly from the file list.  
The Voice Sense QWERTY displays the information about a file or folder in 
the following order: file type, file size, creation date and time, and attribute. 
You can review this information by pressing “Tab”.  
1. File type: Displays the file format information, such as "brl file," "doc file," 
or "txt file". When a folder is selected, this area indicates that the item is a 
folder containing x number of files and folders. 
2. File size: displays the size of the selected file or folder. When multiple files 
or folders are selected, this area displays the total size of the selected files 
and folders. 
3. Date and time: Displays the time and date the folder/file was created or 
modified. 
4. Attribute: Displays whether the file is write protected or is writable. You 
can change this attribute by using the “Up arrow” or “Down arrow” or "space”. 
When multiple files or folders are selected, this attribute is not shown. 
5. Confirm: To change the attribute, press "Enter" on "Confirm".  
6. Cancel: To cancel the change, press "Enter" on the "Cancel" button.  
 

4.2.19 Share Folder On Network  
 

The Voice Sense allows you to share folders over a network, so that you 
may access them from other devices, such as computers, on the network. 
After selecting a folder you want to share open the menu with "Alt" and 
press "Enter" on "Share This Folder on a Network". Or, press J from within 
the menu. You can also activate this function directly from the file list by 
pressing "Alt-S" when placed on the folder you want to share.	  	  

The Voice Sense prompts, "Folder successfully shared, please reset your 
Voice Sense". If a folder is shared, this menu item reads "Do not share this 
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Folder". You can unshare a folder by selecting it and choosing the "Do Not 
Share this Folder" item from the menu, or by pressing "Alt-U".	  	  

4.2.20 Set Local Security  
 

If you have chosen to share folders over a network, you may wish to 
require a username and password for access to the folder in order to 
ensure others cannot gain unauthorized access to the shared folders on 
your Voice Sense. To secure your folder, select the folder and open the 
menu with "Alt" and press "Enter" on "Local Security Setting" Or, press "Y" 
from within the menu. You can also activate this function directly from the 
file list by pressing "Alt-P" when placed on the folder you want to secure.	  	  

The "Local Security Setting" dialog contains 4 items: "Username" computer 
edit box, "Password" computer edit box, a "Confirm" button, and a "Cancel" 
button. You can move among the items using "Tab" or "Shift-Tab". 	  

To secure your folder with a username and password, type the username 
and password you wish to use into the respective computer edit boxes. 
Press "Enter" to save your settings, or Tab to "Confirm" and press "Enter". 
If you do not wish to save your settings, Tab to "Cancel" and press "Enter" 
or press "Escape" or "Alt-F 4".	  	  

 
4.2.21 EML Viewer 
 

The Voice Sense QWERTY allows you to view and interact with EML files (e-
mail message files) directly from within the File Manager. E-mail messages 
created and received using the E-mail program on the Voice Sense are 
stored in the “E-mail” folder on the unit’s flashdisk. The e-mail folder contains 
“pop3” and “Imap” folders consisting of subfolders for each account in that 
category. Each account folder contains folders for each mailbox, which, in 
turn, contain the message or “EML” files.  
 
At times, you may find it more efficient to access a specific e-mail using the 
File Manager as you do not have to wait for the e-mail program to load the 
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mailboxes, etc. Use normal file and folder navigation as described previously 
to access the EML file, or rather, the message you wish to locate. When you 
have located the message you wish to open, you can open it in the EML 
Viewer by pressing “Enter”.  
 
The EML Viewer opens the message, and places you in the message body. 
The “EML Viewer” dialog contains 7 controls: “Subject” static box, “Date” 
static box, “From” static box, “Message Body” multi-line edit box, “”Attach” 
file list box (only appears if message contains attachment), Forward” button, 
“Reply” button, and “Close” button. You can move among the controls using 
“Tab” or “Shift-Tab”.  
 
From within the Message body, use normal file reading commands to 
navigate the message. (see section 5, Word processor for more details) You 
may also forward or reply to a message from the EML Viewer. To forward a 
message, tab to the “Forward” button and press “Enter” or press “Control-f”. 
from within the message. To reply to a message, tab to the “Reply” button 
and press “Enter” or press “Control-r” from within the message.  
 
When either “Forward” or “Reply” is launched, you are placed on the “To” 
field of a new message dialog. Create the forwarded or reply message just 
as you would in the Voice Sense QWERTY’s “E-mail” program. (see section 
8 of this manual.) 
 
To close the EML file/message and return to the file list, tab to the “Close” 
button and press “Enter” or press “Alt-F4”. 
 
4.3 Using the Address Window 

 
This edit box lets you type the direct path of the file name you want to open. 
This window also contains the history list for easily accessing recently 
opened files or directories.  
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4.3.1 Editing 
 
When you are in a file or folder list, you can press “Tab” to navigate to the 
address window. The Voice Sense QWERTY displays the current path 
including the current drive name, such as "flashdisk/download/". When you 
edit the path, use the cursor routing keys to move the cursor to the place 
where you wish to modify the text of the path. When you first enter the 
address window, the cursor is located at the end of the path name.  
The address window is only visible when you are in a file or folder list. When 
you are in the drive list, the address window is not available. 
 

4.3.2 Typing a Path / File Name 
 
When you relocate the cursor with a cursor routing key, the Voice Sense 
QWERTY inserts the text at the cursor location. If you know the exact path 
and file name, you can type in the path and file name to open the file with the 
appropriate application. For example, if you type in "flashdisk/download" in 
the address window and press "Enter," the Voice Sense QWERTY displays 
the list of the files in the download folder. If you type "flashdisk/My 
Documents/sample.txt" in the address window, and press "Enter," the Voice 
Sense QWERTY loads the Word Processor, and opens the file "sample.txt". 
When the file is open, you can read or edit the file, "sample.txt". 
 

4.3.3 Opening the History List 
 
The history list contains paths, folders, and files that you have opened 
previously. You can access the history list from within the address window 
by pressing the down arrow. Use the “Up arrow” or “Down arrow” to review 
the history list. You can also use the scroll buttons to navigate this list. To 
open a file in the history list, press "Enter". The file opens with the 
appropriate application. (See section 4.2.3).  
While navigating the history list, you may type in new path names or file 
names to instantly access a file or folder. 
 



125 
 

4.4 Network and sharing  
 
The network file sharing function enables you to share files between your 
Voice Sense QWERTY and computers connected to the same network, and 
access files on other computers just as you would files located directly on 
your Voice Sense QWERTY.   
In other words, you can copy files on the Voice Sense from other computers 
on the network, edit files on other computers with the Word Processor or 
even open media files on other devices and play them in the Media Player 
on the Voice Sense QWERTY.  In addition, you can share folders on your 
Voice Sense QWERTY and access them from other computers connected to 
the network.  
You can share files over a network using LAN or WIRELESS LAN. When 
using LAN, once the Voice Sense QWERTY is connected, you can easily 
find and access the shared files of other computers connected to the 
network.  
However, when using wireless LAN, it is only possible to access shared files 
when your Voice Sense QWERTY and the connected computer are at the 
same layer. This means that you can't search for a computer connected to 
router A if you are connected to router B, a wireless LAN sub-connection of 
router A.  
For more detailed information on LAN/WIRELESS LAN configurations, refer 
to the "Setup Internet" section of the "Utilities" chapter in this user manual.  
 

4.4.1 Search for shared computers and add to the network 
list. 

 
When you open the "File Manager", network is displayed in the drive list. The 
network list consists of the shared folders on computers connected to your 
network that you have added to the network list. From the network list, you 
can open the shared folder, or delete the network location from the list. If you 
have not added shared folders to the network list, this list is empty. To add 
items to the network list, you must search the network for devices, then 
select the shared folders on these devices and add them to the network list.  
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To search shared computers connected to the network, Use the "Network 
Connection Setting" dialog to search for computers with shared content. You 
can open the "Setup Network connection" dialog box, by pressing "Alt-e" 
regardless of your position in the File Manager. Or Press “Alt” to open the 
menu and navigate to "Network Connection Setting" and press "Enter".  
The "Network Connection Setting" dialog box contains the following controls: 
 
"Remote name" computer edit box  
"Remote folder" list box  
"Add/Remove" button 
"Cancel" button 
 
When the "Network connection Setting" dialog box is opened using "Alt-e", 
you are placed on the "Computer name" edit box. Type the computer name 
with or without backslashes and press "Enter". 
For example, if the computer name you want to search is "hims", type 
"\\hims" or "hims" and press "Enter". If the shared computer is found, a login 
prompt may be displayed according to the shared computer setting. 
If the computer is running Windows vista or Windows 7, you must enter the 
folder path as shown below.  
Ex) "\\hims\sharing", "hims\music" 
Note: if the shared folder name exceeds 11 characters, it cannot be 
recognized by the Voice Sense QWERTY.  
 
If the computer you are trying to access does not have a network user name 
and password specified, type "guest" in the Login edit box and press "Enter". 
If the computer requires a specific network user name and password, make 
sure they are entered correctly. If login is successful, you are placed in the 
Remote Folder list and the folders shared on that computer appear in the list. 
Move to the desired folder in the list and press "Enter" on the "Add" button. 
The network location of the shared folder is added to the network list in the 
File Manager. You may select as many folders as you wish from the Remote 
Folder list and add them to the network list. 
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Use the following keystrokes to navigate the "Network Connection Setting" 
dialog: 
Move to the next control: "Tab”  
Move to the previous control: "Shift-Tab" 
  
Use the following keystrokes in the Remote Folder list.   
Move to the next item in the list: "down arrow” 
Move to the previous item in the list: "up arrow” 
Select current item: Space 
Select all items: Enter-a  
 
Use the "Add" button, to add the selected shared folder from the Remote 
Folder list to the File Manager's network list. From the Remote Folder list, 
press "enter" to exit the "Network connection Setting" dialog box. YOU can 
also cancel using "Alt-F4" or "Esc".  
Once the network locations of the shared folders have been added to the list, 
they are accessible from the "network" option in the File Manager as long as 
you are connected to the network where they reside. In other words, if you 
have added a location for a shared folder on your home network, you cannot 
access this location from your office as you are no longer connected to the 
home network on which the shared folder is located. Also remember that you 
cannot access shared folders on a network if you do not have a wireless or 
LAN connection to that network.  
 
 

4.4.2 Remove Remote folder  
 
There are 2 ways to remove a remote folder from the File Manager's network 
list: using the "Remove" option in the network list, or via the "Network 
Connection Setting" dialog. 
   
Using the network list: 
Execute the File Manager and choose "network" from the drive list. Navigate 
to the remote folder you want to remove and press "Del".  
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You can also access this function using the menu. Press “Alt” to open the 
menu. Arrow down to "Remove this remote folder on network" and press 
"Enter".  
 
Using the "network connection setting" dialog: 
Press "Alt-e" to open the "network connection setting" dialog. Navigate to the 
remote folder you want to remove. Press “Tab” to navigate to the "Remove" 
button and press "Enter".  
 
4.5 Hot Keys in the "File Manager" 

 
The following is a list of hot keys that can be used in the File Manager 
1. Open: Ctrl-o  
2. Open with: Ctrl-h  
3. Zip: Ctrl-z 
4. Unzip: Ctrl-u 
5. Send To: Ctrl-s 
6. Copy: Ctrl-c 
7. Cut: Ctrl-x 
8. Paste: Ctrl-v  
9. Delete: DEL 
10. Rename: control-r 
11. New document: Ctrl-n 
12. New folder: Alt-f 
13. File conversion: Ctrl-t 
14. Select all: Ctrl-a 
15. Sort files by: Ctrl-g  
16. Set file info: Ctrl-i  
17. Display only files of type: Ctrl-w  
18. Search for file: Ctrl-f 
19. Information: Alt-Enter 
20. Setup Network connection: Alt-e 
21. Remove remote folder on network Alt-u 
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5. Word Processor 
 
You can execute the “Word Processor” in a couple of ways: 

1. Press “Windows” to bring up the main “Program” menu. 
Navigate to “Word Processor” using the DOWN arrow, 
and press “Enter”. 

2. Type “W” from the main menu to quickly jump to and 
open the “Word Processor”. 

3. You can launch the “Word Processor” from anywhere on 
the unit by pressing “Windows-W”.  

	  
When	  you	  launch	  the	  Word	  Processor	  on	  the	  Voice	  Sense	  QWERTY,	  you	  are	  placed	  
in	  a	  new,	  blank	  document.	  The	  menu	  can	  be	  opened	  by	  pressing	  “Alt”.	  Don't	  worry	  
if	   you	   can't	   remember	   the	   exact	   shortcut	   keys	   for	   all	   of	   the	   Word	   Processor	  
functions,	  as	  you	  can	  activate	  all	  the	  functions	  of	  the	  Word	  Processor	  via	  the	  Word	  
Processor	  menu.	  The	  menu	  in	  the	  Word	  Processor	  consists	  of	  File,	  Edit,	  Go	  To,	  Read,	  
and	   Layout.	   To	   access	   these	   menus,	   press	   “Alt”	   in	   the	   Word	   Processor,	   select	   a	  
menu	  item,	  and	  press	  "Enter".	  Or,	  you	  can	  press	  “Alt”	  followed	  by	  the	  shortcut	  for	  
the	  corresponding	  menu	   item.	   	  For	  example	  to	  open	  the	  edit	  menu,	  press	  “Alt”	  to	  
open	   the	  menu,	   and	  navigate	   to	   the	  Edit	  menu	  by	  pressing	   “Up	  arrow”	  or	   “Down	  
arrow”	  and	  press	  "Enter".	  Or,	  press	  “Alt”	  and	  press	  "e".	  	  

Before going in to more detail about the Word Processor, it is also important 
to note that while you are anywhere in a document, you can discover your 
location by pressing "Fn-s". In addition, if you are editing a document, and 
turn the Voice Sense QWERTY off, it announces the status when you power 
back on. In the next few sections the features of the Word Processor are 
explained in more detail. The functions of each of the available menu items 
are also explained. 
 
5.1 File Menu 

 
The "File" menu contains the functions that allow you to create new 
documents, open documents saved to a disk, save edited documents, and 
print and emboss. It also contains various option settings. To select the file 
menu, press “Alt”, and press "f". Or, press "Enter" on "File". 
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5.1.1 New 

 
The new command creates a new, editable document. By default, the name 
of the new document is "noname.txt". The extension, ".txt" is the extension 
given to text documents that are created on the Voice Sense QWERTY. It is 
the same file name that is created automatically when the Word Processor 
opens.  
Note: if you have changed your default document type in the "Global 
Options", the extension may be “.brl” or “HBL”, as your default document 
type can be set to Braille, text, or Sense document. 
To create a new document, select "New" from the "File" menu. Or, press 
"Ctrl-n". If "New" is executed while editing another document, you are 
prompted for the file type of the new document: "Sense Document (s)" is 
displayed first. If you press “down arrow” repeatedly, "Braille Document (b)" 
and "Text Document (t)" are displayed. Select the document type you want, 
and press "Enter". 
"New" refers to creating a new, blank document after closing the document 
that is currently being edited. Closing the document currently being edited 
means that the document is erased from the temporary memory. If a new 
document is created or opened without saving the document currently being 
edited, the Voice Sense QWERTY asks whether to save the current 
document, so that changes to it are not lost. When "Save: Yes" is displayed, 
users can select "Yes" To save the current document or select "No" in order 
not to save the changes. If you press "Space" once more and select 
"Cancel", the Word Processor cancels the new document, and returns to the 
current document. 
  

5.1.2 Open  
 

The open command opens a document that has already been savedto a 
disk. Select “Open” from the “File” menu, or press “Ctrl-o”. The “Open File” 
dialog is displayed.  
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The "Open dialog" is a tool that helps you find documents that you want to 
edit and read. It consists of the "file list" (the list of files or folders in the 
current directory), "File name" (an edit box for typing the file name directly), 
"Type" (for choosing the format of the file you want to open), a "Confirm" 
button (for confirming the selection), and a "Cancel" button (for canceling 
the selection). To move among the controls, press “tab” or “shift-tab”.  
 

When the "Open dialog" is executed, you are placed in the "File name:" edit 
box. YOU can type in a file name that you want to open, and press "Enter". 
The Voice Sense QWERTY searches for the file in the "/flashdisk/My 
Documents" folder. If you have recently accessed other files, you can scroll 
through them by pressing “Up arrow” or “Down arrow”or the up and down 
scroll buttons. You can open a selected file by pressing "Enter". If you select 
a folder and press "Enter", the list of files in that folder is displayed. 
To access a file that is on an SD card or USB memory stick, you can access 
the file in the "Open" dialog by moving to the "file list" using "shift-tab”. Then, 
press "Backspace" until you reach the drive list. Use “Up arrow” or “Down 
arrow” to navigate among the drives until you reach the USB stick memory 
or the Sd card. Press "Enter" to open the storage device and the files and 
folders are displayed.  
When opening documents, The Voice Sense QWERTY chooses the Braille 
grade depending upon the file type. For example, if you press "Enter" to 
select a file that has the extensions hbl or brl, or if you type in a file name 
with those extensions and press "Enter", the Voice Sense QWERTY opens 
the selected file in Grade 2 Braille. You are not able to change the Braille 
grade in these documents. If you press "Enter" to select a file that has the 
extensions txt or doc, it opens the file according to the "View/Input grade" 
setting in "Global Options". After the file opens, you can switch the Braille 
grade among computer Braille, uncontracted Braille, and grade 2 Braille, 
using "FN-g".  
The Word Processor allows you to open and work with up to 10 files 
simultaneously. If you already have one document open, and you try to open 
another document, the Voice Sense QWERTY asks you to save changes to 
the document that is already open. Once the document is saved, an open 
dialog appears. However, your original document remains open. You can 
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move among open documents by pressing "shift-tab” for the previous 
document, and "tab” to move to the next document. 

 
 
5.1.3 Save 

 
The save command saves a document to a disk. To use this option, press 
“Alt” to open the "File" menu and execute the "Save" command by pressing 
"Enter" on it, or you can press "s" to quickly jump to and execute it. You can 
also use the hot key, “Ctrl-s” while editing a document. 
If the document has not been saved previously, when you execute "Save", 
the "Save as dialog" opens. You can refer to section 5.1.4 for information on 
using the "Save as dialog". 
If you execute "Save" after editing an existing document, Voice Sense 
QWERTY saves the document with your changes under the same file name 
without opening a dialog. After saving a document, you are returned to 
document editing.  
When you have several documents open, you can save and close the 
focused document, by pressing "Ctrl-F4". The document is saved and closed, 
and your focus is placed in the previous document in the tab order. 
 
Note: 
1) Though you can open PDF and unprotected EPUB files in the Word 
Processor, they cannot be saved under these file types as editing in these 
formats is not supported. If you save one of these documents, the "Save as" 
dialog opens so that you can save in one of the file types supported by the 
Voice Sense QWERTY.  
2) When saving as "rtf" and "doc", the file formatting is lost as the creation of 
advanced formatting is not supported in the Voice Sense QWERTY.  
 

5.1.4 Save As 
 
The "Save As" option is used to save a document under a different file name, 
in a different location, or as a different file type. To execute this command, 
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press “Alt”, and press "Enter" when the "File" menu is displayed. Move to 
"Save As" by pressing “down arrow”. Then, press "Enter". Or, use the hot 
key, "Ctrl-s", while editing a document. 
If you execute "Save As", the "Save as dialog" is displayed. This dialog is 
almost the same as the "Open" dialog. It consists of "file list", "File name", 
"Type" (representing the file format), a "Confirm" button, and a "Cancel" 
button. When the dialog opens, "File name:" is displayed. You can move 
among the controls by pressing “Tab” or "shift-tab". 
If you execute "Save As" when you are editing an existing document, the 
displayed file name, file format, and the folder are the same as those of the 
existing file. When executing "Save as", on "PDF" and "EPUB", documents, 
the formatting is lost as these files are converted to txt format on opening. 
If you execute "Save" or "Save As" while in a new document, the displayed 
default file name is "noname.brl" and the file path is "flashdisk/My 
Documents/". 
To edit the displayed file name, press the cursor routing key at the position 
you want to edit, and modify it. Or, to create a new file name, simply type in 
the new file name to overwrite what is currently in the edit box. You cannot 
use the following characters in a file or folder name. “|, \, <, >, ?, :, *” 
To change the file format, navigate to "Type". Move to your desired file 
format by pressing “up arrow” or “down arrow”. 
To save a file with a file name that is in the file list, move to the "file list" by 
pressing "shift-tab".  
 

5.1.5 Saving password Protected Files 
	  

The Voice Sense QWERTY allows you to encrypt and password protect files 
which you do not wish for anyone else to be able to open, accidentally or 
otherwise. Before you save a document as a protected file, you must set a 
password in the “Settings” option under the “File” menu. Press “Alt” to open 
the menu, navigate to “settings”, and press “Enter”. Press “tab” twice to 
move to the “Set Password” button, and press “Enter”.  
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The “Set Password” dialog consists of 5 items: “Delete the original file” 
checkbox, “, a “Password?” edit box, a “Retype Password” edit box, a 
“confirm” button, and a “cancel” button. Move among the items in the dialog 
by pressing “Tab” and “Shift-Tab”.  
 
The “Delete the original file” checkbox allows you to choose whether, when 
you save the file as a protected file, the original is deleted. If you wish to 
delete the original file, press “Space” to check this box. By default, it is 
unchecked.  
 
Once you have chosen whether to delete the original file, tab to each of the 
edit boxes for typing the password, and type it using computer Braille. When 
the password is entered in both edit boxes, Tab to the “Confirm” button and 
press “Enter” to save your password. The unit announces, “Set password 
completed” and returns you to the “settings” dialog. If you decide you do not 
wish to save your password, Tab to “Cancel” and press “Enter” or press “Alt-
F4”. 
 
When you have created and saved a password for the file you wish to 
protect, access the “Save as” dialog as described in the previous section, 
and choose “HPF” (HIMS Protected File) as your file type. Your document is 
encrypted and password protected. The next time you open the document, 
you are prompted for the password you created. To open the document, type 
it in and press “Enter”. 
 
Note: When saving protected files, please ensure you make note of the 
password used to protect them. Use passwords you can remember, and 
make note when typing them that they are typed correctly. Though it is not 
impossible, recovering password protected documents is extremely difficult, 
and your document will need to be sent to HIMS for decryption.  

 
5.1.6 Close Current Document 
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The "Close Current Document" command allows you to close the currently 
focused document without closing the Word Processor. You can access the 
"Close Current Document" command by pressing “Alt”. Then, press "Enter" 
on the "File" menu. Use the “Up arrow” or “Down arrow” to navigate to 
"Close Current Document", and press "Enter". Or, you can press "q" in the 
"File" menu. You can also access this function by pressing "Ctrl-F4" while 
editing a document. Please note that this function is not available if you only 
have one document open. You must have at least two or more documents 
open to execute the "Close Current Document" command. 
 

5.1.7 Print 
 
The "Print" command is used to print or emboss the current document. To 
execute this command, press “Alt”, and press "Enter" on the "File" menu. 
Then, move to "Print" by pressing “down arrow”, and press "Enter", or just 
press "p”. While editing a document, the hot key for printing is "Ctrl-p". There 
are two lower level dialogs for the "Print" option. One is for printing with an 
ink printer, and the other is for embossing in Braille. Remember that you can 
move between the menu items by using “up arrow” or “down arrow”. 
1. Embossing in Braille 
Open the document that you want to emboss. Press “Alt” to activate the 
menu. Locate "print" in the "File" menu and select "Embosser", or press "b". 
When you select "Embosser (b)" above, the "Embosser dialog" is opened 
and contains the following items:  
1) Start page number 
This is the first page number to be embossed. The default page number is 
set to 1. You can change the value of the page number, by typing in a new 
value. Press “down arrow” to move to "End page number"  
 
2) End page number 
This is the last page number to be embossed. The default value is set to 
100000. This means the document is embossed to the end of the document, 
unless the document exceeds 100000 pages. To change the value, input the 
number of the end page. Use “down arrow” to move to "Number of copies").  
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3) Number of copies 
This option designates the number of copies to be embossed. The default 
value is set to 1. You can change this number by typing your desired number 
of copies. Press “down arrow” to navigate to "Set Braille format".  
 
4) Set Braille format 
In this option, you can set whether or not the Braille document layout 
settings specified in Voice Sense QWERTY are used when embossing. If 
you set this to "Yes", the document is embossed using the Braille document 
layout settings in Voice Sense QWERTY. If you set it to "No", the document 
is embossed in the format specified in the original document. 
 
5) Confirm / Cancel 
To begin embossing the document, move to "Confirm" by pressing “Tab”, 
and press "Enter". Or, to cancel embossing, move to "Cancel" by pressing 
“Tab”, and press "Enter". 
 
When "Enter" is pressed on "Confirm", "Print: Yes" is displayed. Press 
"Enter" on "Yes", and embossing commences. If you do not want to emboss, 
press "Space" to select "No", and press "Enter". You can also choose to 
create an electronic Braille file of the document according to the embossing 
preferences. To do this, press "Space" once more to select "Save as file", 
press "Enter", and the current document is saved as a "brl" file. If you've 
chosen to emboss, and there are problems with the Braille printer, the Voice 
Sense QWERTY shows an error message and returns to the open document. 
 
2. Print Text 
This option is used when you want to print a document on an ink printer. To 
do so, open the document to be printed and press “Alt”, and press "Enter" on 
the "File" menu. Move to "Print" by pressing “down arrow” repeatedly, and 
press "Enter". Or just press "p" from the "File" menu. The dialog for the 
"Printer" is almost the same as for the "Embosser". After you input the values 
as in the embosser dialog, press “Tab” and press "Enter" on "Confirm".  
"Print: Yes" is displayed. If "Enter" is pressed, printing commences. If you 
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press "Space" to move to "No", and press "Enter", printing is canceled, and 
the Voice Sense QWERTY returns you to the open document. 

Note that the Voice Sense QWERTY is compatible with all HP printers 
(level PCL 3 or higher), and with HP-compatible printers and Epson printers 
using the ESC/P-R library to the compatible printers.  

 
 

5.1.8 Settings 
 
To change your Word Processor preferences, press “Alt”, and press "Enter" 
on "File". Move to "Settings (e)" by pressing “down arrow” repeatedly, and 
press "Enter" or just press "e” from the "File" menu. While editing a 
document, pressing "Ctrl-e" opens the "Settings" dialog. 
The "Settings" dialog contains the following: the "settings" list, "Default 
folder" button, “Set Password” button, "Confirm" button and a "Cancel" 
button. You can move among the controls by pressing “Tab” or "shift-tab". 
And you can move among the items in the settings list by pressing “up arrow” 
or “down arrow”. 
The following are the settings that can be changed: 
 
1. View format character (Yes/No): If this option is set to "Yes", all of the 
format characters are displayed. Use "Space" to toggle this option. A 
"carriage return is shown as “$p", and a "mark is indicated by ‘$pl". 
Advanced formatting  is indicated by the following characters: 
 
Font properties: 
$sf $ef à Start/End font 
$n à Font Name(ex: $nAr à Arial, $nTNR à Times New Roman, $nWi à 
$Wingdings).  
$s à Font Size 
$c à Font Color 
$sb $eb à Start/End bold 
$si $ei à Start/End italic 
$su $eu à Start/End underline 
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Table formatting: 
$stb $etb à Start/End table 
$str $etr à Start/End table row 
$std $etd à Start/End table cell 
$w à Table width 
$h à Table height 
$cp à Table cell padding 
$cd à Table cell spacing 
$vt à Table align top 
$vm à Table align middle 
$vb à Table align bottom 
 
Style properties: 
$ml à Margin left 
$mr à Margin right 
$ti à Text indent 
$mt à Margin top 
$mb à Margin bottom 
$lh à Line Height 
$c à Align Center 
$j à Align Justify 
$r à Align Right 
$l à Align Left 
 
Miscellaneous: 
$sl $el à Start/End Hyper link. 
$pg à Page Break 
$le à Language English 
$ls à Language Spanish 
$lf à Language French 
$lg à Language German 
$li à Language Italic 
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2. Reading unit (Line/Paragraph): Defines the unit of movement when 
pressing “up arrow” or “down arrow” while reading a document. If this option 
is set to "Line", “up arrow” moves up line by line. If this option is set to 
"Paragraph", “up arrow” moves backward in a document paragraph by 
paragraph. To toggle between "Line" and "Paragraph", press "Space". 
3. Read only (Yes/No): If this option is set to "Yes", the document cannot be 
modified. This setting is used to protect the document from any unintentional 
modifications. To change it to "No", press "Space". 
4. Reading mode (Original/Compressed): This option sets the reading mode. 
Original reading mode shows the document in its original format. 
In "Compressed" reading mode, The Voice Sense QWERTY displays 
document content on the Braille display (When connected to SyncBraille) 
continuously without regard to formatting such as carriage returns ($p). To 
toggle between "Original" and "Compressed" reading modes, press "Space". 
5. Auto scroll speed (1~35): This option sets the duration of displaying one 
Braille display length while you are auto scrolling in a document. Thirty-five is 
the fastest scrolling speed. Pressing "Space" increases the scroll speed and 
"Backspace" decreases it.  
6. Automatic save interval (Don't save automatically, 10~60): This option 
defines the automatic save time interval for the file that is currently being 
edited. The setting time can be increased or decreased by 10 minutes if you 
press "Space" or "Backspace" respectively. If you do not wish for the 
document to be saved automatically, choose "Don't save automatically". 
7. Apply settings to all documents (Yes/No): This option allows you to apply 
the current settings to all documents. If "Yes" is selected, the settings apply 
to all documents, if "No" is selected, the settings affect only the document 
currently being edited. To toggle between "Yes" and "No", press "Space". 
8. Support Formatting Documents: (Yes/no). This setting allows you to 
choose whether or not to process document formatting when loading 
documents that contain advanced formatting features such as Microsoft 
Word documents. Press “Space to toggle between “Yes” and “No”.  
9. The Word View Display option allows you to choose whether to show text 
documents in full display view. Full display view allows a sighted teacher or 
assistant to view what is on the notetaker using a PGA monitor. The focused 
line of text is shown at the top, followed by a full screen of text below. Use 
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"Space" to toggle "Word View Display" on and off. Or, you can use "Control-
Alt-M" to toggle Word Display View on/off directly within a document. Use the 
following keystrokes to navigate the full screen view:	   
	  

Read the current line on the visual screen: Alt-FN-S  
Move to the first line on the visual screen: Alt-Home  
Move to the last line on the visual screen: Alt-End  
Move to the previous line on the visual screen: Alt-Up arrow  
Move to the next line on the visual screen: Alt-Down arrow  
Change the position of the current cursor line to the first line on the visual 
screen: Alt-Page Up or FN-Up arrow  
Set the highlight color of the current line on the visual screen. (Options are 
yellow and black): Alt-U  
 
To change the default save-to folder, move to the "Default folder" button by 
pressing "tab" and press "Enter". You are placed in the "file list". Navigate to 
the folder or disk you want using normal navigation keys, press "Space" on 
the folder you wish to select, and press "Enter".  
 
To set a password for your currently open file, move to the “Set password” 
button using “Tab”, and press “Enter”. Set your password as described in 
section 5.1.5, “Saving protected Files”. 

 
When you are finished setting your preferences, move to the "Confirm" 
button by pressing "tab" and press "Enter". If you do not want to save the 
settings, press "Enter" on the "Cancel" button. Activating the "confirm" or 
"Cancel" buttons performs the operation and returns you to the document 
you are currently editing. 
 

5.1.9 Exit 
 
This command closes the Word Processor. To execute this command, select 
"Exit" from the file menu, or press "Alt-F4". If you have edited the document 
and have not saved the changes, when you select "Exit", you are prompted 
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to save the current document. You can select "Yes" or "No" with the 
spacebar and press "Enter" to exit the Word Processor. 
 
5.2 Edit Menu 

 
On the Voice Sense QWERTY, you can edit all files regardless of what the 
view/input grade is set to. The "Edit" menu contains the following items: 
"Start Selection", "Copy", "Cut", "Paste", "Delete", "Delete Blank Lines", "Add 
To clipboard", "Clear Clipboard", "Select All", "Insert From File", "Insert Date", 
"Toggle Insert/Overwrite Mode", and "Check Spelling". To open the menu, 
press “Alt”, and press "Enter" on "Edit". Or, you can press "e" from the menu.  
 

5.2.1 Start Selection 
 
The "Start Selection" command allows you to select a certain portion of text 
that you would like to edit. When you use the "Start Selection" command, the 
cursor appears as blinking "dots 1-2-3-4-5-6-7-8" to indicate what text is 
being selected. When text is selected, you can make changes to only the 
selected text, without affecting the text in the rest of the document. This 
command is especially useful for copying, cutting, and pasting.  
To select text in a document, place your cursor on the location at which you 
want to start selecting text. Press “Alt” to open the "Edit" menu, and press 
"Enter" on "Start Selection", or you can press "b" in the "Edit" menu to get to 
this option. While editing a document, pressing “Ctrl-b” activates this 
command.  
The end point of the selected text is determined by the location at which you 
place the cursor after setting the start point. For example, if you have typed 
the word, "mother" in a document, and you want to select the word "mother", 
place the cursor on the letter m, activate the "Start selection command", and 
place the cursor directly after the letter r. The word "mother" is selected.  
 

5.2.2 Copy 
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After selecting text in a document, press “Alt” to open the menu, and move to 
"Edit" by pressing “down arrow”. Press "Enter" to open the "Edit" menu. 
Press “down arrow” to move to "Copy" and press "Enter", or press "c" from 
the "Edit" menu. While editing a document, pressing "Ctrl-c” activates this 
command. 
When you copy the selected text, it is copied to the clipboard. The clipboard 
is the virtual space that is used for storing copied data temporarily. If you 
copy new text to the clipboard, the data in the clipboard that you copied 
previously is erased, and is replaced by the current text selection.  
 

5.2.3 Cut 
 
To cut a selection of text, press “Alt”, and press "Enter" on "Edit". Move to 
"Cut" by pressing “down arrow” repeatedly, and press "Enter", or press "x" 
from the "Edit" menu. While editing a document, pressing "Ctrl-x" activates 
the "Cut" command. 
The difference between "Cut" and "Copy" is that if you execute the "Cut" 
command, the selected text is moved to the clipboard and the selection is 
removed from the document. The "Copy" command simply copies the 
selection to the clipboard, and the selected text remains in the document. 
 

5.2.4 Paste 
 
To paste selected text to the clipboard, press “Alt”, and press "Enter" on 
"Edit". Move to "Paste" by pressing “down arrow” repeatedly and press 
"Enter", or press "v" from the "Edit" menu. While editing a document, press 
"Ctrl-v" to paste the text from the clipboard to your current cursor location. 
 

5.2.5 Delete 
 
To delete selected text, press “Alt”, and press "Enter" on "Edit". Move to 
"Delete" by pressing “down arrow” repeatedly, and press "Enter", or press 
"d" from the "Edit" menu. While editing a document, you can press "Del" to 
delete selected text.  
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5.2.6 Delete Blank Lines 

 
To delete blank lines, you must select the area of the document from which 
you want the blank lines to be deleted. Once done, press “Alt”, and press 
"Enter" on "Edit". Move to "Delete blank lines" using “up arrow” or “down 
arrow” and press "Enter", or press "l" from the "Edit" menu. To delete empty 
lines while editing a document, press "Alt-e".  
 

5.2.7 Add to Clipboard 
 
To add selected text to the clipboard, press “Alt”, and press "Enter" on "Edit". 
Move to "Add To Clipboard" by pressing “down arrow”, and press "Enter", or 
press "p”. While editing a document, pressing "Ctrl-Insert" activates this 
command. 
"Add To Clipboard" is almost the same as the "Copy" command. However, 
while the "Copy" command replaces the text copied previously with the 
newly selected text, the "Add To Clipboard" command does not erase the 
previously copied data, but appends the newly selected text to the clipboard. 
 

5.2.8 Clear Clipboard 
 
To clear the clipboard, press “Alt”, and press "Enter" on "Edit". Move to 
"Clear Clipboard" by pressing “down arrow” repeatedly, and press "Enter". 
Or, you can press "e" from the "Edit" menu. Executing the "Clear Clipboard" 
command erases everything on the clipboard. While editing a document, you 
can press "Ctrl-Del" to activate this command. 
 

5.2.9 Select All 
 
The "Select All" command selects all text in a document. To activate this 
command, press “Alt”, and press "Enter" on "Edit". Move to "Select All" by 
pressing “down arrow” repeatedly, and press "Enter", or press "a" from the 
"Edit" menu. While editing a document, press "Ctrl-a" to activate this function. 
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5.2.10 Insert from File 

 
This command inserts another file in the document you are currently editing. 
To execute this command, press “Alt”, and press "Enter" on the "Edit" menu. 
Move to "Insert from File" by pressing “down arrow” repeatedly and press 
"Enter", or press "I" from the "Edit" menu. While editing a document, 
pressing “Ctrl-i" activates this function. 
When you use this option, an insert dialog is displayed similar to the "Open" 
dialog. Select file you want to insert, and press "Enter". The selected file is 
inserted at the beginning of the paragraph on which your cursor is located. 
When you execute "Insert from File", if the format of the inserted file differs 
from your current document, the text inserted from the file is converted to the 
file format of the current document.  For example, if you insert "sample.txt" in 
"sample.brf" and save it, the saved file is "sample.brf". 
Note: If you insert a Braille file in to a text file, the Braille document is back-
translated to text. Though the inserted text appears normally in grade 2, on 
rare occasions you might see differences in the back-translated text. 
 

5.2.11 Insert Date 
 
To insert the date into your document, press “Alt”, and press "Enter" on 
"Edit". Move to "Insert Date" by pressing “down arrow” repeatedly and press 
"Enter", or press "w" from the "Edit" menu. The current date and time "is 
inserted at your current cursor location. While editing a document, press 
"Ctrl-w" to activate this command. 
 

5.2.12 Insert Time 
 
To use this function, press “Alt”, and press "enter" on "edit". Move to "insert 
time" by pressing “down arrow” repeatedly and press "enter", or press "t" 
from the "edit" menu. The current time is inserted into your document at your 
cursor location. While editing a document, press "Alt-w" to activate this 
function. 
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5.2.13 Toggling Insert and Overwrite Modes 

 
There are two ways of editing documents on the Voice Sense QWERTY. 
The first is to insert your text, which pushes back the text after the cursor. 
This is called "Insert mode" because you are simply inserting text. When you 
are in "Insert mode", the cursor displays as "dots 7-8". The second is to 
overwrite text at the cursor location. This is called "Overwrite mode". In 
"Overwrite mode", the cursor displays as blinking "dots 7-8". 
When you start the Word Processor (or open a document), "Insert mode" is 
the default.  You can switch to "Overwrite mode" by pressing "Insert".  To 
return to "Insert mode", press "Insert" again. You can also access this 
function via the menu. Press “Alt”, press "Enter" on "Edit". Navigate to 
"Toggle Insert/Overwrite Mode" using “up arrow”, or you can press "m" from 
the "Edit" menu. 
 

5.2.14 Check Spelling 
 
This option is used to check spelling while editing a document. 
To execute the spell checker, do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to the "Edit" menu by pressing “down arrow”. 
3) Press "Enter" on the "Edit" menu. 
4) Press “down arrow” until "Check Spelling" is displayed. Or, press "k" To 
move to "Check Spelling" directly. 
5) Press "Enter" on "Check Spelling".  
Or, you can open the spell checker by pressing "Ctrl-k" while editing a 
document. 
 
When "Check Spelling" is executed, a dialog is displayed containing the 
following items: 
 
"Range" combo box 
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"Custom dictionary" dialog (c) 
"Options" dialog (o) 
"Begin" button (b) 
"Cancel" button 
 
You can move among the controls by pressing “Tab” or "shift-tab". 
The following explains each item in detail: 
 
The "Range" combo box is used to designate the range to be spell checked. 
 
1. Whole document: check the entire document. 
2. Chapter: check the current chapter.  
3. Paragraph: check the current paragraph.  
4. From cursor to bottom: check from the cursor position to the end of the 
document. 
5. Current word: check only the word under the cursor.  
You can move among the items in the combo box by pressing “up arrow” or 
“down arrow”. 
 
When you press "Enter" on the "Custom dictionary" dialog, the following 
items are displayed: 
 
1. List: shows the words that are registered in the custom dictionary. 
(Example: Braille 1/20). If there are no words registered, "no items" is 
displayed. 
2. Add word (Alt-a): press "Enter" on this button, and you are prompted to 
"Add word:". Type the word you wish to add and press "Enter". The new 
word is added and the Voice Sense QWERTY returns to the "Add word" 
button. 
3. Modify word (Alt-m): select the word to be modified from the "list" and 
press "Enter". You are prompted to "Modify word:". Input the correct word 
and press "Enter". The selected word is modified and you are returned to the 
"Modify word" button. 
4. Delete word (Del): select the word to be deleted from the "list" and press 
"Enter". 



147 
 

5. Close: this command closes the dialog.  
You can move among the items by pressing “Tab” or "shift-tab". 
 
When you press "Enter" on the "Options" dialog, the following items are 
displayed: 
 
1. Always suggest recommended word: if this option is set to "On", the Voice 
Sense QWERTY suggests a word if the word that is encountered is not in 
the dictionary. The default is set to "On". If the option is set to "Off", the 
Voice Sense QWERTY does not recommend a word. To toggle between 
"On" and "Off", press "Space". 
2. Use main dictionary only: if this option is set to "On", the spell checker 
does not look up any words in the "custom dictionary". It only uses the main 
dictionary. The default value is set to "Off". You can toggle between "On" 
and "Off" by pressing "Space". 
3. Skip an upper-case word: if this option is set to "On", words with only 
upper-case letters are not checked. The default is set to "On". You can 
change it by pressing "Space". 
4. Skip a word which includes an address: if this option is set to "On", the 
words that contain an address are not checked. The default is set to "On". 
You can change it by pressing "Space". 
5. Skip a word which includes numbers: if this option is set to "On", the 
words that include numbers are not checked. The default value is set to "Off". 
You can change it by pressing "Space". 
6. Confirm: if you press "Enter" on "Confirm", the changes that you made 
above are saved, and the Voice Sense QWERTY exits the "Options" dialog. 
7. Cancel: if you press "Enter" on "Cancel", the changes that you have made 
above are canceled and the Voice Sense QWERTY exits the "Options" 
dialog. 
 
To move among the option settings, press “up arrow” or “down arrow”. To 
move to "Confirm" or "Cancel", press “Tab” or "shift-tab". 
Press "Enter" on the "Begin" button and the Voice Sense QWERTY starts to 
check spelling. If you press "Enter" on the "Cancel" button, the "Spell Check" 
is canceled. 
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Once "Spell Check" is executed, the following dialog is displayed: 
 
1. Text window: shows the sentence with the current word to be checked. 
The cursor is located at the word that is to be checked.  
2. Change word edit box: shows the current word to be checked. You can 
input the correct word directly into the edit box.  
3. Suggestions list: if the word to be checked is not in the dictionary, the 
Voice Sense suggests words. You can move among the suggestions by 
pressing “up arrow” or “down arrow”. 
4. Skip once (s): if you press "Enter" on this button when a word is 
encountered that is not in the dictionary, the word is not modified. You can 
also press the "down scroll button" To skip the word. 
5. Skip all (i): if you press "Enter" on this button, all instances of the currently 
focused word are not modified and are automatically skipped throughout the 
spell check range. 
6. Add to custom dictionary (a): if you press "Enter" on this button, the word 
that is currently focused is added to your "Custom dictionary". 
7. Modify once (c): focus on the modified word and select the desired word 
from the "suggestions list" and press "Enter". The currently focused word is 
replaced with your selection from the "suggestions list".  
8. Modify all (m): focus on the modified word and select the desired word 
from the "suggestions list" and press "Enter". All instances of the currently 
focused word are replaced by the suggested word.  
9. Cancel: if you press "Enter" on the "Cancel" button, the "Spell Check" is 
exited.  
 
You can move among the controls by pressing “Tab” or "shift-tab". When the 
spell check is complete, the Voice Sense QWERTY announces, "00 words 
checked. 00 misspellings found. 00 words corrected". 
Also remember, you can check the spelling of the current word by pressing 
"Alt-k" while editing a document. A list of suggestions is displayed. Move 
through the list using “up arrow” or “down arrow”, and press "Enter" to 
replace the misspelled word with the selected suggestion. 
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5.2.15 Edit Language attribute 
	  

When you change the language attribute for a block of text, the text to 
speech voice used to read the selected text automatically changes to the 
language attributed to that text. This ensures that pronunciation of the text is 
proper for the language in which it was created. You can edit the language 
associated with a selected block of text using the “Edit Language Attribute” 
function.  

 
To use this function, press “Alt”, and press "enter" on "edit". Move to 
"Select edit Language Attribute" by pressing “down arrow” repeatedly and 
press "enter", or press "i" from the "edit" menu. To activate this function, 
directly, press “Windows-Alt-I”. The unit prompts, “Change language?” and 
a combo box is displayed from which you can choose the desired language. 
Navigate among the languages using “up arrow key” and “down arrow key”. 
When you reach your desired language, press “Enter” to change the 
language associated with the selected block of text. You can also type the 
first letter of your desired language from the prompt box to activate that 
language attribute: For example, Use “f” for French, “s” for Spanish, etc. 
 
If “View Format Characters” is on, text language is noted as follows: 
Spanish: $LS 
French: $LF 
German: $LG 
Italian: $LI 
English: $LE 

 
5.2.16 Font Setting  
 

The "Font Setting" dialog allows you to choose the type, size, color and 
style of the font for the current text selection. You can open the "Font 
Setting" dialog by pressing "Alt" and press "Enter" on "Edit". Navigate to 
"Font Setting" using the Down arrow or you can press "F from the "Edit" 
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menu. You can open the "Font Setting" dialog while editing a document 
using "Alt-M".  

The "Font Setting dialog contains the following items: "Font Name" list box, 
"Size" list box, "Color" list box, "Underscore" combo box, "Bold" combo box, 
"Italics" combo box, a "Confirm" button and a "Cancel" button. You can 
move among the controls in the dialog using "Tab" and "Shift-Tab".  

The "Font Name" list box contains a "None" option for choosing no font 
type, and 84 font choices based on popular fonts available in Microsoft 
Windows. The "Size" list box allows you to set the font size in various 
increments from 8 to 72 point font. The "Color" list box contains a "None" 
option, 140 color options, and an option called "User definition" which 
allows you to enter the exact RGB value of a color in cases where the color 
you want is not in the list or you need to be very specific about the color 
you're using. When you choose "User Definition" as your color option, 3 
edit boxes appear in the tab order: "Red", "Green" and Blue". Enter the 
appropriate red, blue, and green values in these edit boxes to define your 
font color. Use "Space" to toggle "Underscore", "Bold" and "Italics" on/off 
when your cursor is placed on the appropriate combo box. When you have 
finished setting your font, Tab to Confirm" and press "Enter". If you do not 
wish to save your settings, Tab to "Cancel" and press "Enter" or press 
"escape" or "Alt-F 4".  

 
5.3 Go to Menu 

 
To open the "Go To" menu in the Word Processor, press “Alt”, and move to 
"Go To" by pressing “down arrow”, and press "Enter". Or, you can press "g" 
from the menu. The "Go To" menu contains the following items: "Find", "Find 
Again", "Replace", "Go To Location", "Go to Previous Page", "Go To Next 
Page", "Set Mark", "Go to Mark", "Go To Previous Document", and "Go To 
Next Document". 
 

5.3.1 Find 
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The find function allows you to search for text in a document. Once the text 
is found you are taken to that position in your document. To execute this 
command, press “Alt”, and move to "Go To" by pressing “down arrow” and 
press "Enter". Move to "Find" by pressing “up arrow” or “down arrow”, or you 
can press "f" from the "Go To" menu. While editing a document, pressing 
"Ctrl-f" activates the "Find" command. When "Find" is executed, the "Find" 
dialog is displayed. This dialog consists of "Text to find", "Search direction", 
"Match case", a "Confirm" button, and a "Cancel" button. You can move 
among the fields by pressing “Tab” or "shift-tab". 
1. Text to find 
The first field in the "Find" dialog is "Text to find". In this edit box, you can 
type the text that you want to find. To find the text immediately, press "Enter". 
To set other fields in the dialog, press “Tab” to move to the next field. 
2. Search direction 
The next field is "Search direction". The default direction is "Forward". If you 
would like to change the search direction, press "Space" to toggle between 
"Forward" and "Backward". After you type in the text to be found, and set the 
search direction, press "Enter" To find the text immediately. 
3. Match case 
The next field is "Match case". This field displays only when you execute the 
"Find" command in a text file. This field does not display in Braille files. The 
default value is "No". To change the value, press "Space".  
4. Confirm 
To execute "Find", press "Enter" on "Confirm". You can also execute "Find" 
by pressing "Enter" on "Text to find" or "Search direction". 
5. Cancel 
To cancel the "Find" function, press "Enter" on "Cancel". Or, you can cancel 
the "Find" command by pressing "Alt-F4". 
If Voice Sense QWERTY finds the text you typed, the sentence with the text 
is displayed. If there was no text that matched what you typed, the cursor 
remains in its current location and the Voice Sense QWERTY announces 
"not found". This function saves the text last searched for, as well as the 
direction, so you can use it again to search for the next occurrence of the 
text. 
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When using the find command, the current cursor position is very important. 
If the cursor is located at the beginning of the document, it is necessary to 
select the "Forward" search direction. If the cursor is located at the end of 
the document, it is necessary to select "Backward" as the direction used for 
searching. If you do not choose the correct search direction in regards to the 
text you're looking for and your current position, the text is not found even if it 
is present in the document. 
 

5.3.2 Find Again 
 
To execute the "Find Again" command, press “Alt”. Then move to "Go To" by 
pressing “down arrow” and press "Enter". Move to "Find Again" by pressing 
“down arrow” and press "Enter", or press "h" from the "Go To" menu. While 
editing a document, press "F3" to activate this command. When "Find Again" 
is executed, "Find Again" looks for the text that was searched for in the 
previous "Find". "Find again" searches in the same direction that was used 
with the last "Find". If you have not yet used the "Find" command in the 
current document, "Find again" is not available.   
 

5.3.3 Replace 
 
To execute this command, press “Alt”, and move to "Go To" by pressing 
“down arrow”, and press "Enter". Move to "Replace" using “down arrow” and 
press "Enter", or press "r" from the "Go To" menu. While editing a document, 
pressing "Ctrl-r" activates this function. 
"Replace" opens a dialog that consists of the following fields: "Text to find", 
"Replace with", "Search direction", "Match case", "Replace", "Confirm" and 
"Cancel". You can move among the fields by pressing “Tab” or "shift-tab". 
Each of the controls is described below: 
 
1. Text to find 
Type the text that you want to replace in this field. 
2. Replace with 
Type the replacement text in this edit box. 
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3. Search direction 
The "Search direction" has the same function as the "Search direction" 
explained in section 5.3.1. After you set the search direction, press "Enter" to 
start the replacement of text, or press “Tab” to set the "Match case" or 
"Replace" options. 
4. Match case 
This field displays only when you execute the "Replace" command in text 
files. This field does not display in Braille files. The default value is "No". To 
change the value, press "Space".  
5. Replace 
You may want to replace only one instance of the text you searched for. Or, 
you may want to replace all the instances of the searched text. Choose 
"Once" or "All" according to your preference. You can toggle between the 
two choices by pressing "Space". 
6. Confirm and Cancel 
Pressing "Enter" on "Confirm" starts finding and replacing text. If there is no 
text that matches the text you typed, "Not found" is displayed, and the 
function is canceled. Pressing "Enter" on "Cancel" cancels the "Replace" 
function. 
 

5.3.4 Go to Location 
 
The "Go to Location" command moves quickly to a specific location. You can 
move to a specific page, paragraph, or line. To execute this command, press 
“Alt”, and move to "Go To" by pressing “down arrow”, and press "Enter". 
Move to "Go To Location" by pressing “down arrow”, and press "Enter". 
While editing a document, press "Ctrl-g" to activate this function.  
When "Go to Location" is executed, the Word Processor says, "Move to 
page number". If you type a number here, the Voice Sense QWERTY takes 
you to the page number that corresponds with the number you type. You can 
also type the letter "f" before the number. This tells the Voice Sense 
QWERTY that you are looking for a page number, and not a paragraph, or, 
line number. Type the number of the page you want to move to without the 
PLUS sign or minus sign, and press "Enter". The Word Processor jumps 
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from the start of the document to the specific page. To move forward from 
your current location, put the PLUS sign in front of the number and letter. For 
example, to move forward five pages type "+f5". To move backward from 
your current location, type the minus sign in front of the number and letter.  
You can also use this function to move to a specific paragraph. Select "Go 
To Location" in the "Go To" menu, or press "Ctrl-g". The Voice Sense 
QWERTY says, "Move to page number:" Before you type the number of the 
paragraph you want to go to, type "p", then type the number of the paragraph. 
By typing in the letter "p", the Voice Sense QWERTY knows that you are 
looking for a paragraph, and not a page or line. To move forward from your 
current location, type the PLUS sign in front of the number and letter. To 
move backward from your current location, type the minus sign in front of the 
number and letter. If the paragraph number you type is not valid, the Voice 
Sense QWERTY announces, "Move range error". 
You can also use this function to move to a specific line. Select "Go To 
Location" in the "Go To" menu, or press "Ctrl-g". The Voice Sense QWERTY 
says, "Move to page number:" Before you type the number of the line that 
you want to go to, type "l", then type the line number. AS when jumping by 
page and paragraph, to move forward from your current location, type the 
PLUS sign in front of the number and letter. To move backward from your 
current location, type the minus sign in front of the number and letter.  If the 
line number you type is not valid, the Voice Sense QWERTY says, "Move 
range error". 
You can also go to a specific line number on a specific page. The Voice 
Sense QWERTY enables you to type this information at the same time. To 
do this, press "Ctrl-g", or you can select "Go to Location" in the "Go To" 
menu. Then, when the Voice Sense QWERTY says, "Move to page 
number:" you can type the page number followed by the line number. For 
example, to move to the 3rd line on the 20th page, you would type "20 3", or 
you could type "f20 3".  
 

5.3.5 Go to Previous Page 
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The “Go To Previous Page” command allows you to move to the page that is 
located before the page you are currently on. To execute this command, 
press “Alt,” and move to “Go To” by pressing “Down arrow”. Then, press 
“Enter” on “Go To”. Move to “Go to Previous Page” by pressing “Down arrow,” 
and then press “Enter,” or press “Page up” while you are in the document. 
Once you have activated the “Go to Previous Page” function, the Voice 
Sense QWERTY goes directly to the previous page. 
 

5.3.6 Go to Next Page 
 
The "Go To Next Page" command allows you to move to the page that is 
located after the page you are currently on. To execute this command, press 
"Alt", and move to "Go To" by pressing "down arrow", and press "Enter". 
Move to "Go To Next Page" by pressing "down arrow”, and press "Enter". Or, 
you can press “Page down” while you are in the document. Once you have 
activated the “Go to Next Page” function, the Voice Sense QWERTY goes 
directly to the next page. 
 

5.3.7 Set Mark 
 
The "Set mark" command marks a position in the document that you want to 
return to later. To execute this command, press “Alt”, and move to "Go To" 
by pressing “down arrow” and press "Enter". Move to "Set mark" by pressing 
“down arrow”, and press "Enter", or press "m" from the "Go To" menu. While 
editing a document, press "Ctrl-m" to activate this command. 
Move the cursor to the location that you want to mark, and press "Ctrl-m”. 
The Voice Sense QWERTY says, "Mark name:". To name the mark use the 
letters a through z. While editing a document, the Voice Sense QWERTY 
does not show the mark sign unless you have selected "View format 
character" in "Settings", explained in section 5.1.7. If you have this option 
turned on, the bookmark sign is shown in the document. You can go to 
marked text by using "Left arrow” or “Right arrow” and the bookmark sign 
appears, which is "$pl (mark name)". If you move the cursor to the mark 
location in a document, you can see dots 7-8 all through the mark sign. This 



156 
 

means that the Voice Sense QWERTY deals with the marked text as a 
chunk, but not with each character.  
 

5.3.8 Go to Mark 
 
The "Go to Mark" command finds a mark that has previously been set. To 
execute this command, press “Alt”, and move to "Go To" by pressing “down 
arrow” and press "Enter". Move to "Go to Mark" by pressing “down arrow”, 
and press "Enter", or press "j” from the "Go To" menu. While editing a 
document, go to marked text by pressing "Ctrl-j". 
The Voice Sense QWERTY says "Move to mark:". Type the character of the 
mark name that you want to locate, and the Voice Sense QWERTY moves 
the cursor to the marked position. 
 

5.3.9 Go to Previous Document 
 
If you have multiple documents open, you can easily move among them. To 
go to the previous document, press “Alt”, and move to "Go To" by pressing 
“down arrow”, and press "Enter". Move to "Go To Previous Document" by 
pressing “down arrow”, and press "Enter". Or, you can press "shift-tab" while 
editing a document.  
 

5.3.10 Go to Next Document 
 
To go to the next document, press “Alt”, and move to "Go To" by pressing 
“down arrow”, and press "Enter". Move to "Go to Next Document" by 
pressing “down arrow”, and press "Enter". Or, you can press “Tab” while 
editing a document.  
 
5.4 Read Menu 

 
The "Read" menu is used to read specific parts of the document with speech 
and/or Braille. To open the "read menu", press “Alt”, and press "r". The items 
in the "Read" menu are: "Read Selected Text", "Read Beginning Of Selected 
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Text", "Read From Beginning To Cursor", "Read From Cursor To End", "Auto 
Scroll", "Read Current Sentence", "Read Current Line", "Read Current Word", 
"Read Current Character", and "Read Status". 
 

5.4.1 Read Selected Text 
 
The "Read Selected Text" command reads the text you currently have 
selected. To execute this command, press “Alt”, and move to the "Read" 
menu by pressing “down arrow”, and press "Enter", or press "r" to open the 
"Read" menu. Press "Enter" on "Read Selected Text". While editing a 
document press "Alt-b" to activate the "Read Selected Text" function. 
Although you activate this function, the cursor location does not move to the 
selected text. It is simply read aloud, and your cursor remains in its current 
position.  
 

5.4.2 Read Beginning of Selected Text 
 
The "Read Beginning of Selected Text" command allows you to hear the first 
line of the selected text without moving the cursor position. To execute this 
command, press “Alt”, and move to the "Read" menu by pressing “down 
arrow”, and press "Enter". Move to "Read Beginning Of Selected Text" by 
pressing “down arrow”, and press "Enter", or press "u" from the read menu. 
While editing a document, press "Ctrl-u" to activate this function.  
 

5.4.3 Read from beginning to cursor 
 
Using this function, the Voice Sense QWERTY speaks the text in the 
document from the beginning to the current cursor position. To execute this 
command, press “Alt”, and move to the "Read" menu by pressing “down 
arrow”, and press "Enter". Move to "Read From Beginning To Cursor" by 
pressing “down arrow”, and press "Enter", or you can press "t" from the read 
menu. While editing a document, press "Alt-g" to activate this function. 
If you want to stop speech before you reach the cursor location, you can 
press “Ctrl”. Your cursor remains in the position on which it was located 
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when you activated this function. In other words, the cursor does not relocate 
to the position at which you interrupted reading.  
 

5.4.4 Read from Cursor to End 
 
This command reads a document from the current cursor position to the end 
of the document. While the Voice Sense QWERTY is reading the text, the 
cursor remains at the location from which you executed this command. 
However, when reading is completed, the cursor is placed at the end of the 
document. 
To execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow”, and press "Enter". You can move to "Read From 
Cursor To End" by pressing “down arrow” and press "Enter", or you can 
press "g" from the "Read" menu. While editing a document, press “Fn-Enter" 
to activate this function. 
If you interrupt speech before reading is completed, you can press "Ctrl", to 
move the cursor to where you stopped reading. 
 

5.4.5 Auto Scroll 
 
The "Auto Scroll" command scrolls the Braille display (When connected to 
SyncBraille) automatically through the document. The speed of the "Auto 
Scroll" is set in the "Settings" menu, located in the "File" menu, explained in 
section 5.1.7. When using auto scroll, no speech is heard as the Braille 
display (When connected to SyncBraille) scrolls through the document.   
To execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow”, and press "Enter". Move to "Auto Scroll" by pressing 
“down arrow”, and press "Enter", or press "a" from the read menu. While 
editing a document, you can turn the auto scroll feature on and off by 
pressing the up and down scroll buttons simultaneously. For faster scrolling, 
press "right arrow”. For slower scrolling, press "left arrow”. Read a line again 
by pressing the up scroll button or “Up arrow” Similarly, to skip lines you do 
not wish to read, press the down scroll button or “Down arrow”.  
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5.4.6 Read Current Sentence 
 
This function reads the current sentence. To execute this command, press 
“Alt”, and move to the "Read" menu by pressing “down arrow”. Press "Enter" 
to move to "Read Current Sentence" by pressing “down arrow” and press 
"Enter". Or you can press "e", from the read menu. While editing a document, 
press "fn-n" to activate this function.   
 

5.4.7 Read Current Line 
 
This function reads the current line. To execute this command, press “Alt”, 
and move to the "Read" menu by pressing “down arrow”. Then, press "Enter". 
Move to "Read Current Line" by pressing “down arrow”, and press "Enter", or 
you can press "l" from the read menu. While editing a document, press "Fn-
c" to activate this function.   
 

5.4.8 Read Current Word 
 
This function reads the current word. To execute this command, press “Alt”, 
and move to the "Read" menu by pressing “down arrow”. Then, press "Enter". 
Move to "Read Current Word" by pressing “down arrow”, and press "Enter", 
or you can press "w" from the read menu. While editing a document, press 
"Fn-x" to activate this function.   
 

5.4.9 Read Current Character 
 
This function reads the current character. To execute this command, press 
“Alt”, and move to the "Read" menu by pressing “down arrow”. Then, press 
"Enter". Move to "Read Current Character" by pressing “down arrow”, and 
press "Enter", or you can press "c" from the read menu. While editing a 
document, press "Fn-z" to activate this function.   
 

5.4.10 Read Status 
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This function gives you information about your current file. When you 
activate this function, the Voice Sense QWERTY tells you the "file name", 
"edit mode (insert or overwrite)", and "file protection (write or read only)". To 
execute this command, press “Alt”, and move to the "Read" menu by 
pressing “down arrow”. Then, press "Enter". Move to "Read Status" by 
pressing “down arrow”, and press "Enter", or you can press "s" from the read 
menu. While editing a document, press "Fn-/(slash)" to activate this function.  
 

5.4.11 Read Selected Text in Current Language 
 
This function allows you to read the currently selected text in another 
language. To execute this command, press “Alt”, and move to the "Read" 
menu by pressing “down arrow”. Then, press "Enter". Move to "Read 
Selected Text in Current Language" by pressing “down arrow”, and press 
"Enter". While editing a document, press "Alt-Windows-r" to activate this 
function. When you execute this command, you are prompted to choose the 
language in which you wish to read the selected text. Navigate to the desired 
language using Up or Down arrow, and press “Enter”. The text is then 
spoken using the TTS of your chosen language.  
 
5.5 Layout 

 
The "Layout" menu contains options for setting the layout for printing on an 
ink printer or embossing on a Braille embosser. The "Layout" menu contains 
the following items: "Braille Document Layout", "Print Document Layout", 
"Braille Paragraph Layout", and "Print Paragraph Layout". The changes 
made in the "Layout" menu are not displayed on the Braille display (When 
connected to SyncBraille). To check the layout, open the menu by pressing 
“Alt”, and press "l" to open the Layout menu.  
 

5.5.1 Braille Document Layout  
 
While editing a document, press “Alt” to open the menu, and select "Layout" 
or press "l", and select "Braille Document Layout". Or, you can press "Alt-F5" 
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to open the "Braille Document Layout" dialog while editing a document. 
"Braille Document Layout" is used to set the width and height of the paper for 
embossing as well as other options.  
You can navigate the menu items with “up arrow” or “down arrow”, and you 
can move to "Confirm" or "Cancel" by pressing “Tab”. You can skip an item 
by pressing “down arrow” if you don't want to change the default setting. 
You can adjust the following settings: 
 
1. Set characters per line 
This sets the number of Braille characters per line to emboss. The default 
value is set to 32. To change the value, type the number of characters per 
line. Move to the next setting by pressing “down arrow”. 
2. Set lines per page 
This sets the number of lines per page to be embossed. It includes the line 
on which the page number is printed. For example, if it is set to 26, the 
content of the document is embossed with 25 lines and the page number is 
printed as the 26th line. To change the value, type the number of lines that 
you want to emboss. Move to the next setting by pressing “down arrow”. 
3. Print type 
This sets whether the document is embossed on one or both sides of the 
page. The default value is set to double sided embossing. For single sided 
embossing, press "Space". Move to the next setting by pressing “down 
arrow”. 
4. Page numbering type 
This sets the numbering type for embossing a document. The default type is 
set to "Double sided". It means that the page number is embossed on every 
page. The setting values are "Double sided", "Odd", "Even", and "None". 
Press "Space" and "Backspace" to change the value. Press “down arrow” To 
move to the next setting. 
5. Set page numbering 
This sets the position of the page number when embossing. The selections 
are "Upper right" and "Lower right". The default setting is set to "Lower right". 
Press "Space" To change the setting. Press “down arrow” To move to the 
next setting. 
6. Header 
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This is an edit box in which you can type the text to be embossed as the 
header. To move to the next setting, press “down arrow”. 
7. Footer 
This is an edit box into which you can type the text to be embossed as the 
footer. After you set your preferences, move to "Confirm" or "Cancel", by 
pressing “Tab”.  
8. Confirm / Cancel 
To apply settings, when "Confirm" is displayed press "Enter". If you do not 
want to change the setting when "Cancel" is displayed press "Enter".  
 

5.5.2 Print Document Layout 
 
This option allows you to set the document layout for printing on an ink 
printer. Press “Alt” to open the menu, and select "Layout" or press "l". Select 
"Print Document Layout". Or, press "Alt-F6" while editing a document.  The 
settings in this menu are applied throughout the document. You can navigate 
the menu items with “up arrow” or “down arrow”, and you can move to 
"Confirm" or "Cancel" by pressing “Tab”. You can skip an item by pressing 
“down arrow” if you do not want to change the default setting. 
The following is a detailed explanation of each setting: 
 
1. Set top margin 
This sets the top margin for ink printing. The top margin is the distance from 
the top of the paper to the first line of the printed paragraph. The default 
value is set to 20mm (about 0.78 inches). To change the default setting, type 
a new value.  
2. Set bottom margin 
This sets the bottom margin for ink printing. The bottom margin is the 
distance from the bottom of the paper to the last line of a printed paragraph. 
The default value is set to 20mm (about 0.78 inches). To change the default 
setting, type a new value. 
3. Set left margin 
This sets the left margin for ink printing. The left margin is the distance from 
the left edge of the paper to the first text that is printed. The default value is 
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set to 20 mm (about 0.78 inches). To change the default setting, type a new 
value. 
4. Set right margin 
This sets the right margin for ink printing. The right margin is the distance 
from the right end of the printed text to the right edge of the paper. The 
default value is set to 20mm (about 0.78 inches). To change the default 
setting, type a new value. 
5. Set page numbering 
This sets the position where the page numbers are printed. The available 
positions are "Upper left", "Upper middle", "Upper right", "Lower left", "Lower 
middle", and "Lower right". To change the setting, press "Space" or 
"Backspace".  
6. Header 
This is used to edit the header printed at the top of each page. Move to 
"Header", and type the text that you want to be printed. 
7. Footer 
This is used to edit the footer printed at the bottom of each page. Move to 
"Footer", and type the text that you want to be printed. 
8. Distance between lines 
This sets the distance between the printed lines. The default value is set to 
150%. The distance can be anywhere from 100% to 300%. If you type a 
value that exceeds this range, the Voice Sense QWERTY says, "Out of 
range. Value too large", and waits for you to type another value. 
9. Confirm / cancel 
To apply the settings, press "Enter" when "Confirm" is displayed. If you do 
not want to apply a setting when "Cancel" is displayed, press "Enter".  
 

5.5.3 Braille Paragraph Layout  
 
To open the "Braille Paragraph Layout" dialog, press “Alt”. Then, press 
"Enter" on "Layout", or press "l". Select "Braille Paragraph Layout" and press 
"Enter". Or, you can press "Alt-F7" while editing a document. These settings 
are only applied to the selected paragraph.  
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You can navigate between the menu items by pressing “up arrow” or “down 
arrow”. Move to the "Confirm" or "Cancel" buttons by pressing “Tab”. You 
can skip an item by pressing “down arrow” if you do not want to change the 
default setting. 
In this dialog, you can set the following items:  
 
1. Indent first line 
This indents the first line of the paragraph as designated by the number of 
characters. The default value is set to 0. To change this setting, type the 
number of characters to be indented. Press the down scroll button or “down 
arrow” To move to the next setting.  
2. Indent all lines except the first line 
This indents all the lines of the paragraph, except the first line of the 
paragraph as designated by the number of columns. To indent the text, type 
the number to indent.  
3. Confirm / cancel 
Press “Tab” or "shift-tab" to get to the Confirm and Cancel buttons. To apply 
changes, press "Enter" when "Confirm" is displayed. To exit the settings 
without making changes, press "Enter" when "Cancel" is displayed.  
 

5.5.4 Print Paragraph Layout  
 
You can set the layout of the current paragraph for printing on an ink printer. 
To set "print paragraph layout", press “Alt”. Select "Layout", or press "l" and 
select "Print Paragraph Layout". Or, press "Alt-F8", while you are editing a 
document. This setting applies only to the current paragraph.  You can 
navigate the menu items by pressing “up arrow” or “down arrow”, and you 
can move to "Confirm" or "Cancel" by pressing “Tab”. You can skip an item 
by pressing “down arrow” if you do not want to change the default setting. 
The following is a detailed explanation of the settings for "Print Paragraph 
Layout:" 
 
1. Set left margin 
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This sets the left margin for the current paragraph. The default value is set to 
0mm. To change the setting, type the value of the margin you want. Move to 
the next setting by pressing the down scroll button or press “down arrow”. 
2. Set right margin 
This sets the right margin for the current paragraph. The default value is set 
to 0mm. To change the setting, type the value of the margin you want. Move 
to the next setting by pressing the down scroll button or press “down arrow”. 
3. Indent first line 
This sets the indentation of the first line by the value you select. THIS setting 
is valid for the paragraphs that follow, unless the setting is changed. The 
default value is set to 0. To change the setting, type the number of 
characters to indent. Press the down scroll button or press “down arrow” To 
move to the next setting. 
4. Indent all lines except the first line 
All the lines in the paragraph, except the first line, are indented by the value 
you select. This setting is valid for the following paragraphs, unless the 
setting is changed. The default value is set to 0. To change the setting, type 
the number of characters to indent. 
5. Alignment 
This sets the alignment type. The default type is set to "Left justified". The 
other options are "Centered" and "Right justified". Press "Space" To change 
the setting. 
6. Set style 
When printing a document with an ink printer, the style of each paragraph 
can be set independently for differing types of text. Style includes "font type", 
"font size", and "text shape". You can select "Text", "Title", "Sub title", 
"Abstract 1", and "Abstract 2" by pressing "Space" or "Backspace". The 
default fonts for each style are listed below. 
Text: Times New Roman, Font size 11 
Abstract1: Times New Roman, Font size 11, Boldface  
Abstract2: Times New Roman, Font size 14, Boldface  
Sub title: Courier New, Font size 16, Italic, Boldface, Center-aligned  
Title: Times New Roman, Font size 20, Boldface, Center-aligned  
7. Confirm / cancel 
Press “Tab” or "shift-tab" to get to “confirm” and “cancel” buttons.  
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To apply the settings, press "Enter" on "Confirm". To cancel without saving 
settings, press "Enter" on "Cancel".  
 
5.6 Nemeth Code Entry 

Whether you are a student, or in a work position which requires a large 
amount of mathematic writing, you may find it advantageous and/or more 
natural to enter mathematic expressions using the Nemeth Code for 
Mathematic and Scientific notation. As many of the symbols in the Nemeth 
code overlap with those in the literary Braille code, it is necessary to enter a 
special Nemeth mode to ensure Nemeth entry is translated correctly. Press 
“Alt-N” to toggle Nemeth Mode on/off. When nemeth mode is on, the unit 
announces, “Start Nemeth mode”. When Nemeth Mode is turned off, the unit 
announces, “End Nemeth Mode”. While in Nemeth Mode, the QWERTY 
keyboard functions as a Braille keyboard just as it does when entering text in 
a Braille file. When you end nemeth Mode, the keyboard is returned to 
normal QWERTY entry. 
When Nemeth Mode is on, you may enter mathematic and algebraic 
expressions as you would normally enter them on a Perkins Brailler and they 
will be translated and spoken correctly by the notetaker.  
You may also import and export math using DOC and RTF files. If you save 
a file with Nemeth entry as a DOC, a teacher or colleague may view or print 
the file and the math symbols will appear correctly. Note: the “support 
Formatting” option must be set to “No” in the “Settings” dialog of the “File” 
menu for this to work correctly. 
You may also import an RTF file and mathematic text will be rendered using 
Nemeth symbols. 
 
[Supported Nemeth symbols] 
 

Category Math Symbol Braille Dots 

Operations Identity dots-1-2-3 

  Plus or Minus dots-3-4-6 then 5 then 3-6 

  Minus sign dots-3-6 
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  Plus sign dots-3-4-6 

  Divided By dots-4-6 then 3-4 

  Times dots-4 then 1-6 

  Factorial dots-1-2-3-4-6 

  Hollow Dot dots-4-6 then 1-6 

  Union Dots-4-6 then 3-4-6 

  Intersection dots-4-6 then 1-4-6 

  Asterisk Times Sign Dots-4 then 3-4-5-6 

  Curved division sign Dots-1-3-5 

  Percent Dot-4 then 3-5-6 

Comparative symbols Equals Dots-4-6 then 1-3 

  Greater Than Or Equal To Dots-4-6 then 2 then 1-5-6 

  Less Than Or Equal To  Dots-5 then 1-3 then 1-5-6 

  Directly over Dots-1-2-6 

  Directly under Dots 1-4-6 

  Greater Than Dots-4-6 then 2 

  Less Than Dots-5 then 1-3 

  Not Equal to Dots-3-4 then 4-6 then 1-3 

  Congruent 
Dots-4 then 1-5-6 then 4-6 then 1-

3 

  Not Congruent 
Dots-3-4 then 4 then 1-5-6 then 4-

6 then 1-3 

  Similar Dots-4 then 1-5-6 

  Not Similar Dots-3-4 then 1-5-6 

  Approximately Equal Dot-4 then 1-5-6 then 4 then 1-5-6 

  Equivalent  Dot-4 then 1-2-6 then 6 then 1-2-6 
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  Is to (Ratio sign) Dot-5 then 2 

  Is proportionate to Dot-5-6 then 2-3 

  Not Greater Than Dots-3-4 then 4-6 then 2 

  Not Less Than Dots-3-4 then 5 then 1-3 

  Element Of Dot-4 then 1-5 

  Subset of Dots-4-5-6 then 4 then 1-3 

  Such that Dots-1-2-5-6 

  Proper Superset 
Dots-4-5-6 then 4-6 then 2 then 1-

5-6 

  Negative sign Dots-3-6 

  Plus as opposed to positive dots 3-4-6 

Punctuation vertical bar  Dots-1-2-5-6 

  Double vertical bar  Dot-6 then 1-2-5-6 

  Ampersand dots-1-2-3-4-6 

  Decimal point dots-4-6 

  Comma dot-6 

  Left parentheses Dots-1-2-3-5-6 

  Right Parentheses  Dots-2-3-4-5-6 

  Left Brace   Dots-4-6 then 1-2-3-5-6 

  Right Brace   Dots-4-6, 2-3-4-5-6 

  Left Bracket Dots-4 then 1-2-3-5-6 

  Right Bracket Dots-4 then 2-3-4-5-6 

  Separation line dots 2-5 

  
A period as opposed to a 

subscript 
dots-2-5-6 

  Tally dots 4-5-6 
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  Bold indicator dots-4-5-6 

  Italics indicator dots 4-6 

  Vertical line dots 4-5-6 

  Termination indicator dots 1-2-4-5-6 

  Multipurpose indicator dot 5 

Measurement symbols Prime dot-3 

  Double prime dot-3 then 3 

  Feet dot-3 

  Inches dot-3 then 3 

  Minutes dot-3 

  Seconds dot-3 then 3 

  Degrees dots-4-5 then 4-6 then 1-6 

Fractions Open Fraction indicator dots-1-4-5-6 

  Close Fraction indicator dots-3-4-5-6 

  Open Mixed Number Dots-4-5-6 then 1-4-5-6 

  Close mixed Number Dots-4-5-6, Dots-3-4-5-6 

  Fraction line dots-3-4 

  Long Horizontal fraction line  dots-3-4 then dots-3-4 

Roots, Superscripts 

and Subscripts 
Script indicator dot 4 

  Subscript Indicator dots-5-6 

  Superscript with subscript dots-4-5 

  Baseline indicator dot-5 

  Square Root dots-3-4-5 

  Root dots-3-4-5 
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  End Root dots-1-2-4-5-6 

Limits symbols Infinity Dot-6 then Dots-1-2-3-4-5-6 

  Lower Limit of 
dots-1-4-6 then 1-2-3 then 2-4 

then 1-3-4 

  Upper Limit of 
dots-1-2-6 then 1-2-3 then 2-4 

then 1-3-4 

Integrals symbols Integral sign dots-2-3-4-6 

  Double integral dots-2-3-4-6 then 2-3-4-6 

  Triple integral sign 
dots-2-3-4-6 then 2-3-4-6 then 2-

3-4-6 

  Integral with infinity 
dots-2-3-4-6 then 4 then 6 then 1-

2-3-4-5-6 then 1-2-4-5-6 

Data Set Symbols Element of dots-4 then 1-5 

  Not an Element Of dots-3-4 then 4 then 1-5 

  Null set dots-3-5-6 

  Subset of dots-4-5-6 then 5 then 1-3 

  Is a subset of or is equal to  
dots-4-5-6 then 5 then 1-3 then 1-

5-6 

  Is a superset of or is equal to 
dots-4-5-6 then 4-6 then 5 then 1-

5-6 

  Contains dots-4-5-6 then 4-6 then 2 

geometric Symbols Shape indicator dots-1-2-4-6 

  Right arrow 
dots-1-2-4-6 then 2-5 then 2-5 

then 1-3-5 

  Left arrow 
dots-1-2-4-6 then 2-4-6 then 2-5 

then 2-5 

  Perpendicular dots-1-2-4-6 then 1-2-3-4 

  Parallel dots-1-2-4-6 then 1-2-3 
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  Angle dots-1-2-4-6 then 2-4-6 

  Triangle Dots-1-2-4-6 then 2-3-4-5 

  Circle dots-1-2-4-6 then 1-4 

  Square dots-1-2-4-6 then 2-5-6 

  Pentagon Dots-1-2-4-6 then 2-6 

  Hexagon dots-1-2-4-6 then 2-3-5 

  Octagon dots-1-2-4-6 then 2-3-6 

  Horizontal Bar Dots-1-5-6 

Currency symbols Cents Dot-4 then c 

  Dollar Dot-4 then s 

  Pounds Dot-4 then l 

Greek symbols Greek indicator dots-4-6 

  Alpha a 

  Beta b 

  Sampi c 

  Delta d 

  Epsilon e 

  Phi f 

  Gamma g 

  Iota i 

  Kappa k 

  Lambda l 

  Mu m 

  Nu n 

  Omicron o 
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  Pi p 

  Koph q 

  Rho r 

  Sigma s 

  Tau t 

  Upsilon u 

  Vau v 

  Xi x 

  Psi y 

  Zeta z 

  Chi Dots-1-2-3-4-6 

  Stigma Dots-2-3-4-6 

  Theta Dots-1-4-5-6 

  Eta Dots-1-5-6 

  Omega w 

 
5.7 Reading PowerPoint Files 

 
The Word Processor in the Voice Sense supports reading and navigating of 
Microsoft PowerPoint (PPT and PPTX) files. These files are opened as 
protected, read Only files, and you may navigate them using normal text 
reading commands. You may also move forward and back by slide using 
“Space” and “Backspace” respectively.  
You can bring up the list of slides in a presentation by pressing “Alt-Shift-S”. 
Use the Up and Down arrows to navigate the slides, and press “Enter” on 
the one you wish to navigate to. 
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5.8 Keys for Text Scrolling and Deleting 
 
While reading a document, you can use the following commands to read with 
Braille and/or speech. You can move character by character, word by word, 
or paragraph by paragraph. 
 
Previous character: Left arrow 
Next character: Right arrow 
Previous word: Ctrl-Left arrow 
Next word: Ctrl-Right arrow 
Beginning of line: Home 
End of line: End 
Previous sentence: Ctrl-Alt-Right arrow 
Next sentence: Ctrl-Alt-Left arrow 
Previous line: Up arrow 
Next line: Down arrow 
Next paragraph: Ctrl-Down arrow 
Previous paragraph: Ctrl-Up arrow 
Top of document: Ctrl-Home 
Bottom of document: Ctrl-End 
 
Read the current paragraph	  Fn-v 
Read the current line: Fn-c 
Read the current sentence: Fn-n 
Read the current word: Fn-x 
Read the current character: Fn-z 
 
Use the following commands to delete various elements of a document 
according to your current cursor position. 
 
Delete the current paragraph: Alt-Del 
Delete the current line: Ctrl-Backspace 
Delete the current word: Alt-Backspace 
Delete the current character: Del 



174 
 

 
5.9 Cursor Location 

 
While reading a document, you can query the cursor location. To do this, 
press "Fn-s". Your current position is announced in several ways: "Page: xx, 
Line: xx, column: xx, xx%, Word x/y,Paragraph: xx/yy, Line: xx/yy". 
 
5.10 Hot keys in the Word Processor: 

 
1.	  File menu 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Settings: Ctrl-e  
Exit: Alt-F4 
 
2. Edit menu 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Insert time: Backspace-w  
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
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Check spelling of the current word: Alt-k 
 
3. Go to menu 
Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
Go to previous page: Page up (Fn-Up arrow) 
Go to next page: Page down (Fn-Down arrow)  
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
4. Read menu 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons 
Read status: Fn-/ 
 
5. Layout menu 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
6. Miscellaneous hot keys 
Move to previous character: Left arrow 
Move to next character: Right arrow 
Move to previous word: Ctrl-Left arrow 
Move to next word: Ctrl-Right arrow 
Move to the beginning of the line: Home 
Move to the end of the line: End 
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Move to previous line: Up arrow 
Move to next line: Down arrow 
Move to previous sentence: Alt-Ctrl-Left arrow 
Move to next sentence: Alt-Ctrl-Right arrow 
Move to previous paragraph: Ctrl-Up arrow  
Move to next paragraph: Ctrl-Down arrow 
Move to the beginning of the document: Ctrl-Home 
Move to the end of the document: Ctrl-End 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current sentence: Fn-n 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
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6. E-mail 
 
The e-mail program is used to communicate with others by sending 
messages via the Internet. To use the e-mail program, you must have an e-
mail account, provided to you by your Internet account provider or sign up for 
a free account such as Gmail or hotmail. 
Your e-mail account needs to support POP3 (Post Office Protocol 3) or 
IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer 
Protocol) to be accessed with the Voice Sense QWERTY. You should check 
with your Internet account provider to make sure that your provider supports 
POP3/IMAP and SMTP. 
 
POP3 and IMAP are two different standard protocols for receiving e-mail. 
POP3 and IMAP function very differently from each other and each has its 
own advantages.  
 
When you access your received messages via POP3, they are downloaded 
from the server, and stored locally on whatever device you are using to 
download them; in this case, the Voice Sense QWERTY. You have the 
option of setting whether or not to delete the messages from the server on 
download. If you do, once they are downloaded, they are deleted from the 
server. If you choose to leave the messages on the server, and you delete 
an e-mail from the Voice Sense QWERTY, it is downloaded again the next 
time you access new mail as the Voice Sense QWERTY simply retrieves 
anything from the server it does not find stored locally. . If you wish only to 
access your e-mail on the Voice Sense QWERTY, you may find it more 
advantageous to use POP3, and set the PLUS not to leave messages on the 
server. In this case, your e-mail is completely controlled by the Voice Sense 
QWERTY. Your received messages are downloaded from the server, and 
when you delete an e-mail, it goes away. Whatever you choose to save is 
saved, and whatever you choose not to save is not. 
 
If you access your received messages via IMAP, rather than just retrieving 
the information from the mail server, Each time you load a mailbox on the 
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Voice Sense QWERTY, it synchronizes itself with the information found on 
your e-mail server. In other words, rather than pulling the information from 
the server, you are viewing the contents of your various e-mail boxes as they 
exist on the server. If you delete a message, that message no longer 
appears on any device you use to access your e-mail. If you move it to a 
different folder, you will see it in that folder on any device you use to access 
your e-mail. The advantage to IMAP is that, when using multiple devices, 
you can access the same e-mails from any of them, and changes made on 
one device apply to the information on the general e-mail server, and thus, 
also affect all devices as they access it. This is especially useful when using 
different devices in different situations; for example, using a PC at work, a 
PLUS when you travel, and a smart phone while in the car.  
 
SMTP is the protocol used to send a message from an e-mail client, (in this 
case the PLUS’s e-mail program) and deliver it to an e-mail server. 
 
Before you use the e-mail program, you must configure the Voice Sense 
QWERTY to access the Internet, (see section 3.2 "Internet Setup"). 
 
Note: The menus in the Voice Sense’s e-mail program are specific to the 
task you are performing: for example, When checking the "Inbox" in the e-
mail program, the menus are different from the menus that are used when 
you are writing an e-mail. Read this chapter carefully and familiarize yourself 
with the specific contexts before using the e-mail program on the Voice 
Sense QWERTY. 
 
6.1 Executing E-mail and E-mail Account management 

 
To use the e-mail program, you must configure the e-mail program to access 
your various e-mail accounts. The following sections provide a detailed 
explanation of how to execute e-mail, how to add e-mail account information, 
and how to check, modify, and delete this information.  
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6.1.1 Executing e-mail 
 
To execute the e-mail program, follow these steps: 
 
1) Navigate to "E-mail" in the "program" menu, by pressing “up arrow” or 
“down arrow”. 
2) Press "Enter" on "E-mail" or press "E". 
You can also launch the “E-mail” program from anywhere on the unit by 
pressing “Windows-E”. 
  
When you launch the e-mail program for the first time, the Voice Sense 
QWERTY says, "You must create at least 1 mail account from the accounts 
manager in the Tools menu". Then, the "Inbox" is opened. The "Inbox" is the 
main window of the E-mail program. When you run the e-mail program for 
the first time, this "Inbox" is empty and the Voice Sense QWERTY displays 
"no items". 
Press "Shift-Tab", and you are placed in the mailbox list.  
 
By default, the Voice Sense QWERTY contains the following mailboxes:  
1) Inbox: received mail that has not been deleted or saved to a different 
folder. 
2) Sent: sent messages you have chosen to store  
3) Outbox: messages waiting to be sent, either when you save mail in 
"Outbox" or sending mail fails. 
 
By pressing “up arrow” and “down arrow”, you can move among the 
mailboxes.  
 
If there are e-mail messages in the "Inbox", "Opening inbox”. is announced 
and is shown on the LCD display; and "xx% processed" is displayed on the 
Braille display (When connected to SyncBraille). Once progress has reached 
100%, the "Inbox" is opened and displays the received e-mail in the 
message list. Move to "Sent" or "Outbox", and press "Tab". If there are any 
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e-mail messages in "Sent" or "Outbox", they are displayed in message lists 
as in the "Inbox".  
 

6.1.2 Managing e-mail account information 
 
In the "Accounts manager", you can manage e-mail account information.  
 
To access the "Accounts Manager", follow these steps: 
1) Press “Alt” to open the menu from the "Inbox" message list. 
2) Press “down arrow”, to move to "Tools". Press "Enter" on "Tools". Or 
press "T". 
3) You are placed on "Accounts manager". 
4) Press "Enter". 
5) "Account name: no items" is displayed. You can also move to this menu 
by pressing "Ctrl-m". 
 
The "Accounts manager" contains the following 6 items. 
1. Accounts list 
2. Information 
3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among these items by pressing “Tab” or "shift-tab". You can 
execute each item by pressing "enter" on it. 
To exit the "Accounts manager", move to the "Close" button, and press 
"enter". Or, press "Esc" or "Alt-F4".  
The following is a detailed explanation of each item in the "Accounts 
Manager". 
 

6.1.2.1 Add e-mail Account 
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To receive e-mail, you must add an e-mail account with which to send and 
receive messages. To add an e-mail account, follow these steps: 
 
1) Press “Alt” to open the menu. 
2) Move to "Tools", by pressing “down arrow”. 
3) Press "Enter" or press "T". 
4) You are placed on "Accounts manager". Press "Enter". 
5) "Account name: no items" is displayed. You can also jump quickly to this 
dialog from the "Inbox" by pressing "Ctrl-M". 
6) Press "Tab", to move to "Add". 
7) Press "Enter" on the "Add" button or press "A". 
8) The dialog is opened and "Account name:" is displayed. Type the name 
by which you want to identify the e-mail account: (example, "Gmail" or "work 
e-mail"). 
9) Press “down arrow”, to move to "Display name". Type the "Display name" 
in the edit box. This name is the name people will see when they receive an 
e-mail from you. 
10) Press “down arrow”, to move to "Logon username". Type the "Logon 
username" in the computer edit box. (Ex: Sense or sense@hims-inc.com). 
Note: some providers require you to use the entire e-mail address as the 
username, while others may use the part of the address before the at-sign. 
BE sure you type the username correctly for your e-mail provider. 
11) Press “down arrow”, to move to "Password". Type the "password" in the 
computer edit box. Note: by default, the password is hidden, and thus 
displays as asterisks. Be sure to type carefully as you cannot review your 
password unless you have chosen not to hide passwords in the “Global 
Options”.  
12) Press “down arrow”, to move to "E-mail address". Type your "E-mail 
address" in the computer edit box. (Ex: sense@hims-inc.com) 
13) Press "Down arrow", to move to "Default mail server". You can choose to 
use a “POP3” or “IMAP” server using “Space”.  
14) Press “Down arrow”, to move to “Incoming Server?”. If you have selected 
“IMAP” as your incoming server type, “Incoming IMAP server?” is displayed. 
If you have chosen “POP3” as your incoming server type, “Incoming POP3 
server” is displayed. Type the "Incoming server" in the computer edit box. 
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(Ex: imap.himsintl.com, or pop.himsintl.com). Check with your Internet 
account provider or network administrator for your specific incoming server 
name.  
15) Press “down arrow”, to move to "Outgoing SMTP server". Type the 
"Outgoing SMTP server" in the computer edit box. Check with your Internet 
account provider or network administrator to find out what you should use as 
the Outgoing SMTP server.  
16) Press "Tab", to move to the "Confirm" button. 
17) Press "Enter" on the "Confirm" button. 
18) The Voice Sense QWERTY exits to "Account name list" and shows the 
added account name (Ex: Account name: Voice Sense QWERTY 1/1). 
19) When you finish adding accounts, press "Alt-F4" to exit to the "Inbox". 
 
To move from a setting item (Ex: ID, password) to the previous setting item, 
press “up arrow”. And, to move to the "Confirm" button or the "Cancel" button, 
press "Tab" or "Shift-Tab". 
If you made a typing error in an item such as account name, ID, or password, 
you can correct the error as follows; 
 
1) To delete the letter where the cursor is located, press "Del". 
2) To delete the letter in front of the cursor position, press "Backspace". 
3) To delete the current line, press "Ctrl-Backspace".  
 
Note: many e-mail service providers use secure servers with different port 
numbers. If your service provider requires you to use encryption, you must 
set these options in the "Advanced" dialog explained in section 8.1.2.1.1.  
 

6.1.2.1.1 Signature and Advanced 
 
While adding your account, you can create a signature and set advanced 
options in the "Advanced" dialog.  
1) Press “Alt” to open the menu. 
2) Press “down arrow”, to move to "Tools". 
3) Press "Enter" on "Tools" or press "T". 
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4) Voice Sense QWERTY displays "Accounts manager".  
5) Press "Enter" on the "Accounts manager".  
6) Voice Sense QWERTY displays "Account name". You can also use the 
hot key, "Ctrl-M" to quickly open this dialog. 
7) Press "Tab”, move to "Add". 
8) Press "Enter" on the "Add" button or press "A". 
9) When you have filled in everything in the Main Account settings list, press 
"Tab”, to move to "Advanced". 
10) Press "Enter" on the "Advanced" button. 
11) Voice Sense QWERTY displays "Use secure POP3 (POP-SSL)" or “Use 
IMAP SSL”. The default value of this check box is unselected. If your POP3 
or IMAP server uses "SSL", select the check box by pressing "Space". 
12) Press “down arrow” to move to "POP3 (or IMAP) port number". The 
POP3 port number is set to 110 by default, and the IMAP port number is set 
to 143 by default. Type a different POP3 or IMAP port number in the 
computer edit box if your provider requires a different port number. Note: if 
you check "SSL" above, the pop port number is automatically changed to 
995, as most pop servers with SSL require. If you check SSL for an IMAP 
server, the default IMAP port number is automatically set to 993 as is most 
common for IMAP servers using SSL. 
13) Press “down arrow” to move to "SMTP encryption type". The setting 
values are "None", "SSL" and "TLS". If your Outgoing SMTP server uses 
"SSL" or "TLS", change the value by pressing "Space". 
14) Press “down arrow” to move to "SMTP port number": set to 25 by default. 
Type a different value in the computer edit box if your provider uses a 
different SMTP port number. Common port numbers are 465 for SMTP 
servers using SSL, and 587 for SMTP servers using TLS.  
15) Press “down arrow” to move to "SMTP username". If your Internet 
account provider requires you to use a different SMTP username, enter it in 
this computer edit box. 
16) Press “down arrow” to move to "SMTP password". Type the password 
that corresponds to the above ID. It should be typed using ASCII. 
17) Press “down arrow” to move to "Use as default send-from account" To 
use the username and password that were set in steps 7 and 8, select the 
check box by pressing "Space". 
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18) Press “Down Arrow” to move to “default IMAP account”. (only appears if 
you are using IMAP as your incoming server type) 
19) Press “down arrow” to move to "Keep mail copies in server". When you 
download e-mail from your e-mail server, you can set the Voice Sense 
QWERTY to keep e-mail messages on the server or delete them as they 
download. Press "Space" to toggle "Yes" and "No", and press "enter" if you 
do not want a copy of the e-mail to remain on the e-mail server. 
20) Press “down arrow” to move to "Save mail copies in sent mailbox". When 
you send e-mail, you can set whether or not the Voice Sense QWERTY 
stores e-mail messages you send in the sent mailbox. Press "Space" to 
toggle "Yes" and "No", and press "Enter". 
21) Press "Tab", move to "Use signature". The default value is "No". To 
attach a signature to your mail, press "Space" to change "No" to "Yes". 
22) Press "Tab", to move to "Signature".  
23) Press "Enter" on the "Signature" button. 
24) You are placed in the "Signature:" multi edit box. Type the information for 
the signature you want to attach to your e-mails.  
25) Press "Tab", to move to "Confirm".  
26) Press "Enter" on the "Confirm" button. 
27) This saves the signature, and you are returned to the "Signature" button. 
You can cancel by pressing "enter" on the "Cancel" button. 
28) Press “Tab”, and press "enter" on the "Confirm" button. 
 

6.1.2.2 Checking added account list 
 
Use the following steps to view the information about an added e-mail 
account. 
 
1) Press “Alt” to open the menu. 
2) Press “down arrow” to move to "Tools". 
3) Press "Enter", or press "T" from the menu. 
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press "Enter" on the "Accounts manager". 
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6) Press “down arrow” or “up arrow” to move to the desired account in the 
account list. 
7) If the desired account is displayed, press "Enter". Or "Tab" to move to the 
"Information" button, and press "enter". 
8) The "Information" dialog is opened, and "Account name: (Added account 
name)" is displayed (Ex: account name: Voice Sense QWERTY). 
9) Press “down arrow” or “Tab” to read the information for each item. 
Pressing "enter" on the "Close" button returns you to the account list. 
 
IN this dialog you can read all information associated with an e-mail account.  
USE the navigation keys listed below to move among the items in the dialog: 
 
Move to the previous item: Up arrow 
Move to the next item: down arrow 
Move to the first item: Home 
Move to the last item: End 
Move to the previous control: Shift-Tab 
Move to the next control: Tab 
 

6.1.2.3 Modifying an e-mail account  
 
Use the following steps to modify the information for an e-mail account.  
  
1) Press “Alt” to open the menu. 
2) Press “down arrow” to move to "Tools". 
3) Press "Enter" on "Tools" or press "T" 
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press "Enter" on the "Accounts manager". 
6) Press “down arrow” or “up arrow” to move to the desired account in the 
account list. 
7) When the desired account is displayed, press "Tab" to move to the 
"Modify" button, and press "Enter". Or, press "m". 
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8) Voice Sense QWERTY displays "Account name" and you are placed in 
the "Account name" edit box with the current information filled in. For 
example, "Account name: Voice Sense QWERTY". 
9) The "Modify" dialog is opened. You can now make changes to the 
information presented.  
10) Press “down arrow”, to move to "Display name" and make any changes 
you wish.  
11) Use “down arrow” to continue through the dialog, editing any of the fields 
you wish to modify as you navigate them. 
12) When you reach the bottom of the main account settings dialog, press 
"Tab", to move to the "Advanced" button, and press "Enter". Again, use 
“down arrow” to move through the list of items in this dialog, and make 
changes as necessary. 
13) When you have finished making modifications, press "Tab”, to move to 
"Confirm" and press "Enter". 
14) You are returned to the main account settings dialog. Press “Tab” to 
move to the "confirm" button, and press "Enter". 
15) When the modification is complete, you are returned to the "account list". 
 
As described, you can move among the items (account name, logon 
username, password...) by pressing “up arrow” or “down arrow”. You can 
move to the "Confirm" button or the "Cancel" button by pressing “Tab” or 
"shift-tab". 
For all of the items, the values that were entered previously are displayed. If 
you type new information, the new information replaces the old information. 
To modify part of an item, press the "cursor routing key" at the desired 
position and edit the text. 
If you made a typing error in an item (account name, logon username, 
password...), you can modify it using the following hot keys: 
 
1. Delete the current letter by pressing "Del". 
2. Press "Backspace" To delete the previous letter. 
3. To delete the current line, press "Alt-c".  
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6.1.2.4 Deleting an E-mail Account 
 
Use the following steps to delete an E-mail account. 
  
1) Press “Alt” to open the menu. 
2) Press “down arrow” to move to "Tools". 
3) Press "Enter" on "Tools" or press "T". 
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press "Enter" on "Accounts manager". 
6) Press “down arrow” or “up arrow” to move to the desired account in the 
account list. 
7) When the desired account is displayed, press "Del". Or, press "Tab" to 
move to the "Delete" button, and press "Enter". 
8) "Are you sure you want to delete the (added account name) account? 
Yes" is displayed. 
9) Press "enter" To delete it. 
10) The Voice Sense QWERTY deletes the account, shows "Successfully 
deleted", and returns to the "account list". 
 
To cancel the deletion, press "Space" when the "Are you sure you want to 
delete the (Added account name) account? Yes" is displayed. Press "enter". 
Or, press "Esc" or "Alt-F4". 
 
6.2 Receiving and Sending E-mail 

 
6.2.1 Receiving E-mail 

 
The Voice Sense QWERTY is capable of receiving plain text e-mail and html 
e-mail messages. 
 
4. POP3 

You can receive e-mail messages from POP3 accounts by doing the 
following: 

1) Press “Alt” to open the menu. 
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2) Press “down arrow”, to move to "Message". 
3) Press "Enter" on "Message" Or, press "M". 
4) Voice Sense QWERTY displays "Reply". 
5) Press “down arrow”, move to "Check for New Mail". 
6) Press "Enter" on "Check for New Mail". Or press "N". 
7) You are presented with the "Account name" list. You can also move to this 
dialog directly from the "Inbox" by pressing "Alt-m". This dialog consists of 
"account list", a "Confirm" button, and a "Cancel" button. 
8) When "Account name: (Added account name x/x)" is displayed, press “up 
arrow” or “down arrow” to move to the desired account. 
9) Press "enter" when the desired account is displayed, or press "Tab" to 
move to the "Confirm" button, and press "enter". 
10) The Voice Sense QWERTY displays "There are xx messages to receive. 
Now receiving”. "x/you mail received;" "Successfully received x out of y 
message" is displayed. When the e-mail messages are downloaded from the 
server, the e-mail message list is displayed in the "Inbox" (Ex: Subject: 
(subject of the e-mail received) xx/xx). 
 
If the e-mail size is greater than the Voice Sense QWERTY can handle, it 
announces, "This message is too large to download. Skipping". And the 
Voice Sense QWERTY begins downloading the next e-mail message.  
To cancel the download, press "Tab" to move to the "Cancel" button, and 
press "enter", or you can press "Esc". 
 
2) IMAP  
When receiving messages via an IMAP server, you can both check the 
newest mail, according to the number of messages you have it set to 
automatically receive in the “Set options” dialog, or you can ask the Voice 
Sense QWERTY to load older e-mail messages. To receive the newest e-
mail messages, press “Alt-m” from the message list of the mailbox on which 
you are located. To receive previous mail, press “Alt-e”. You can also access 
“Get new mail” and “Get Previous mail” from the “Message” menu by 
pressing “Alt” and navigating to “Message”. Press “Enter” on “Message” and 
choose “Get New Mail” or “Get list of previous mail” and press “Enter”. In 
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addition, when using IMAP, as you navigate the various mailboxes in an 
account, new mail is automatically received for each mailbox as you open it.  
 
When you execute the command to receive mail, the Voice Sense QWERTY 
announces, “Getting new mail” or “Getting previous mail”. As the messages 
are downloaded, progress beeps are heard and full cells are displayed to let 
you know the action is being taken. When the Voice Sense QWERTY 
finishes receiving messages, you are placed in the mailbox from which you 
executed the “get mail” command.  
 
6.2.2	  Move	  to	  account	  or	  mail	  box	  	  

There are two ways to move to an account or mail box.  
 
You can access the accounts list or mailbox list by pressing “Tab” or “Shift-
Tab” until you reach “mailboxes” or “Accounts”. Use “Up arrow” or “Down 
arrow” to move among the items in the list, and press “tab” to open the 
Account or mailbox.  
 
You can also use the following hot keys to navigate accounts and mailboxes: 
Go to the next mailbox: Alt-Fn-down arrow. 
Go to previous mailbox: Alt-FN-Up arrow. 
Go to the next account category: Control-FN-Down arrow. 
Go to the previous account category: Control-FN-Up arrow. 
 
Note: the hot keys are not available from the account list or mail box list. 
They are only available from the message list. 
  

6.2.2 Reading Received E-mail Messages 
 
If you downloaded e-mail from your server, the e-mail messages are listed in 
the "Inbox". Each e-mail in the "Inbox" contains the following items. 
 
1. Subject 
2. Date 
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3. From (Sender) 
4. CC 
5. Message 
6. Attach (this is displayed only for an e-mail that has one or more attached 
files) 
You can move among the items by pressing "Tab" or "Shift-tab".  
 

6.2.2.1 Subject Control 
 
"Subject" shows the title of the e-mail; "Subject: (subject of the e-mail) xx/yy". 
After the subject of the e-mail, you find "xx/yy", which shows the number (xx) 
of the current e-mail and the total number (yy) of received e-mail messages. 
For example, "11/21" means that the e-mail is the 11th e-mail out of a total of 
21 e-mail messages. 
If there is a file attached to the e-mail, "a Subject: (subject of the e-mail) 
xx/yy" is displayed. The symbol "a (dot 1)" means that the e-mail has an 
attached file. It is displayed as "a (dot 1)" on the Braille display (When 
connected to SyncBraille), and it is announced as "1 attachment", which 
indicates the number of the attached files.  
The Voice Sense QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages are unread. E-mail messages that 
have not yet been read have a dash placed in front of the subject. For 
example, let's suppose there is an e-mail with an attachment that has been 
unread. It would appear as -a Subject: (subject of the e-mail) xx/yy. 
You can move among e-mail messages when the subject is displayed, by 
using the following keys; 
 
Move to the next e-mail: down arrow 
Move to the previous e-mail: up arrow  
Move to the first e-mail in the Inbox: Ctrl-Home  
Move to the last e-mail in the Inbox: Ctrl-End  
 

6.2.2.2 Date Control 
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"Date" shows the date and time when the e-mail was received; "Date: (date), 
(time) xx/yy". The date is displayed in the following order: day, month, date, 
and year. The time is displayed in the following order: hour, minute, and 
second using the 24 hour system. And, "xx/yy" shows the current number of 
the e-mail in relation to the total number of e-mail messages received. You 
can also move among e-mail messages when the date is displayed using the 
same navigation keys described above.  
The Voice Sense QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages are unread when viewing by date.  
 

6.2.2.3 Sender Control 
 
"From" shows the sender information; "From: (sender's e-mail address) 
xx/yy". The Voice Sense QWERTY also indicates which e-mail messages 
have been read, and which e-mail messages are unread when viewing by 
sender.  
You can save the e-mail id of the sender to your contacts in the "Address 
Manager" using the following steps: 
 
1) Press "Ctrl-i" when "From: (sender's e-mail address) xx/yy" is displayed. 
2) The "add address" dialog is opened, and "Name: (sender's user name or 
e-mail address)" is displayed. 
3) Type the sender's name, or, if what is automatically filled in is acceptable, 
press “Tab” to move to "Confirm", and press "enter". 
 
When you type the name, you can type it directly without pressing a cursor 
key to designate the input position. Or, you can modify what is already filled 
in, by pressing a corresponding cursor key, and editing the text. If the 
address is saved, and the dialog is closed, the Voice Sense QWERTY 
returns you to the message list, and shows you the "From" item again. 
By saving the e-mail ID using the above method, the name and its e-mail id 
is saved in the Voice Sense QWERTY's "Address Manager". . The saved e-
mail ID can be used to send a message to that person at a future time.  
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To cancel saving the e-mail ID, press “Tab” to move to the "Cancel" button, 
and press "enter", or press "Esc". 
 

6.2.2.4 CC Control 
 
"CC" shows the carbon copy recipient. This control is shown if the e-mail has 
a "CC". 
You can save the e-mail id of the carbon copy recipient using the process 
described above for saving a sender's e-mail address. 
 

6.2.2.5 Message Control 
 
"Message" displays the message body of the selected e-mail. You can move 
to a message by pressing “Tab”. Or, you can read a message by pressing 
"enter" when "Subject", "Date", or "From" is displayed. When you press 
"enter" on the "Subject", "Date", or "From" controls, the entire message is 
automatically spoken. To interrupt reading, press "Ctrl". 
To return to the "Subject" while reading the message, press "Esc". 
When you read the message, all of the navigation and control keys are the 
same as in the "Word Processor". 
 

6.2.2.6 Attachment Control 
 
You can find and download attached files by navigating to "Attach" on 
messages containing attachments. Voice Sense QWERTY displays this 
control only for e-mails which contain attachments. Attachments are 
displayed as, "Attach: (attached file name) xx/yy". The "yy" is the total 
number of the attached files to the e-mail and "xx" is the "xxth" attached file. 
Use the following steps to download attachments: 
 
1) From the body of a message containing attachments, press "Tab" to move 
to the attached files list. 
2) Move to the desired file name in "Attach" by pressing “down arrow” or “up 
arrow”. 
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3) Press "Space" on the file name you want to download to select it. * is 
displayed in front of the file name. 
4) Press "enter" to download the file. You are prompted, "Attachments will be 
saved to /flashdisk/download. Do you want to change this location? No" 
Press "enter".  
By doing so, the selected file is saved in the "download" folder on the 
"flashdisk". 
 
If you have more than one attachment you want to download, you can press 
"Ctrl-a" to select all attachments in the list, or press space on any number of 
individual files to select them. To download only the currently focused file, 
you can simply press "enter" on it.  
To change the download path:  
1) When you are prompted, "Attachments will be saved to 
/flashdisk/download. Do you want to change this location?", navigate to 
"Yes" and press "Enter".  
2) You are placed in the file list of the "Downloads" folder on the "flashdisk". 
Use normal file and folder navigation keys as described in the "File Manager" 
section of this manual to locate the folder into which you want to save the 
attachments.  
3) Press "Space" to select the folder in which to save the attachments, and 
press "Enter".  
4) The file is downloaded, and you are returned to your e-mail message on 
the “attachments” field. 
 

6.2.2.7 Reading HTML e-mail 
 
If you receive an html e-mail, follow these steps to access the links, etc: 
 
1) Open the message with the Web browser by pressing the hot key, "Alt-o".  
2) Or, you can use the menu: Press “Alt”, move to "Message" and press 
"enter". Navigate to "Open Message In Web Browser" and press "enter".  
The "Web Browser" is launched and you can view the html message in the 
"Web Browser". If the e-mail message contains links, you can visit these 
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sites by pressing "Enter" just as you would on any web page, provided your 
Voice Sense QWERTY is connected to the Internet. 
 

6.2.3 Writing e-mail 
 
Use the following steps to create an e-mail message: 
 
1) Press “Alt” to open the menu. 
2) Voice Sense QWERTY displays "File" menu. 
3) Press "Enter" on the "File" menu.  
4) Voice Sense QWERTY displays "Write New Message". 
5) Press "Enter" on "Write New Message". 
6) "To:" is displayed on the Braille display (When connected to SyncBraille). 
Pressing "Ctrl-n" opens this dialog directly from the "Inbox"..  
7) Press "shift-tab" to move to the "Account" combo box. Move to the 
account from which you want to send this message by using “up arrow” or 
“down arrow”. Press “Tab” to move to the "To:" field. 
8) Type the e-mail address of the recipient, or rather, the person to whom 
you are sending the message. (Ex: sense@hims-inc.com). 
9) Press “Tab” to move to "CC:". 
10) Type the e-mail address of the copy recipient using computer Braille. If 
you do not need to carbon copy anyone, you can skip to the next step. 
11) Press “Tab” to move to "BCC:". 
12) Type the e-mail address of the blind copy recipient using computer 
Braille. If there is no blind copy recipient, you can skip to the next step. 
13) Press “Tab” to move to "Subject:". 
14) Type the subject of the e-mail message.  
15) Press “Tab” to move to "Message body:" 
16) Type the text of your e-mail message. The input method and the editing 
method are the same as the input and editing method used in the word 
processor 
17) When you finish writing the e-mail message, press “Alt” to open the "E-
mail" menu. The "File" menu is displayed again. 
18) Press "enter". 
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19) Press “down arrow” to move to "Send". 
20) Press "enter". You can also send mail directly by pressing “Ctrl-s”.  
21) "Sending…". is displayed, and the e-mail is sent. When the e-mail is 
finished sending, "Successfully sent new message" is displayed. If sending 
fails, the Voice Sense QWERTY displays "Unable to sent message". If this 
occurs, the e-mail is saved in the "Outbox". 
Note: Be sure you have an active Internet connection before executing the 
"Send" command, as you cannot send e-mail if the Voice Sense QWERTY 
cannot access the Internet.  
After sending is completed, or has failed, you are returned to the "Inbox". 
 
To cancel e-mail message creation or sending, press "Esc or "Alt-F4" and 
you are returned to the "Inbox". 
 

6.2.3.1 Attaching a File 
 
While you are writing e-mail, you can attach files to your messages. 
Use the following steps to attach a file: 
 
1) While writing e-mail, press “Alt” to open the menu. Voice Sense QWERTY 
displays "File" menu. 
2) Press "Enter" on the "File" menu.  
3) Voice Sense QWERTY displays "Attach File". 
4) Press "Enter" on "Attach File". The file list is opened. You can also access 
"attach file" directly by pressing "Ctrl-f".  
5) The default folder for the "file list" is the "upload" folder on the "flashdisk". 
Use normal file and folder navigation keys to locate the file or files you want 
to attach.   
6) Move to the desired file, and press "enter". To attach more than one file, 
move to each file, and press "Space" to select it. * is displayed in front of the 
selected file names. Press "enter" To attach the selected files. 
7) When the selected files are attached, the Voice Sense QWERTY 
announces, "xx attached", and returns to the message body. "xx" is the 
number of the attached files. 
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If there are files attached to an e-mail, the "Attach" item is displayed in the 
tab order after the "Message body".  
Attachments are displayed as: "Attach: (attached file name) xx/yy (file size)". 
"yy" is the total number of attached files, and "xx" means the "xxth" file out of 
"yy" files. You can move among the attached files by pressing “up arrow” or 
“down arrow”. If there is a file in the attached file list you do not wish to 
attach, you can delete it from the list by pressing "Del". 
If you press "Del", “Delete (file name) file? Yes" is displayed. If you press 
"enter", this file is deleted from the attached file list. If you press "Space" to 
switch from "Yes" to "No", and press "enter", your selection is cancelled, and 
the file remains in the attached file list. 
 

6.2.3.2 Sending E-Mail to Multiple Recipients 
 
You can type more than one recipient, carbon copy recipient, or blind copy 
recipient. If you type more than one e-mail address in these fields, the same 
e-mail is sent to all of them at once. 
When you input more than one recipient, you must insert a semi-colon or 
comma between the e-mail addresses.  
 
For example, sense@hims-inc.com;hims@hims-inc.com. 
 

6.2.3.3 Searching the Address List 
 
You can add a recipient to "To", "CC", or "BCC" from the address list without 
typing in the e-mail address directly. 
The following are the steps to search for and add e-mail addresses to the 
recipients of a message: 
 
1) Press “Alt” to open the "E-mail" menu from "To", "CC", or "BCC". "File" is 
displayed. 
2) Press "Enter" on the "File" menu. 
3) Press “down arrow” to move to "Lookup Address". 
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4) Press "Enter" on "Lookup Address". "Search for address" is displayed. 
Press "Ctrl-l” to look up an address directly from one of the recipient fields. 
5) Type the last name of the desired recipient at "Search for address", and 
press "enter". Or, press “Tab” to move to "Confirm", and press "enter". 
6) "xx addresses are found" is displayed, and the first item of the found list is 
also displayed. "xx" is the number of the found addresses that have the 
same name in the address list (Ex: HIMS hims@hims-inc.com 1/xx) 
7) Press “up arrow” or “down arrow” to move to the desired address, and 
press "enter". You can select more than one address by pressing "Space". 
When you have chosen the addresses you want, press "enter". 
8) The selected addresses are inserted in "To", "CC" or "BCC".  
If you press "enter" without typing in the desired name, all of the addresses 
in your address list are displayed. If there is no matching address, "No 
match". is announced and "Search for address" is displayed again. 
 

6.2.3.4 Saving E-Mail to the Outbox 
 
Messages are saved in the "Outbox" in 2 ways: 
1. The user saves the e-mail to the "Outbox" for later sending. 
2. An e-mail fails to send due to a network error or other reason. 
 
The "Save Mail in Outbox" dialog contains the following: 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "Storage folder" List 
 
You can move among the menu controls by using "Shift-Tab" or "Tab". 
 
Use the following steps to save an e-mail in the outbox: 
1) Press “Alt” after creating the e-mail message. The "File" menu is 
displayed. 
2) Press "enter". 
3) Press “down arrow” to move to "Save Mail In Outbox". 



198 
 

4) Press "Enter".  
5) The dialog for saving is opened.  
6) "File name: (subject of writing e-mailgg.txt" is displayed. You can also 
jump to this dialog by pressing "Fn-s" while writing a message. 
7) Press "Enter" on "File name: (subject of writing e-mailgg.txt", or press 
“Tab” to move to the "Confirm" button.  
8) The message is saved as "(subject of writing e-mailgg.txt".  
9) To name the e-mail message, type a file name. Use the same procedure 
as in "Save As" in the "Word Processor". You can also change the path 
where the message is stored. 
10) After the Voice Sense QWERTY saves the e-mail message, it returns to 
the previous location. 
 
By following the explanation above, the e-mail message is saved as 
"(subject of writing e-mailgg.txt" in the "flashdisk/email/storage box".  
If you do not input a subject when writing the e-mail, the file is named 
"noname".  
If you choose to save the e-mail in a location other than 
"flashdisk/email/storagebox", you cannot access the e-mail message in the 
"Outbox". Thus, you cannot send the e-mail unless it is returned to the 
"Outbox" storage folder. 
 
While creating a "message", press "Esc" or "Alt-F4” To cancel writing the e-
mail.  
1) The Voice Sense QWERTY displays "Currently writing mail. Save? Yes".  
2) To return to the "Inbox" without saving the e-mail, press "Space" to 
change "Yes" to "No", and press "Enter". 
 

6.2.3.5 Saving E-Mail as New Name in the "Outbox" 
 
If you save an e-mail message in the "Outbox", you can save it under a 
different file name. To do this, use the steps described above, but choose 
"Save Draft" from the "File Menu".  
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6.2.3.6 Sending the E-Mail in the "Outbox" 
 
Use the following steps to send e-mail from the "Outbox": 
1) When the Voice Sense QWERTY displays message list in "Inbox". 
2) Press "Shift-Tab", to move to "Mailbox". 
3) Press “up arrow” or “down arrow”, to move to "Outbox". 
4) Press "Enter". 
5) Voice Sense QWERTY displays the message list in the "Outbox".  
6) Press “up arrow” or “down arrow”, to move to the mail message you want 
to send. 
If you want to send all the e-mails in the list: Press "Ctrl-a” to select all. 
If you want to send individual messages, use normal selection commands to 
select them. 
8) Press “Alt” to open the menu. 
9) Press "Enter" on the "File" menu. 
10) Press “up arrow” or “down arrow”, to move to "Send" menu. 
11) Press "Enter" on the "Send" menu. 
12) The selected messages are sent. 
 
Press “Ctrl-s” to directly execute the "Send" command. 
If you send all the messages in the "Outbox", no items" is displayed. 
 

6.2.3.7 Setting Default E-mail account 
 
If you have set up more than one e-mail account on the Voice Sense 
QWERTY, you can set the default e-mail account for sending messages.  
 
1) Press “Alt” to open the menu from any mailbox but "Outbox". 
2) Press “down arrow”, to move to "Tools". 
3) Press "Enter" on the "Tools menu" or press "T". 
4) Voice Sense QWERTY displays the "Accounts manager". 
6) Press "Enter" on the "Accounts manager".  
6) Voice Sense QWERTY displays "Account name" list. 
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7) Press “up arrow” or “down arrow”, to move to the e-mail account you want 
to set as the default.  
8) Press "Tab", to move to "Modify". 
9) Press "Enter" on the "Modify" button or press "m". 
10) Press "Tab", to move to "Advanced". 
1) Press "Enter" on the "Advanced" button. 
12) Voice Sense QWERTY displays the "Use secure POP3 (POP-SSL)". 
13) Press “down arrow”, repeatedly to move to "Use as default send-from 
account SMTP". 
14) Press "Space" to change the state of the check box to "checked". 
15) Press "Tab", to move to "Confirm" and press "Enter". 
16) You are returned to the "Advanced" button. 
17) Press "Tab", to move to "Confirm" and press "Enter". 
18) Voice Sense QWERTY announces, "Successfully modified account" and 
you are returned to the accounts list. 
 
Voice Sense QWERTY displays "default" on the LCD and Braille display next 
to the default account. 
 
6.3 Advanced E-mail features  

 
6.3.1 Deleting E-mail 

 
You can delete e-mail messages individually, or you can select multiple 
messages and delete them simultaneously. 
 

6.3.1.1 Deleting an e-mail 
 
You can delete an e-mail in the mailbox by following the steps below; 
 
1) Press “up arrow” or “down arrow” to move to the "Subject" of the e-mail 
you want to delete. 
2) Press "Del".  
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3) Voice Sense QWERTY displays "Delete (subject of the selected e-mail) 
mail? Yes". 
4) Press "Enter" To delete the e-mail. 
 
To cancel, press "Space" to change "Yes" to "No" and press "Enter". 
You can also cancel e-mail deletion by pressing "Esc" or "Alt-F4".  
 

6.3.1.2 Deleting Multiple E-mail Messages 
 
To delete two or more e-mail messages, use the following steps: 
1) Press “up arrow” or “down arrow” to move to the e-mail "Subject" that you 
want to delete. You can also select messages from the "Date control".  
2) Press "Space" on the e-mail messages you want to delete.  
3) Voice Sense QWERTY displays * in front of the selected e-mail subject.  
4) Move to other e-mail messages you want to delete by pressing “down 
arrow” or “up arrow”. Press "Space" on each of the messages you wish to 
delete. 
5) Press "Del". 
6) Voice Sense QWERTY displays "Delete xx message? Yes". "Xx" is the 
total number of messages to be deleted. 
7) Press "Enter". 
 
You can also select all messages in the current mailbox by pressing "Ctrl-a", 
or select a contiguous group of messages by pressing "Ctrl-b" to set the 
beginning of the selection, and move your cursor to the last message you 
want to select.  
 
To cancel this function, press "Space" to change "Yes" to "No" on the delete 
prompt and press "Enter". 
Or you can cancel by pressing "Esc" or "Alt-F4". 
 

6.3.2 Reply And Reply All to a Received E-Mail. 
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When you reply to an e-mail, you can edit or add a message to the original 
message, or add another recipient.  
Example: 
Suppose you received an e-mail with the following information: 
Sender's e-mail address: hims@hims-inc.com 
Subject of the e-mail: Welcome to HIMS 
You could reply to this e-mail using the following steps: 
 
1) Press “Alt” to open the menu from "Subject", "Date", or "Message body" of 
a message in the "Inbox". 
2) Voice Sense QWERTY displays "File".  
3) Press “down arrow” to move to "Message". 
4) Press "Enter".  
5) Voice Sense QWERTY displays "Reply". 
6) Press "Enter" on "Reply". 
7) Voice Sense QWERTY displays "Message body".  
8) The message body already contains the original message body of the 
received e-mail; "--- below Original Message ---. You can also execute the 
"Reply" command directly by pressing “Ctrl-r". 
9) Press "Shift-Tab" to move to "Subject", "BCC"", "CC", and "To".  
10) At "Subject", Voice Sense QWERTY displays "Subject: Re: Welcome to 
HIMS". And, at "To", Voice Sense QWERTY displays "To: hims@hims-
inc.com". 
11) Press "Tab" to move to "Message body".  
12) Type the text you want to add or edit. 
13) Press "Ctrl-s” to send the e-mail. 
  
 
You can save replies just as you can save new messages in the "Outbox" for 
sending later. 
 
You can reply to an e-mail by using either "Reply" or "Reply To All", as 
Choosing "Reply" sends en e-mail to only the original sender. Choosing 
"Reply To All" sends an e-mail back to the original sender as well as all other 
recipients of the original e-mail.  
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To activate the "Reply To All" function:  
 
1) Press “Alt” to open the menu.  
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, to move to "Message". 
4) Press "Enter".  
5) Voice Sense QWERTY displays "Reply". 
6) Press “down arrow”, to move to "Reply To All". 
7) Press "Enter" on "Reply To All". You can activate the "Reply To All" 
function directly by pressing "Alt-r". 
8) Voice Sense QWERTY displays "To: (the original sender and all other 
original recipients)" 
9) You can use the same steps to send a message as when using the 
"Reply" function. 
 

6.3.3 Forwarding a Received E-Mail Message 
 
"Forwarding" refers to sending an e-mail you received to another person. 
You can also add to or edit the message and subject. You can also attach a 
file to this e-mail.  
  
Example: 
Let's suppose there is an e-mail message that you received as follows: 
Sender's e-mail address: hims@hims-inc.com 
Subject of the e-mail: Welcome to HIMS 
 
You can forward this e-mail to others using the following method: 
 
1) Press “Alt” to open the menu from the "Subject", "Date", or "Message 
body". 
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, to move to "Message". 
4) Press "Enter" on "Message".  
5) Voice Sense QWERTY displays "Reply". 
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6) Press “down arrow”, to move to "Forward". 
7) Press "Enter" on "Forward".  
8) Voice Sense QWERTY displays "To:". You can activate the "Forward" 
command directly by pressing "Ctrl-f". Input the e-mail address of the new 
recipient, or multiple recipients. 
9) Press "Tab", to move to "CC", "BCC", and "Subject".  
10) At "Subject", Voice Sense QWERTY displays "Subject: Fw: Welcome to 
HIMS". 
11) Press "Tab", to move to "Message body".  
12) The original e-mail message is shown following, "----- Forwarded 
Message -----". 
13) Type any additional text you wish to add to the message, or make any 
edits to the forwarded text.  
14) Press "Ctrl-s” to send the e-mail. 
 
When you forward an e-mail, you have all of the same capabilities as when 
writing a new e-mail. Thus, you can add recipients and attach files to the e-
mail you are forwarding just as with a new message. And, as with a new 
message, you can also save to the "Outbox" for sending later.  
 

6.3.4 Saving a Received E-mail as Document. 
 
There may be times when you wish to save a received message as a 
document. You can do this using the following steps: 
1) Press “Alt” to open the menu.  
2) Voice Sense QWERTY displays "File". 
3) Press "Enter" on "File". 
4) Press “down arrow”, to move to "Save As Text". 
5) Press "Enter" on "Save As Text".  
6) The "save as dialog" is opened. 
7) Voice Sense QWERTY displays "File name: (subject of e-mail being 
read.txt". You can open this dialog directly by pressing "Fn-s". 
8) Press "Enter" on the "File name: (subject of e-mail being read.txt". Or 
press “Tab”, to move to the "Confirm" button, and press "Enter". If you wish, 
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you can rename the file using the same method as in the "Save As" dialog of 
the "Word Processor". 
9) You are returned to your previous location.  
 
The text file is saved in "flashdisk/My Documents" with the file name 
"(subject of e-mail being read.txt". You cannot change the file format. You 
can read the saved text file in the "Word Processor". 
To cancel "Save As Text", press "Tab" from the "Confirm" button to move to 
"Cancel". And press "Enter". Or, press "Esc" or "Alt-F4". 
 

6.3.5 Printing E-Mail Messages 
 
You may wish to emboss or print an e-mail message. 
To print an e-mail message, do the following: 
 
1) Connect the Voice Sense QWERTY to an ink printer. Make sure to use 
the same printer port set in the "Global Options". 
2) Press “Alt” to open the menu.  
3) Voice Sense QWERTY displays "File". 
4) Press "Enter" on "File". 
5) Press “down arrow”, to move to "Print E-mail". 
6) Press "Enter" on "Print E-mail".  
7) Voice Sense QWERTY displays "Print type". Press "Alt-p" to activate the 
"print" function directly. 
8) Press "Space" or “down arrow”, to change the "print type". The setting 
values are "Printer" and "Embosser". 
9) After selecting the "Print type", press "Enter". Or press "Tab”, to move to 
the "Confirm" button, and press "Enter". 
10) The selected e-mail is printed. 
To cancel printing, press "Tab" to move to "Cancel" and press "Enter". Or 
press "Esc" or "Alt-F4". 
 
6.4 Additional features of E-mail 
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6.4.1 Find 
 
The "Find" command is used to search for messages in the current mailbox. 
The "Find" function looks for text that matches the text you enter in "Subject", 
"Date", and/or "From". This function only works in the "Subject", "Date", or 
"From" controls. 
The "Find" dialog consists of the following: 
1. "Find": Edit box for text to search 
2. "Search" radio button 
3. "Direction" radio button  
4. "Confirm" button 
5. "Cancel" button.  
 
In the "Find" dialog, you can move among the five controls by pressing "Tab" 
or "Shift-Tab". The hot key for opening the "Find" dialog is "Ctrl-Shift-f ".  
 
To activate the "Find" function, use the following steps: 
1) Press “Alt” to open the menu.  
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, to move to "Edit".  
4) Press "Enter" on "Edit". 
5) Voice Sense QWERTY displays "Select All". 
6) Press “down arrow” or “up arrow”, to move to "Find".  
7) Press "Enter" on "Find". Or press "f".  
8) Voice Sense QWERTY displays the "Find:" edit box for typing the text you 
want to search. 
9) After typing the text, press "Tab" to move to the "Search" radio button. 
You can select among "All", "Subject", "Date", or "From". Choosing "All" 
searches all three fields. You can select an item by pressing “down arrow” or 
“up arrow”. By selecting a field, you can search that specific field for the text 
you want to find. 
10) Press "Tab", to move to the "Direction" radio button, containing the 
values "Forward" or "Backward". Pressing “down arrow” or “up arrow” selects 
the search direction.  
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11) Press "Tab", to move to the "Confirm" button.  
12) Press "Enter" on the "Confirm" button.  
To cancel, press "Tab" on "Confirm", move to "Cancel". And press "Enter". 
Or, you can press "Alt-F4" or "Esc" anywhere in this dialog to cancel "Find". 
 

6.4.2 Find Again 
 
The "Find Again" command finds the next occurrence of the text according to 
the search text and direction specified in the "Find" dialog. As with "Find", the 
"Find Again" function only works in the "Subject", "Date", or "From" fields. 
To activate the "Find Again" function, use the following steps: 
 
1) Press "Alt" to open the menu. 
2) Voice Sense QWERTY displays "File" 
3) Press “down arrow”, to move to the "Edit" 
4) Press "Enter" on "Edit".  
5) Voice Sense QWERTY displays "Select All". 
6) Press “up arrow” or “down arrow”, to move to "Find Again". 
7) Press "Enter" on "Find Again". Or press "g". 
 
To activate this function directly, press "F3". 
 

6.4.3 Move to Next Unread Message 
 
The "Move To Next Unread Message" option allows you to move to the next 
unread message. If you use this function on the last unread message in a list, 
you are sent to the first unread message in the list.  
 
To activate this function from the "Subject", "Date", or "From" field, 
1) Press “Alt” to open the menu.  
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, to move to "Edit". 
4) Press "Enter" on "Edit". 
5) Voice Sense QWERTY displays "Select all". 
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6) Press “down arrow”, to move to "Move to Next Unread Message". 
7) Press "Enter" on "Move to Next Unread Message". Or press "u”. 
To use this function directly, press "Ctrl-u". 
 

6.4.4 Copy or Move to Mailbox 
 

You can copy and move e-mails using the "Copy to Mailbox" or "Move To 
Mailbox" commands in the "Edit" menu. 
 
The "move/Copy dialog" contains the following: 
1. "Folder" list. 
2. "Create mailbox" Button 
3. "Delete mailbox" Button 
4. "Rename mailbox" Button 
5. "Confirm" Button 
6. "Cancel" Button 
 
You can move among the controls by pressing "Tab" or "Shift-Tab". And you 
can move among items in the "Folder" list by pressing “up arrow” or “down 
arrow”.  
To cancel this dialog, press "Esc" or "Alt-F4". 
 
To copy and move an e-mail to another folder, follow these steps: 
1) You can select individual e-mails by pressing "Space", select a continuous 
group with “Ctrl-b”, or select all with "Ctrl-a”. Or you can select e-mail using 
the "Select All" or "Start Selection" options in the ""Edit" menu. 
2) Press “Alt” to open the menu. 
3) Voice Sense QWERTY displays "File". 
4) Press “down arrow”, to move to "Edit". 
5) Press "Enter" on "Edit". 
6) Voice Sense QWERTY displays "Select All". 
 7) Press “down arrow”, to move to "Copy to Mailbox" or "Move To Mailbox". 
8) Press "Enter" on "Copy to Mailbox" or "Move To Mailbox". 
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9) Voice Sense QWERTY displays "Folder list". You can activate these 
functions directly by pressing "Alt-c" or "Alt-x”. 
10) Press “down arrow”, to move to the folder into which you want to copy or 
move messages.  
11) Press "Enter". 
12) The e-mail is moved or copied to the folder. 
13) You are returned to the mailbox from which you activated the "Move" or 
"Copy" command. 
 

6.4.4.1 Creating a Mailbox 
 
You can create additional mailboxes in the "E-mail" folder for sorting and 
storing your messages.  
To create a new mailbox, follow these steps: 
1) Press “Alt” to open the menu from the “Inbox" message list  
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, to move to "Edit" and Press "Enter". Or Press "e”. 
4) Voice Sense QWERTY displays "Select All". 
5) Press “up arrow” or “down arrow”, to move to "Copy to Mailbox" or "Move 
To Mailbox".  
6) Press "Enter". Or press "Alt-c" or "Alt-x”, to open this dialog directly from 
the message list. 
7) Voice Sense QWERTY displays "Folder" lists. 
8) Press "Tab", to move to "Create mailbox". 
9) Press "Enter" on "Create mailbox". 
10) Voice Sense QWERTY displays "Mailbox name:". Type the mailbox 
name you want to create. 
11) Press "Enter" or press "Tab”, to move to "Confirm" and press "Enter". 
12) Voice Sense QWERTY displays the created mailbox in the "Folder" list. 
The folder is also visible in the "Mailbox" and in the e-mail folder from "File 
manager". 
 

6.4.4.2 Deleting Folders/mailboxes 
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You are not able to delete "Inbox", "Sent", or “Outbox". However, you can 
delete folders/mailboxes you have created. 
 
To delete a folder, follow these steps: 
1) Press “Alt” to open the menu from the message list of the "Inbox". 
2) Voice Sense QWERTY displays "File". 
3) Press “down arrow”, move to "Edit" and Press "Enter". Or Press "e”. 
4) Voice Sense QWERTY displays "Select All". 
5) Press “up arrow” or “down arrow”, to move to "Copy to Mailbox" or "Move 
To mailbox".  
6) Press "Enter". Or press "Alt-c" or "Alt-x”, to activate these commands 
directly. 
7) Voice Sense QWERTY displays the "Folder" list. 
8) Press “up arrow” or “down arrow”, to move to the folder you want to delete. 
9) Press "Tab”, to move to "Delete mailbox". 
10) Press "Enter". 
11) Voice Sense QWERTY displays "Delete (mailbox name) mailbox? Yes". 
12) Press "Enter". 
 
You can also delete the current mailbox by pressing "Del" on the folder you 
want to delete.  
To cancel this function, press "Tab” to move to "Cancel". And press "Enter". 
If you attempt to delete the "Inbox", "Sent", or "Outbox", Voice Sense 
QWERTY plays the warning sound to notify you of the error. 
 

6.4.4.3 Changing the name of a Folder Mailbox 
 
You can also rename a mailbox. To do this, follow these steps: 
 
1) Open the "Move/Copy to Mailbox" dialog as described in the steps above. 
2) Voice Sense QWERTY displays the "Folder" list. 
3) Press “up arrow” or “down arrow”, to move to the folder you want to 
rename. 
4) Press "Tab”, to move to "Rename mailbox". 
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5) Press "Enter". 
6) Voice Sense QWERTY displays "Folder mailbox:" 
7) Type the new name for the folder mailbox.  
8) Press "Enter. Or press "Tab” to move to "Confirm" and press "Enter". 
If you attempt to rename the "Inbox", "Sent", or "Outbox", the Voice Sense 
QWERTY plays the warning bleep to notify you of the error. 
 
6.5 Using the Tools Menu 

 
IN addition to the "Accounts Manager", the "Tools" menu contains options for 
setting path and e-mail options.  
 
The "Tools" menu contains the following four items: 
1. Accounts Manager 
2. Set path 
3. Set options 
4. Set spam 
 
The "Accounts Manager" was explained at the beginning of this chapter. The 
other items are explained in detail below: 
 
 

6.5.1 Set Path 
 
"Set Path" sets the default download path where file attachments and e-mail 
are stored. You can set the download path using the following steps: 
 
1) Press “Alt” to open the "E-mail" menu from the "Inbox". 
2) Press “down arrow”, to move to "Tools". 
3) Press "Enter".  
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press “down arrow”, to move to "Set Path". 
6) Press "Enter" on "Set Path".  
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7) Voice Sense QWERTY displays "Save attachments path: 
/flashdisk/download". You can open this dialog directly by pressing "Ctrl-p".  
 
"Set Path" contains the following three items: 
1. Save attachments path 
2. Send attachments path 
3. Disk to save mail in 
 
You can move among these items by pressing “down arrow” and “up arrow”. 
Each item consists of "Path", "Modify", and "Close". At "Path", the default 
path is displayed. You can move among this information by pressing “Tab” or 
"shift-tab". 
"Set Path" is closed if you press "Esc" or "Alt-F4". Or, you can close it by 
pressing enter on the "Close" button. 
 

6.5.1.1 Set the Save Attachments Path 
 
The default path for downloaded attached files is "/flashdisk/download".  
You can set the download path using the following method: 
 
1) Use the steps described above to access the "Save Path" dialog. 
2) Press "Enter" on "Save attachments path: /flashdisk/download", or press 
"m". Or, press "Tab” " to move to the "Modify" button, and press "Enter". 
3) Voice Sense QWERTY displays "download folder xx/yy". 
Use normal file and folder navigation keys to locate the folder in which you 
want to save attachments. 
4) Press "Space" to select the folder, and press "Enter". If a folder is selected, 
* is displayed in front of the selected folder. 
If you press "Enter" to set the path, the Voice Sense QWERTY shows the 
changed path. For example, if you changed the path to the "My Documents" 
folder, "Save attachments path: /flashdisk/My Documents" is displayed. 
 

6.5.1.2 Set the Send Attachments Path 
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"Send attachments path" is the path where the e-mail program looks by 
default when you attach a file to an e-mail.  The default path is 
"/flashdisk/upload". You can change this path to a different path using the 
following steps: 
 
1) Open the "Set Path" dialog using the steps described above. 
2) Press “down arrow”, to move to "Send attachments path: 
/flashdisk/upload". 
3) Press "Enter" or "m" on "Send attachments path: /flashdisk/upload". Or, 
press "Tab", to move to the "Modify" button and press "Enter". 
4) Voice Sense QWERTY displays "upload folder xx/yy" Use normal file and 
folder navigation keys to locate the folder you want to use as the path for 
attachments to be sent.  
5) Press "Space" to select the desired folder, and press "Enter".  
6) Voice Sense QWERTY displays * in front of the selected folder. 
 
If you set the path by pressing "Enter", the Voice Sense QWERTY shows the 
changed path.  
 

6.5.1.3 Set the Disk in which to save mail 
 
The e-mail messages that are downloaded from your network are saved in 
the "e-mail" folder, located on the "flashdisk". If the size of an e-mail you are 
receiving is so large that it cannot be downloaded and stored in the 
"flashdisk", or you simply want to store your e-mail somewhere else, you can 
save to a different disk using the following steps: 
 
1) Connect the external storage disc to the Voice Sense QWERTY. 
2) Use the steps described above to open the "Set Path" dialog. 
3) Press “down arrow”, to move to "Disk to save mail in: /flashdisk". 
4) Press "Enter" or "m" on "Disk to save mail in: /flashdisk". Or, press "Tab", 
to move to the "Modify" button, and press "Enter". 
5) Voice Sense QWERTY displays "flashdisk".  



214 
 

6) Press “down arrow” or “up arrow”, to move through the disk list. If you 
have connected a USB memory stick or SD memory, Voice Sense QWERTY 
displays "USB" or "SD" (SD memory). 
7) Press "Enter" on the desired disk.  
Voice Sense QWERTY displays the changed disk. 
 

6.5.2 Set Options 
	  

The “Set options” dialog contains 5 items: “Default mail server”, “default 
mailbox for POP3 server”, “get the number of mail at once for IMAP”, a 
“confirm” button, and a “Cancel” button. You can move among the items in 
the dialog using “Tab” and “Shift-Tab”. Use “Up arrow” and “Down arrow” to 
move among the settings in the settings list. 
 
To open the “Set Options” dialog, , follow these steps: 
1) Press “Alt” to open the "E-mail" menu from the "Inbox". 
2) Press “down arrow”, to move to "Tools". 
3) Press "Enter".  
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press “down arrow”, to move to "Set Options". 
6) Press "Enter" on "Set Options". Or activate this command directly, by 
pressing "Ctrl-o”. 
 
The first item in the “Set options” dialog is “Default server?”. You can set the 
default server to “IMAP” or “POP3”. Use “Space” to change the value of the 
setting. 
 
The next item in the “Set Options” dialog is “Use inbox as default mailbox 
when using POP3 server? Yes.”. if you want the e-mail program to always 
place you in the “inbox” when starting e-mail using POP3, leave this setting 
as is. If you would like to use a different mailbox, press “Space” to change 
this option to “no”.  
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The next option in the dialog is “Get the number of mail at once when using 
IMAP”. The default is set to 64. Use “Space” or “Backspace” to cycle through 
the various options. The available values are All, 32, 64, 96, and 128. 
 
When you have finished adjusting the settings, press “Enter” to save the 
options, or tab to the “Confirm” button and press “Enter”. If you do not wish 
to save your changes, tab to the “cancel” button and press “Enter” or press 
“Alt-F4”. 
 

6.5.3 Spam Settings 
 
When the Voice Sense QWERTY downloads e-mail from the e-mail server, 
there may be a number of e-mail messages that are spam. In this case, you 
can avoid downloading these spam e-mail messages by identifying specified 
words in the subject or specifying e-mail addresses you know are from 
spammers. 
The spam e-mail messages that are identified by your "Spam Settings" are 
not downloaded into the Voice Sense QWERTY, and remain on the e-mail 
server. 
Use the following steps to set spam e-mail filters: 
 
1) Press “Alt” to open the menu from the "Inbox". 
2) Press “down arrow”, to move to "Tools". 
3) Press "Enter".  
4) Voice Sense QWERTY displays "Accounts manager". 
5) Press “down arrow”, to move to ""Spam Settings". 
6) Press "Enter".  
7) Voice Sense QWERTY displays "Type: Subject 1/3". You can also open 
this dialog directly by pressing "Ctrl-e". 
 
The "Spam Settings" dialog contains the following 6 items; 
 
1. Type 
2. List 
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3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among the items by pressing "Tab" or "Shift-Tab".  
To exit "Spam Settings", move to the "Close" button and press "enter", or 
press "Esc" or "Alt-F4".  
"Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 
"Host". You can move among these options by pressing “up arrow” or “down 
arrow”. The "list" is displayed in a different form according to the "Type" you 
choose. 
If you have selected "Subject", the list is displayed as "Subject: (Registered 
word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail 
address string: (Registered e-mail address string) 1/xx". It is displayed as "no 
items" if there is no registered word or e-mail address string. 
The following explains how to register, modify, and delete the spam settings. 
 

6.5.3.1 Add As Spam E-Mail 
 
1) Use the steps described above to open the "Spam Settings" dialog.  
2) Press "a" when "Type: Subject 1/3" is displayed. Or, press "Tab" to move 
to the "Add" button, and press "enter". 
3) The "add dialog" is opened and "Subject add:" is displayed. 
4) Type the words, by which you want to identify spam messages and press 
"Enter". Or, press "Tab" to move to the "Confirm" button, and press "enter".  
5) "Successfully added spam data" is announced and you are returned to the 
"list". "Subject: (registered word) 1/1" is displayed. 
 
If there is more than one registered word, you can move among them by 
pressing “up arrow” or “down arrow”. 
By adding the word as explained above, if there are any e-mail messages 
that include the words you entered in the subject of the message, the Voice 
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Sense QWERTY downloads those e-mails from the e-mail server, but 
deletes them automatically.  
You can also avoid receiving e-mail messages from a specific sender or host 
by registering it. 
The following are the steps to register a sender's e-mail address as spam: 
 
1) Use the steps described above to open the "Spam Settings" dialog. 
2) Press “down arrow” when "Type: Subject 1/3" is displayed. "Type: E-mail 
address string 2/3" is displayed. 
3) Press "a" or press “Tab” to move to the "Add" button, and press "enter". 
4) The "Add dialog" is opened, and "E-mail address string: (e-mail address)" 
is displayed. The "(e-mail address)" is the sender's e-mail address that was 
focused when you opened the dialog. You can choose to filter by this 
address, or type a different e-mail address in the edit box. 
5) Press "Enter" on "E-mail address string: (e-mail address)". Or, press "Tab" 
to move to the "Confirm" button, and press "Enter". 
6) "Successfully added spam data" is announced and "E-mail address string: 
(Registered e-mail address) 1/1" is displayed. 
 
When "E-mail address string: (registered e-mail address) 1/1" is displayed, 
you can add another address by pressing "a" or pressing "Tab" to move to 
the "Add" button,  and press "Enter". You can check the registered e-mail 
addresses by pressing “up arrow” or “down arrow”. 
To register a specific host as a spam sender, do the following: 
 
1) Use the steps described above to open the "Spam Settings" dialog. 
2) Press “down arrow” when "Type: Subject 1/3" is displayed to move to 
"Type: Host 3/3". 
3) Press "a" on "Type: Host 3/3", or press "Tab" to move to the "Add" button, 
and press "Enter". 
4) The "Add dialog" is opened, and "Host add: (host address)" is displayed. 
By default, "host address" is the host address that was focused on when you 
executed this command. You can add this host or type a different host in the 
edit box. 
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5) Press "Enter" on "Host add: (host address)". Or, press “Tab” to move to 
the "Confirm" button, and press "enter". 
6) The Voice Sense QWERTY says, "Successfully added spam data" and 
shows "Host: (registered host address) 1/1". 
 
When "Host: (registered host address) 1/1" is displayed, you can add 
another host by pressing "a" or pressing "Tab" to move to the "Add" button, 
and press "Enter". You can check the registered host addresses by pressing 
“up arrow” or “down arrow”. 
 
To cancel setting spam filters from the "Add dialog", press "Tab" to move to 
the "Cancel" button, and press "Enter". Or, press "Esc" or "Alt-F4". 
 

6.5.3.2 Modifying Spam Registration 
 
To modify a spam filter you have set, do the following: 
1) Access the "Spam Settings" dialog as described previously, and navigate 
to the "Type" of spam setting you want to modify by pressing “up arrow” or 
“down arrow”.  
2) Press "Tab" to move to the list of registered items in that category.  
3) Navigate to the item you want to modify using “up arrow” or “down arrow”.  
4) Press "m" or press "Tab" to move to the "Modify" button, and press 
"Enter".  
5) Make the modifications in the edit box. 
6) Press “Tab” to move to the "confirm" button, and press "Enter" to save the 
changes.   
 

6.5.3.3 Deleting Spam 
 
You can also delete an item that has been registered in the spam list.  
1) Access the "Spam Settings" dialog as described previously, and navigate 
to the "Type" of spam setting you want to delete by pressing “up arrow” or 
“down arrow”.  
2) Press "Tab" to move to the list of registered items in that category.  
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3) Navigate to the item you want to delete using “up arrow” or “down arrow”.  
4) Press "d" or press "Tab" to move to the "Delete" button, and press "Enter".  
 
6.6. Hot Keys for E-Mail 

 
6.6.1 Hot Keys That Are Used in the Inbox 

 
Open "accounts manager": Ctrl-m 
Switch from offline to online mode (IMAP): Alt-l. 
Check for New Mail: Alt-m 
Get  previous mail (IMAP): Alt-e. 
Go to previous account category: Alt-FN-Up arrow. 
Move to next account category: Alt-FN-Down arrow. 
Move ot previous mailbox: Alt-FN-Up arrow. 
Move to next mailbox: Alt-FN-Down arrow. 
Write New Message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Open "set path": Ctrl-p 
Open "set option": Ctrl-o  
Open "set spam": Ctrl-e  
Find: Ctrl-shift-f (Only while in a message) 
Find again: F3 (Only while in a message) 
Move to next unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to Mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (valid only on the "from" field of the 
"Inbox"). 
Delete received e-mail: Del (valid only on the "Subject" and "date" fields in 
the "Inbox"). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: Esc 
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Cancel and exit from e-mail program: Alt-F4 
 

6.6.2 Hot Keys for Sending E-Mail Including Reply, Forward, 
and Saving to Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f  
Send e-mail: Ctrl-s 
Save in mail outbox: Alt-s 
Cancel: Esc 
Cancel and exit from e-mail program: Alt-F4 
 

6.6.3 Hot Keys for Reading/writing E-Mail Messages  
 
Start selection: Ctrl-b 
Select all: Ctrl-a 
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 
"Inbox"). 
Paste from the clipboard: Ctrl-v (not valid when reading e-mail in the "Inbox") 
Delete: Del (not valid when reading e-mail in the "Inbox") 
Cancel block: Esc 
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7. Media  
 
The “Media” menu on the Voice Sense QWERTY consists of programs 
related to media playback: specifically music, fideos, and DAISY content. 
The “Media” menu contains 3 items: “Media Player”, “FM Radio”, and 
“DAISY Player”.  
You can open the “Media” menu by pressing “Windows” to bring up the main 
“Program” menu, then navigating to “Media” using the DOWN Arrow and 
pressing “Enter”. Or, you can quickly jump to and open the “Media” menu by 
pressing “M” from the main menu. 
The following sections will discuss the programs in the “Media” menu in 
detail. 
 
7.1 Media Player 

 
The Media Player on the Voice Sense QWERTY is a program you can use 
to play audio files as well as listen to the audio for some video file formats. 
The Media Player plays the following formats, ac3, asf, asx, m3u, mp2, mp3, 
MP 4, mpa, mpg, ogg, pls, wav, wax, wma, flac, midi and wmv. Note: you 
cannot see the video for "avi" and "wmv" files, however, you may listen to the 
audio contained in these formats. 
You can control the playing of audio files using either keyboard commands 
or the media buttons on the front panel of the Voice Sense QWERTY. The 
Media Player can play back audio recordings and books as well as music 
files. 
You can launch the “Media Player” by navigating to it in the “Media” menu 
and pressing “Enter”. Or, you can launch the “Media Player” from anywhere 
on the unit by pressing “Windows-M”. 
 

7.1.1 Using the media buttons 
 
Near the center of the front panel on the Voice Sense QWERTY is a group 
of 5 buttons with varying shapes. These buttons can be used to control the 
Media Player. Moving from left to right, the buttons are: "Back", "Record", 
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"Stop", "Play/Pause", and "Forward". These buttons are used for playing and 
recording music or voice quickly and easily. 
The media buttons can control media playback, DAISY content playback, or 
FM radio operation, depending on the position of the Media Mode switch, 
located to the left of the media buttons. Slide this switch to the right-most 
position, "Media Mode", to control media playback.  
 
If the "Play/Pause" button is pressed while you are using another program on 
the Voice Sense QWERTY, the unit opens the Media Player and begins 
playing the files in the most recently played  list. If there are no files in the 
playlist, the Voice Sense QWERTY says, "There are no items to display". 
"Back", "Stop", and "Forward" are available after audio playback is started.  
Note: As the Voice Sense QWERTY is able to multi-task, initiating audio 
playback with the "Play/Pause" button does not close the program you were 
running when you pressed it. To return to your former position, press "F2-F3" 
to cycle through the running programs until you reach your former location.  
 

7.1.1.1 Play/Pause Button 
 
The "Play/Pause" button has a long, rectangular shape. It is the second 
button from the right in the group of media buttons. As explained above, 
pressing the "Play/Pause" button starts playback of the files in the most 
recently played media playlist. A playlist can contain only 1 file, or many files. 
If there is more than one file in the playlist when you press the "Play/Pause" 
button, the Voice Sense QWERTY plays all the files in the list one after 
another. If you press the "Play/Pause" button during playback, audio 
playback is paused. To resume playing, press the button again. If you press 
the "Play/Pause" button while you are in the "Record" dialog, the most 
recently recorded file is played.  
 

7.1.1.2 "Forward" button and "Back" button 
 
Both of these buttons have a triangular shape. The "Back" button is the left-
most button in the media group and is pointed to the left. The "Forward" 
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button is the right-most button in the media group and is pointed to the right. 
If you press the "Forward" button, the next file in the playlist is played, and 
pressing the "Back" button plays the previous file. If you press one of these 
buttons while an audio file is playing, the Voice Sense QWERTY stops 
playing the current file, and jumps to the previous or next file (depending on 
which button you press) and starts playing it. If you press the "Forward" 
button (while the last file in the list is playing, (or the "Back" button (while the 
first file in the list is playing), it has no effect, as there is no file to navigate to.   
 

7.1.1.3 Record Button 
 
The "Record" button has a circular shape, and is used to record sound using 
the built-in or an external microphone. The "Record" button is located directly 
to the right of the "Back" button. You can use this button to create a 
recording from anywhere on the unit provided the Media Mode switch is set 
to the right-most position. Pressing the "Record" button once opens the 
"Record" dialog. Press the "Record" button again to start recording. Press 
the "Record" button while you are recording to pause recording. Resume 
recording by pressing the "Record" button one more time. Press the "Stop" 
button, directly to the right of the "Record" button, to stop and save your 
recording. The recorded file is saved in the "flashdisk/media/record" folder.  
 

7.1.1.4 Stop Button 
 
The "Stop" button has a square shape and a dot on it, and is used to stop 
playback or recording.   If you press "Stop" during audio playback, the next 
time media playback is launched, the Voice Sense QWERTY starts playing 
the first file in the playlist. If you press this button while recording, the Voice 
Sense QWERTY stops and saves the recording. If you press the "Stop" 
button in the "Record" dialog when not recording, the dialog closes. 
 

7.1.1.5 Using the media buttons in Open File dialog 
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Press and hold the "Stop" button to open the "Open File" dialog from within 
the "Media Playback" dialog. Press and hold "Stop" again to close the "Open 
File" dialog and return to the "Media Playback" dialog. 
In the "Open File" dialog, the "Play/Pause" button functions the same as 
"Enter". The "Stop" button, "Record" button, "Back" button and "Forward" 
button function the same as "Backspace", "Space", “up arrow” and “down 
arrow” respectively. 
Namely, you can navigate up and down by pressing the "Back" and 
"Forward" buttons in a file list; and you can select and unselect items by 
pressing the "Record" button. Press the "Stop" button to move back a level in 
the folder structure. And press "Play/Pause" button to play the selected files.  
 

7.1.2 Keyboard and Extended Keys 
 
You can use the QWERTY keyboard to perform the same functions as the 
media buttons as well as more advanced features in the Media Player. To 
open the "Media Player", press "Enter" on "Media Player", or press m from 
the Voice Sense QWERTY "program" menu. As explained previously, you 
can also open the Media Player by pressing "Play-Pause" when the "Media 
Mode" switch is set to the right-most position. 
The "Media Playback" dialog contains two information tabs: "playback 
information" and "playlist". Press “Tab” or "Shift-Tab" to move between these 
tabs. 
 

7.1.2.1 Playback Information Tab 
 
The "playback information" tab displays the track number, the file name, and 
the current playback status: (play, pause, or stop). If there are no files in the 
playlist, the Voice Sense QWERTY displays "Title: There are no items to 
display". If you press “down arrow”, the Voice Sense QWERTY displays 
playback time information.  
First, the elapsed or remaining time is displayed. You can set whether the 
elapsed time or remaining time is displayed, using the "playback settings" 
dialog. If you have selected the "Remaining time" with this option, the - 
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(minus sign), is displayed before the time. Next to the elapsed/remaining 
time, the Voice Sense QWERTY displays the total playback time of the 
currently selected file. 
If there are no files in the playlist, "Time: There are no items to display" is 
displayed. 
 

7.1.2.2 Playlist Tab 
 
The "playlist" tab displays all the files in the playlist. For each file in the 
playlist, it displays the track number, file name, the location of the file in the 
list, and the total number of files in the list. If there is no file in the playlist, the 
Voice Sense QWERTY displays the message "no items". 
For example, if you had the following track on the Voice Sense QWERTY: 
"Track 1 Chopin - Fantasie Impromptu 1/10", "Track 1" indicates this file is 
the first item in the playlist. "Chopin - Fantasie Impromptu" is the file name. 
"1/10" indicates this file is the first of ten files in the playlist.  
 

7.1.2.3 LYRICS Tab  
 

The Voice Sense  QWERTY's Media Player supports the viewing of lyrics for 
MP3 files which contain them. The "Lyrics tab appears in the tab order only if 
the file you are playing contains lyrics in its file information. If your file 
contains lyrics, the "Lyrics" tab appears in the tab order after the "Playlist" 
tab. The lyrics to the currently playing track are displayed in a multi edit box. 
Read and navigate the lyrics using normal document navigation commands. 
See chapter 5 of this manual on the "Word Processor" for details on 
document navigation.  
 
 

7.1.2.3 Hot Keys in the Playback Information and playlist Tabs 
 
The hot keys that can be used in the "playback information" and the "playlist" 
tabs are as follows: 
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1) Hot keys in the Play Information Tab 
 

Hot key Function 
Down arrow Move to the next information 
Up arrow Move to the previous 

information 
Space “Pause” when it is play state 

and “play” when it is pause 
state. 

Enter or x Start playing 
Backspace or c Stop playing 
Alt-Right arrow or z Play the next file 
Alt-Left arrow or b Play the previous file 
Ctrl-End Play the last file 
Ctrl-Home Play the first file 
Alt-Down arrow Play the fifth file after the 

current file 
Alt-Up arrow Play the fifth file before the 

current file 
Ctrl-Right arrow Move to next position by time 

index and play 
Ctrl-Left arrow Move to previous position by 

time index and play 
Ctrl-Up arrow or Ctrl-Down 
arrow 

Change time index 

Shift-Left arrow Speed up 
Shift-Right arrow Slow down 
Shift-Up arrow Volume up 
Shift-Down arrow Volume down 
Alt Open menu 
F1 Open help 
Tab/Shift-tab  Move to “play list” tab 
Alt-F4 Exit “Media player” 
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2) Hot Keys in the Play List Tab 

 
Hot key Function 
Down arrow Move to the next file 
Up arrow Move to the previous file 
End Move to the last file 
Home Move to the first file 
Space Select/resume current file 

(while playing, it is used as 
play/pause) 

Ctrl-b Start selecting files 
Enter Start playing the selected files 
Backspace Stop playing 
Del Delete the selected files in the 

play list 
Alt-Right arrow Play the next file 
Alt-Left arrow Play the previous file 
Ctrl-End Play the last file 
Ctrl-Home Play the first file 
Ctrl-Down arrow Play the fifth file after the 

current file 
Ctrl-Up arrow Play the fifth file before the 

current file 
Ctrl-Right arrow Move to next position by time 

index and play 
Ctrl-Left arrow Move to previous position by 

time index and play 
Ctrl-Up arrow Change time index 
Shift-Left arrow Speed up 
Shift-Right arrow Slow down 
Shift-Up arrow Volume up 
Shift-Down arrow Volume down 
Alt or F10 Open menu 
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F1 Open help 
Tab/Shift-tab Move to “playback information” 

tab 
Alt-F4 Exit “Media player” 

 
 

7.1.3 How to Use the Media Player Menu 
 
To open the "Media Player" menu, press “Alt” while in the "Media Playback" 
dialog. This menu contains five items: "File", "Play", "Record", "Position", 
"Mark" and "Settings". The "File" menu allows you to add or delete files in 
the playlist. The "Play" menu lists all of the commands related to playing files. 
The "Record" menu opens the "Record" dialog which allows you to record 
sound and play it. The "Position" menu contains commands related to 
bookmark and go to position. The "Settings" menu allows you to set various 
Media Player options. 
 

7.1.3.1 File 
 
To use the "File" menu, press “Alt” to open the "Media Player" menu, then 
press "Enter" on "File", or press "f". A submenu appears, containing "Open 
File", "Open Folder", "Add File", "Add Folder", "Save Playlist", "Save As 
Playlist", "Delete Item", "Open URL" and "Exit". You can move between 
these items by pressing “down arrow” or “up arrow”. Press "Enter" on the 
item you want to execute. To return to the Media Player menu, press "Esc". 
To exit the menu, press, "Alt-F4" and you are returned to the "Media 
Playback" dialog. 
 

7.1.3.1.1 Open File 
 
You can use the "Open File" menu item to add files to the playlist and start 
playing them. If you press "Enter" on "Open File", a dialog opens, similar to 
the "file list" in the "File Manager". You can navigate folders and files just as 
you would in the "File Manager". The files playable in the "Media Player" are 
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those with the extensions, ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, 
wma, flac, midi and wmv.  
If you select all the files you want to play, and press "Enter", the Voice Sense 
QWERTY adds the files to the playlist, and starts playing the first file. You 
can select more than one file in the "Open File" dialog by pressing "Space" 
on each of the items you want to add to the playlist. When you have selected 
all the files you want, press "Enter".  
When you open the "Open File" dialog, files in the default folder are 
displayed. The default folder is set to "/flashdisk/media". You can also open 
the "Open File" dialog by using the hot key, “Ctrl-o” directly from the "Media 
Playback" dialog. 
 

7.1.3.1.2 Open Folder 
 
The "Open Folder" menu item is used to add all of the audio files in the 
selected folders to the playlist. If you press "Enter" on "Open Folder" in "File" 
menu, or press "Ctrl-f" in the "Media Playback" dialog, the "Open Folder" 
dialog is opened. The "Open Folder" dialog is almost the same as the "Open 
File" dialog. The difference is that only folder names are displayed in the 
"Open Folder" dialog. When you open the "Open Folder" dialog, the default 
folder name is displayed. The default folder is set to "flashdisk". Press 
"Enter" to display all of the folders in "flashdisk", and press “up arrow” or 
“down arrow” to move among the folders. To enter the folder under your 
cursor, (and list any sub-folders contained there) press "Enter" on it. Press 
"Backspace" to move back to the parent folder. To select a folder, press 
"Space" on the folder name. You can select more than one folder. Once you 
have selected all of the folders you want, press "Enter". The Voice Sense 
QWERTY adds all of the supported audio files from the selected folders to 
the playlist and starts playing the first file. 
 

7.1.3.1.3 Add File 
 
The "Add File" menu item is used to add audio files to the currently playing 
list. If you press "Enter" on "Add File" in the "File" menu, or press "Alt-o" in 
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the "Media Playback" dialog, the same dialog that is used for "Open File" is 
displayed. Select all of the files that you want, and press "Enter" (as in the 
"Open File" dialog). The Voice Sense QWERTY adds the selected files to 
the playlist. However the Voice Sense QWERTY does not start playing these 
files. To start playing the files in the playlist, press the "Play/Pause" button 
on the front panel. Or, you can press "Enter" on "play" in the "play" menu. A 
detailed explanation of the "play" menu can be found in section 9.3.2. 
 

7.1.3.1.4 Add Folder 
 
The "Add Folder" menu item is used to add all of the audio files in a selected 
folder to the currently playing list. If you press "Enter" on "Add Folder" in the 
"File" menu (or press "F3" in the "Media Playback" dialog), the same dialog 
that is used for "Open Folder" is displayed. If you select all of the folders you 
want to add, and press "Enter", the Voice Sense QWERTY adds all of the 
supported audio files in the selected folders to the playlist. However, it does 
not start playing the files. You can start playing the files in the playlist by 
pressing the "Play/Pause" button on the front panel of the Voice Sense 
QWERTY, or press "Enter" on "play" in the "play" menu.  
 

7.1.3.1.5 Save playlist 
 
The "Save Playlist" menu item is used to save the playlist to a disk drive. To 
access this function, you can press “Alt” to open the "File" menu and execute 
the "Save Playlist" command by pressing "Enter" on it. Or, you can press "s" 
to quickly jump to and execute it from within the menu. You can also press 
"Ctrl-s" from the "Media Playback" dialog. 
If you are saving files to a new playlist, the "Save as playlist" dialog opens.  
If you execute "Save Playlist" after adding files to an existing playlist, the 
Voice Sense QWERTY saves the playlist with the same file name without 
opening the dialog. After saving the playlist, it returns to the "Media 
Playback" dialog. 
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7.1.3.1.6 Save as playlist 
 
The "Save As Playlist" menu item is used to save the playlist under a 
different name or in a different location. Press “Alt” to open the "File" menu 
and execute the "Save As Playlist" command by pressing "Enter" on it; or 
you can press "l" to access it quickly. You can also press "Alt-s" from the 
"Media Playback" dialog.  
If you execute "Save As Playlist", the "Save As Playlist" dialog is displayed. 
This dialog consists of "file list", "File name", a "Confirm" button, and a 
"Cancel" button. When the dialog is opened, "File name:" is displayed. You 
can move among the tabs by pressing “Tab” or "shift-tab". The file format of 
playlists saved by the Voice Sense QWERTY is always "m3u". By default, 
playlist files are saved in "/flashdisk/media". 
To create a new file name, type in the new file name. You cannot use the 
following characters in a file mane. "|, \, <, >, ?, :, *". 
To change the location, move to the "file list" by pressing "shift-tab". 
Navigate to the location in which you want to save the playlist, and press 
"Enter". 
 

7.1.3.1.7 Delete Item 
 
To delete a file from the playlist, first, locate the file you want to delete in the 
"playlist" tab by pressing “up arrow” or “down arrow” repeatedly. Then, open 
the "Media Player" menu by pressing “Alt”, and press "Enter" on "File". 
Navigate to "Delete Item" by pressing “down arrow” repeatedly, and press 
"Enter". Or, you can press "Del" on the file you want to delete from the 
playlist. You can select more than one file in the "playlist" tab by pressing 
"Space" on each file to be deleted. * is displayed before each selected item. 
If you press "Space" on a selected item, the selection is canceled and the / 
disappears.  
You can also delete multiple files in a block from the playlist. Press “Ctrl-b” 
on the first file to be deleted. “Ctrl-b” indicates the start of the block. Next, if 
you press “down arrow” or “up arrow”, the displayed files are selected. After 
selecting the files you want to delete, press "Del" to delete them. 
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7.1.3.1.8 Tag Information  
 

The "Tag Information" option in the "File" menu allows you to view 
information about the currently playing file such as Artist, Genre, etc. To 
open the "Tag Information" dialog, press "Enter" on "Tag Information" in the 
"File" menu, or press "Control-T" while playing a file.  

The "Tag Information" dialog consists of an information list, and a "Close" 
button. You can move among the items using "Tab" or "Shift-Tab". Move 
among the items in the information list using the Up or Down arrow. The 
information list includes "Title", "Artist", "album", "Genre", "Official 
homepage", "Link", "Sample Rate", "Bitrate" and "Channels". When you 
have finished viewing the information, Tab to the "Close" button and press 
"Enter", or press "Escape".  

 
7.1.3.1.9 Open URL 

 
The "Open URL" menu item is used to play the audio stream from a web 
page. If you press "Enter" on "Open URL" in the "File" menu, or press "Ctrl-i" 
in the "Media Playback" dialog, the "Open URL" dialog is displayed. In this 
dialog, type the web address of an audio stream and press "Enter". The 
Voice Sense QWERTY automatically accesses the audio stream from the 
Internet and begins playing it.  
Note: Please make sure to have an active Internet connection before 
attempting to open an audio stream. 
 

7.1.3.1.10 Exit 
 
You can exit the "Media Player" by selecting "Exit" in the "File" menu, or by 
pressing "Alt-F4" in the "Media Playback" dialog. The Voice Sense QWERTY 
stops playing (if it is playing a file), and exits to the "program" menu. 
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7.1.3.2 Play 
 
The "Play" submenu contains all of the commands that can be used to 
control playback. To access this menu, press “Alt” to open the "Media 
Player" menu. Press “down arrow”. The Voice Sense QWERTY displays 
"Play (p)->". Press "Enter", and the "Play" submenu is displayed. You can 
move among the items in this menu by pressing “down arrow” or “up arrow”. 
To return to the "Media Player" menu, press "Esc". Press "Alt-F4" To close 
the menu and return to the "Media Playback" dialog.  
 

7.1.3.2.1 Play 
 
If you press "Enter" on "Play", the Voice Sense QWERTY begins playing the 
files in the current playlist. You can also start playback from the "Media 
Playback" dialog by pressing Space". 
 

7.1.3.2.2 Previous Track 
 
"Previous Track" is used to play the previous file in a playlist.  You can also 
do this by pressing “z” or “Alt-Left arrow” in the “Media player” dialog box. 
 

7.1.3.2.3 Next Track 
 
This item is used to play the next file in the playlist. You can also press “b” or 
“Alt-Right arrow” in the “Media player” dialog box to do this. 
 

7.1.3.2.4 Back 5 Tracks 
 
Use this command to play the fifth file before the file that is currently playing. 
You can also press “Alt-Up arrow” in the “Media playback” dialog box to do 
this. 
 

7.1.3.2.5 Forward 5 Tracks 
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Use this command to play the fifth file after the file that is currently playing. 
You can also do this by pressing “Alt-Down arrow” in the “Media playback” 
dialog box. 
 

7.1.3.2.6 First Track 
 
Use this command to play the first file in the playlist. You can also do this by 
pressing “Ctrl-Fn-Left arrow” in the “Media player” dialog box. 
 

7.1.3.2.7 Last Track  
 
Use this command to play the last file in the playlist. You can also do this by 
pressing “Ctrl-Fn-Right arrow” in the “Media playback” dialog box. 
 

7.1.3.2.8 Volume Up and Volume Down 
 
These options are used to adjust the audio playback volume. Here, the 
volume level ranges from 0 to 10. You can also adjust the volume level by 
pressing “Shift-Up arrow (up)” or “Shift-Down arrow (down)” in the “Media 
playback” dialog box. The actual volume level depends on the value of 
“voice volume” that is set in the “global options”. For example, if “voice 
volume” is set to 5, and the volume level in the “Media player” is set to its 
maximum 10, the actual volume is 5. If the volume level in the “Media player” 
is set to 5, the actual volume level is 2.5. 
 

7.1.3.2.9 Speed Up and Slow Down 
 
You can use these controls to adjust the audio playback speed. The speed 
level ranges from -2 to 8. You can also adjust the speed level by pressing 
“Shift-Left arrow” or “Shift -Right arrow” in the “Media playback” dialog box. 
“Shift -Right arrow” increases the audio playback speed, and “Shift-Left 
arrow” decreases the audio playback speed. 
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7.1.3.2.10 Pause 
 
This item pauses playback of a file. If you activate this command again, the 
Voice Sense QWERTY resumes playback from the position where the file 
was paused. You can also do this by pressing "Space" in the "Media 
Playback" dialog.  
 

7.1.3.2.11 Stop 
 
This command stops playback of the currently playing file. You can also do 
this by pressing “c” or “Backspace” in the “Media playback” dialog box. 
 

7.1.3.3 Record 
 
This menu item is used to open the "Record" dialog. To open the "Record" 
dialog, press “Alt” to open the "Media Player" menu. Press “down arrow” 
twice to move to "record (r)", and press "Enter". Or you can press "r" from 
the Media Player Menu. The Voice Sense QWERTY displays the "Record" 
dialog. You can also open this dialog by pressing "Ctrl-r" from the "Media 
Playback" dialog.  
The "Record" dialog contains an "information" tab and five buttons. You can 
move among these by pressing “Tab” or “Shift-Tab”. Activate the buttons in 
this dialog by pressing "Enter" on the button you want to use. You can also 
activate the buttons by typing the character displayed after the button name. 
 

7.1.3.3.1 Record/Playback Information Tab 
 
This tab is displayed only when the Voice Sense QWERTY is recording, or 
when there is a file that has just been recorded.  The information displayed 
in this tab includes: the file name, the current status, and two pieces of time 
information. The file name is the name of the file containing the sound that is 
currently being recorded or played. The current status is one of the following: 
recording, playing, pause, or stop. The time information that is displayed first 
is the elapsed recording time and the elapsed or remaining time while 
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playing, (depending on the "Display time" setting in the "Playback Settings" 
dialog, explained in section 9.3.6.2). The final piece of time information 
during recording is the available recording time according to the space 
available on your flashdisk. While playing, the total length of the file in time is 
displayed. You can move between time information and other information by 
pressing “down arrow” or “up arrow”. 
 

7.1.3.3.2 Record 
 
Use this command to start recording. You can also start recording by 
pressing the "Record" button on the front panel of the Voice Sense 
QWERTY. While recording, the Voice Sense QWERTY displays the 
"recording information" tab. whenever you start recording the Voice Sense 
QWERTY creates a file. The file is named "record 01.mp3", or "record 
02.mp3" etc. By default, these files are saved in "/flashdisk/media/record". 
You can change the save-to folder and recording file type using the "Record 
Settings" option, explained in section 9.3.6.3. When recording, pause the 
recording by pressing "Tab" to move to the "Pause" button, and then press 
"Enter". You can also pause by pressing the "Record" button on the front 
panel. To resume recording, press "Enter" on the "Continue" button, or press 
the "Record" button again. To stop recording, press “Tab” repeatedly to 
move to the "Stop" button, and press "Enter". 
If you wish to cancel the recording, you can press Alt-F4”. You are prompted, 
“Do you want to save the current file? Choose “Yes” or “No” using the Up 
and Down arrows and press “Enter”. 
 

7.1.3.3.3 Play 
 
This button is used to play the file that has just been recorded. You can also 
start playing the recorded file by pressing the "play" button on the front panel. 
This function is only available just after you have recorded a file. While 
playing, the "playback information" tab is displayed. To pause or stop playing, 
tab to the desired button and press "Enter".  
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7.1.3.3.4 Stop 
 
Use this command to stop recording or playback. If you press "Enter" on 
"Stop" while recording, the Voice Sense QWERTY stops recording and 
shows the "recording information" tab. If you press "Enter" on the "Stop" 
button during playback, the Voice Sense QWERTY stops playing and shows 
the "playback information" tab. You can also stop recording or playing by 
pressing the "Stop" button on the front panel.  
 

7.1.3.3.5 Pause 
 
Use this command to pause the recording or playing of a file. If you press 
"Enter" on "Pause", or press the "Play/Pause" button on the front panel, 
recording or playing is paused, and the "recording information" or "playback 
information" tab is displayed. 
 
 

7.1.3.3.6 Continue 
 
Press "Enter" on "Continue" when the current status is "pause", and the 
Voice Sense QWERTY resumes recording or playing. 
 

7.1.3.3.7 Cancel 
 
If you press "Enter" on "Cancel", the Voice Sense QWERTY stops recording 
or playing, closes the "Record" dialog, and returns to the "Media Playback" 
dialog. If you press "Enter" on "Cancel" while recording, the recorded file is 
not saved. To save the recording and exit the dialog; press "Enter" on "Stop", 
and then move to the "Cancel" button, and press "Enter". You can also use 
"Esc" or "Alt-F4" to cancel an operation. 
 

7.1.3.4 Position Menu 
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ACCESS the "Position" menu to set or delete a bookmark while listening to 
music or an audio file. This menu also lets you jump to a specified time in an 
audio file. 
The "Position" menu contains 7 items: 
 
1. Mark Position 
2. Delete Marked Position 
3. Jump To Marked Position 
4. Go To Time 
5. Go To Percent 
6. Set Start Point 
7. Release Point 
 
You can move between the menu items by pressing “down arrow” or “up 
arrow”. To activate a menu item, press "Enter". 
 

7.1.3.4.1 Mark Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, a bookmark is set. A bookmark marks a specific location, so you 
can return to the exact spot at a later time.  
To execute this function, 
 
1) Press “Alt” and move to "Position" by pressing “down arrow”. 
2) Press "Enter" on "Position". 
3) Navigate to "Mark Position" by pressing “down arrow”, and press "Enter". 
4) Or, press "Alt" when playing a file, or when a file is paused. 
 

7.1.3.4.2 Delete Marked Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, it deletes the bookmark that was previously created. 
To execute this function,  
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1) Press “Alt” and move to "Position" by pressing “down arrow”. 
2) Press "Enter" on "Position". 
3) Navigate to "Delete Marked Position" by pressing “down arrow”, and press 
"Enter". 
4) Or, you can press "Alt-d" when playing a file, or when a file is paused. 
 
If you execute this function in a file that does not have a bookmark, the Voice 
Sense QWERTY displays, "There is no bookmark in selected file". 
 

7.1.3.4.3 Jump to Marked Position 
 
If you execute this function when you are playing a file, or when a file is 
paused, it jumps to the position of a bookmark that has already been created. 
To execute this function,  
 
1) Press “Alt” and move to "Position" by pressing “down arrow”. 
2) Press "Enter" on "Position". 
3) Navigate to "Jump To Marked Position" by pressing “down arrow”, and 
press "Enter". 
4) Or, you can press "Alt-j" when playing a file, or when a file is paused. 
 
If you execute this function in a file that does not have a bookmark, the Voice 
Sense QWERTY displays, "There is no bookmark in selected file". 
 

7.1.3.4.4 Go to Time 
 
If you execute this function when you are playing a file, or when a file is 
paused, it moves to a time that you specify, and begins playing the file at 
that position. 
To execute this function,  
 
1) Press “Alt” and move to "Position" by pressing “down arrow”. 
2) Press "Enter" on "Position". 
3) Navigate to "Go To Time" by pressing “down arrow”, and press "Enter". 
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4) Or, you can press "Ctrl-g" when playing a file, or when a file is paused. 
5) The Voice Sense QWERTY displays "Go to position: 0 minute". 
6) Type the time you want to go to, and press "Enter". You can jump more 
than an hour using a couple of methods: 
If you wish to type 1 hour and 20 minutes, type the "1", "Space" or “:”, "20" 
sequentially. Also you can input 80 minutes by simply typing "80". If there is 
no "Space" or “:", the input value is dealt with as minutes.  
 
If you type a time longer than the total playback time of the file or playlist, the 
Voice Sense QWERTY displays, "invalid time", and resumes playing from 
the paused location. 
 

7.1.3.4.5 Go To Percent 
 
In play or pause status, you can move to a specified percentage of a file. 
1) In playing or pause status, press “Alt” to open the menu. 
2) By pressing “up arrow” or “down arrow”, navigate to the "Position" menu.  
3) Press "Enter". Or press "a" 
4) By pressing “up arrow” or “down arrow”, move to the "Go to percent" 
menu item. 
5) Press "Enter". Or press "Alt-p" from the "Media Playback" dialog.  
6) You are prompted "Go to percent: XX".  
7) Enter the percent that you want to move to in the edit box using numbers 
0 to 99. 
8) Press "Enter".  
9) You are placed at the position in the file matching the percentage you 
entered. 
 

7.1.3.4.6 Set Start Point 
 
A B repeat mode allows you to play a specific part of an audio file as many 
times as you wish. This can be useful when learning a new language, and 
you need to hear the same information in a file over and over again.  
A B repeat mode requires setting start and end points for repetition. 
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To set a start and end point, follow these steps: 
1) Press "p" at the position at which you want to set the start point. 
2) Or, press “Alt” and move to "Position" by pressing “down arrow”. Press 
"Enter" on "Position". Move to "Set start point" by pressing “down arrow” and 
press "Enter". 
3) The unit announces, "Set start point" and the file continues playing. 
4) To set the end point, press "p" at the point where you want to end the 
section for repetition. 
Or, you can execute A B repeat mode by pressing the "Record button" 
during playback. 
1) Press "Record button" at the position at which you want to set the start 
point. 
2) To set the end point, press the "Record button" again at the point where 
you want to end the section for repetition. 
 
Note: You can only use the "Record button" to perform this function while a 
file is playing. If playback is paused or stopped, the "record button" activates 
the recording function. 
 
After you have highlighted a section of a file using start and end points, A B 
repeat mode allows you to play that specific part of the file as many times as 
you wish. To set how many times a specified section repeats, go to 
"playback settings" under the "settings" menu. 
 

7.1.3.4.7 Release Point 
 
To set a release point, press "Esc". Or, press “Alt” and move to "Position" by 
pressing “down arrow”. Press "Enter" on "Position". Move to "Release point" 
by pressing “down arrow” and press "Enter". After stopping playback of the 
specified section, the file continues playing. 
 

7.1.3.5 Mark 
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You can insert a mark while listening to music or an audio file. The mark is 
stored even when you exit the program or play another file.  
To use the mark function, press “Alt” and move to "Mark" by pressing “down 
arrow”. And press "Enter".  
The "Mark" menu has the following submenus. 
 

7.1.3.5.1 Set Mark 
 
To set a mark while listening to audio, Open the menu, and press "Enter" on 
"Mark". Navigate to "Set Mark" and press "Enter". Or, to activate this function 
directly, press "Alt-m" up to 1000 marks can be inserted into a file. 
The marks are automatically numbered in sequential order.   
 

7.1.3.5.2 Move to Mark 
 
You can move to the next or previous mark by pressing "V" or "N" 
respectively. You can also move to a mark using the menu. Press “Alt” and 
move to "Mark". And press "Enter". Navigate to the "Previous Mark" or the 
"Next Mark"  item and press "Enter". 
You can also move to a mark using the mark number. 
 
1) Open the menu and press "Enter" on "Mark". Navigate to "Move To Mark". 
2) Press "Enter" on "Move To Mark". Or press "Alt-j" from the "Media 
Playback" dialog. 
3) Input the mark number in the edit box and press "Enter". 
4) If you input a non-existent mark number, The Voice Sense QWERTY 
displays, "Mark x does not exist" and the edit box is displayed again.   
 

7.1.3.5.3 Delete Mark 
 
Use the following steps to delete a mark: 
1) Open the menu and press "Enter" on "Mark". Navigate to "Delete mark". 
2) Press "Enter" on "Delete Mark". Or press "Alt-d" from the "Media 
Playback" dialog. 
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3) The Voice Sense QWERTY displays: "Enter mark name to delete:". Type 
the number of the mark to be deleted and press "Enter". 
4) If you input a non-existing mark number, an "input error" message is 
appears, and the edit box is displayed again.  
 

7.1.3.5.4 Mark Manager 
 
You can open the Mark Manager dialog to query mark information for the 
current audio file by pressing "Alt-k". You can also open the dialog using the 
menu. Open the menu by pressing “Alt” and move to "Mark". Press "Enter", 
and navigate to "Mark Manager" and press "Enter". 
The dialog consists of the "mark list", a "Move button", a "Delete button", and 
a "Close button". You can move among the controls by pressing “Tab” and 
"shift-tab". 
All of the marks for the current file appear in the "mark list" with the "name 
and setting time of mark". You can navigate to the other information in the 
list by pressing “up arrow” or “down arrow”.  
You can delete a mark in the list by pressing "Del". In addition, you can start 
playback from the specific mark by pressing "Enter" on the mark name or by 
pressing "Enter" on the "Move button"  
 
To close the mark manager dialog, press "Enter" on the "Close" button or 
press "Esc". 
 

7.1.3.6 Settings 
 
Using this menu, you can change settings for recording, playing, and general 
Media player options. To access the "Settings" menu, press “Alt” to open the 
"Media Player" menu. Press “down arrow” three times to reach "Settings", 
and press "Enter". Or, you can press s from within the "Media Player" menu. 
The "Settings" submenu appears containing four items: "Configuration", 
"Playback Settings", "Record Settings", and "Effect settings". 
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7.1.3.6.1 Configuration dialog 
 
If you press "Enter" on the first item, "Configuration", or press "Alt-c" from the 
"Media Playback" dialog, the "Configuration" dialog is displayed, containing 
the following: the "Display title" option, the "Store position of file if longer 
than:", a "Confirm" button, and a "Cancel" button. You can move among the 
controls by pressing “Tab” and "shift-tab". Move among options for a setting 
by pressing “up arrow” or “down arrow”. 
The "Display title" option allows you to set whether or not the track title is 
announced when you move to previous/next track. The default value is set to 
"Off".  You can toggle this option by pressing "Space". 
The "Store position of file if longer than:" option allows you to set memory of 
your last position on files longer than the length you specify. The default is 
set to "Off" meaning your last position is never saved. You can set the value 
to 5, 10, 30, or 60 minutes. If you set the value to 30 minutes, your last 
position is remembered for all files longer than 30 minutes. This option can 
be useful if you don't want to save the position for music files, but you want 
to save the position of audio books or podcasts.  
To save the changed settings and exit the dialog, press "Enter". Or move to 
the "Confirm" button by pressing “Tab” repeatedly and press "Enter". To 
cancel saving changes and exit this dialog, press "Esc", or "Alt-F4". You can 
also press "Enter" on the "Cancel" button to close the dialog without 
changing any options.  
 

7.1.3.6.2 Playback Settings dialog 
 
If you press "Enter" on "Playback Settings", or press "p" on the "Settings" 
menu, the "Playback Settings" dialog is displayed. In this dialog, pressing 
“Tab” or “Shift-Tab” moves among setting options, "Confirm" and "Cancel". 
The setting options are "Display time", "Repeat", "Playlist", "Shuffle", "Times 
to repeat the specified track", "Set speed", and "Time index". Press “down 
arrow” or “up arrow” to move among the various options. You can also open 
this dialog by pressing “Ctrl-s” from the "Media Playback" dialog. 
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The "Display time" option allows you to set which type of time messages are 
displayed in the "playback information" tab. You can set it to either "Elapsed 
time" or "Remaining time". You can change its value by pressing "Space".  
The "Repeat" option allows you to set whether all files in the playlist are 
played repeatedly. If this option is set to "Yes", all files in the playlist are 
played repeatedly, and if it is set to "No", the Voice Sense QWERTY stops 
playing after playing the last file in the playlist. Again, you can change the 
value of this option by pressing "Space".  
The next option is "Playlist". To play audio files from File Manager, you can 
select multiple files by pressing "Space" and play them by pressing "Enter".  
If the playlist already contains files, this setting allows you to choose whether 
you want to overwrite the playlist or to append the selected files to the 
playlist. The default value is "Overwrite" meaning the playlist is created anew 
with the selected files. If you press "Space", the value is set to "Append" and 
the selected files are appended to the playlist.  
The "Shuffle" option allows you to set the audio playback order. The default 
value is set to "Off" thus, audio files are played in the order they appear in 
the playlist. If you set "Shuffle" to "On", the playlist is reorganized in random. 
If you have just one audio file in the playlist and you switch the option to "On", 
a message "Shuffle mode not available" is displayed. 
"Times to repeat the specified track" allow you to set how many times you 
wish to repeat, when you execute section repetition. "Times to repeat the 
specified track" You can choose from values 1 to 10 or unlimited. The default 
setting is 3. Pressing "Space" increases the times to repeat the specified 
track and "Backspace" decreases the times to repeat the specified track. 
The "Set speed" option allows you to set the audio playback speed. 
The speed level ranges from 1 to 10. The default setting is 5. 
To change the value, press "Space" or "Backspace". The higher the number, 
the faster the audio playback speed.  
The "Time index" option allows you to set the time by which to jump. The 
default value is set to 1 minute. The values are "5 seconds", "10 seconds", 
"30 seconds", "1 minute", "3 minutes", "5 minutes", "10 minutes", "15 
minutes", "20 minutes", "30 minutes" and "1 hour". You can change the value 
using "Space" or "Backspace".  
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Or, you can change the value of the time index by pressing “Ctrl-Left arrow” 
or “Ctrl-Right arrow” from the "Media Playback" dialog. Press “/”, to hear 
the current time index. 
After changing the time index, press “Ctrl-Left arrow” or “Ctrl-Right arrow”, 
to jump to previous or next position by time index.  
To save your settings and exit the dialog, press "Enter" or tab to the 
"Confirm" button, and press "Enter".  To cancel the changes, and exit the 
dialog, press enter on the "Cancel" button, or press "Esc" or "Alt-F4". 
 

7.1.3.6.3 Record Settings dialog  
 
If you press enter on "Record Settings" in the "Settings" menu, or press "Alt-
r" from the "Media Playback" dialog, the Voice Sense QWERTY displays the 
"Record Settings" dialog, which contains "Recording type", "Sample rate", 
"Quality", "recording source", "Set folder", "Confirm" button and a "Cancel" 
button. You can move among the controls by pressing “Tab” and "shift-tab". 
And you can move among the options by pressing “up arrow” or “down 
arrow”. 
The "Recording type" allows you to set the default file type of recorded files. 
The default value is set to "mp3". You can toggle between "wav" and "mp3" 
by pressing "Space". 
The next three options are used to control the quality of recorded sound. 
Higher values in "Sample rate" and "Bitrate"/”Bits per channel” mean a better 
quality of recorded sound, as well as a larger file size for recorded files. In 
other words, to record high quality sound, the total time the Voice Sense 
QWERTY can record is shortened. On the other hand, if you lower the 
values of these options, the Voice Sense QWERTY can record sound longer, 
but the sound quality may not be as good. You can change these values by 
pressing "Space". When using “mp3”, “Sample rate” is available from 16000 
Hz to 44100Hz and “Bitrate” value is available from 64K to 320K.  
 When using “wav”, “Sample rate” value is available from 8000Hz to 
44100Hz and “Bits per channel” value is available between 8 bits and 16 bits.   
When you record sound using the external microphone, you must set the 
recording source to "External Mic". When you record audio using the line-in-
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cable, you must set the recording source to "Line in". When you record 
sound using the internal microphone, set the recording source to "Internal 
Mic".  
The "Set folder" option allows you to set the default folder where the 
recorded files are saved. The default value is set to "/flashdisk/media/record". 
To specify a different folder, press "Enter" on "Set folder", and a File 
Manager-type dialog is displayed. Select a folder as you would in the "Open 
Folder" dialog.  
Press "Enter" to save your settings, or "Esc" to exit the dialog without saving 
your settings. 
 
Note: the following tables show approximate available recording times when 
recording at various sample rates using both WAV and MP3. The available 
recording time is measured based on a newly formatted, empty flashdisk. 
 
  * Recording type: mp3 
- 48000Hz 320K: 217’h 55’m 
- 44100Hz 192K: 363’h 45’m 
- 32000Hz 128K: 544’h 48’m 
- 24000Hz 96K: 726’h 25’m 
- 22050Hz 80K: 872’h 27’m 
- 16000Hz 64K: 1089’h 37’m 

 
  * Recording type: wav 
- 44100Hz: 49’h 25’m 
- 22050Hz: 98’h 50’m 
- 11025Hz: 197’h 40’m 
- 8000Hz: 272’h 25’m 

 
7.1.3.6.4 Effect Settings dialog 

 
Press "Alt" to open the menu in the Media player program, move to 
"Settings" menu and press "Enter". By pressing the Down arrow. Move to 



249 
 

"Effect settings" and press "Enter". or press "Control-E" in the "Play list tab" 
or "Playback information tab".  
The "Effect settings" dialog box is displayed, containing the following options: 
"Equalizer" list box, "Bassboost", "Surround", "3D Effect", "Reverb" and 
"Echo" and "Confirm" and "Cancel" buttons. You can move among the 
controls by pressing "Tab" or "Shift-Tab". And you can move among options 
or list items by pressing the up or Down arrow.  
The "Equalizer list box allows you to choose from a number of 
preprogrammed sets of equalizer settings optimized for certain types of 
music, such as Jazz, Classical, Pop or Rock. Use the Up and Down arrows 
to navigate the "Equalizer" list. Navigate to your desired setting, and press 
"Enter". You should immediately hear the sound of your playback changed 
according to the "Equalizer setting you chose.  
 
The "Bass boost" option is used to emphasize bass sound. Enter a value 
from 0 to 20 in the edit box. The higher the value you enter, the more bass 
sound is heard.  
The "Surround" can bring out ambient sound more distinctly. Enter a value 
from 0 to 100 in the edit box. The higher the value you enter, the stronger 
the surround effect. 
The "3D Effect" can enhance the surround effect. Enter a value from 0 to 100 
in the edit box. The higher the value you enter, the stronger the 3D effect.  
The "Reverb" option adds reverberation to the audio files you are listening to.  
Enter a value from 0 to 100 in the edit box. The higher the value you enter, 
the stronger the reverb effect.  
The "Echo" option is used to add an echo effect to your audio files. Enter a 
value from 0 to 100 in the edit box. The higher the value you enter, the 
stronger the echo effect.  
To save your settings, press "Enter". To exit the dialog without making 
changes, press "Esc". 
 

7.1.4 Hot Keys in the Media Player 
 

1) Hot Keys for the Commands for the File Menu 
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Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 

Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 
 

2) Hot Keys for Commands While in the Playback menu 
Play: Enter, x, Play button 
Previous track: Alt-Left arrow, z, Previous button 
Next track: Alt-Right arrow, b, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow)  
Back 5 track: Alt-Up arrow 
Forward 5 track: Alt-Down arrow 
First track: Ctrl-Home 
Last track: Ctrl-End 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow  
Speed up: Shift-Right arrow 
Slow down: Shift-Left arrow 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow or Ctrl-Down arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
Delete play list during stop: Del 
 

3) Hot Keys for the Commands in the Record Dialog Box 
Open the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
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Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
 

4) Hot Keys for the Commands in the Position Menu 
Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
 

5) Hot Keys for the Commands in the Mark Menu 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 

 
6) Hot Keys for the Commands in the Settings Menu 

Configuration dialog box: Alt-c 
Playback settings dialog box: Ctrl-p 
Record settings dialog box: Alt-r 
Effect settings dialog box: Ctrl-e 

 
7) Hot keys for toggling options. 

Toggle “display time” between “elapsed time” and “remaining time”: t 
Toggle “repeat” between “Yes” and “No”: r  
Toggle “shuffle” between “On” and “Off”: s 

 
 
7.2 FM Radio 

 
To use the "FM Radio" program on the Voice Sense QWERTY, you must 
connect headphones to the headphone jack on the unit, as the headphone 
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cord serves as the antenna, and without it, radio reception will be poor to 
nonexistent.  
From the program menu, use the scroll buttons to navigate to the “Media” 
menu, and press “Enter”. Navigate to "FM Radio" and press "Enter". You can 
also press "r" to quickly jump to and launch the "FM Radio” from the “Media 
menu". You can launch the “FM Radio” from anywhere on the unit by 
pressing “Windows-R”. 
When the FM Radio program is launched, your Voice Sense QWERTY 
announces the radio frequency. If you have used the FM Radio program 
previously, the Voice Sense QWERTY tunes to the frequency that you last 
listened to. 
Note: the frequency range of the FM Radio is 87.5MHz to 108MHz. 
 

7.2.1 Listening to FM Radio via the internal speakers 
 
When you execute the FM Radio after connecting headphones, sound from 
the radio is directed through the headphones. As previously explained, it is 
necessary to connect the headphones to provide an antenna for radio 
reception. However, there may be times when you wish for the sound from 
the radio to output through the speakers on the Voice Sense QWERTY. To 
listen to the radio through the internal speakers, press "Fn-x", or just X, to 
toggle internal speaker output on/off.  
 
You can also change this option using the menu:  
1) Press “Alt” to open the FM Radio menu, press "Enter" on "File" menu, and 
press "Enter" on "Settings". 
2) Or press "Ctrl-e" to quickly access the "settings" dialog. 
3) "Internal speaker: No" is announced, as the speaker setting is the first 
setting in the dialog. 
4) Press "Space" to change the setting to "Yes" and press "Enter" to apply 
the setting. 
 
The radio sound should now output through both the headphones and the 
internal speakers. 



253 
 

Note: This setting is available only in the FM Radio program. If you exit the 
FM Radio program and you wish to hear the audio output of the Voice Sense 
QWERTY through the internal speakers, you must disconnect the 
headphones. 
You can adjust the radio volume independent of the general volume of the 
Voice Sense QWERTY. The radio volume can be adjusted using "shift -down 
scroll button" to lower the volume and "shift-up scroll button" to raise it.  
 

7.2.2 Frequency control 
 
While listening to the radio, to tune to another frequency, press “Alt” to open 
the menu. Navigate to "Frequency" and press "Enter" to open the 
"Frequency" menu.  
The "Frequency" menu consists of the following items: 
1) Previous Frequency 
2) Next Frequency 
3) Auto Scan Backward 
4) Auto Scan Forward 
5) Go to Frequency 
 
To navigate between these items, press “up arrow” or “down arrow”. 
Pressing "Enter" activates the selected item.  
You can also use hot keys from within the radio to quickly execute these 
commands. Press "Ctrl-Left arrow" to scan backward for the next radio 
station. If you press "Ctrl-Right arrow", your Voice Sense QWERTY 
autoscans forward. Press “Right arrow”, to increase the frequency by 
0.1MHz. Press “Left arrow”, to decrease the frequency by 0.1MHz. 
Press "Ctrl-f" to input the frequency directly. Type the frequency in numbers 
in the edit box and press "Enter" to jump to that frequency. 
In addition to using the keys on the top panel, you can use the media buttons 
on the front panel to control the FM Radio. To control the radio using the 
media buttons, the Media mode switch should be moved to the left-most 
position, "FM". After setting the Media Mode switch, pressing the "Back" 
button scans backward, and pressing the "Forward" button scans forward. 
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7.2.3 Adding and navigating presets 

 
Use the following steps to add the currently selected frequency as a preset.  
 
1) Press “Alt” to open the menu. Navigate to "Presets" and press "Enter".  
2) Navigate to "Add Preset" and press "Enter". (Use the hot key “Ctrl-s” to 
quickly access this option)  
3) The "add preset" dialog is opened and "Frequency: (current frequency)" is 
announced. 
4) Press "Tab". 
5) You are placed in the "Label" edit box. Type the name by which you want 
to identify the preset. 
6) Press "Tab" to move to "Confirm" and press "Enter". 
 
If you wish to add a frequency other than the one you're currently listening to, 
you may type the number of the frequency you wish to add in the 
"Frequency" edit box of the "add preset" dialog.  
You can navigate your presets by using “Alt-Left arrow” to move back a 
preset, and “Alt-Right arrow” to move forward a preset.  
To delete a preset, navigate to the preset and press "Del". Note: when this 
command is executed, the preset is deleted instantly without any warning or 
verification.  
You can also add and delete presets using the Preset Manager dialog. Press 
“Alt” to open the menu, and navigate to "presets" and press "Enter". 
Navigate to the "Preset Manager" and press "Enter". You can also press 
"Ctrl-m" to open the Preset Manager directly. 
The Preset Manager dialog contains the "Preset list", an "Add" button, a 
"Delete" button, a "Modify" button and a "Close" button. You can move 
through the controls by pressing “Tab” and "shift-tab". 
Pressing "Enter" on the "add" button opens the "add preset" dialog explained 
above. If you wish to change the label of a previously added preset, move to 
the desired preset item in the preset list by pressing “up arrow” or “down 
arrow”. Press “Tab” to move to the "Modify" button and press "Enter". The 
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"Modify" dialog is opened. The structure of the "Modify dialog" is the same as 
that of the "Add" dialog. The only difference is that the preset label and 
frequency are both filled in for the "Modify" dialog.  
If you want to delete a preset from the preset list, select the desired preset 
and move to the "Delete" button by pressing “Tab” and press "Enter". 
To exit the Preset Manager" dialog navigate to the "Close" button and press 
"Enter" or press "Esc". 
 
You can also use the media buttons on the front panel to add and move 
among presets. 
To use the media buttons, the Media Mode switch should be set to "FM 
radio". 
Press the "record" button for more than 2 seconds, to open the "add preset" 
dialog. To move to the previous preset in the Preset List, press the "Back" 
button for more than 2 seconds. Pressing the "Forward" button for more than 
2 seconds moves to the next preset in the preset list. 
Pressing the "stop" button for more than 2 seconds deletes the selected 
preset. 
 

7.2.4 Recording from the FM Radio  
 
To record the audio of the radio station to which you are currently listening, 
press “Alt” To open the menu, navigate to "Record (r)" and press "Enter". Or 
use the hot key, "Ctrl-r". The "record" dialog is opened and the Voice Sense 
QWERTY begins recording. 
The record dialog consists of the following controls: 
1. "Record status" status bar 
2. "Pause/Continue" button 
3. "Stop" button  
4. "Cancel" button 
 
You can move among these controls by pressing “Tab” or "shift-tab". 
While recording the radio, press "Tab" and press "Enter" on the "Pause" 
button or press "a" to pause recording. The name of this button is changed to 
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"Continue". If you activate the "Continue" button or press "g", recording 
resumes.  
To stop the recording, press "s”. Or press "Tab" and press "Enter" on the 
"Stop" button. 
To check the duration of the current recording while recording, press “down 
arrow”. The unit announces the current recording run time and total possible 
recording time.  
Recorded files are saved in the "flashdisk/media/radio" folder. The files are 
named according to the preset label and frequency. If you are recording a 
radio station that is not in your preset list, the recording is named "radio" 
followed by the frequency. The first recording of a station is numbered 01, 
and each subsequent recording of that station is numbered 02, 03, etc.  
If you stop recording, the record dialog is exited automatically. If you press 
"Enter" on the "Cancel" button or press "c", the recorded file is not saved and 
the dialog is exited.  
Note: while recording, you cannot change the preset or frequency. 
While listening to the radio, you can instantly start recording by pressing the 
"record" button on the front panel. As previously explained, make sure the 
Media Mode switch is set to FM radio mode. If you press the "record" button, 
the record dialog is opened and recording begins.  
If you press the "stop" button on the front panel during recording, recording 
stops and the recorded audio file is saved. If you press the "pause" button 
during recording, the "pause" button is changed to the "continue" button. 
Press the "pause" button again, (now the "continue" button) to resume 
recording. Pressing the "Back" button or the "Forward" button moves among 
the controls in the "record" dialog.  
 

7.2.4.1 Changing record folder 
 
To change the folder where recorded files are saved, follow these steps: 
 
1) Press “Alt” to open the menu and press "Enter" on "File". 
2) Navigate to "Record Settings" and press "Enter". Or use the hot key, "Alt-
s" to open the "Record Settings" dialog.  
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3) You are placed on the first item, "Recording type: mp3".  
4) Press “Tab” to move to the "Record folder" setting. 
5) "Record folder: /flashdisk/media/radio" is displayed. Press "Enter". 
6) The list of folders and files in the "Media" folder is displayed. Press 
"Backspace" to move back a level in the folder structure, and press “up 
arrow” or “down arrow” to move to your desired folder. 
7) Press "Space" on the folder in which you wish to store recordings and 
press "Enter". 
8) "Record folder: (Changed folder)" is announced. 
9) Press "Tab" to move to the "Confirm" button and press "Enter". 
 
When the recording type is set to “MP3”, the available "Sample rate” values 
range from 16000Hz to 48000Hz and available "Bitrate" values range from 
64K to 320K.    
When the recording type is set to “WAV”,  the available "Sample rate" values 
range from "8000Hz" to "44100Hz" and you can set the "Bits per channel" to 
8 bits or 16 bits.  
 
 To change the sample rate and bit rate, press “up arrow” or “down arrow” to 
move to the desired item to be changed. Press "Space" to change the value. 
When you have finished setting your preferences, press “Tab” to move to the 
"Confirm" button and press "Enter". 
 
Raising the values of the sample rate and bit rate produces a higher quality 
recording. However, higher quality recordings, though they have better 
sound, take up greater amounts of storage space. Be sure to set your 
recording values according to your specific quality and space requirements.  
 

7.2.5 Additional features 
 
1. Sensitivity adjustment 
If the Voice Sense QWERTY cannot tune to the broadcast frequency you 
desire, adjust the scanning sensitivity. To adjust the sensitivity, open the 
"Settings" dialog as described in Section 10.1. Press “down arrow” to 
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navigate to "Sensitivity" and press "Space" or "Backspace" to adjust the 
sensitivity. Higher values increase the scanning sensitivity of the radio. If the 
sensitivity is increased, you can fine tune to more frequencies. 
 
2. Mute 
While listening to the radio, press "Space" to mute the audio. Pressing 
"Space" once again unmutes the radio. You can also mute the radio by 
pressing the "stop" button on the front panel, and unmute by pressing the 
"play" button. If mute is activated, the radio is silent, but TTS (text to speech) 
and all other system sounds are heard. 
 

7.2.6 Hot Keys in the FM Radio 
 

Open the presets dialog box: Ctrl-e 
Open the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow 
Move to previous frequency: Ctrl-Down arrow 
Auto previous frequency: Ctrl-Left arrow or short press previous button 
Auto next frequency: Ctrl-Right arrow or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow or long press previous button 
Move to next preset: Alt-Right arrow or long press next button 
Add preset: Ctrl-s or long press record button 
Delete the preset: long press stop button or Delete 
Open the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
Mute off: short press play button or Space 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow 
Record settings: Alt-r 
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7.3 DAISY Player 
 
Using the DAISY Player on the Voice Sense QWERTY, you can listen to 
files and read books that use the DAISY format. DAISY is an acronym for 
(DIGITAL ACCESSIBLE INFORMATION SYSTEM). One advantage to 
DAISY books is that you can listen to the audio as well as read the 
associated text with the audio in DAISY books where both text and audio are 
present.  
The Voice Sense QWERTY supports DAISY books that are version 3.0 or 
earlier. The DAISY player also supports DAISY content from specialized 
service providers, such as books from NLS, BookShare, and the Open 
library. 
 
The DAISY Player supports the following book types: 
DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 
ANSI/NISO Z39.86 2002, 2005. 
NLS content: 3gp, AMR-WB+ 
Bookshare.org DAISY content,  learning Ally Audio Plus content, 
NIMAS 1.1  
DRM: supports 2006 PDTB2 authentication.  
archive.org (open library) 
 
Note: To access content from services such as BookShare and the National 
Library Service, you must sign up for these services, meet all eligibility 
requirements, and pay any associated fees if applicable. 

7.3.1 Registering with Digital Book service providers 
 
1) Registering your Voice Sense with NLS: 

As of firmware version 6.2, the Voice Sense DAISY Player supports 
playback of digital talking books from the National Library Service for the 
Blind and Physically Handicapped (NLS) as well as protected DAISY content 
from the Open library (openlibrary.org/archive.org). In order to play content 
from these services, you must register your Voice Sense with the National 
library Service.  
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Note: the following instructions assume you already have an account with 
the NLS Braille and Audio Reading Download service (BARD). If you do not 
currently have a BARD account, please contact your regional NLS lending 
library or visit: 
https://nlsbard.loc.gov/ApplicationInstructions.html 
 
To register your Voice Sense with NLS BARD, follow these steps: 
 
1) Log in to your account on the BARD main page. 
2) Choose the "Update Account Settings" link. 
3) Choose the "Add a purchased player" link. 
3) Fill out the form as requested; choose "Sense Notetaker" as the player 
type. 
4) You will receive an email confirming your request to add a purchased 
player. 
6) If there are no problems with your eligibility, within a couple of days, you 
will receive another email confirming your eligibility to add the Sense 
Notetaker to your account. This message also informs you that an email has 
been sent to HIMS to confirm your eligibility. 
7) When HIMS receives the email confirmation of your eligibility, we will send 
an email requesting your key number and notetaker model, including 
instructions for obtaining your key number. 
8) When we receive your key number and notetaker model, we will send the 
key file via email. (The key file is a small file with a .kxo extension.) 
9) Save the attachment, and copy it to the root of your notetaker's flashdisk. 
(Please be sure to copy the .kxo file to the root of the flashdisk. It must not 
be contained in a folder, but must reside at the top level of the flashdisk 
directory.) 
10) Play an NLS book. The key file installs itself on a special protected area 
of the flashdisk. 
 
To obtain your key number, follow these steps: 
1) Press "f1" to bring up the main menu. 
2) Press h to access the Help Menu. 
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3) Press "I" to bring up the Information Dialog. 
4) Navigate below "Mac Address for wireless LAN". 
5) After the words "Key Number" a 5 or 6 digit number is displayed. 
 
 

2) Setting up your notetaker with Learning Ally: 
 

Note: These instructions assume you already have an account with 
Learning Ally. If you do not have an account, you can learn more and 
obtain instructions for signing up at www.learningally.org. 
 
Instructions for obtaining a Learning Ally UAK for your notetaker: 
	  

1.) Log in to your Learning Ally account 
2.) Once you reach “My Home” page, click the “My Bookshelf” link in the 

upper right portion of the header 
3.) On the “My Bookshelf” page on the left hand side, you should see a 

selection labeled “I’m ready to listen to my audiobooks”- click the 
“Continue” button in that selection. Note: if you already have an 
authorized Learning Ally device on your account, this option is labled 
“Choose a different device”. 

4.) On the “Choose A Device” screen, select the “DAISY- Compatible 
Player” radio button and click “Continue” 

5.) On the “Setting-Up Your DAISY-Compatible Device” screen click the 
“Authorize a DAISY Device” link beneath the player model drop down 

6.) That link will open a new tab or window titled “Authorize DAISY 
Player (UAK)”, select the “Notetaker” from the drop-down list and 
click Continue 

7.) Enter your notetakers key number, and then click “Continue” 
	  
Instructions for obtaining the Key Number on the Sense notetaker 
	  

1.) Press F1 (Windows key) to bring up the main “Program” menu 
2.) Press “H” to access the “Help” menu 
3.) Press “I” to open the “Information” dialog 
4.) Use “Space-4” (down arrow) to navigate to “Key Number” 
5.) After the words, “Key Number”, a 5 or 6 digit number is displayed. 

	  
Instructions for Installing the UAK 
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1.) Save the zip file obtained from the Learning Ally site to your PC. 
2.) Connect your Sense Notetaker to the PC via the USB cable, and then 

turn it on 
3.) Extract (unzip) all the files into the root of the flash disk of the unit 
4.) Download a Learning Ally book to your Sense notetaker using the 

Learning Ally Audio Book Manager 
5.) Disconnect the Sense notetaker from the PC 
6.) Use the notetakers DAISY Player to select and play the Learning Ally 

book 
7.) Your notetaker will then prompt you for your 4 digit Learning Ally PIN 

Number. Type 7323, and press Enter. Your Sense notetaker will now 
be authorized to play Audio PLUS books, and your selection will start 
playing. 

Once your Sense notetaker is authorized, you should delete the UAK files 
from the root of the flash disk and keep a backup copy of the original zip file 
on your computer. 

	  
Instructions for setting up a HIMS notetaker as a device on the Learning 
Ally Audio Book Manager 
	  

1.) Open the Audio Book Manager, and log in 
2.) Tab to the “Player List”, arrow down to “Manage Players” and press 

“Enter” 
3.) Tab to “Add a player to Learning Ally Audio Book Manager” and press 

“Enter” 
4.) When prompted to “Select the Audio Book player you would like to 

use”, arrow down to “Manually Manage your Files” and press “Enter” 
5.) Tab to “Add player details” and press “Enter” 
6.) You are placed in a text box in which you can write a nickname for 

the player. Please create a nickname that makes the notetaker easy 
to identify so that you can identify it when choosing a player with 
which to synchronize content. For example, you may call it “Voice 
Sense” or “Voice Sense QWERTY”. By default, the nickname is “ 
Manually Manage Your Files-1” 

7.) If you tab, the next item contains the download path. You may keep 
the default or change the path.  
Note: You can also change the path to which to synchronize books 
when choosing sync options before activating synchronization. You 
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may choose to synchronize the files to a location on your computer, 
and manually copy them later to your HIMS notetaker using an SD 
card or by connecting via Mass Storage Mode, or you may connect 
your notetaker in Mass Storage Mode, and synchronize them directly 
to a chosen location on the notetaker. 

8.) Tab to “Add Player” and press “Enter” to complete the addition of 
your HIMS notetaker to your “Player List” 

9.) Tab to “Close Window” and press “Enter” to return to the “Player List” 
10.) To select your HIMS notetaker as the player to which to 

synchronize content, navigate to it using your arrow keys, and press 
“Enter” 
 
For instructions on synchronizing content or other functions of the 
Learning Ally Audio Book Manager, please see the Learning Ally 
Audio Book Manager User Guide. 

 
 
 
7.3.2 Executing the DAISY Player 

 
To	  launch	  the	  DAISY	  Player,	  follow	  these	  steps:	  

(1) Press "Enter" on "DAISY Player" in the Voice Sense QWERTY " “Media" 
menu. 
(2) Or press the shortcut key "d” from the "Media" menu.  
Or, you can launch the DAISY player from anywhere on the unit by pressing 
“Windows-D”. 
(3) When you launch the DAISY Player, all of the drives available on the 
Voice Sense QWERTY are displayed (regardless of whether they contain 
DAISY-formatted files).  
(4) You can navigate the list with “up arrow” or “down arrow”. You can open 
a drive containing DAISY-formatted files by pressing "Enter" on the drive 
name.  
(5) After opening the drive, all of the folders on the drive, and any DAISY 
book titles on the drive that you have opened are displayed.  
(6) When you locate a folder containing a DAISY book you want to open, 
press "Space" to select it.  
(7) Press "Enter" to play the book. 
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If you have DAISY books in a folder on a drive, you can go into the folder by 
pressing "Enter" on it. Make sure that you do not press "Space" on the folder. 
You can navigate the drive by using the same navigation keys used in the 
file manager. Navigate to the folder containing the DAISY book you wish to 
read or listen to. Press "Space" to select the folder, and press "Enter" to play 
the DAISY book. If you only have one DAISY book in the selected folder, it 
automatically starts playing after showing the title. If your selected folder 
contains more than 1 DAISY book, you can play the DAISY book by pressing 
"Enter" on the selected book after navigating the file list with “up arrow” or 
“down arrow”.  
If you replay a book that you have listened to before, playback resumes from 
the location where you last exited. To stop playing a DAISY book, press "Alt-
F4". A prompt box appears asking if you would like to exit the DAISY Player. 
You can select "Yes" or "No" with "Space" or "Backspace" and press "Enter".  
You can also control DAISY playback using the media buttons on the front 
panel. To use the media buttons to control the DAISY Player, the Media 
Mode switch must be set to the center position, "DAISY Mode". You can start 
DAISY playback by pressing the "play" button on the front panel. While 
playing DAISY content, press "play" again to pause playback. PRESS the 
"Back" button to move back 1 navigational element, and press the "Forward" 
button to move forward by 1 navigational element. Use the "Record" button 
to set the navigational element by which the "Back" and "Forward" buttons 
move. Controlling the DAISY Player via the Media buttons is explained in 
further detail later in this chapter.  
Open the DAISY Player menu by pressing “Alt”. The menu contains "File", 
"Document", "Mark", and "Heading". You can navigate the menu items using 
“up arrow” and “down arrow”. To activate a menu item, press "Enter".  
 

7.3.3 Components of the DAISY Player 
 
While playing DAISY content, four controls/components are available:  
1) "heading"  
2) "Information"  
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3) "Play" 
4) "Pause"  
You can move among the controls using “Tab” and "shift-tab". While playing 
a DAISY book, “heading", shows you a prefixed heading or navigation 
element as well as the text under that element if text exists. In "information", 
you can find the current page, level, phrase, elapsed time, and running time. 
You can move among these items with “up arrow” or “down arrow”. You can 
press "Enter" on "Pause" or "Play", to pause or play the audio. From 
anywhere in the four control components, you can toggle play/pause by 
pressing "Space". 
 

7.3.4 File 
 
When in the "File" menu, you can open a new DAISY book, check file 
information on the currently open book, and set voice parameters. You can 
open the "File" menu by pressing “Alt”, and press "Enter" on "File". Or, you 
can press "f" to quickly access the File menu.  
The "File" menu contains:  
1) "Open DAISY"  
2) "Voice Settings"  
3) "Book-Info" 
4) "Exit"  
You can move among these items with “up arrow” or “down arrow”. You can 
activate the selected item by pressing "Enter". 
 

7.3.4.1 Open DAISY 
 
You can open another DAISY book using "Open DAISY". To get to "Open 
DAISY", press “Alt” to open the menu, and press "Enter" on "File". Use 
“down arrow” to navigate to "Open DAISY" and press "Enter". Or, you can 
use the hot key “Ctrl-o”.  
When you activate "Open DAISY", the drive list is displayed. 
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You can also open the "Open DAISY" dialog by holding the "Stop" button. If 
you press and hold the "Stop" button again, this dialog is closed and you are 
returned to your previous position. 
The "Play” button performs the same function as "Enter" in the "Open 
DAISY" dialog. The "Stop" button, "Record" button, "Back" button and 
"Forward" buttons perform the same functions as "Backspace", "Space", “up 
arrow” and “down arrow” in the "open DAISY" dialog. 
Namely, you can move up and down by pressing the "Back" and "Forward" 
buttons in the "Open DAISY" dialog. And you can select and unselect by 
pressing the "Record" button. Press the "Stop" button, to move back a level 
in the folder structure, and press the "play" button to play the selected file in 
the "Open DAISY" dialog. 
To use these functions, you must set the Media Mode switch to "DAISY 
Mode". 
 

7.3.4.2 Voice Settings 
 
In the "Voice Settings", you can set the DAISY Player voice parameters.  
To execute voice settings, follow these steps: 
(1) Press “Alt” to open the menu.  
(2) Move to "Voice Settings", below the "File" menu and press "Enter". Or 
press "s".  
(3) Or, you can directly activate the "Voice Settings" by pressing “Ctrl-s”.  
 
Executing this option opens the "Voice Settings" dialog.  
The dialog contains the following items: 
1) DAISY play Type: (Available when a DAISY book contains both text and 
audio, this option allows you to choose your playback method.) 
2) Voice control 
- Set speed 
- Set volume 
- Set to control information of contents 
3) Confirm 
4) Cancel 
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You can move among the four controls with "Tab" or "Shift-Tab". In the 
"voice control" tab, you can move among "Set speed", "Set volume" and "Set 
to control information of contents" with “up arrow” or “down arrow”.  
To cancel this function, press "Esc or "Alt-F4". 
 

7.3.4.2.1 DAISY play type 
 
This option appears when playing text audio DAISY books. You can access 
this option directly by pressing "Ctrl-t". 
The default setting is "Audio". This means the DAISY Player plays audio in 
text audio DAISY. If you set the "Text", it plays the text in text audio DAISY, 
and thus the content is read using the TTS. 
To change the setting value, press “up arrow” or “down arrow”. After 
changing the setting value, press "Enter". Or press "Tab", to move to 
"Confirm" and press "Enter". 
 

7.3.4.2.2 Volume and Speed 
 
You can increase the levels of speed and volume with "Space", and 
decrease them with "Backspace". After setting the levels, press "Enter" to 
confirm your settings. 
Without using the "Voice Settings" menu, you can increase or decrease the 
speed and volume with the following hot keys:. 
  
1. Increase the speed: Shift-Right arrow 
2. Decrease the speed: Shift-Left arrow 
3. Increase the volume: Shift-Up arrow 
4. Decrease the volume: Shift-Down arrow 
 

7.3.4.2.3 Auto Play On/off 
 

By default, the DAISY Player automatically begins reading content when you 
open a book or return to a book that you have already read. If you are in 
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situations where it is not ideal for your notetaker to be speaking aloud, you 
may wish to turn this option off, so that you can open the DAISY Player and 
navigate text without the concern that the unit will begin reading the book 
aloud.  
From the “Auto Play” setting, press “Space” to toggle between ‘On” and “Off”. 
Press “Enter” to save the setting. When Auto play is off, when you press the 
“Play/Pause” key, the unit reads only to the end of the current phrase. When 
Auto Play is on, the unit reads continuously to the end of the book unless 
you manually pause or discontinue it.  
 

7.3.4.2.4 Set to control information of contents 
 
Use this function when you play NIMAS DAISY content. The default setting 
value is "On". To change the setting value, press "Space" or "Backspace". 
If you set this to "On", the Voice Sense QWERTY displays controls and 
information symbols while playing NIMAS DAISY content. 
NIMAS DAISY controls include "image", "description", "caption", "prodnote, 
and "table". These controls appear on the Braille display (When connected to 
SyncBraille) as "img" for image, "desc" for "description" and "prodnote", 
"cap" is for "caption", and "tdt for "table". 
 

7.3.4.3 Book-Info 
 
Using "Book-Info", you can query the information on the currently playing file.  
Press “Alt” and press "Enter" on "File". Press “down arrow” repeatedly to 
move to "Book-Info" and press "Enter" on "Book-Info". You can also activate 
"Book-Info" by pressing "Alt-Enter". 
Activating "Book-Info" opens the "Book-Info" dialog. The dialog contains a 
status box with "running time and pages", another status box containing the 
"mark information", and a "Close" button. You can move among the three 
controls with “Tab” or "shift-tab". The first status box contains "Total time", 
"Read time", "Remaining time", "Total pages", "Current page", and 
"Remaining pages". The second status box contains the "Total marks" and 
"Mark page". You can move among the items with “up arrow” or “down 
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arrow”. If you want to close the dialog, press "Enter" on "Close", and you are 
returned to the currently playing file. 
 

7.3.4.4 Exit 
 
To exit the DAISY Player, press “Alt”, and press "Enter" on "File". Press 
“down arrow” repeatedly to move to "Exit" and press "Enter". Or, you can 
press "Alt-F4" to instantly exit the DAISY Player. When you execute the 
"Exit" command, the Voice Sense QWERTY prompts, "Exit DAISY Player. 
Are you sure?" press "Enter" on "Yes", which is the default; or, if you do not 
want to exit, select "No" by pressing "Space", and press "Enter". 
 

7.3.5 Document Navigation 
 
When in the "Document" menu, you can move by phrase or level while 
playing a DAISY book. To activate the "Document" menu, press “Alt” and 
press "d".  
 
The "Document" menu contains the following items:  
1) "Play/Pause"  
2) "Previous Phrase"  
3) "Next Phrase"  
4) "Previous Page"  
5) "Next Page"  
6) "Go To Page"  
7) "Move down"  
8) "Move up"  
9) "Set To Prior Level" 
10) "Set To Next Level".  
You can move among these items using “up arrow” or “down arrow”. To 
activate a menu item, select the menu item, and press "Enter". 
 

7.3.5.1 Play and Pause 
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You can access "Play/Pause" in the menu by pressing “Alt”, and press 
"Enter" on "Document". Then, use “down arrow” to move to "Play/Pause", 
and press "Enter". You can also activate "Play/Pause" directly by pressing 
"Space". While playing, you can move to the beginning of a document by 
pressing “Fn-Left arrow”. You can move to the last phrase by pressing “Fn-
Right arrow”. 
 

7.3.5.2 Move by Phrase 
 
You can access this command in the menu by pressing “Alt,” and then press 
“Enter” on “Document”. Then, use “Down arrow” to move to “Previous 
Phrase” or “Next Phrase,” and press “Enter”. You can move to the next, 
previous, next fifth, or previous fifth phrase without opening the menu by 
pressing “Right arrow”, “Left arrow”, “Ctrl-Up arrow”, or “Ctrl-Down arrow”, 
respectively. 
Also you can move to the previous or next phrase directly with a short press 
of the "Back" button or "Forward" button on the front panel. To move by 
phrase using the "Back" and "Forward" buttons, you must set the Media 
mode switch to "DAISY mode". 
 

7.3.5.3 Move by Page 
 
You can access this item in the menu by pressing “Alt”, and press "Enter" on 
"Document". Then, use “down arrow” to move to "Previous Page", "Next 
Page", or "Go To Page", and press "Enter". You can move to the next or 
previous page directly by pressing "page down" or "page up" during play or 
pause status. You can jump to a specific page by pressing "Ctrl-g". When 
you activate "Go To Page", you are prompted "Move to page number?" Type 
the number of the page that you want to move to in the edit box. Press 
"Enter", and the Voice Sense QWERTY moves you to that page. 
 

7.3.5.4 Move by Level 
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You can access this function in the menu by pressing “Alt,” and then press 
“Enter” on “Document”. Then, use “Down arrow”to move to “Move up” or 
“Move down,” and press “Enter”.Or, you can move up and down without 
opening the menu by pressing “Alt-Left arrow” or “Alt-Right arrow”. You can 
set the level by pressing “Alt-Down arrow” or “Alt-Up arrow”. Namely, if the 
level is set to 3, you can move through the level 1, 2 and 3 and if the level is 
set to 1, you can move through the level 1 only. 
 

7.3.5.5 Move by Time Index 
 
You can use this function in the following situations: 
1. While playing an audio DAISY book or in pause status. 
2. While playing audio in an audio text DAISY book or in pause status. 
 
The setting values are "5 seconds", "10 seconds", "30 seconds", "1minute", 
"3 minutes", "5 minutes", "10 minutes", "15 minutes", "20 minutes", "30 
minutes" and "1 hour". 
 

To set previous time index, follow these steps: 
(1)  Press “Ctrl-Alt-Up arrow”. Every time you press “Ctrl-Alt-Up arrow”, 

Voice Sense QWERTY toggles between 30, 10, or 5 seconds; 1 hour 
and 30 minutes. 

(2)  Choose the setting value you want. 
 
To set next time index, follow these steps: 

(1)  Press “Ctrl-Alt-Down arrow”. Every time you press “Ctrl-Alt-Down 
arrow”, Voice Sense QWERTY toggles between 5, 10, or 30 seconds: 
1 minute, 3 minutes and 5 minutes. 

(2)  Choose the setting value you want. 
 

The time index to move by a specified amount of time is as follows. 
1) Move to previous time: Press “Ctrl-Alt-Left arrow”. If you set “5 

minutes”, it moves back 5 minutes from your current position. 
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2) Move to next time: Press “Ctrl-Alt-Right arrow”. If you set “5 minutes”, 
it moves forward 5 minutes from your current position.  

 
7.3.5.6 Move by Text Index 

 
You can use this function in the following situations: 
1. While playing a text DAISY book or in pause status. 
2. While playing text in an audio text DAISY book or in pause status. 
 
The setting values are "Phonetic", "Character", "Word" and "Sentence". 
To set previous text index, follow these steps: 
(1)  Press “Ctrl-Alt-Up arrow”. Every time you press “Ctrl-Alt-Up arrow”, Voice 
Sense QWERTY toggles between “Sentence”, “Word”, “Character” or 
“Phonetic”. 
(2) Choose the setting value you want. 
 
To set next text index, follow these steps: 
(1) Press “Ctrl-Alt-Down arrow”. Every time you press “Ctrl-Alt-Down arrow”, 
Voice Sense QWERTY toggles between “Phonetic”, “Character”, “Word” and 
“Sentence”. 
(2) Choose the setting value you want. 
 
To move by the specified text index value, follow these steps: 
(1) Move to previous text: Press “Ctrl-Alt-Left arrow”. If you set “Sentence”, it 
moves back 1 sentence from your current position. 
(2) Move to next text: Press “Ctrl-Alt-Right arrow”. If you set “Sentence”, it 
moves forward 1 sentence from your current position. 
 

7.3.6 Mark 
 
Using the "Mark" menu, you can insert a mark or jump to a previously 
created mark in a DAISY book. Up to 1000 marks can be inserted into each 
DAISY book. You can open the "Mark" menu by pressing “Alt”, then "m". In 
the "Mark" menu, you will find the following items:  
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1) "Previous Mark"  
2) "Next Mark"  
3) "Set Mark"  
4) "Move To Mark" 
5) "Delete Mark"  
You can move among the menu items using “up arrow” or “down arrow”. 
 

7.3.6.1 Previous Mark 
 
The "Previous Mark" function allows you to move to a location prior to your 
current position where you have placed a mark. You can access the 
"Previous Mark" function by pressing "Enter" on the "Mark" menu, move to 
"previous mark" by pressing “down arrow” and press "Enter". Or just press 
"p" to execute the "Previous Mark" command. You can also move to the 
previous mark by pressing "V" while reading DAISY content. 
 

7.3.6.2 Next Mark 
 
The "Next Mark" function allows you to move to a location ahead of your 
current position where you have placed a mark. You can access the "Next 
Mark" function by pressing "Enter" on the "Mark" menu, Navigate to "Next 
Mark" by pressing “down arrow” and press "Enter". Or just press "n" to 
execute the "Next Mark" command. You can also move to the next mark by 
pressing "N" while reading DAISY content. 
 

7.3.6.3 Set Mark 
 
You can set a mark anywhere you want while playing a file to note a position 
you would like to return to at a later time. You can set a mark by pressing 
"Ctrl-m" from within a DAISY book. You can also activate this function by 
pressing “Alt”. Then, press "Enter" on "Mark". Use “down arrow” to move to 
"Set Mark", and press "Enter". Or press "m" when you are in the "Mark" 
menu. The "Set Mark" dialog opens, and you are prompted to "Enter mark 
name:". Enter the number of the mark that you want to insert from 1 to 1000. 
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7.3.6.4 Move to Mark 

 
You can move to the next or previous mark by pressing "V" or "N" during 
play/pause status. You can also move to a specific mark by pressing "Ctrl-j". 
You can access this feature in the menu by pressing “Alt”. You can then use 
“down arrow” to move to "Mark", and press "Enter". Or, you can press "j" 
when you are in the "Mark" menu. If you activate the "Move To Mark" 
function, you are prompted for the "Mark name to move to:". Type the mark 
name in the edit box. If you have not previously set a mark, you cannot use 
this function.  
 

7.3.6.5 Deleting a Mark 
 
You can activate the "Delete Mark" function by pressing "Del" during 
playback. You can also activate this function from the menu by pressing “Alt”. 
Use “down arrow” to move to "Mark", and press "Enter". Use “down arrow” to 
move to "Delete Mark", and press "Enter" once more. When you activate the 
"Delete Mark" function, you are prompted to "Enter mark name to delete:". 
Make certain that you want to delete the mark that you have entered. If you 
type a mark name in this edit box, the mark is deleted without warning or 
confirmation. 
 

7.3.7 Heading 
 
When in the "Heading" menu, you can navigate a document by the available 
text headings, or you can search a heading during DAISY playback. You can 
open the "Heading" menu by pressing "Alt", and press "h".  
 
The "Heading" menu contains the following items: 
1) "Previous Heading" 
2) "Next Heading"  
3) "Scan Heading"  
4) "Read Heading"  
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5) "First Heading"  
6) "Last Heading"  
7) "Find Heading"  
8) "Find Again"  
 
You can move among the sub-menu items using “up arrow” or “down arrow”. 
 

7.3.7.1 Move by Heading 
 
While playing a DAISY book, you can move heading by heading using hot 
keys. You can move to the next, previous, first, and last heading by pressing 
“Ctrl-F6”, “Ctrl-F5”, “Ctrl-f7”, and “Ctrl-F8” respectively. You can also move 
to the previous or next heading directly using the media buttons on the front 
panel. Before you use this feature, be sure to set the Media Mode switch on 
the front panel to "DAISY mode". To move to previous or next heading, press 
the "Back" or "Forward" button for about 2 seconds and release it.  
 

7.3.7.2 Move to Specific Heading 
 
To move to a specific heading, follow these steps: 
1) Press "Ctrl-h" while playing a DAISY book. 
2) The Voice Sense QWERTY displays, "Current Heading: xx Total heading: 
yy. Enter the heading number to move to:". 
3) Type the number of the heading you want to move to. 
4) Press "Enter". 
5) The DAISY book starts playing at the specified heading.. 
 

7.3.7.3 Find Heading 
 
You can activate the "Find Heading" function by pressing "Ctrl-f". When you 
press this hot key, you are prompted, "Heading to find:" and You are placed 
in an edit box into which to type the heading name. The "Find Heading" 
dialog also contains "Search direction:", a "Confirm"button, and a 
"Cancel"button. You can move among the four items with “Tab” or "shift-tab". 
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Tab to the "Search Direction" combo box, and press "Space" to toggle 
between forward and backward. Tab to "Confirm", and press "Enter" to 
execute the search.  
 

7.3.7.4 Scan Heading and Read Heading 
 
While playing a DAISY book, you can read your current heading, or scan the 
headings from your current location to the end of the book. You can scan 
them by activating the "Read Heading" or "Scan Heading" in the "Heading" 
menu or by using the hot keys for these functions. 
You can query the current heading (in the open book, by pressing "Ctrl-w". 
When you activate this function, the current heading name and level are 
displayed. By pressing "Ctrl-n”, you can scan the heading list from the 
current position to the end of the book. The headings from the current 
position to the end are displayed in a list. Press "Enter" or "Space" on a 
heading in this list to start playback at that position. If you want to cancel the 
"Scan Heading" function, press "Esc" or "Alt-F4", and you are returned to 
your previous location. 
 

7.3.7.5 Find Phrase 
 
You can also search for a phrase in an open DAISY book.  
Follow these steps: 
1) Press “Alt” to open the menu. 
2) Voice Sense QWERTY displays, "File". 
3) Press “down arrow”, to navigate to "Heading". 
4) Press "Enter" on the "Heading" menu. Or press "h". 
5) "Previous heading" is displayed. 
6) Press “down arrow”, to move to "Find Phrase". 
7) Press "Enter" on the "Find Phrase" option. Or press "s". 
You can also open the "Find PHRASE" dialog directly by pressing "Alt-s". 
 
The "Find Phrase dialog" consists of the following: 
1) Phrase to find 
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2) Search direction 
3) Confirm 
4) Cancel 
 
You can move among the 4 controls by pressing "Tab" and "Shift-Tab". 
 
Type all or part of the phrase in the edit box. Press "Tab", to move to 
"Search direction". The default setting is "Next". You can choose "Next" or 
"Back". To change the setting value, press "Space". 
After setting the "Search direction", press "Enter". Or press "Tab", to move to 
"Confirm. Press "Enter" on the "Confirm" button. 
Playback starts at the searched phrase. 
If you want to cancel the "Find Phrase" dialog, press "Enter" on the "Cancel" 
button. Or press "Alt-F4". 
 

7.3.8 Hot Keys in the DAISY Player 
 

Play  
Play/Pause: Space 
Move to the beginning of document: Home 
Move to the last phrase: End 
Increase the speed: Shift-Right arrow 
Decrease the speed: Shift-Left arrow 
Increase the volume: Shift-Up arrow 
Decrease the volume: Shift-Down arrow 
 
Move by Phrase 
Move to the next phrase: Ctrl-Right arrow or short press “Forward” button 
Move to the previous phrase: Ctrl-Left arrow or short press “Back” button 
Move to the next fifth phrase: Ctrl-Down arrow 
Move to the previous fifth phrase: Ctrl-Up arrow 
 
Move by page 
Move to the next page: Page down 
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Move to the previous page: Page up 
Go to the page: Ctrl-g 
 
Move by level 
Move up: Alt-Left arrow 
Move down: Alt-Right arrow 
Set to prior level: Alt-Up arrow 
Set to next level: Alt-Down arrow 
 
Move by heading 
Move to the next heading: Ctrl-F6 or long press “Forward” button 
Move to the previous heading: Ctrl-F5 or long press “Back” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the current-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Move to Specific Heading: Ctrl-h 
Find Phrase: Alt-s 
 
Heading 
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
 
Set mark 
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
 
Miscellaneous Hot Keys 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
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Voice settings: Ctrl-s 
Set DAISY play type: Ctrl-t 
Check the book-info: Alt-Enter 
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8. Organizer 
The “Organizer” menu on the Voice Sense QWERTY contains items similar 
to those normally found in an electronic or hard copy organizer. The 
“Organizer” menu contains 3 items: “Address Manager”, “Schedule 
Manager”, and “Database Manager”. 
To open the “Organizer” menu, press “Windows” key to bring up the main 
menu, navigate to “Organizer” using the DOWN arrow, and press “Enter”. 
Or, you can press “o” from the main menu to quickly jump to and open the 
“Organizer” menu. 
The following sections will discuss each of the programs in the “Organizer” 
menu in detail. 
 
8.1 Address Manager 

 
8.1.1 What is the "Address Manager"? 

 
The "Address Manager" is a program that you can use to keep track of your 
contact information for friends and colleagues, such as company addresses, 
home addresses, e-mail addresses, as well as other information. 
The "Address Manager" consists of two main dialogs: "Add Address" and 
"Search Address". In the "Add Address" dialog you can enter contact 
information, such as names, company addresses, home addresses and so 
on. In the "Search Address", dialog you can look for information that is stored 
in the "Address Manager". You can edit or delete information you find. You 
can also select addresses to be printed using an ink print or Braille printer. 
IN addition, you can connect to a web site by pressing "Enter" on a 
homepage address field if the field contains an address for a web site.  
In the "program" menu, you can start the "Address Manager" by first opening 
the “Organizer” menu by pressing “O”, then typing "a". You can launch the 
“Address Manager” from anywhere on the unit by pressing “Windows-A”. 
Before going into the details of how to use the "Address Manager", let's 
discuss the structure of address data. 
The address data that is stored in the "Address Manager" consists of a set of 
records. A "record" is a collection of contact information about one person or 
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company. Each record contains 23 fields. These 23 fields are: "Last name", 
"First name", "Company name", "Title", "Mobile phone", "Home phone", 
"Home fax", "Company phone", "Company fax", "Home street address", 
"Home city", "Home state", "Home zip code", "Home country", "Company 
street address", "Company city", "Company state", "Company zip code", 
"Company country". "Home e-mail", "Company e-mail", "Home page", and 
"Memo". Thus, one record contains all the information you can enter about a 
person or company. 
 

8.1.2 Starting the "Address Manager" 
 
When you press "Enter" on the "Address Manager" in the ”Organizer" menu, 
the Voice Sense QWERTY says, "Search Address", and displays the prompt, 
"Last name:" and the "Search Address" dialog is opened. 
In the "Address Manager", you can use the menus to conveniently browse 
and execute all of the available commands. When you cannot remember the 
exact hot key for the command you want to execute, you can press “Alt” to 
open the menu and access all of the functions there. 
 

8.1.3 Using "Add Address" 
 
This dialog allows you to enter new addresses in the "Address Manager". To 
use the "Add Address" function, press “Alt” to bring up the "Address 
Manager" menu, then press “up arrow”, “down arrow” or the up and down 
scroll buttons to move to "Add Address". Then, press "Enter". Or, press "Ctrl-
n" directly from in the "Address Manager".  
 

8.1.3.1 Adding an Address 
 
"Add address" is a dialog that contains a list of 22 input fields, the "Memo" 
field, a "Confirm" button, and a "Cancel" button. In the input fields, you can 
enter the information corresponding to the 22 fields of a record. "Confirm" is 
used to save the information entered, and "Cancel" is used to discard the 
entry. You can move among the input fields, "Memo", "Confirm", and 
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"Cancel" by pressing “Tab” or "shift-tab". Among the 22 input fields, you can 
move from one field to the next by pressing the “up arrow”, “down arrow” or 
the up and down scroll buttons. Type in the appropriate information for each 
field, and press the down arrow to move to the next field. You do not have to 
fill in all of the fields. To skip a field, press the “Down arrow”, and the field is 
left blank. You are then prompted for the information for the next field. 
When you have entered information in the desired fields, you can save the 
information by pressing “Tab” or "shift-tab" repeatedly to move to the 
"Confirm" button and press "Enter". Or, you can press "Enter" in any field. 
If you don't want to save the information, press “Tab” or "shift-tab" repeatedly 
to move to the "Cancel" button, then press "Enter". 
After you cancel or save the entry, you are prompted to enter information 
into another record, beginning with the "Last name" field. 
You can use the cursor routing keys to move from one field to the next. 
In any input field, if you press the first cursor routing key to the left, the first 
input field ("Last name:") is displayed and you can type a name. To enter a 
mobile phone number without entering other information, press the 5th 
cursor routing key, then enter the phone number. To jump to the "Home e-
mail" field, the 20th field, press the 20th cursor routing key. 
If you have pressed the 23rd cursor routing key, or any key to the right of the 
23rd key is pressed, you will hear a warning sound because there are only 
23 fields in a record. 
 
You can enter telephone numbers separating the various parts of the 
number with a -. To type in a dash (-) while typing in a telephone number 
(e.g. 000-000-0000), you should press “-”. 
If you want to put an extension after a phone number, enter the phone 
number as described above, and then type a comma (,), followed by the 
extension number, as in “000-000-0000,100”.  
 
Press “tab,” to get to the “Memo” field. You can type in multiple lines of text 
in the “Memo” field. When you want to start a new line of text, press “Enter”. 
 
When you have finished entering information for a record, press “tab” until 
you reach the “Confirm” button. Press “Enter. 
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8.1.3.2 Setting Add Address Fields 

 
"Set Address Fields" enables you to select what of the 22 fields to be shown 
when you enter contact information. There are 22 fields in a record, but you 
may not want to enter information in every one of the 22 fields. You can use 
"Set Address Fields" to select only the fields that you need. 
To use this function, press “Alt” to bring up the menu, then select "Set 
Address Field", or press "o" then press "Enter". Or, you can press “Ctrl-o” 
from the "Add Address" dialog. 
To the right of each field name, "used" or "unused" is displayed. The default 
value is set to "used". To toggle the value, press "Space". 
After setting all the fields you want to change, move to the "Confirm" button 
or the "Cancel" button by pressing “Tab” or "shift-tab", and press "Enter" to 
save or cancel the changes. You can also cancel the changes by pressing 
"Esc" or "Alt-F4". 
 

8.1.3.3 Using "Search Address" in "Add address" 
 
From "Add Address", access the "Search Address" function to jump to 
another record. To use the "Search Address" function, press “Alt” to open the 
menu. Next move to "Search Address", then press "Enter", or press "s". You 
can also press “Ctrl-s” from the "Add Address" dialog. 
If you have entered information in a record before executing "Search 
Address", you are asked, "Save changes? Yes/No".  After you make your 
choice, the "Search Address" dialog is displayed. 
 

8.1.4 Searching For an Address 
 

8.1.4.1 Using "search address" 
 
The "Search Address" dialog enables you to search for information stored in 
the "Address Manager". If you execute the "Address Manager" from the 
"program" menu, the "Search Address" dialog is opened automatically. To 



284 
 

open "Search Address" from "Add Address", you can either select it from the 
menu, and press "Enter", or press “Ctrl-s” from the "Add Address" dialog. If 
you press "Enter" in the "Search Address" dialog, without typing any text, 
when "Last name:" is displayed, you can browse through all of the records 
that are stored in the "Address Manager". A "record" is a collection of 
information about one person. If more than one record is found, you can 
move to the next record by pressing “down arrow”. To move to the previous 
record, press “up arrow”. 
To navigate fields and records in the search result list, you can use the 
following hot keys: 
 
Move to a previous field in a record: Ctrl-Left arrow 
Move to the next field in a record: Ctrl-Right arrow 
Move to the first field in a record: Home 
Move to the last field in a record: End 
Move to the previous record: Up arrow 
Move to the next record: Down arrow 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 
 
You can also search records using the other fields. To find records with a 
company name, press “down arrow” repeatedly until "company name:" is 
heard. Then, type the company name, and press "Enter". The first record 
that has the company name is displayed. 
When you enter text to be searched, you do not have to type the entire 
content of a field. For example, to find a record about "Edward", type in "ed" 
in the "search name" field. Then, all the records whose name field contains 
"ed" is found. 
 

8.1.4.2 Setting Searching Address Fields 
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This option enables you to select the fields that you want to search. Press 
“Alt” to bring up the menu, and select "Set Address Search Fields". Then, 
press "Enter". Or, you can press “Ctrl-o” from the "Set Address Search 
Fields" dialog. 
To search only the name, mobile phone number, and company telephone 
number fields, move to those fields that you do not want to search by 
pressing “down arrow” or “up arrow”, then press "Space" to change the value 
of that field to "unused". By pressing "Space", you can toggle the value of a 
field between "used" and "unused".  
 

8.1.4.3 Using "Add Address" In "Search Address" 
 
You can also access the "Add Address" command from the "Search 
Address" dialog. To do this, press “Alt” to bring up the menu, then select 
"Add Address". Then, press "Enter". You can also press "Ctrl-n", from the 
"Search Address" dialog.  
 

8.1.5 Backing up and restoring the address list 
 

8.1.5.1 Backup Address List 
 
If you perform a hard reset, or if your battery dies, all of the data in the 
"Address Manager" is lost. So, it is very important that you make a backup 
file every time you make a change to the address list. To go to "Backup 
Address List", open the menu by pressing “Alt”. Then, use the up and down 
arrows to navigate to "Backup Address List". Then, press "Enter". You can 
also press "u" from the menu to get to "Backup Address List". Or, you can 
press "Ctrl-u" to activate this function directly. 
If you already have a backup file, you are prompted, "Backup file already 
exists. Continue to backup? Yes". If you have made changes to your 
address list, press "Enter" to create a new backup file. To keep the previous 
backup file press “down arrow”, to move to "No", and press "Enter". When 
you create a backup file in your address list, you will have a new backup file 
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with the extension DAT, and you will have another file with the extension 
BAK created from the previous "address.dat" file). 
 

8.1.5.2 Restore Address List 
 
To restore the address list after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to find "Restore Address List". Then, 
press "Enter" on "Restore Address List". Or, you can press "r" from the menu 
to find "Restore Address List". You can also press "Ctrl-r" to activate this 
function directly. 
If you activate the "Restore Address List" function, and you already have an 
address list, you are prompted, "Address file already exists. Which do you 
prefer? Append". If you press "Enter", the backup address list is appended to 
the current address list. If you press “down arrow” once and press "Enter" on 
"Overwrite", the new backup file is restored, erasing the old backup file. For 
example, let us assume that you have three records in your address list and 
you have ten addresses in your backup file. If you select "Append", you will 
have 13 records in your address list. In this case, three addresses could 
possibly be redundant. If you select "Overwrite", you will have 10 addresses 
backed up, and the three original addresses are deleted. If you don't want to 
either "Append" or "Overwrite", press “down arrow”, to navigate to "Cancel", 
and press "Enter". 
 

8.1.5.3 Setting Backup Options 
 
You can back up your address list manually using the "Backup Address List" 
function. You can also backup your address list automatically using the "Set 
Backup Options". To activate the "Set Backup Options" function, press “Alt” 
to open the menu. Then press “down arrow” or “up arrow” repeatedly to 
locate "Set Backup Options". Then press "Enter". Or, you can press "e" from 
the menu to go to "Set Backup Options". You can also activate the function 
directly by pressing "Ctrl-e". 
When you activate this function, a dialog opens. The dialog has three 
controls: "Backup mode" radio button, a "Confirm" button, and a "Cancel" 
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button. You can move among the controls by pressing “Tab” or "shift-tab". To 
move among radio buttons, press “up arrow”, "Backspace", “down arrow”, or 
"Space". 
The "Backup mode" has three radio buttons: "Always backup changes when 
exiting", "Manual backup", and "Prompt backup changes when exiting". 
 
1. If you select the "Always backup changes when exiting", a new backup file 
is automatically created when you exit the "Address Manager" if you modify 
the address list or add other information. 
2. If you select the "Manual backup", it does not create a new backup file 
even if there are changes to the address list. In this case, you can only 
create a new backup file using the "backup address list" menu option. 
3. If you select the "Prompt backup changes when exiting", the message 
"Backup changes? Yes" appears when you exit the "Address Manager", if 
you have modified the address list or added other information. If you press 
"Enter" on "Yes", a new backup file is created and the "Address Manager" is 
closed. If you press “down arrow” once and press "Enter" on "No", it will exit 
without making a new backup file. 
 
You can change the backup mode by pressing "Enter" after focusing on one 
of the three radio buttons. Or, you can press "Enter" on "Confirm" after 
moving to it using “Tab”. The default backup mode is set to "Prompt backup 
changes when exiting. 
 

8.1.6 Importing and Exporting CSV 
 
"CSV" is the acronym for Comma Separated Value. A CSV file is used for 
the digital storage of data structured in a table form, with the information in 
the various columns separated using commas. The "Address Manager" can 
import a CSV contact file created using MS outlook or some cell phones. 
 
1. "Import from CSV" allows you to import the data from a CSV file in to the 
"Address Manager". 
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2. "Export to CSV" allows you to export the data of the "Address Manager" 
as a CSV file. 
 

8.1.6.1 Import from CSV 
 
You can import the data from a CSV file in to the "Address Manager", using 
this function. You can execute this function, from anywhere in the "address 
Manager". 
 

8.1.6.1.1 Executing Import CSV" 
 
To execute "Import from CSV", follow these steps: 
1) Press “Alt” to open the menu. 
2) Press "down arrow” to move to "Import from CSV" and press "Enter". Or 
press "c. 
You can also activate this function by pressing "Alt-i". 
 

8.1.6.1.2 Import from CSV Controls 
 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "Path search" list 
You can move among the controls by pressing "Tab" or "Shift-Tab". 
 

8.1.6.1.3 Importing a CSV file 
 
To import a CSV file, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow” or “down arrow”, to move to "Import from CSV" and 
press "Enter". Or press "C" from the menu. You can activate this function 
directly by pressing "Alt-i". 
3) You are prompted for the "File name". 
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4) Type the name of the file you want to import. For example, to search for 
"address.CSV", type "address" or "address.CSV" in the "File name" edit box. 
5) Press "Shift-Tab" to move to "Path Search" list. Navigate to the folder that 
contains the CSV file. For example, if the CSV file is located in the download 
folder under the flashdisk, press "Enter" on the download folder to open it. 
6) After selecting the folder, press "Enter". Or press "Tab” move to "Confirm" 
and press "Enter". 
7) Import of the CSV file is performed. 
 
If you don't know the file name of the CSV file,  
1) Press "Tab" on the "File name". 
2) Move to "Path search" list. 
3) The "Open File" dialog is displayed. Use normal navigation commands to 
navigate to the CSV file and press "Enter".  
 
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4. 
 

8.1.6.1.4 Adding the data from the CSV file to the "Address 
Manager" 

 
When the CSV file is imported, "Last name: unused 1/xx" is displayed.  
Structure appears as below. 
 
1. Field list address/ Add address 
1) Unused 
2) Field name list of CSV file 
2. "Allow fields in first record" 
3. "Confirm" 
4. "Cancel" 
By pressing "Tab" or "Shift-Tab", you can move among the controls. 
By pressing “up arrow” or “down arrow”, you can move among the items in 
"Unused" and "Field name list in the CSV file". 
To add the CSV file data to the "Address Manager", follow these steps: 
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1) On "Last name: unused 1/xx", press “up arrow” or “down arrow”. Move to 
the field of the CSV file that you want to import to the "Last name" field.  
For example, there might be 5 fields like, "Name", "Company name", "title", 
"Company address" and "Company zip code" in the CSV file. "Last name: 
unused 1/6" is displayed. To import the value of the "Name" field from the 
CSV file, press “down arrow” and move to "Name". Then Voice Sense 
QWERTY displays "Last name: Name 2/6" on the LCD and Braille display. If 
there is no field value from the CSV file to import, leave the field "unused". 
If you set "First name" and "Company name", as "unused" you are prompted, 
"you must select one or more of first name and company name". You must 
select a value from the CSV file for "First name" and/or "Company name". 
2) After setting your preferences, press "Tab" to move to other field such as 
"Group", "Company", and "Title" etc. 
3) Press "Tab", move to "Allow fields in first record". You can change the 
setting, by pressing "Space". When you import the CSV file, you can choose 
whether the data from the CSV file for each field should be imported using 
this option. Some CSV files may contain data that is not equivalent to any of 
the fields in the "Address Manager", or you may simply not wish to import 
certain pieces of information.    
4) Press "Tab", move to "Confirm".  
5) Press "Enter" on the "Confirm" button. 
6) You are prompted, "Address file already exists. Which do you prefer?" 
The default value is "Overwrite". The setting values are "Overwrite" and 
"Add". You can either replace the existing file with the data imported from the 
CSV file, or you may add it to the existing address list. To change the setting 
value, press "Space. 
7) You are returned to "Search Address". 
8) Press "Enter". The data imported from the CSV file should now appear 
among your address records. 
 
To cancel this function, press "Tab” to move to "Confirm" and press "Enter". 
Or press "Alt-F4". 
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8.1.6.2 Exporting CSV 
 
You can export the data from the "Address Manager" as a CSV file, using 
this function.  
 

8.1.6.2.1 Executing the "Export To CSV" function 
 
To execute the "Export to CSV" function, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow” or "down arrow” and move to "Export to CSV". 
3) Press "Enter". Or press "x". 
You can execute this function directly by pressing "Alt-x". 
 

8.1.6.2.2 Structure of the "Export to CSV" dialog  
 
1. "File name" edit combo box 
2. "Confirm" Button 
3. "Cancel" Button 
4. "File storage" list 
You can move among the controls by pressing "Tab" or "Shift-Tab". 
 

8.1.6.2.3 How to save as CSV file 
 
To save as CSV file, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow” or “down arrow”, to move to "Export to CSV". 
3) Press "Enter". Or press "X". 
4) You are prompted, "File name".  
5) Type a file name for the exported data. 
6) Press "Tab", to move to "Confirm".  
8) Press "Enter". 
The file is saved in the "Flashdisk".  
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4". 
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8.1.6.2.4 How to change the Save Location 

 
To change the location where the CSV file is saved, follow these steps: 
1) Press “Alt” to open the menu. 
2) Press “up arrow” or “down arrow”, to move to "Export to CSV". 
3) Press "Enter". Or press "x". 
4) "File name" is displayed. 
5) Press "Tab", to move to the file list. Use normal file and folder navigation 
commands to choose a different location for saving the CSV file.   
6) Press "Tab" to move to "Confirm". 
7) Press "Enter" on the "Confirm" button. The file is saved in the new location. 
 
To cancel this function, press "Tab" to move to "Cancel" and press "Enter". 
Or press "Alt-F4". 
 

8.1.7 Commands in the Records Found List 
 

8.1.7.1 Find again 
 
To search for another name, press "Tab" or "Shift-Tab". The prompt, "Last 
name:" is displayed. You can type the new text for which you want to search. 
Just as in a new search, you can start the search by pressing "Enter".  
 

8.1.7.2 Opening a home page 
 
If a record has a homepage address or an email address, you can open the 
homepage or send an email. Move to the "Home page", "Home e-mail" or 
"Company e-mail" field by pressing “up arrow” or “down arrow”. Then, press 
"Enter" on "Home page", "Home e-mail" or "Company e-mail". 
If you press "Enter" on a "Home page", the Voice Sense QWERTY 
automatically opens the Web browser program. If you press "Enter" on a 
"Home e-mail" or "Company e-mail", the Voice Sense QWERTY opens the 
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"E-mail" program, so that you can send an email to the selected email 
address.  
Before you use this command, please make sure that you are connected to 
the internet. 
 

8.1.7.3 Editing Addresses 
 
To edit information in a record, find the desired address by using the "Search 
Address" function, then move to the field you want to change by using “Ctrl-
Left arrow” or the “Ctrl-Right arrow”. Then, press “Alt” to open the "menu", 
and select "Modify Address". Press "Enter", or you can press "Ctrl-m", to 
activate this command directly. You can now enter new information the field. 
When you have modified the information, press "Enter". The Voice Sense 
QWERTY saves the changes, and you are returned to the first field of the 
record. 
To save the changes and exit modify mode, move to "Confirm" by pressing 
“Tab” or "shift-tab", then press "Enter". To exit from modify mode without 
saving the changes, move to "Cancel" by pressing “Tab” or "shift-tab" and 
press "Enter". You can also exit from "Modify Address" by pressing "Esc" or 
"Alt-F4".  
 

8.1.7.4 Deleting Addresses 
 
To delete the record you are currently reading, open the "menu" by pressing 
“Alt”, and select "Delete Address". Then, press "Enter" or press "d" from the 
"menu". Or, you can press "Del" while viewing the record. You can also 
delete more than one record at a time as follows: 
1. Select the records to be deleted and use the "Delete" command. 
To select the record that you want to delete, press "Space" when the record 
is displayed. Selected records can be deleted by pressing the "delete" key.  
The records you have selected * symbol to the left of the "last name:" field. 
The Voice Sense QWERTY says, "selected". If you cancel a selection by 
pressing "Space" on a selected record, the / disappears, and the Voice 
Sense QWERTY says, "Canceled selection". 
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2. Select all and delete 
To delete all the records in the "Address Manager", press “Alt” to open the 
"menu" and choose "Select All". Then, press "Enter". Next, press “Alt” to 
open the "menu" again, and then select "Delete Address". Then, press 
"Enter". Or, you can press "Ctrl-a" to select all, and press "Del" to delete the 
addresses.  
 

8.1.7.5 Printing addresses 
 
This option allows you to print the selected records to a Braille printer or an 
ink printer. First, search the records to be printed with the "Search Address" 
command, then select the records that you want to print. To select a record, 
press "Space" on the record to be printed. To select all records in the 
"Address Manager", press "Ctrl-a” or choose "Select All" from the "menu", 
and press "Enter".  
After selecting the records to be printed, press “Alt” to open the "menu", and 
then select "Print Address". Then press "Enter", or press "Ctrl-p" to activate 
this function directly from the “Search Address" dialog.  The Voice Sense 
QWERTY prompts you to select a printer. The default selection is "Printer". 
Press "Space" once, and the selection is changed to "Embosser". Press 
"Space" again, and "Cancel" is selected.  Press "Enter" when the option you 
want is displayed. 
 

8.1.7.6 Saving Addresses to a File 
 
You can also save selected records to a file.  
To save selected records in a document, press “Alt” to open the "menu", 
select "Save addresses As File", then press "Enter". Or, you can press "Alt-
S" from the "Search Address" dialog after selecting the desired records. The 
"file save" dialog is displayed and you are asked to enter the file name and 
select a file format. After you type the file name, and select one of the 
available file formats, press "Enter" on "Confirm", and the selected record(s) 
are saved. This dialog is the same as the "Save As" dialog in the Word 
processor, except that, here, when you are saving addresses to a file, the 
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default file name is not displayed. Refer to section 5.1.4 to learn about the 
"Save As" dialog in the Word processor. 
 

8.1.8 Synchronizing With Microsoft Outlook 
 
The "Address Manager" can be synchronized with Microsoft Outlook on your 
personal computer to help you keep track of your information. For a more 
detailed explanation of how to connect the Voice Sense QWERTY to your 
computer and use ActiveSync or Windows Mobile Device Center to 
synchronize your contacts with Microsoft Outlook, please refer to chapter 19, 
"Using ActiveSync".  
 

8.1.9 Hot Keys in the "Address Manager" 
 

1. Move keys for moving from field to field in add address or in the “menu” 
Move to the previous field or menu item: Up arrow or up scroll button 
Move to the next field or menu item: Down arrow or down scroll button 
Move to the first field or menu item: Home 
Move to the last field or menu item: End 
 

2. Move Keys For Moving From Record To Record in the search result list 
Move to a previous field in a record: Ctrl-Left arrow 
Move to the next field in a record: Ctrl-Right arrow 
Move to the first field in a record: Ctrl-Home 
Move to the last field in a record: Ctrl-End 
Move to the previous record: Up arrow 
Move to the next record: Down arrow 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 

3. Shortcut keys in the “menu” 
Add address: i 
Modify address: m 
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Delete address: d 
Select all: a  
Save as a file: t 
Print address: p 
Backup address list: u 
Restore address list: r  
Set backup options: e 
Set address search fields: o 
Import from CSV: c  
Export to CSV: x  
 

4. Hot Keys For The Commands 
Add address: Ctrl-n 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Set backup options: Ctrl-e 
Set address search fields: Ctrl-o 
Import from CSV: Alt-i 
Export to CSV: Alt-x 
 

5. Miscellaneous hot keys 
Cancel: ESC  
Exit: Alt-F4 

 
 
8.2 Schedule Manager 

 
8.2.1 Overview 
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The "Schedule Manager" is a program used to manage important information 
about appointments, anniversaries, and events. The Schedule Manager can 
also inform you of appointments at a specified time using alarms. You can 
start the "Schedule Manager" from the "program" menu, by pressing the up 
or down arrows to move to the “Organizer” menu and press “Enter”. 
Navigate to “Schedule Manager” using the UP or DOWN arrow, and press 
“Enter” to open it. Or, you can press “O”, then "s" from the "program" menu. 
You can launch the “Schedule Manager” from anywhere on the unit by 
pressing “Windows-S”. 
The "Schedule Manager" has two main dialog boxes: "Add Schedule" and 
"Search Schedule". In "Add Schedule", you can enter information for a new 
appointment. Using "Search Schedule", you can look for information about a 
specific appointment stored in the "Schedule Manager", and edit or delete 
the schedule information.  
 

8.2.2 Starting "Schedule Manager" 
 
When you press "Enter" on "Schedule Manager", or press "s" from the 
"program" menu, the "Search Schedule" dialog box is displayed so you can 
quickly search for an appointment. You are prompted for a "Find date:" with 
the current date filled in as the default. To add a new appointment or 
schedule, press “Alt” to open the menu. Then, select "Add Schedule", then 
press "Enter". Or, you can quickly open the "Add Schedule dialog" by 
pressing "Ctrl-n" from the "Search Schedule" dialog. As with other programs 
on the Voice Sense QWERTY, you can use menus and shortcut keys in the 
"Schedule Manager".  
 

8.2.3 Setting time and date 
 
Due to the nature of appointments and schedules, it is very important that 
dates and times are entered correctly to ensure that your schedule is 
accurate and you are alerted to your appointments at the proper times 
through the "Check Today's SCHEDULE" option as well as the alarms that 
can be associated with appointments in the "Schedule Manager".  
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As date and time entry is associated with several programs on the Voice 
Sense QWERTY, such as the "Wake up Alarm", the "time And Date" option 
in the SettingsMenu, and of course the "Schedule Manager", The Voice 
Sense QWERTY provides you with a consistent interface for entering time 
and date information in these dialog boxes. Before we start talking about 
using the "Schedule Manager" we will explain how to enter the date and time.  
When you are asked to enter a date and time, you can either type in the date 
and time, or select it using shortcut keys, outlined at the end of this section. 
When entering time, use "hh mm" format, two digits for the hour, and two 
digits for the minute separated by a colon.. For example, use "10 05" to enter 
5 minutes past 10. You can enter a date in "mm dd yyyy" format, two digits 
for the month, two digits for the day, and four digits for the year, as in "09 01 
2004", with slashes separating the day, month, and year.  
You may also select the various components of your date and time using 
navigation keys: 
 
1. Date setting keys 
Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Up arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
 
2. Time setting keys 
Move to 1 hour after: Down arrow 
Move to 1 hour before: Up arrow 
Move to 10 minutes after: Ctrl-Right arrow 
Move to 10 minutes before: Ctrl-Left arrow 
Move to 1 minute after: Right arrow 
Move to 1 minute before: Left arrow 
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8.2.4 Adding a Schedule 
 
To add a new appointment, press “Alt” to open the menu. Select "Add 
Schedule", and press "Enter", or press "Ctrl-n" from the "Search Schedule" 
dialog. The "Add Schedule" dialog has a set of input fields, a "Confirm" 
button, and a "Cancel" button. The input fields are "Start date", "Start time", 
"End date", "End time", "Subject", "Location", "Memo", "Alarm time", and "Set 
recurrence schedule". You can move among the input fields by pressing 
“Tab” or "shift-tab". For the "Subject" and "Memo" fields, you can type text, 
and for the "start date", "End date", "start time", "End time" fields, you can 
either type in a date/time, or select it using the shortcut keys described 
above. If you press "Enter" on the "Confirm" button, the schedule information 
is saved. If you press "Enter" on the "Cancel" button, the entry is not saved. 
 

8.2.4.1 Start date 
 
When you start "Add Schedule", the "Start date" edit box is displayed. To 
use the date displayed, simply press “Tab” to move to the next field. To enter 
a new date, type month/day/year. Press “Tab” to move to the next field. If 
you press "Enter" accidentally after filling in this field, you are prompted, "no 
subject", then the focus moves to the "Subject" field. 
 
Note: The default "Start date" varies in the following 2 ways: 
1. If you have not searched for an appointment, the default start date is 
today's date. 
2. If you have searched for an appointment on a specific date, the default 
start date is the last date you searched. If you search appointments by 
subject, the default start date is today's date.  
 

8.2.4.2 Start time 
 
"Start time" is the second field in the "Add Schedule" dialog. By default, this 
field shows the current time. If you set the time format as "12 hour" in this 
option, the time is displayed in "am/pm" format. Otherwise, the time is 
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displayed in 24 hour format. If you have set the time format to "12 hour" 
press "Fn-x" to change between am and pm. After you have entered the time, 
press “Tab” to move to the next field. If you press "Enter" accidentally after 
entering this field, you are prompted, "no subject", then the focus moves to 
the "Subject" field. 
 

8.2.4.3 End date 
 
The "End date" is the third field in the "Add Schedule" dialog. By default, the 
date is the same date as you set in the "Start date" field. To use this date, 
press “Tab” to move to the next field. To enter a new date, type 
month/day/year. Press “Tab” to move to the next field.  
 

8.2.4.4 End time 
 
"End time" is the fourth field in the "Add Schedule" dialog. By default, the end 
time is the same time as you set in the "Start time" field. To change the time, 
type the time as hhmm. Press “Tab” to move to the next field.  
 

8.2.4.5 Subject 
 
"Subject" is the fifth field. Type the subject of an appointment. If you do not 
enter anything in this field, you cannot save the record. If you press "Enter" 
after typing in the subject, the record is saved, leaving the "Location" and 
"Memo" field empty, and the "Alarm time" field set to its default value ("Time 
of appointment"). To move to the next field press “Tab”. 
 

8.2.4.6 Location 
 
In the "Location" field, type location of your appointment. If you press "Enter" 
after typing in the location, the record is saved, leaving the "Memo" field 
empty, and the "Alarm time" field set to its default value ("Time of 
appointment"). To move to the next field, press “Tab”. 
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8.2.4.7 Memo 
 
In the "Memo" field, you can enter detailed information about an appointment. 
This is a multi-line edit box, meaning you can type more than one line of text. 
You can use most of the editing commands that are used in the "Word 
processor". Press "Enter" to create a new line. You can leave this field blank 
if you wish. Press “Tab” to move to the next field. 
 

8.2.4.8 Alarm Time 
 
The "Alarm time" function allows you to set the time when you are notified 
about an appointment. The alarm is set relative to the appointment time. For 
example, you may want the alarm to sound 30 minutes before your 
appointment, so that you are not late. The default value for this field is set to 
"Time of appointment". This means that the alarm sounds at the same time 
as your appointment. You can set the time as when you set the appointment 
time. The time can be set anywhere from one minute to forty-seven hours 
before the appointment. To set the time with shortcut keys, use the following 
commands.  
 
1. Time setting keys 
Move to 1 hour after: Down arrow 
Move to 1 hour before: Up arrow 
Move to 10 minutes after: Ctrl-Right arrow 
Move to 10 minutes before: Ctrl-Left arrow 
Move to 1 minute after: Right arrow 
 Move to 1 minute before: Left arrow 
 
If you attempt to set the time to 0, the Voice Sense QWERTY displays the 
message, "Time of appointment". If you do not want to set an alarm when 
"Alarm time" is set to "Time of appointment", press “up arrow”. "Alarm off" is 
displayed, and the alarm for this appointment is turned off. After setting the 
"Alarm time", save this appointment by pressing "Enter", or by pressing “Tab” 
to move to the "Confirm" button, and press "Enter". If you have set the 
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"Alarm time", it sounds at the specified time even if the Voice Sense 
QWERTY is turned off. To stop the alarm, press "Ctrl". 
 

8.2.4.9 Setting a recurring Schedule 
 
You can set this option when the schedule you are creating recurs 
periodically. If you clear this check box, the schedule is set to occur once. 
You can check or uncheck this option by pressing "Space". If you have 
unchecked this box, press "Enter", or press “Tab” repeatedly to move to the 
"Confirm" button and press "Enter" to save the schedule. To set a recurring 
schedule, press "Space" then press “Tab” or "Enter" to move to the combo 
box where you can set the recurrence pattern. In this combo box, you can 
select from "Daily", "Weekly", "Monthly" and "Yearly". We will discuss these 
options in more detail in the next section. 
 

8.2.4.9.1 Daily 
 
If you select "Daily", and press “Tab”, the focus moves to "Recurring interval 
of day" edit box. Here, you can enter the number of days after which the 
appointment recurs. You can type a number between 1 and 999. If you enter 
1, the appointment recurs every day, and if you enter 2, it recurs every other 
day. When you use this option, be sure the difference between the start and 
end date is shorter than the recurring interval value. For example, suppose 
that the appointment starts at 09:00, Feb. 1, 2006, and ends at 12:00, Feb. 2, 
2006. If you set the recurring interval to 1, you receive an error message, 
"The appointment duration should be shorter than the recurring interval". 
This is because it is logically impossible that the appointment duration is 27 
hours, and the appointment recurs every 24 hours. This rule is applied in the 
same way when you set weekly, monthly, or yearly recurring appointments. 
If you press “Tab” after setting the recurring interval, the "Set recurrence end 
date" check box appears. By default, it's unchecked, which indicates that the 
appointment recurs indefinitely. If you check this box by pressing "Space", 
and press “Tab”, the focus moves to the edit combo box for entering the end 
date. Enter the date on which you want the recurrence to end. 
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8.2.4.9.2 Weekly 

 
Press “Tab” to move to the "Recurring interval" edit box, after you set the 
"Recurrence" to weekly. Choose the number of weeks between each 
recurrence. You can type a number between 1 and 999. If you set it to 1, the 
appointment recurs every week, and if you set it to 2, it recurs every other 
week. The restriction on the recurring interval as in "Daily" is applied to 
"Weekly". If the recurring interval is one week, the appointment duration 
should be shorter than one week. Or you receive the error message, "The 
appointment duration should be shorter than the recurring interval". Press 
“Tab” and the focus moves to a list box where you can select the day of the 
week on which the appointment recurs. You can move between the items in 
the list box, by pressing “up arrow” or “down arrow”. To select or unselect the 
current item, press "Space". You can make more than one selection, thus 
the appointment recurs on more than one day during the week. If you don't 
select a day, it is set to the today's week day. Press “Tab”, and the focus 
moves to the "Set recurrence end date" check box.  
 

8.2.4.9.3 Monthly 
 
If you press “Tab” after setting the "Recurrence to monthly", the focus moves 
to the "Recurring type" combo box. You can set the recurring type as "Date" 
or "Day of the week". To move between the two options, use “up arrow” or 
“down arrow”. "Date" is used when you want to set an appointment recurring 
on the same day of a month, for example, on the 17th of every month, or 
every other month. On the other hand, "Day of the week" is used when you 
want to set an appointment recurring on the same week and day of the week 
of a month, for example, on Wednesday of the second week of every month. 
After selecting the "Recurring type", press “Tab” to move to the "Recurring 
interval".  
In this field, you set after how many months the appointment will recur. You 
can type a number between 1 and 999. Press “Tab” and different fields are 
shown depending on what you have selected in "Recurring type". If you set 
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the "Recurring type" to "Date", an edit box is shown, where you can type the 
day of the month when the appointment recurs. By default the date set in the 
"Start date" is shown. You can type a number between 1 and 31. If you press 
“Tab” after setting this option, the focus moves to "Set recurrence end date". 
 

8.2.4.9.4 Yearly 
 
If you set the "Recurrence" to "Yearly", press “Tab” to move to the "Recurring 
type" combo box. You can select either "date" or "day of the week", and you 
can move between them by pressing “up arrow” or “down arrow”. If you set 
the "Recurring type" to "Date", you can set the month and the day of the 
month when the appointment recurs. If you set it to "Day of the week", you 
can set the month, the week, and the day of the week when the appointment 
recurs every year. If you press “Tab” after setting "Recurring type", the focus 
moves to the "Month for recurrence" combo box. You can select the month 
of the year by pressing “up arrow” or “down arrow”. If you press “Tab” here, 
the focus moves to different fields, depending on how you have set the 
"Recurring type". If you have set the "Recurring type" to "Date", the focus 
moves to "Day for recurrence" edit box. You can type a number between 1 
and 31. If you press “Tab” the focus moves to the "Set recurrence end date" 
check box. If the "Recurring type" is set to "Day of the week", you have to set 
"recurring week" and "Day of week for recurrence".  
 

8.2.4.10 Confirm 
 
If you press "Enter" on the "Confirm" button, the appointment is saved, and 
the "Add Schedule" dialog is closed. 
 

8.2.4.11 Cancel 
 
If you press "Enter" on the "Cancel" button, the appointment information you 
entered is discarded, and you are returned to the "Add Schedule" dialog 
where you can create a new appointment. You can also cancel the entry by 
pressing "Esc". 
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8.2.5 Search Schedule 

 
"Search schedule" is used for searching Appointments that you have entered 
previously. When you start "Schedule Manager", the "Search Schedule" 
dialog is opened. You can also open this dialog from the "Add Schedule" 
dialog, by pressing “Ctrl-s”. Or you can open the menu by pressing “Alt”, and 
press "Enter" on "Search Schedule". 
There are two methods for searching an appointment: "searching by subject" 
and "searching by date". When "searching by subject", you can find a 
schedule using keywords in the subject field. When "searching by date", you 
can find schedules according to a specified date. To toggle the search mode, 
press “Alt” to open the menu and move to "Toggle Search Mode" and press 
"Enter". Or you can execute it by pressing "Ctrl-f" directly. Every time you 
press "Ctrl-f", the Voice Sense QWERTY says, "Search mode: Date" or 
"Search mode: Subject", and the searching mode is toggled. 
The last searching mode you used is saved when you exit the Schedule 
Manager.  
 

8.2.5.1 Searching by date 
 
This mode searches the schedule using a date you specify. When "Search 
Schedule" is executed in this mode, the Voice Sense QWERTY says, "Find 
date: (current date)". 
If you press "Enter" here, the Voice Sense QWERTY searches for 
appointments occurring today. To search for another date, you can type the 
date in the format "mm/dd/yyyy", or use the "move by date" hotkeys. If you 
press "Enter" after entering the date, the appointments occurring on the day 
are shown. If there is no appointment on that day, the unit announces, 
"There is no schedule registered". If appointments are present, the first 
appointment on that day is announced in the form of "date, time, and 
subject". If the appointment lasts for more than one day, "continuous 
schedule" is announced. If the appointment recurs, "recurring schedule" is 
announced. If you scheduled more than one appointment for that day, you 



306 
 

can move among the appointments on that day by pressing “up arrow” or 
“down arrow”. To move to the first appointment on a day, you can press “Fn-
Left arrow”, and to move to the last appointment on the day, and if you want 
to move to the last appointment on the day, press “Fn-Right arrow”. To move 
to the appointments on another day, press “Ctrl-Left arrow” or “Ctrl-Right 
arrow”. The previous/next appointment occurring within four months is 
displayed. To move to the first appointment stored in the Schedule Manager, 
press “Ctrl-Fn-Left arrow”, and to move to the last appointment stored in the 
Schedule Manager, press “Ctrl-Fn-Right arrow”. To obtain details  
 

8.2.5.2 Searching by subject 
 
When the Search Schedule" dialog is opened in this mode, the Voice Sense 
QWERTY says, "Search subject:" Type in the keywords to search and press 
"Enter". All schedules with the keywords are displayed. If you press "Enter" 
without typing text in the "Search subject:" edit box, the Voice Sense 
QWERTY displays all appointments in your Voice Sense QWERTY. 
To move to the next or previous schedule, press “down arrow” or “up arrow” 
respectively. Pressing “Fn-Left arrow” moves to the first item in the 
appointment list, and pressing “Fn-Right arrow” moves to the last item in the 
appointment list. 
For recurring appointments and multiple day appointments, the Voice Sense 
QWERTY only shows the schedules of the first day if you search the 
schedule by subject. For example, if you have an appointment on January 1, 
2007 and it recurs the first day of every month, the Voice Sense QWERTY 
shows this schedule on January 1, 2007 only when you search by subject. 
Press "Enter" on an appointment to read the details. Press "Esc" to return to 
the appointment list. TO SEARCH other keywords, press “Tab” to move to 
the "Search subject" edit box. 
 

8.2.6 Modify Schedule 
 
You can modify an appointment that you have previously scheduled. Move 
to the appointment you want to modify. Open the menu by pressing “Alt” and 
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press "Enter" on "Modify Schedule", or press the shortcut key "m" from the 
menu. Or you can press its hot key, "Ctrl-m" from the search results list. If 
the appointment is a recurring schedule, a prompt, displaying "Recurrence 
appointment. Open type?" appears. Choose whether you want to modify the 
recurring schedule or the schedule for a specific day. If you select "This 
occurrence", your changes affect the appointment of the day, but the 
recurring appointments on other days are not changed. If you select "The 
series", your changes affect all the recurrences. If you select "Cancel", 
"Modify Schedule" dialog is not opened and you are returned to your last 
position. Make your selection by pressing "Space" or "Backspace". Press 
"Enter" to open the "Modify Schedule" dialog. This dialog contains the same 
controls as in the "Add Schedule" dialog. The only difference is that each 
field has the value entered previously. If you have made changes you wish 
to save, tab to "Confirm" and press "Enter".  
 

8.2.7 Deleting a Schedule 
 
To delete a schedule, move to the schedule in the search results list. Press 
“Alt” to open the menu, and press "Enter" on "Delete Schedule". Or you can 
press its hot key, "Del" from the search results list. If the selected schedule is 
a recurring schedule, you are prompted, "Recurring appointment. Delete 
type?" is displayed. You can choose whether you want to delete the 
recurring schedule, or just the appointment for that day. If you select "This 
occurrence", only the current appointment is deleted. If you select "The 
series", all recurrences of the appointment are deleted. You cannot select 
and delete multiple schedules at once. You can delete only the currently 
focused appointment.  
 
If you want to completely initialize the Schedule Manager, you can delete all 
schedules by opening the menu with “Alt”, move to “Delete All Schedule”, 
and press “Enter”. You can also use the hot key “Control-Alt-q” to activate 
this option from anywhere in the Schedule Manager. You are prompted, 
“Delete all schedules” Yes”. To delete all the appointments in your Schedule 
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Manager, press “Enter”. If you do not want to delete all your appointments, 
press “Down arrow” to move to “no” and press “Enter”. 

 
8.2.8 Printing a Schedule 

 
After finding an appointment using the "Search Schedule" dialog, you can 
print an appointment using the "Print Schedule" command. Open the menu 
by pressing “Alt”, and press "p", or select "Print Schedule" and press "Enter". 
Or, from the search results list, press "Ctrl-p". The Voice Sense QWERTY 
asks you to specify the beginning date of the appointments to be printed. By 
default, the current date is displayed. If you wish, you can specify another 
date using the entry and navigation procedures described in 7.3. Press “Tab” 
to set the end date of the appointments to be printed. Again, you can enter 
or select a different date than what is displayed. Press "Enter" or “Tab”, and 
you are asked to select the type of printer to use. "Printer" is the default 
setting. Press “up arrow” or “down arrow” to move between "Embosser" and 
"Printer". If you have selected the appropriate printer type press "Enter" to 
start printing. Please make sure the Voice Sense QWERTY is connected to 
the printer and that the printer is ready to receive information. When printing 
is complete, the Voice Sense QWERTY returns to the search results list. 
 

8.2.9 Saving Appointments as a File 
 
You can save appointments stored in "Schedule Manager" as a document.  
Open the menu by pressing “Alt”, then select "Save Schedule As File", and 
press "Enter". Or press "t" from the menu. Or, from the search results list, 
press "Alt-s". The Voice Sense QWERTY asks you to specify the beginning 
and end dates of the appointments to be saved just as with "Print Schedule". 
After setting the beginning and end dates, press "Enter" or “Tab”, and you 
are prompted to enter the name and the format of the file to be saved. This 
dialog is the same as the "Save As" dialog in the "Word processor".  
 

8.2.10 Backing Up and Restoring Your Appointments 
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8.2.10.1 Backup Schedule 
 
If you perform a hard reset, or your battery dies, all of the data in the 
Schedule Manager is lost. Thus, it is very important to create a backup file 
each time you change your schedule. To backup your schedule, open the 
menu by pressing “Alt”. Then, use the “Up arrow” or “Down arrow”, to locate 
"Backup Schedule". Then, press "Enter". You can also press "u" from the 
menu. Or, you can press "Ctrl-u" to activate this function directly. 
If you already have a backup file, you are prompted, "Backup file already 
exists. Backup anyway? Yes". If you have made changes to your schedule, 
press "Enter" to create a new backup file. To keep the previous backup file, 
press “down arrow”, locate "No", and press "Enter" on it. If you make a 
backup file again in the Schedule Manager, a new backup file is created with 
the extension DAT, and another file is created with the extension BAK 
containing your previous backup file.  
 

8.2.10.2 Restore Schedule 
 
To restore your schedule after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to locate "Restore Schedule". Then, 
press "Enter". Or, you can press "r". You can also press "Ctrl-r" to activate 
this function directly. 
If you activate the "Restore Schedule" function, and you already have an 
existing schedule, you are prompted, "Schedule file already exists. Which do 
you prefer? Append" or, press “down arrow” to move to "Overwrite". You can 
choose to add to or overwrite the current schedule with the backup file. If you 
choose to append, and the backup file contains appointments that also exist 
in your current file, you will have redundant appointments. If you choose to 
overwrite and your current schedule contains appointments the backup file 
does not, these appointments are lost. If you don't want to "Append" or 
"Overwrite", press “down arrow” once more, locate "Cancel", and press 
"Enter" on it. 
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8.2.10.3 Setting Backup Options 
 
You can backup your schedule manually by activating the "Backup 
Schedule" function. You can also backup the schedule automatically by 
activating the "Set Backup Options" function. To activate the "Set Backup 
Options" function, press “Alt” to open the menu. Next press “down arrow” or 
“up arrow” repeatedly to locate "Set Backup Options". Then, press "Enter". 
Or, from the menu, you can press "e" to jump directly to "Set Backup 
Options". You can also activate the "Set Backup Options" function directly by 
pressing "Ctrl-e". 
The "backup Options" dialog has three controls, "Backup mode" radio button, 
a "Confirm" button, and a "Cancel" button. You can move among the controls 
by pressing “Tab” or "shift-tab". To move between the radio buttons, you can 
press “up arrow”, "Backspace", “down arrow”, or "Space". 
The "Backup mode" has three radio buttons: "Always backup changes when 
exiting", "Manual backup", and "Prompt backup changes when exiting". 
 
1. If you select the "Always backup changes when exiting", a new backup file 
is created automatically if you have modified or added to your schedule.  
2. If you select the "Manual backup", a new backup file is not created, even if 
there are changes to your schedule. If you select this option, you can only 
create a new backup file by using the "Backup Schedule" function. 
3. If you select "Prompt backup changes when exiting", you are prompted, 
"Backup changes? Yes" if you have modified or added to your schedule. If 
you press "Enter" on "Yes", a new backup file is created before exiting the 
Schedule Manager. If you press “down arrow” once, and press "Enter" on 
"No", you exit the Schedule Manager, without creating a backup file.  
 
You can change the backup mode by pressing "Enter" after focusing on one 
of the three radio buttons. Or, press "Tab”, and press "Enter" on "Confirm". 
The default backup mode is set to "Prompt backup changes when exiting". 
 

8.2.11 Setting Alarm Options 
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You can open the "Set Alarm Options" dialog by pressing “Ctrl-o”, or by 
pressing "Enter" on "Set Alarm Options" in the menu by pressing “Alt” in the 
"Schedule Manager". This dialog has a list of alarm option fields, a "Confirm" 
button, and a "Cancel" button. Alarm option fields include “Type of echo”, 
"Alarm duration", "Alarm repeat interval" and "Repeat". You can move 
between these fields by pressing “up arrow” or “down arrow”. You can 
access the "Confirm" and "Cancel" buttons by pressing “Tab” or "shift-tab". 
 

8.2.11.1 Alarm Duration 
 
With this option, you can change the duration of the alarm sound. You can 
set this option to a value that is between 5 and 600 seconds. The default 
value is set to 30 seconds. Press "Enter" to save the changes, and exit from 
the dialog. To set the "Alarm repeat interval" in the next field, press “down 
arrow”.  
 

8.2.11.2 Alarm Repeat Interval Time 
 
When the alarm goes off, if you do not stop it by pressing "Ctrl", the Voice 
Sense QWERTY keeps reminding you of the appointment after a specified 
time interval. The "Alarm repeat interval" option allows you to change this 
interval. You can set the value anywhere from 1 to 60 minutes, the default 
value is set to 5 minutes. To change the value, type a number between 1 
and 60. Press "Enter" to save the changes, and exit the dialog. Or, if you 
press “Tab”, the Voice Sense QWERTY moves to the "Repeat" edit box. 
 

8.2.11.3 Repetition Times 
 
The alarm sounds for the amount of time for which you set the alarm 
duration, then stops. If you have not acknowledged the alarm, after a 
specified time interval, the alarm sounds again. 
The "Repeat" field allows you to decide how many times the alarm will sound. 
You can set the value from 1 time to 10 times; the default value is set to 3. 
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To change the value, type a number between 1 and 10. Press “Tab”, and 
press "Enter" on the "Confirm" button to save your settings. 
 
An alarm repeats according to the number of times that you set for this 
option and then stops automatically. The Braille display (When connected to 
SyncBraille) on the Voice Sense QWERTY also displays the "date" and 
"subject" for the alarm. 
 

8.2.11.4 Confirm 
 
By pressing "Enter" on the "Confirm" button, the settings are saved, and the 
"Set Alarm Options" dialog is closed. 
 

8.2.11.5 Cancel 
 
If you press "Enter" on the "Cancel" button, or press "Esc" or "Alt-F4", the 
default alarm options are restored and the "Set Alarm Options" dialog is 
closed. 
 

8.2.12 Synchronizing With Microsoft Outlook 
 
The "Schedule Manager" can be synchronized with Microsoft Outlook on 
your personal computer to help you keep track of your appointments. For a 
more detailed explanation of how to connect the Voice Sense QWERTY to 
your computer and how to use ActiveSync or Windows Mobile Device Center, 
refer to chapter 19.  
 

8.2.13 Hot Keys for the Schedule Manager 
 

1. Add Schedule 
Move between fields 
Move to the next field: Tab 
Move to the previous field: Shift-tab 
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2. Hot keys for the Commands 
Search schedule: Ctrl-s 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-b 
Restore schedule: Ctrl-r 
Setting backup option: Ctrl-e 
Exit: Alt-F4  

 
3. Search schedule 

Hot keys for the commands 
Add schedule: Ctrl-n 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Toggle search mode: Alt-s 
Exit: Alt-F4 

 
4. Move keys in the search result list 
1)  Move from a appointment to another in the schedule list: 

Move to the previous a in the same day: Up arrow 
Move to the next appointment in the same day: Down arrow 
Move to the first appointment in the same day: Home 
Move to the last appointment in the same day: End 

2)  Move from one appointment to another in all the appointments 
registered: 
Move to the previous schedule: Ctrl-Left arrow 
Move to the next schedule: Ctrl-Right arrow 
Move to the first schedule: Ctrl-Home 
Move to the last schedule: Ctrl-End 

3)  Hot keys for the commands: 
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Alarm option: Ctrl-o  
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Backup schedule: Ctrl-b 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 

 
5. Cancel / Exit 
1) Cancel: ESC 

cancels the current menu or setting like the “esc” key on a personal 
computer. 

2) Exit: Alt-F4 
Exits the schedule manager. cancels any function. 

 
8.3 Database Manager 

 
The "Database Manager" is a program which can be used to create a 
database in the form that you specify. You can use the "Database Manager" 
to add records and search for data in your records.  
To open the “database Manager”, press “Windows” to bring up the “Program” 
menu. Navigate to the “Organizer” menu using the UP or DOWN arrow and 
press “Enter”, or type “O”. From the “Organizer” menu, navigate to the 
“Database Manager” using the UP or DOWN arrow and press “Enter”, or 
press “D”. You can launch the “database Manager” from anywhere on the 
unit by pressing “Windows-T”. 
 
Database Terminology 
A table contains at least one record, and a record consists of at least one 
field. You can specify attributes for each of the fields. In other words, a 
record is made up of a group of one or more fields, and a table is made up of 
one or more records. 
 
When the "Database Manager" is started, it checks whether or not a table 
has been created. If no table has been created, a "Table Manager" dialog 
appears to take you through the process of creating a new table. If there is at 
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least one table created, the "Search Records" dialog appears and the 
"Search" edit box is focused, so that you can search for data. To close the 
program while adding or searching a table, press "Alt-F4". Or you can use 
the menu. Press “Alt” to open the menu. Move to "Exit" by pressing “up 
arrow” or “down arrow” (or up or down scroll button) repeatedly, and press 
"Enter". Or you can type "z" from the menu. 
The general navigation keys for the ""Database Manager"" are as follows. 
1. Moving among controls 
Move to the previous control: Shift-Tab 
Move to the next control: Tab  
2. Moving in a list box 
Move to the previous list item: Up arrow or up scroll button 
Move to the next list item: down arrow or down scroll button 
3. Changing the selection in a prompt box 
Select the next value: down arrow, Space or down scroll button 
Select the previous value: Up arrow, Backspace or up scroll button 
 
The menu in the "Database Manager" consists of the following items. You 
can open this menu by pressing “Alt”. 
 
1. Table Manager: Create, delete, and modify tables, records, and their fields. 
When you start the "Database Manager" for the first time, the "Table 
Manager" dialog appears. 
2. Add record: Add records to the current table. 
3. Search records: Search records in the current table. You can also search 
each field in the table. 
4. List of records found: Use this menu item to navigate a list of records 
found in the table by the previous search. You can delete or modify each 
record in the list. If you have not performed a search before you using this 
function, the message, "no items", is displayed. 
5. Setting backup options: Select the method for backing up the database. 
6. Backup database: Backup all database files used in the "Database 
Manager". 
7. Restore database: Restore the previously backed up database files.  
8. Exit: Used to close the "Database Manager". 
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These menu items are explained in detail in the sections below. 
 

8.3.1 Table Manager 
 
Use the "Table Manager" dialog to create, delete, or modify a table. This 
dialog contains the following controls. 
1. Table name list: Displays the name of created tables, and their order in 
the list. 
2. Add table button: Use this option, to create a new table. 
3. Modify table button: Use this option, to change the name of a table, or 
modify the structure of the table, by adding or deleting fields. 
4. Delete table button: Use this option, to delete the table that you have 
selected in the table name list. 
5. Set default table button: Use this option, to set the table that opens by 
default when you run the program. 
6. Close button: After closing the "Table Manager" dialog, and returns you to 
your previous position in the program. When there is no table created, if you 
press "Enter" on the "Close" button, the "Database Manager" program is 
closed. 
Move among these controls by pressing “Tab” or "shift-tab". 
 

8.3.1.1 Add Table 
 
"Add table" is a dialog for creating a new table. This dialog contains "Table 
name" edit box, "created fields" list, "Add field" button, "Modify field" button, 
"Delete field" button, "Previous field" button, "Next field" button, "Confirm" 
button and "Cancel" button. Move among these controls by pressing “Tab” or 
"shift-tab". 
Suppose you want to create a table called "address book" which contains 4 
fields: name, telephone, address, and memo. Create this table as follows. 
 
1) In the "Table Manager" dialog, press “Tab” to move to the "Add table" 
button, and press "Enter". Or just press "a" from the dialog. 
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2) The "Add Table" dialog appears, and the "Table name" edit box is focused. 
3) Type "address book" and then press “Tab”. 
4) The "created fields" list is focused. As you have not yet added fields, "no 
items" is displayed in the list. As you add fields to this table, they are added 
to this list box. 
5) Press “Tab” to move to the "Add field" button, and press "Enter". Or press 
the shortcut key, "a". 
6) The "Add field" dialog is opened, and the "Field name" edit box is focused. 
7) Type "name" and press “Tab”. 
8) The "Field type" combo box is focused. Press “down arrow” or “up arrow” 
to move to "edit box", and press “Tab”. 
9) The "Set primary key" check box is focused. To set the current field as the 
primary key, press "Space" to check it. 
10) Press “Tab” to move to the "Confirm" button, and press "Enter". Now, the 
"name" field has been added to the "address book" table. 
 
To cancel adding the field, press “Tab” once more to move to the "Cancel" 
button, and press "Enter". If you have added a new field, you get a message 
saying that a new field has been added. The "created fields" list is shown 
again. Now, "name" field appears in the list, with the form, "name (edit box, 
pri) 1/1". Since only one primary key exists in a table, if you have set a field 
as the primary key, the "Set primary key" check box is not shown in the "Add 
field" dialog when you add another field.  
Add the "telephone", "address", and "memo" fields by repeating steps 5 
through 10 above. Note that you may want to set the "Field type" of the 
"telephone" field to "number", "address" to "edit box", and "memo" to "multi 
line edit box". Once you have added all of the fields you wish to add, press 
“Tab” to move to the "Confirm" button, and press "Enter". 
To change the name of a created field, move to the field name you want to 
change in the "created fields" list. Press "m" or “Tab”, and enter on the 
"Modify field" button. "Field name: (selected field name)" is displayed. Type 
the new name for the field and press "Enter". Though you can change the 
name of a field, it is not possible to change the properties of a field once it is 
created. 
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To delete a created field, press “up arrow” or “down arrow” repeatedly in the 
"created fields" list to move to the name of the field you want to delete. Press 
“Tab” repeatedly to move to "Delete field" button and press enter or press "d", 
to activate the shortcut key for the "Delete field" button. You may also press 
“Tab” repeatedly to move to the "Delete field" button and press "Enter". 
To change the placement of a field in your table, move to the field that you 
want to change in the "created fields" list. Press "p" or "n". Or press “Tab” 
and enter on the "Previous field" button or "Next field" button to change the 
location of the current field. 
The "Add Table" dialog is closed, and the "table name" list box is shown 
again. The newly created table is added to this list, and "address book 1/1" is 
shown in the list. To close the "Table Manager" dialog, press “Tab” to move 
to the "Close" button, and press "Enter". Or press "Alt-F4" to close the dialog. 
Then, the "Search Records" dialog is opened, and the "name" field, the first 
field of the "address book" table, is shown. Here, type the name you want to 
search for. 
 

8.3.1.2 Modify Table 
 
"Modify table" is used to modify the name or structure of a created table. It 
contains the same controls as in the "Add Table" dialog. To modify a table, 
press “Alt” to open the menu, and press "Enter" on "Table Manager". Or 
press the hotkey for "Table Manager", "Ctrl-t". When the "Table Manager" 
dialog is opened, the "table name" list is focused. Press “up arrow” or “down 
arrow” to move to the table that you want to modify, and press "m", the 
shortcut key for the "Modify table" button. Or press “Tab” repeatedly to move 
to the "Modify table" button, and press "Enter". The "Modify Table" dialog 
appears. This table is the same as the "Add Table" dialog. The only 
difference is that the "Table name" edit box, and "created fields" list contain 
the information already stored in the table. You cannot change the name of a 
table. 
To add additional fields, press “Tab” to move to "Add field" and press "Enter". 
Type the new field name and press "Enter". To delete an already created 
field, press “up arrow” or “down arrow” repeatedly in the "created fields" list 
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to move to the name of the field you want to delete. Press “Tab” repeatedly 
to move to the "Delete field" button and press enter or press "d", to activate 
the shortcut key for the "Delete field" button. You can also press “Tab” 
repeatedly to move to the "Delete field" button and press "Enter". 
To change the order of a field in your table, move to the field that you want to 
change in the "created fields" list. Press "p" or "n". Or press “Tab” and enter 
on the "Previous field" button or "Next field" button. 
To change the name of a created field, move to the field name you want to 
change in the "created fields" list. Press "m" or “Tab”, and enter on the 
"Modify field" button. "Field name: (selected filed name)" is displayed. Type 
the new name for the field and press "Enter". 
Though you can change the name of a field, it is not possible to change the 
properties of a created field. 
 

8.3.1.3 Delete table 
 
Use this option to delete a table. To delete a table, Press “Alt” to open the 
menu, and press "Enter" on "Table Manager". Or press "Ctrl-t", the hot key 
for opening the "Table Manager". When the "Table Manager" dialog is 
opened, the "Table name" edit box is focused. In this list box, move to the 
name of the table you want to delete by pressing “down arrow” or “up arrow” 
repeatedly, and press "d", the shortcut key for the "Delete table" button. Or 
press “Tab” repeatedly to move to the "Delete table" button, and press 
"Enter". You are prompted, "Delete table? Yes". To delete press "Enter". To 
cancel, press "Space" to select "No", and press "Enter". 
 

8.3.1.4 Set Default Table 
 
When you set a table as the default table, each time the "Database 
Manager" is started, this table is displayed and you are placed in the search 
dialog. If you have created more than one table and you use one of them 
more frequently than the others, it may be convenient for you to set this table 
as the default table. If no table is set as the default table, the last table used 
is displayed when opening the "Database Manager".  
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To set a table as the default table, press “Alt” to open the menu, and press 
"Enter" on table manager. You can also press "Ctrl-t", the hot key for 
opening the "Table Manager". The "Table Manager" dialog appears, and the 
"table name" list is focused. In this list, press “down arrow” or “up arrow” 
repeatedly to move to the name of the table you want to set as the default 
table. Then press "s", the shortcut key for the Set default table" option. Or 
press “Tab” repeatedly to move to the "Set default table" button and press 
"Enter". Or simply press "Enter" on the name of the table in the "table name" 
list. The Voice Sense QWERTY announces that the table is set as the 
default table, and the "Table Manager" dialog is closed. 
 

8.3.2 Add Record 
 
 Use this option to add information to a table that you have created. When 
the "Database Manager" is started, the "Search Records" dialog is opened. 
To open the "Insert a New Record" dialog, press “Alt” to open the menu, and 
press "Enter" on "Insert a New Record". Or press "Ctrl-n" from the dialog.  
Think of a record as a collection of information (fields) for an object (record). 
Let's consider the "address book" table you created in the previous section. 
YOU can add records to this table using the method described below: 
1) Press “Alt” to open the menu, and press "Enter" on "Insert a New Record". 
Or press "Ctrl-n" from the records list. 
2) The "name" field, the first field in the "address book" table, is shown. Type 
the name of the person for whom you want to create a record, and press 
“Tab”. 
3) The "telephone" field is focused. Type the person's phone number. Since 
this field is a "number" field, a limited set of characters including numbers 
and hyphen is available. Enter a number. If you press "Space" instead of “-” 
(hyphen), the hyphen is entered. 
4) Press “Tab” to move to the "address" field. Type the address. 
5) Press “Tab” to move to the "memo" field. Since this field is a "multi edit 
box", you can type multiple lines of text. To start a new line, press "Enter". 
6) Press “Tab” to move to the "Confirm" button. If you press "Enter", the 
record is added to the table. If you do not want to save the record you have 
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created, press “Tab” once more to move to the "Cancel" button, and press 
"Enter". Or press "Esc". 
If you have added a record, the "name" field is focused again so you can add 
another record.  
To go back to the "Search Records" dialog, press “Ctrl-s”. To open the 
"Table Manager" dialog, press "Ctrl-t". If you open these dialogs while 
entering a record, you are asked to save the record. Select "Yes" or "No" by 
pressing "Space" or "Backspace", and press "Enter". If you select "Yes", the 
record is saved, and if you select "No", it is not saved and the specified 
dialog is opened. If you select "Cancel", the dialog is not opened. 
 

8.3.3 Search Records 
 
Once you have added records, you will likely want to access this information 
in an efficient manner. To search for information in your records, use the 
"Search Records" dialog. To open the "Search Records" dialog, press “Alt” 
and press "Enter" on "Search Records". Or press “Ctrl-s”. The "Search 
Records" dialog is opened, and the first field of the table is focused. Type the 
text that you want to search for.  
Using the Address Book example, the focused field is the "name" field. Thus, 
type a person's name in the edit box to look up "/her record. If you have 
several records under the same name, you may wish to further specify the 
record you are looking for. To search for records using content from more 
than one field, press “Tab” to move to another field. Type the text to search 
for in this field, and press "Enter".  
The "List of Records Found", or rather, records that matched your search, is 
opened. In the "List of Records Found", each record is shown in the following 
form. "(the name of the first field) : (other information in the record) xx/yy". 
"yy" is the total number of records found, and "xx" is the order of the current 
record in the list. If no record is found, you are informed, "No records found", 
and the current field is shown again, so you can type another search queery. 
Move through the "List of Records Found" as follows. 
 
1.Move by records 
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Move to the next record: Down arrow or down scroll button 
Move to the previous record: Up arrow or up scroll button 
Move to the last record: Ctrl-End 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 
Move to the first record: Ctrl-Home 
2. Move between the fields in a record 
Move to the next field: Ctrl-Right arrow 
Move to the previous field: Ctrl-Left arrow 
Move to the last field: End 
Move to the first field: Home 
 
From the "List of Records Found", to search for new text, press “Ctrl-s” to 
open the "Search Records" dialog again. Type the new text you want to 
search for and press "Enter". 
 
To delete a record, press “up arrow” or “down arrow” to move to the record, 
and press "Del" from any of the fields in the record. You are asked if you 
really want to delete the record. Select "Yes" or "No" by pressing "Space" or 
"Backspace". If you press "Enter" after selecting "Yes", the record is deleted, 
and if you select "No", the deletion is canceled.  
To search for records in another table, press "Ctrl-t" to open the "Table 
Manager" dialog, and press "Enter" on the name of the table you want to 
open. 
To change the content of a record, select the record by pressing “up arrow” 
or “down arrow” repeatedly. And press "Ctrl-m" from any field in the record. 
The same dialog as the "Insert a New Record" dialog is opened. To change 
the content of a field, move to the field by pressing “Tab”, type the new 
content, and press "Enter". To save the modifications, press "Enter" after 
typing new content for all the fields you want to change. Or move to the 
"Confirm" button by pressing “Tab” repeatedly, and press "Enter". To cancel 
modification of the record, press “Tab” once more to move to the "Cancel" 
button and press "Enter". 
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8.3.4 List of Records Found 
 
The "List of Records Found" appears when the queery you typed in the 
"Search Records" function produces results. While using the "Insert a New 
Record" or "Search Records" dialog, to go to the "List of Records Found", 
press “Alt” to open the menu, and press "Enter" on "List of Records Found". 
Or  press "Ctrl-r". 
 

8.3.5 Setting Backup Options 
 
You can backup your database file, manually using the "Backup Database" 
function. You may also backup your database file automatically by using the 
"Set Backup Options". To activate the "Set Backup Options" function, press 
“Alt” to open the menu. Press “down arrow” or “up arrow” repeatedly to move 
to "Set Backup Options". Press "Enter". Or, press "e" from the menu to go to 
"Set Backup Options". You can also activate the function directly by pressing 
"Ctrl-e". 
The "Backup Options" dialog has three controls: "Backup mode" radio button, 
a "Confirm" button, and a "Cancel" button. Move among the controls by 
pressing “Tab” or "shift-tab". To switch among the radio buttons, press “up 
arrow”, "Backspace", “down arrow”, or "Space". 
The "Backup mode" has three radio buttons: "Manual backup", "Always 
backup changes when exiting", and "prompt to backup changes when 
exiting". 
 
1. If you select the "Manual backup", it does not create a new backup file 
even if there are changes in the database. In this case, you can only create 
a new backup file by using the "Backup Database" menu. 
2. If you select the "Always backup changes when exiting", a new backup file 
is automatically created  on exit if you modify or add to the database.  
3. If you select the "Prompt to backup changes when exiting", if you have 
modified or added to the database, you are prompted, "Backup changes? 
Yes" when you exit the "Database Manager". If you press "Enter" on "Yes", it 
automatically creates a new backup file and exits the "Database Manager". If 
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you press “down arrow” once and press "Enter" on "No", it exits without 
creating a new backup file. 
 
To change the backup mode, press "Enter" after focusing on one of the three 
radio buttons. Or, press "Enter" on "Confirm" after moving to it by pressing 
“Tab”. The default backup mode is set to "Prompt to backup changes when 
exiting". 
 

8.3.6 Backup Database 
 
If a hard reset is performed, or if your battery dies, all of the data in the 
"Database Manager" is lost. Thus, it is very important that you create a 
backup file every time you make a change to the Database file. To go to 
"Backup Database", open the menu by pressing “Alt”. Use “up arrow” or 
“down arrow”, to locate "Backup Database". Press "Enter". You can also 
press "u" from the menu to get to "Backup Database". Or, press "Enter-u" to 
activate this function directly. 
If you already have a backup file, you are prompted, "Backup changes? Yes". 
If you have made any changes to your database file, press "Enter" to create 
a new backup file. To keep the previous backup file, press "Space", to 
navigate to "No", and press "Enter" on it. When you create a backup file in 
your "Database Manager", a new backup file with the extension SDF is 
saved. The name of the backup file is "UserDatabase.sdf" 
 

8.3.7 Restore Database 
 
To restore the database file after a hard reset, press “Alt” to open the menu, 
and use the up and down scroll buttons to locate "Restore Database". Press 
"Enter". Or, press "r" from the menu. You can also press “Ctrl-o” to activate 
this function directly. 
If you activate the "Restore Database" function, and you already have a 
database file, you are prompted, "Database file already exists. Restore? 
Yes". If you press "Enter", the backup database file is restored to the current 
database file. To cancel, press "Space" and press "Enter".  
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8.3.8 Hot Keys for "Database Manager" 

 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Set backup options: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 

1. Movement controls 
Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow or down scroll button 
Move to the previous list item: Up arrow or up scroll button 

3. Select answer in the prompt box 
Move to the next answer: Space or Down arrow 
Move to the previous answer: Backspace or Up arrow 

4. Move in the “list of records found” 
Move to the next record: Down arrow or down scroll button 
Move to the previous record: Up arrow or up scroll button 
Move to the last record: Ctrl-End 
Move to the first record: Ctrl-Home 
Move to the next field: Ctrl-Right arrow 
Move to the previous field: Ctrl-Left arrow 
Move to the last field: End  
Move to the first field: Home 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 
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9. Web Tools 
The “Web Tools” menu contains programs used for searching for and 
downloading content from the World Wide Web. The “Web tools” menu 
contains 4 items: “Web Browser”, “Quick Browser”, “Google Search”, and 
“RSS Reader”. 
To open the “Web Tools” menu, press “Windows” to bring up the main 
“Program” menu, navigate to “Web Tools” using the UP or DOWN arrow, and 
press “Enter”. Or, you can press “B” from the main menu to quickly jump to 
and open the “Web Tools” menu. 
The following sections will discuss the programs in the “Web Tools” menu in 
detail. 
 
9.1 Web Browser 

 
You can use the "Web Browser" on the Voice Sense QWERTY to read 
pages on the web, as well as to read html documents you have saved to disk. 
In addition, you can download and read books from places such as Web 
Braille, and BookShare. Note: to access these services, you must create an 
account with the service provider.  
To launch the "Web Browser", open the “Web Tools” menu as described 
above, and press "Enter" on the ""Web Browser"" from the "Web Tools" 
menu. Or, press "b" from the "Web tools" menu. You can launch the “Web 
Browser” from anywhere on the unit by pressing “Windows-B”. 
The Voice Sense QWERTY opens the "Web Browser" and connects to the 
web page set as the "home page". Note: the "Web Browser" supports SSL 
1.0 to 3.0. You can also launch the "Web Browser" by using the global hot 
key for opening a web page: Press "Fn-w" from anywhere on the unit. The 
Voice Sense QWERTY, opens up a computer edit box into which you can 
type in the URL you want to go to. When you have entered the web address: 
press "Enter". The "Web Browser" opens, and takes you to the web page 
you requested. 
 

9.1.1 File 
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The "File" menu can be accessed by selecting "File" after pressing “Alt”. 
"File" appears on the Braille display (When connected to SyncBraille). Press 
"Enter" on "File", to open the "File" menu. To move among the menu items, 
press the up arrow (“up arrow”) or the down arrow (“down arrow”). The 
following is a detailed explanation of the "Web Browser" "File" menu. 
 

9.1.1.1 Open URL 
 
Press “Alt” to open the "Web Browser" menu. Move to "File", and press 
"Enter". The first item that is displayed is "Open URL". Press "Enter" to 
access the "Open URL" edit box, or press "Ctrl-l" from anywhere in the 
Browser. The edit box for entering an address is displayed with the address 
of the current page filled in. Type the web address you would like to access 
such as "www.google.com", and press "Enter". 
When in the edit box, you can view recently accessed web addresses by 
pressing the “down arrow”. Move to the address that you want to open using 
the up arrow” or the “down arrow”, and press "Enter" on the desired address 
to open it.  
If the Voice Sense QWERTY cannot connect to the desired web page, 
indicated by displaying progress on the Braille display (When connected to 
SyncBraille) for an extended period of time, press "Esc" to stop connecting, 
and execute "Open URL" again. You can type in the address and try to 
connect again, or type a different address to access. You can stop the "Web 
Browser" from connecting by pressing "Alt-F4. Sometimes, pages can freeze 
due to network or Internet problems. 
 

9.1.1.2 Open 
 
"Open" allows you to open locally stored content in the "Web Browser". To 
access "Open", press “Alt” to open the "menu", and press "Enter" on "File". 
Go to "Open" by pressing “down arrow”, and press "Enter". Or, you can 
press “Ctrl-o” from anywhere in the Browser. The "Open" dialog is displayed. 
The "Open dialog" consists of "file list", "File name", "Type", "Confirm" button 
and "Cancel" button. You can move among the controls by pressing “Tab” or 



329 
 

"shift-tab". When the "Open dialog" is opened, File name" is focused. Type in 
a file name, and then press "Enter" or press "Shift-tab" to move to the file list. 
Select the desired file name, and press "Enter". 
The default folder is "/flashdisk/download". Navigate files and folders as 
explained in the "File Manager". 
There are three types of files in "Type": "all files", "htm", "html". *** is the 
default and means that all types of files are shown in the file list. 
At "Type", press “up arrow” or “down arrow” to select the file type. 
To check the current path, press "Fn-/(slash)". You can use this command in 
the following dialogs: "Save As", "Add To Favorites", and the "Favorites List". 
 

9.1.1.3 Save As 
 
Use "Save As" to save the currently open document or web page as a 
different file type or store web content on your Voice Sense QWERTY for 
later viewing. This is similar to "Save As" in the word processor.  
To execute "Save As", open the "menu" by pressing “Alt”, and press "Enter" 
on "File". Move to "Save As" by pressing “down arrow” and press "Enter", or 
press "Ctrl-s" while in the Browser. The "Save As" dialog appears. Type in a 
new file name, and press "Enter" to save the file using a different name or 
format.   
In this dialog, you'll find "File name" edit combo box, "Type" combo box, 
"Confirm" button, "Cancel" button and "file list". You can move among these 
items by pressing “Tab” or "shift-tab". 
To edit the file name that is displayed on the Braille display (When 
connected to SyncBraille), press the cursor routing key that corresponds with 
the text that you want to edit. Please remember that “:” cannot be used in file 
names. You have to delete “:” if there is one in your file name. 
To select the file name from the existing file name, press "shift-tab" to move 
to "file list". The default folder is "/flashdisk/download". To move back a level 
in the folder structure, press "Backspace". To enter a selected folder or 
select a file, press "Enter" on the folder or file. Press “down arrow” or “up 
arrow” To move to the next or previous folder or file.  
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You can move from "File name" to "Type" by pressing “Tab”. The available 
file types are htm, html, brl, brf and txt. Use “down arrow” or “up arrow” to 
select the file type.  
Press “Tab” to move to "Confirm" and press "Enter" to save. Or, press “Tab” 
again to move to "Cancel" and press "Enter" to cancel "Save As". 
If you do not want to save, you can also press "Esc” or "exit (Alt-F4)". 
 

9.1.1.4 Page Information 
 
"Page Information" displays how many tables, forms, and controls are on the 
current page. 
To open "Page Information", press “Alt” to open the "menu", and press 
"Enter" on "File". Move to "Page Information" by pressing “down arrow” a few 
times, and press "Enter". Or, you can press the letter "I". 
 

9.1.1.5 Exit 
 
This command terminates the "Web Browser", and returns the Voice Sense 
QWERTY to the "program" menu. You can exit the "Web Browser" by 
pressing "Alt-F4", or by selecting "Exit" from the "Web Browser" file menu. 
 

9.1.2 Read 
 
Use the "Read" menu to read the web page by various text elements. To 
open the "Read" menu, press “Alt”, and press "Enter" on "Read" or press r 
from the menu. 
The "Read" menu contains 3 items: 
 
1. Read From Beginning To Cursor 
2. Read From Cursor To End 
3. Auto Scroll 
You can move among the menus by pressing “down arrow” or “up arrow”. To 
execute an option, press "Enter". 
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9.1.2.1 Read from Beginning to Cursor 
 
This function reads the current page from the beginning to the cursor 
location.  
To execute this function, press "Enter" on "Read From Beginning To Cursor" 
in the "Read" menu. Or, you can press "Alt-g" while in a web page.  
To interrupt speech before the Voice Sense QWERTY has finished reading 
to the cursor location, press "Ctrl".  Your cursor is placed at the location 
where you stopped reading. 
 

9.1.2.2 Read from Cursor to End 
 
This function reads the current page from the cursor position to the end of 
the page. 
To execute it, press "Enter" on "Read From Cursor To End" in the "Read" 
menu. Or you can press "FN-Enter" while in a web page. 
To interrupt reading before the Voice Sense QWERTY has finished reading 
to the end, press "Ctrl". Your cursor is then placed at the position at which 
you stopped reading.  
 

9.1.2.3 Auto Scroll 
 
This function scrolls the current page from the cursor to the end of the page 
using the Braille display (When connected to SyncBraille). 
To execute the "Auto Scroll" function, press "Enter" on "Auto Scroll" in the 
"Read" menu. Or, while in a web page, you can turn the auto scroll feature 
on and off by pressing the up and down scroll buttons simultaneously. For 
faster scrolling, press "Right arrow”. For slower scrolling, press "Left arrow”. 
 
 

9.1.3 Edit 
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The "Edit" menu is used to select any part of the web page and copy or add 
it to the clipboard for use in other applications such as the "Word Processor" 
or "E-mail". 
To open the "Edit" menu, press “Alt”, and press "Enter" on "Edit" or press "e" 
from the menu. 
 

9.1.3.1 Start selection 
 
This command cannot be used on the controls in the web page, but can be 
used on the text or in an edit box. This means you cannot set a block when 
on links, but you can select text chunks on a web page, or an edit box on a 
bulletin board.  
To use this command, navigate to the point at which you wish to start 
selecting text. Press “Alt” and  move to the "Edit" menu by pressing “down 
arrow” and press "Enter". Navigate to "Start Selection" and press "Enter".  
You can also set the starting point of the block by pressing “Ctrl-b” directly. 
 

9.1.3.2 Copy  
 
Use this command to copy your selection to the clipboard for use in other 
applications. To copy the selected section of the web page, press “Alt”, move 
to the "Edit" menu by pressing “down arrow” and press "Enter". Move to 
"Copy" by pressing “down arrow” and press "Enter". Or you can copy the 
selected section by pressing "Ctrl-c" while in a web page. 
 

9.1.3.3 Add to clipboard 
 
Sometimes, you may wish to copy various sections from a web page all at 
once, in which case, you will not want your last selection erased each time 
you copy a new one. You can use the "Add to clipboard" option to append 
each of your selections to the clipboard. 
To add a selection to the clipboard, press “Alt”, move to "Edit" menu by 
pressing “down arrow” and press "Enter". Press “down arrow” to move to 
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"Add To Clipboard" and press "Enter". Or you can add to the clipboard 
directly by pressing "Ctrl-Insert".  
 

9.1.3.4 Copy URL 
 
The "Copy URL" function copies the address of the web page on which you 
are currently located to the clipboard. 
To copy the address of the web page, press “Alt”, move to the "Edit" menu 
by pressing “down arrow” and press "Enter". Press “down arrow” to move to 
"Copy URL" and press "Enter". Or you can copy the URL directly by pressing 
"Alt-d".  
The web address of the page is placed on the clipboard. You can paste it to 
a document, or anywhere you can paste text on the Voice Sense QWERTY. 
 

9.1.3.5 Copy Link  
 
The "Copy Link" function allows you to copy a link in the web page on which 
you are located. If you tab to a link, and select the "Copy Link" function, the 
link is copied to the clipboard.  
To copy a link from the web page, press “Alt”, move to the "Edit" menu by 
pressing “down arrow” and press "Enter". Press “down arrow” to move to 
"Copy Link" and press "Enter". Or you can copy a link directly by pressing 
"Alt-l".  
 

9.1.4 Go To 
 
To open the "Go To" menu, press “Alt”, and navigate to "Go To" by pressing 
“down arrow”. Press "Enter". The menu items are explained in the following 
sections. 
 

9.1.4.1 Go to Home Page 
 
The first page that your "Web Browser" loads when the "Web Browser" 
opens is called the "home page". You can set your favorite site as your home 
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page. When your "home page" is set, your "Web Browser" opens the same 
"home page" every time you execute it. 
The default home page is www.Hims-inc.com. To move to the default home 
page from another web page, press “Alt”, and navigate to the "Go To" menu 
by pressing “down arrow”, and press "Enter". The first item in the "Go To" 
menu is "Go To Home Page". You can activate "Go To Home Page" by 
pressing "Enter", or by pressing "Alt-h" while in the "Web Browser".  
 

9.1.4.2 Go to Previous Page  
 
The previous page is the page shown just before the current page. For 
example, when the "Web Browser" is activated, the first page that opens is 
the home page. Search for and load the Google web page, www.google.com. 
The Voice Sense QWERTY connects to the Google web page. When "Go To 
Previous Page" is activated, the Voice Sense QWERTY returns you to the 
last position on the previous page (the home page).  
To move to the previous page, press “Alt” to open the "menu", and navigate 
to the "Go To" menu by pressing “down arrow”, and press "Enter". Navigate 
to "Go To Previous Page" by pressing “down arrow”, and then press "Enter". 
Or, you can press "Alt-Left arrow”. This command is not available on the first 
page you visit in the "Web Browser", because there is no previous page to 
go to. 
 

9.1.4.3 Go to Next Page 
 
When you have opened multiple web pages, you can move back and forth 
among the various pages you have visited. For example, when you first open 
the "Web Browser", you connect to your home page. Then, you connect to 
the Google website, and next, you connect to the Lycos website. In this case, 
if you navigate back to Google using the "Go to Previous Page" command, 
the next page from the Google website is the Lycos website.  
To move to the next page, press “Alt” to open the menu, and navigate to the 
"Go To" menu by pressing “down arrow”. Press "Enter". Move to "Go To 
Next Page" by pressing “down arrow”, and press "Enter", or you can press 
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"Alt" with "Right arrow”. This command is not available on the last page 
because there is no page after the last page to move to. 
 

9.1.4.4 Go to Previous Heading 
 
If you activate the "Go To Previous Heading" function, you can go to a 
heading that is located above your current location. To execute the "Go To 
Previous Heading" function, open the menu by pressing “Alt”, and press 
“down arrow” repeatedly to move to the "Go To" menu. Press "Enter" on "Go 
To". Then, use “up arrow” or “down arrow” to move to "Go To Previous 
Heading", and press "Enter". Or, press "u" from the menu. To activate this 
function directly, press "Alt-b or Ctrl-F3" while in a web page. 
 

9.1.4.5 Go to Next Heading 
 
If you activate the "Go To Next Heading" function, you can move forward to 
the next heading below your current location. To execute the "Go To Next 
Heading" function, open the menu by pressing “Alt”, and press “down arrow” 
repeatedly to move to the "Go To" menu. Press "Enter" on "Go To". Then, 
use “up arrow” or “down arrow” to move to "Go To Next Heading". Press 
"Enter". Or, press "d" from the menu. You can also activate this function 
directly, by pressing "Alt-F” or “Ctrl-F4" while in a web page. 
 

9.1.4.6 Go to Previous/Next Text 
 
This item can be used to go to the next or previous chunk of text while 
reading a web page. 
To execute the "Go To Next Text" function, do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow”. 
3) Press "Enter".  
4) Press “down arrow” until "Go To Next Text" is displayed. Or, you can 
press "a" To move directly to "Go To Next Text".  
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5) Press "Enter".  
 
Or you can activate the "Go To Next Text" function by pressing "Ctrl-F6" 
while reading a web page.  
To execute "Go To Previous Text", do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow”. 
3) Press "Enter".  
4) Press “down arrow” until "Go To Previous Text" is displayed. Or, you can 
press "b" To move directly to "Go To Previous Text".  
5) Press "Enter".  
 
Or, you can activate the "Go To Previous Text" function by pressing "Ctrl-F5" 
while reading a web page.  
 

9.1.4.7 Refresh 
 
If a web page opens incorrectly due to a network problem, or you know the 
content is updated often, To refresh the current page, press “Alt”, and 
navigate to the "Go To" menu by pressing “down arrow”. Press "Enter". Go 
to "Refresh" by pressing “down arrow”, and press "Enter", or you can press 
"Ctrl-r" while in a web page. 
 

9.1.4.8 History 
 
The "History" is the list of the web page addresses (and their titles) that have 
been visited either by clicking on a link or by typing in the address directly. 
When "History" is executed, the Voice Sense QWERTY displays the titles of 
the web pages in the history list. 
If you have visited a web page such as www.google.com previously, the 
history list on the Voice Sense QWERTY shows you the title of the page as, 
"Google". 
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To visit the Google website using the history list, press “Alt” to open the 
"menu", and navigate to the "Go To" menu by pressing “down arrow”. Press 
"Enter". Go to "History" by pressing “down arrow”, and press "Enter". You 
can open the history list directly by pressing "Ctrl-h" while in a web page.  
The Voice Sense QWERTY displays the history list. Move to the title of the 
website you want to select by pressing “down arrow” or “up arrow”. If you 
want the "History" list to show the web address, instead of the title, you can 
press "Fn-i". If you press “down arrow”, the display shows the title again, 
rather than the address. After you move to the desired website, press "Enter" 
to connect to it. 
To delete an item from the history list, select the item and press the "Del". 
To delete all the items in the history list, press "Ctrl-a" to select all, and press 
"Del". 
The maximum number of items in the history list is 300. If the list exceeds 
300 items, the oldest item is deleted automatically and the new item is added 
to the top of the list. 
 

9.1.4.9 Find 
 
This feature is similar to the "Find" function in the word processor. The "Find 
dialog" allows you to find text on the current web page. 
To execute the "Find" command, press “Alt” to open the menu, and navigate 
to the "Go To" menu by pressing “down arrow”. Press "Enter". Go to "Find" 
by pressing “down arrow”, and press "Enter", or you can press "Ctrl-f" while 
the "Web Browser" is loaded. 
When "Find" is executed, the dialog containing the edit box for entering text 
and the search direction appears. As in any other dialog, you can press “Tab” 
or "shift-tab" to move from one control to another. Enter the text to search for, 
and select the search direction. Then, press "Enter". The Voice Sense 
QWERTY finds the text, and moves the cursor position to the location of the 
text. 
The default search direction is set to "Forward". This means that the Voice 
Sense QWERTY searches for the specified text from the current cursor 
position to the end of the page. To change the search direction, select 
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"Backward", and press "Enter". The selected search direction remains until 
the "Web Browser" is closed, unless you change it. 
 

9.1.4.10 Find Again 
 
The "Find Again" function searches the text again in the direction that you 
have selected. To open "Find Again", press “Alt”, and navigate to the "Go 
To" menu by pressing “down arrow”. Press "Enter". Move to "Find Again" by 
pressing “down arrow”. Press "Enter". Or, you can press "Ctrl-f", while in a 
web page. 
"Find Again" finds the text that you have entered in "Find". There is no edit 
box in "Find Again". It simply repeats the search you specified in "Find". 
 

9.1.4.11 Links list 
 
This function lists all the links on the current page. To activate it, press “Alt” 
and press "Enter" on "Links list" in "Go To" menu. Or execute it directly, by 
pressing "Alt-i". The "Links list dialog" appears. In the dialog, find the 
following controls: "links list", "Focus link" button, "Activate link" button, and 
"Cancel" button. You can move among the controls by pressing “Tab” or 
"Shift-Tab". You can navigate the list of links in the "links list", by pressing 
“up arrow” or “down arrow”. 
To move to the selected page in the "links list", press "Enter" Or move to 
"Activate link" button by pressing “Tab” or "Shift-tab" and press "Enter".  
To go to the position of the link on the web page from the "links list", move to 
"Focus link" button by pressing “Tab”, and press "Enter".  
To close the dialog, move to the "Cancel" button, and press "Enter". Or press 
"Alt-F4" or press "Esc". 
 

9.1.4.12 Go to Next/Previous Visited Link 
 
This item can be used to go to the next or previous formerly visited link while 
reading a web page. 
To execute the "Go To Next Visited Link" function, do the following: 
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1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow”. 
3) Press "Enter".  
4) Press “down arrow” until "Go To Next Visited Link" is displayed.  

5) Press "Enter".  
 
Or you can activate the "Go To Next Visited Link" function by pressing "Alt-v" 
while reading a web page.  
To execute "Go To Previous Visited Link", do the following: 
 
1) Open the menu by pressing “Alt”. 
2) Move to "Go To" by pressing “down arrow”. 
3) Press "Enter".  
4) Press “down arrow” until "Go To Previous Visited Link" is displayed.  
5) Press "Enter".  
 
Or, you can activate the "Go To Previous Visited Link" function by pressing 
"Alt-Shift-V" while reading a web page.  
 

 
9.1.5 Favorites 

 
To open "Favorites", press “Alt”, and move to "Favorites" by pressing “down 
arrow”, and press "Enter". If there are websites that you frequently visit, it is 
inconvenient to enter the long address each time you want to visit the page. 
In such a case, you can add these website addresses to the "Favorites" list. 
Then, you can visit the websites by simply selecting the address from the 
"Favorites" list. 
 

9.1.5.1 Set Current As Home Page 
 
The "home page" is the website that you connect to automatically when the 
"Web Browser" is opened. The user can set any website as the home page.  
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To set the "home page", Navigate to the web page you want to set as the 
home page. While the web page is loaded, press “Alt”, and move to 
"Favorites" by pressing “down arrow”. Press "Enter". "Set Current As Your 
Home Page" is displayed, as it is the first item in the "Favorites" menu. Press 
"Enter". The current website is saved as your home page automatically, and 
the Voice Sense QWERTY says, "Saved as home page", and displays the 
current web page. You can also press “Ctrl-s” to activate this function while 
your desired homepage is loaded.  
 

9.1.5.2 Add to Favorites 
 
You can add the web page you are currently reading to the "Favorites" list. 
To add the web page to the "Favorites" list, press “Alt”, and move to 
"Favorites" by pressing “down arrow”. Press "Enter". Move to "Add To 
Favorites" by pressing “down arrow”, and press "Enter". You can activate 
"Add To Favorites" by pressing "Alt-a" directly from the page you want to add. 
"Add To Favorites" is a dialog that contains the following: the current 
favorites list (including the folders and files of your favorites), an edit box for 
the web address, confirm, and cancel. You can move among the controls by 
pressing “Tab” or "shift-tab". 
When you open "Add To Favorites", the edit box is displayed. In this edit box, 
you can type the title of the current web page. The extension name (.URL) is 
attached automatically to the title name.  
To edit the current title name, press the left-most cursor routing key. The 
current title name is displayed on the Braille display (When connected to 
SyncBraille). You can press the cursor routing key where you want to edit 
the text, and modify it. Make sure that you do not use “:” in the title name.  
The favorites list is saved in the "/flashdisk/favorites" folder. This folder is the 
default folder. Though you can create sub-folders in the "Favorites" folder, 
you cannot change the default folder to another folder at a higher level. To 
save your favorite to a different folder, navigate folders and files from the 
"Favorites" list using normal navigation keys. 
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9.1.5.3 Favorites List 
 
The user can copy, delete, or rename the title of the sites in the favorites list, 
in addition to visiting any web page in the list. 
To open the "Favorites" list, press “Alt”, and move to "Favorites" by pressing 
“down arrow”. Press "Enter". Move to the "Favorites List" by pressing “down 
arrow”, and press "Enter". Or, you can press "Ctrl-l" while in a web page. The 
Voice Sense QWERTY displays the Favorites list dialog. This dialog 
contains the following: the favorites list, an edit box for the title, a type combo 
box, a confirm button, and a cancel button. You can move from one item to 
the next by pressing “Tab” or "shift-tab". 
When the "Favorites List" is open, an edit box is displayed. The edit box 
displays the message, "Name:". You can enter the title of one of your 
favorites, and you can open the web page by pressing "Enter"" If there are 
no titles that match what you entered, the Voice Sense QWERTY says, 
"invalid name" and returns to the edit box. If there is a title in the "Favorites 
list", the Voice Sense QWERTY connects to the web page. If you do not 
remember the exact title, you can find it from the "Favorites" list, using the 
method outlined below. 
When the edit box appears, press "shift-tab" To move to the "Favorites list". 
The Voice Sense QWERTY displays the "file list". You can move among 
folders and files by pressing “up arrow” or “down arrow”. 
Press "Enter" on the title of the website you want to visit. On this list, folders 
are enclosed by quotation marks. Press "Enter" on a folder to open it.  
In the favorites list, you can view only the files with the selected file format. 
Press “Tab” to move to the "Type" combo box. In the type combo box, there 
are two file formats; “*.*” and “url". Press “up arrow” or “down arrow” to select 
one. If you select “*.*” then all types of files are shown. 
 

9.1.6 Options 
 
Using the "Options" menu, you can set user agent, and change default 
download folder. You can also clear cookies in the "Options" menu. 
To execute the "Options" menu, 
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1) Press “Alt” to open the menu. 
2) Move to "Options" by pressing “down arrow”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page.  
 

9.1.6.1 Menu Structure and Movement  
 
When you execute the "Options" menu, the following options are available: 
1) "User agent" list 
2) "Show visited links"  
3) "Default download folder"  
4) "Clear cookies" 
5) "Confirm" button 
6) "Cancel" button 
By pressing “up arrow” or “down arrow”, you can move among the options: 
User agent, Show visited links, Default download folder and Clear cookies. 
And by pressing "Tab" or "Shift-Tab", you can move among controls.  
 

9.1.6.2 Set User Agent 
 
1) Press “Alt” to open the menu. 
2) Move to "Options", by pressing “down arrow”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) "User agent: Windows CE" is displayed. 
5) Using "Space", you can select "Windows XP", "Windows CE" or "Pocket 
PC". 
6) After selecting your desired value, press "Enter". 
When web pages are loaded, the Voice Sense QWERTY uses the version of 
the website created for the operating system defined by your user agent. 
 

9.1.6.3 Show visited links 
 
The "Visited link" option allows you to choose whether links you have visited 
previously are labeled as such. The default setting is "On”. Toggle this 
setting "On" and "Off" by pressing "Space". 
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9.1.6.4 Changing the Default Download Folder 

  
To change the default folder where downloads are saved, follow these steps: 
1) Press “Alt” to open the menu. 
2) Move to "Options" by pressing “down arrow”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) Pressing “down arrow”, move to "Default download folder" 
5) The list of files and folders in the "Flashdisk" is displayed. Navigate among 
the drives, files and folders using normal navigation keys. Press "Space" on 
the folder in which you wish to save your downloads. 
7) Press "Enter". 
8) Press "Tab”, to move to the "Confirm" button. 
9) Press "Enter". 
To cancel the change, press "Enter" on the "Cancel" button. Or press "Alt-
F4".  
 

9.1.6.5 Clear cookies 
 
A cookie contains information which can be read in web applications 
whenever the user visits the website. You can clear cookies in the "Options" 
menu in Voice Sense QWERTY by following these steps: 
1) Press “Alt” to open the menu. 
2) Move to "Options", by pressing “down arrow”. 
3) Press "Enter". Or you can press "Alt-o" while in a web page. 
4) Pressing “down arrow”, move to "Clear cookies" 
5) Press "Enter" on "Clear cookies". 
6) The unit announces, “Successfully cleared cookies" and cookies are 
cleared. 
 
Pressing "Ctrl-d", clears cookies directly from a web page. 
To cancel clearing cookies, press "Enter" on the "Cancel" button. Or press 
"Alt-F4".  
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9.1.7 Read Page 
 
On the web page, there are links, controls, and other various elements, as 
well as text. To read web pages properly, the "Web Browser" should classify 
each element, and notify the user with its information. 
When reading a web page by moving with “down arrow” or “up arrow”, one 
element is displayed on one line. The links and controls are displayed with 
their respective symbols so the user can distinguish each element. 
 

9.1.7.1 Moving Among Controls 
 
A control is a link, an edit box, a radio button, or a combo box. These same 
controls are found in Windows on a personal computer. Web pages also use 
various kinds of controls for user input. Each control has different purposes. 
Therefore, the user has to know exactly what type of control is being used. 
For example, in an edit box, the user enters a text string. In a combo box 
and list box, the user should select one of the items listed in the combo box 
or list box. The Voice Sense QWERTY "Web Browser" uses symbols to 
identify what type of control is used. To move from one control to another 
without reading the text between controls, the Voice Sense QWERTY 
provides the following movement commands: 
 
1. Move to the previous control: "Shift-tab".  
This command moves to the nearest previous control from the current 
position. If there are no more previous controls, the warning sound is heard. 
2. Move to the next control: "Tab" 
This command moves to the next control from the current position. If there 
are no more controls, the warning sound is heard. 
 
When you find controls in web pages, the Voice Sense QWERTY displays 
control symbols ahead of the contents of the control. The following is a list of 
control symbols. 

 
Control name Symbol 
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Link LN 
Visited link LNV 
Anchor ANC 
Edit box EB 
Multi edit box MEB 
List Box LB 
Combo box CB 
Radio button select SRB 
Radio button 
unselect 

URB 

Check box check SCHB 
Check box uncheck UCHB 
Button BT 

 
 
1. Link: If you press "Enter" on link, you move to the page that the link is 
referencing. 
2. Visited link: Alink that you visited previously.  
3. Anchor: If you press "Enter" on anchor, you move to the referenced part of 
the web page. 
4. Edit box: You can start entering the text at the cursor position. After you 
finish entering the text, press “down arrow” to move to the next item. If there 
is any text in the edit box, it is spoken and displayed on the Braille display 
(When connected to SyncBraille). 
5. Multi edit box: This is similar to the edit box. It is an edit box that allows 
you to enter multiple lines in one edit box. You can start a new line by 
pressing "Enter". After you finish entering the text, press “Tab” To move to 
the next item. 
6. List box, combo box: To change a selection in the combo box, press “Alt-
Down arrow” or “Alt-Up arrow". You can move to the next item by pressing 
“down arrow”. 
Also it renews a page automatically when you change a selection in a combo 
box. 
7. Radio button, check box: To select or cancel the selection, press "Enter". 
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8. Button: If you press "Enter" on a button, you move to the referenced page. 
 

9.1.7.2 Moving to a Form Field 
 
A "form" is a page that has all of the controls, except the "link" control. The 
edit boxes, buttons, and combo boxes are included in a "form". When you 
navigate some web pages, if there are many links, it is very cumbersome to 
navigate to a form because you have to push too many “Tab” or "shift-tab" 
keys to get to the form fields. In this case, you can use the "move to form 
field" function. 
 
1. Move to the previous form field: Ctrl-F1 
You can move to the previous form field by pressing this key. If there are no 
previous form fields, the Voice Sense QWERTY plays the warning sound. 
2. Move to the next form field: Ctrl-F2 
You can move to the next form field by pressing this key. If there are no 
more form fields, The Voice Sense QWERTY plays the warning sound. If 
there are no form fields on a web page, the Voice Sense QWERTY says, "no 
control". 
 

9.1.7.3 Table 
 
At the beginning position of the table, the Voice Sense QWERTY shows the 
table number, and the number of rows and columns on the table. 
For example, there are two large tables (we call these "upper level tables") 
on one web page. Each table has 3 sub tables (we call these "lower level 
tables") with 3 rows and 2 columns on each. In this case, when the Voice 
Sense QWERTY shows the first sub table on the second large table, it 
displays "table 2-1 3 rows, 2 columns". At the end of the sub table, the Voice 
Sense QWERTY displays "table 2-1". 
If the table consists of only 1 row and 1 column, or empty space that has 
only border or background, such tables are not considered tables in the 
Voice Sense QWERTY. 



347 
 

The Voice Sense QWERTY provides a way to move table by table, and cell 
by cell, in order for the user to comprehend the structure of the table. To 
move cell by cell, the cell position and contents of the cell are displayed. 
However, the position information is only announced with speech. 
For example, if you have move to a cell that is positioned on the second row 
and third column, and the content of the cell is "news", the Voice Sense 
QWERTY announces, "row 2 cell 3 news". In this case, "row 2 cell 3" is 
announced with speech only, while "news" is displayed in Braille. 
If a table is included in the cell, the Voice Sense QWERTY announces "table 
cell". If there is not a table in the cell, you hear "empty cell". 
In the "table cell", To move to any cell within the lower level table, press 
“down arrow” to move to the beginning line of the lower level table.  
Moving by cell is only valid in the table. If this command is executed outside 
of the table, a warning sound is played. 
 
1. Move to the previous table: Ctrl-F7 
Moves to the beginning of the previous table. If there are no previous tables, 
the warning sound is played. 
2. Move to the next table: Ctrl-F8 
Moves to the beginning of the next table. If there are no more tables, the 
warning sound is played. 
3. Move to the previous cell: Ctrl-Shift-Left arrow 
Moves to the previous cell. If the current cell is the first cell, it moves to the 
beginning line of the table. If this command is pressed on the beginning line 
of the table, the warning sound is played. 
4. Move to next cell: Ctrl-Shift-Right arrow 
Moves to the next cell. If the current cell is the last cell, it moves to the end 
line of the table. If it is pressed on the end line of the table, the warning 
sound is played. 
5. Move to upper cell: Ctrl-Shift-Up arrow 
Moves to the cell in the previous row within the same column. If the current 
cell is on the first row, the warning sound is played. 
6. Move to lower cell: Ctrl-Shift-Down arrow 
Moves to the cell in the next line, within the same column. If the current cell 
is on the last row, the warning sound is played. 
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7. Current cell: Ctrl-Shift-C 
Announces and displays the content of the current cell again. 
8. Move to the previous cell in the upper level table: Ctrl-Left arrow 
Moves to the previous cell from the current cell that contains the current 
table. If the current table cell is the first cell of the highest level table, it 
shows the beginning line of the table. It does not work on the highest level 
table. 
9. Move to the next cell of the upper level table: Ctrl-Right arrow 
Moves to the next cell from the current cell that contains the current table. If 
the current table cell is the last cell in the highest level table, it moves to the 
end line of the table. It does not work on the highest level table. 
10. Move to the upper cell of the upper level table: Ctrl-Up arrow 
Moves to the previous row, within the same column, to the table cell that 
contains current table. If the cell that contains the current table is located on 
the first row of the upper level table, the warning sound is played. It does not 
work on the highest level table. 
11. Move to the lower cell of the upper level table: Ctrl-Down arrow 
Moves to the next row, within the same column, to the table cell that contains 
the current table. If the table cell that contains current table is at the last row 
of the upper level table, the warning sound is played. It does not work on the 
highest level table. 
12. Check the position: Fn-s 
Announces the position of the current cell in the table. It shows the position 
in both Braille and voice, such as "table 2-3 row 3, cell 4". 
 

9.1.7.4 Move to the Frame 
 
1. Move to the previous frame: Ctrl-F9 
Moves to the beginning position of the previous frame. If there are no 
previous frames, the warning sound is played. 
2. Move to the next frame: Ctrl-F10 
Moves to the beginning position of the next frame. If there are no more 
frames, the warning sound is played. 
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9.1.7.5 Playback of Streaming Audio Files 
 
While navigating a web page, if you come across a link for a streaming audio 
file, you can simply press "Enter" on it. The Media player program is 
launched with lists of address inside of the streaming file, and the streaming 
audio file on the first address is played. The supported streaming file formats 
are "m3u", "pls", "asf", "asx". 
 
For other formats, if you press "Enter" the "Web Browser" program plays the 
streaming audio file directly. When you play the streaming audio file in the 
"Web Browser", the "Add To Favorites" dialog appears.  You can add the 
streaming address to the "Favorites list" and the streaming file is saved with 
"ASF-WAS at the beginning of the file name.  "ASF" denotes that the link is a 
streaming audio file. 
 
While you play a streaming audio file in the "Web Browser", if you exit the 
"Web Browser" program or you lose the internet connection, the streaming 
audio file stops playing. 
You can use the following playback commands in the "Web Browser" while 
playing a streaming audio file. 
 
1. Play: "play" button on the front panel 
2. Stop: "stop" button on the front panel 
3. Turn up the volume: Shift-up scroll button 
4. Turn down the volume: Shift-down scroll button 
 
Playback of a streaming audio file does not stop if you switch to another 
program, unless you press the "stop" button on the front panel after returning 
to the "Web Browser".  
Note: Real Audio files are not supported in the "Web Browser". 
 

9.1.8 Hot keys in the "Web Browser" 
 
File Menu 
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Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
Read Menu 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button 
 
Edit menu 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to menu 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow 
Go to the next page: Alt-Right arrow 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
 
Favorites 
Set current as your home page: Ctrl-s  
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Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
Clear Cookies: Ctrl-d 
 
Hot Keys When Playing Audio Files in the Web Browser 
Turn up the volume: Shift-Up arrow 
Turn down the volume: Shift-Down arrow 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
Reading Web Pages 
Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow 
Select the previous item in the combo box (list box): Alt-Up arrow 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow 
Move to the next cell: Ctrl-Shift-Right arrow 
Move to the upper cell: Ctrl-Shift-Up arrow 
Move to the lower cell: Ctrl-Shift-Down arrow 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow 
Move to the next cell of the upper level table: Ctrl-Right arrow 
Move to the upper cell of the upper level table: Ctrl-Up arrow 
Move to the lower cell of the upper level table: Ctrl-Down arrow 
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Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 

9.1.9 What the "Web Browser" Does Not Support 
 
1. Images are not supported. 
2. Any executable files on web sites cannot be executed. It is because the 
operating system on the Voice Sense QWERTY is different from the 
operating system on a personal computer. 
3. A web page using flash can be opened, but the flash content may not be 
read. 
Some web pages that use JavaScript cannot be opened. 
	  

9.2 Quick Browser 
	  

The "Quick Browser" is designed to facilitate more efficient loading of basic 
websites accessed when doing general web searches, reading RSS feeds, 
etc. While it has some limitations in that it cannot stream audio or access 
sites with java script, it can load many websites in a fraction of the time of 
the original "Web Browser" and thus, is more efficient in many situations.	  	  

	  

To launch the "Quick Browser", navigate to the "Web Tools" menu using 
Up or Down arrow and press "Enter" or just press B from the main menu. 
From the "Web Tools" menu, navigate to the "Quick Browser" and press 
"Enter" or just type Q. You can launch the "Quick Browser" from anywhere 
on the unit by pressing "Windows-Q".	  	  
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9.2.1 File menu  
9.2.1.1 Open URL  
Press "Alt" to open the "Quick Browser" menu. Move to "File", and press 
"Enter". The first item that is displayed is "Open URL". Press "Enter" to 
access the "Open URL" edit box, or press "Control-U" from anywhere in the 
Browser. The edit box for entering an address is displayed with the address 
of the current page filled in. Type the web address you would like to access 
such as "www.google.com", and press "Enter".	  	  

	  

If the Voice Sense QWERTY cannot connect to the desired web page, 
indicated by displaying progress on the Braille display for an extended 
period of time, press "BackSpace-enter" to stop connecting, and execute 
"Open URL" again. You can type in the address and try to connect again, 
or type a different address to access. You can stop the "Quick Browser" 
from connecting by pressing "Alt F 4"	  	  

	  

9.2.1.2 Save As Text  
To execute "Save As Text", open the "menu" by pressing "Alt", and press 
"Enter" on "File". Move to "Save As Text" by pressing the Down arrow and 
press "Enter". The "Save As" dialog appears. You can leave the file name 
as is, or type in a new file name, and press "Enter".	  	  

In this dialog, you'll find "File name" edit combo box, "Confirm" button, 
"Cancel" button and "file list". You can move among these items by 
pressing "Tab" or "Shift-Tab"	  	  

To edit the file name that is displayed on the Braille display, press the 
cursor routing key that corresponds with the text that you want to edit. 
Please remember that the colon cannot be used in file names. You have to 
delete a colon if there is one in your file name.	  	  

To keep the existing file name but change the location, press "Shift-Tab" to 
move to "file list". The default folder is "/flashdisk/download". To move back 
a level in the folder structure, press "Backspace". To enter a selected folder 
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or select a file, press "Enter" on the folder or file. Press the Up or Down 
arrow to move to the next or previous folder or file.	  	  

Press "Tab" to move to "Confirm" and press "Enter" to save. Or, press "tab" 
again to move to "Cancel" and press "Enter" to cancel "Save As".	  	  

If you do not want to save, you can also press "escape".	  	  

9.2.1.3 Save As Web Page  
To execute "Save As Web Page", open the "menu" by pressing "Alt", and 
press "Enter" on "File". Move to "Save As Web Page" by pressing the 
Down arrow and press "Enter". The "Save As" dialog appears. You can 
leave the file name as is, or type in a new file name, and press "Enter".	  	  

This function and dialog are the same as "Save As Text" but this function 
allows you to save the web page in its current HTML form to be accessed 
locally on your notetaker.	  	  

9.2.1.4 Exit  
This command terminates the "Quick Browser", and returns the Voice 
Sense QWERTY to the "program" menu. You can exit the "Quick Browser" 
by pressing "Alt F 4", or by selecting "Exit" from the "Quick Browser" file 
menu.	  	  

9.2.2 Read menu  
The "Read" menu contains 2 items:	  	  

1. Read From Beginning To Cursor	  	  

2. Read From Cursor To End	  	  

	  

You can move among the menu items by pressing the Up or Down arrow. 
To execute an option, press "Enter".	  	  
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9.2.2.1 Read from Beginning to Cursor  
This function reads the current page from the beginning to the cursor 
location.	  	  

To execute this function, press "Enter" on "Read From Beginning To 
Cursor" in the "Read" menu. Or, you can press "Alt-G" while in a web page.	  	  

To interrupt speech before the Voice Sense QWERTY has finished reading 
to the cursor location, press "Control". Your cursor is placed at the location 
where you stopped reading.	  	  

	  

9.2.2.2 Read from Cursor to End  
This function reads the current page from the cursor position to the end of 
the page.	  	  

To execute it, press "Enter" on "Read From Cursor To End" in the "Read" 
menu. Or you can press "Function-Enter" while in a web page.	  	  

To interrupt reading before the Voice Sense QWERTY has finished reading 
to the end, press "Control". Your cursor is then placed at the position at 
which you stopped reading.	  	  

9.2.3 Edit  
The "Edit" menu is used to select any part of the web page and copy or add 
it to the clipboard for use in other applications such as the "Word 
Processor" or "E-mail". However, before you can select and copy text, you 
must open the web page in a "Select Text Window".	  	  

To open the "Edit" menu, press "Alt", and press "Enter" on "Edit" or press E 
from the menu.	  	  

If you are looking at the web page in the normal web view, the only option 
in this menu is "Open Select Text Window". Press "Enter" on this option to 
open the web page in a text view in which you can select and copy text.	  	  

When the web page appears in text view, the "Edit" menu contains the 
following items: "Start Selection", "Copy" and "Add to Clipboard".	  	  
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When you are finished selecting and copying text, press "Escape" to exit 
the "Select Text Window" and return to the normal web page view.	  	  

	  

9.2.3.1 Start selection  
To use this command, when in the "Select Text Window", navigate to the 
point at which you wish to start selecting text. Press "Alt" and move to the 
"Edit" menu by pressing the Down arrow and press "Enter". Navigate to 
"Start Selection" and press "Enter".	  	  

You can also set the starting point of the block by pressing "Control-B" 
directly.	  	  

	  

9.2.3.2 Copy  
Use this command to copy your selection to the clipboard for use in other 
applications. To copy the selected section of the web page, press "Alt", 
move to the "Edit" menu by pressing the Down arrow and press "Enter". 
Move to "Copy" by pressing the Down arrow and press "Enter". Or you can 
copy the selected section by pressing "Control-C while in a web page.	  	  

	  

9.2.3.3 Add to clipboard  
Sometimes, you may wish to copy various sections from a web page all at 
once, in which case, you will not want your last selection erased each time 
you copy a new one. You can use the "Add to clipboard" option to append 
each of your selections to the clipboard.	  	  

To add a selection to the clipboard, press "Alt", move to "Edit" menu by 
pressing the Down arrow and press "Enter". Press the Down arrow to move 
to "Add To Clipboard" and press "Enter". Or you can add to the clipboard 
directly by pressing "Control-P"	  	  
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9.2.4 Go To  
To open the "Go To" menu, press "Alt", and navigate to "Go To" by 
pressing the Down arrow. Press "Enter". The menu items are explained in 
the following sections.	  	  

	  

9.2.4.1 Go to Home Page  
The first page that your "Quick Browser" loads when the "Quick Browser" 
opens is called the "home page". You can set your favorite site as your 
home page. When your "home page" is set, your "Quick Browser" opens 
the same "home page" every time you execute it.	  	  

The default home page is www.Hims-inc.com. To move to the default home 
page from another web page, press "Alt", and navigate to the "Go To" 
menu by pressing the Down arrow, and press "Enter". The first item in the 
"Go To" menu is "Go To Home Page". You can activate "Go To Home 
Page" by pressing "Enter", or by pressing "Alt-H" while in the "Quick 
Browser".	  	  

	  

9.2.4.2 Go to Previous Page  
The previous page is the page shown just before the current page. For 
example, when the "Quick Browser" is activated, the first page that opens 
is the home page. Search for and load the Google web page, 
www.google.com. The Voice Sense QWERTY connects to the Google web 
page. When "Go To Previous Page" is activated, the Voice Sense 
QWERTY returns you to the last position on the previous page (the home 
page).	  	  

To move to the previous page, press "Alt" to open the "menu", and 
navigate to the "Go To" menu by pressing the Down arrow, and press 
"Enter". Navigate to "Go To Previous Page" by pressing the Down arrow, 
and then press "Enter". Or, you can press "Alt-Left arrow". This command 
is not available on the first page you visit in the "Quick Browser", because 
there is no previous page to go to.	  	  
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9.2.4.3 Go to Next Page  
When you have opened multiple web pages, you can move back and forth 
among the various pages you have visited. For example, when you first 
open the "Quick Browser", you connect to your home page. Then, you 
connect to the Google website, and next, you connect to the Lycos website. 
In this case, if you navigate back to Google using the "Go to Previous 
Page" command, the next page from the Google website is the Lycos 
website.	  	  

To move to the next page, press "Alt" to open the menu, and navigate to 
the "Go To" menu by pressing the Down arrow. Press "Enter". Move to "Go 
To Next Page" by pressing the Down arrow, and press "Enter", or you can 
press "Alt-Right arrow". This command is not available on the last page 
because there is no page after the last page to move to.	  	  

	  

9.2.4.4 Go to Previous Heading  
If you activate the "Go To Previous Heading" function, you can go to a 
heading that is located above your current location. To execute the "Go To 
Previous Heading" function, open the menu by pressing "Alt", and press the 
Down arrow repeatedly to move to the "Go To" menu. Press "Enter" on "Go 
To". Then, use Up or Down arrow to move to "Go To Previous Heading", 
and press "Enter". Or, press "U" from the menu. To activate this function 
directly, press "Control-F3" while in a web page.	  	  

	  

9.2.4.5 Go to Next Heading  
If you activate the "Go To Next Heading" function, you can move forward to 
the next heading below your current location. To execute the "Go To Next 
Heading" function, open the menu by pressing "Alt", and press the Down 
arrow repeatedly to move to the "Go To" menu. Press "Enter" on "Go To". 
Then, use Up or Down arrow to move to "Go To Next Heading". Press 
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"Enter". Or, press D from the menu. You can also activate this function 
directly, by pressing "Control-F 4" while in a web page.	  	  

	  

9.2.4.6 Go to Previous/Next Text  
This item can be used to go to the next or previous chunk of text while 
reading a web page.	  	  

To execute the "Go To Next Text" function, do the following:	  	  

1) Open the menu by pressing "Alt".	  	  

2) Move to "Go To" by pressing the Down arrow.	  	  

3) Press "Enter".	  	  

4) Press the Down arrow until "Go To Next Text" is displayed. Or, you can 
press "a" To move directly to "Go To Next Text".	  	  

5) Press "Enter".	  	  

Or you can activate the "Go To Next Text" function by pressing "Control-
F6" while reading a web page. 	  

to Execute "Go To Previous Text", do the following:	  	  

1) Open the menu by pressing "Alt."	  	  

2) Move to "Go To" by pressing the Down arrow.	  	  

3) Press "Enter".	  	  

4) Press the Down arrow until "Go To Previous Text" is displayed. Or, you 
can press "B" to move directly to "Go To Previous Text".	  	  

5) Press "Enter".	  	  

Or, you can activate the "Go To Previous Text" function by pressing 
"Control-F5" while reading a web page.	  	  
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9.2.4.7 Refresh  
If a web page opens incorrectly due to a network problem, or you know the 
content is updated often, To refresh the current page, press "Alt", and 
navigate to the "Go To" menu by pressing the Down arrow. Press "Enter". 
Go to "Refresh" by pressing the Down arrow, and press "Enter", or you can 
press "Control-R" while in a web page.	  	  

	  

9.2.4.8 History  
The "History" is the list of the web page addresses (and their titles) that 
have been visited either by clicking on a link or by typing in the address 
directly. When "History" is executed, the Voice Sense QWERTY displays 
the titles of the web pages in the history list.	  	  

If you have visited a web page such as www.google.com previously, the 
history list on the Voice Sense QWERTY shows you the title of the page as, 
"Google".	  	  

To visit the Google website using the history list, press "Alt" to open the 
"menu", and navigate to the "Go To" menu by pressing the Down arrow. 
Press "Enter". Go to "History" by pressing the Down arrow, and press 
"Enter". You can open the history list directly by pressing "Control-H" while 
in a web page.	  	  

The Voice Sense QWERTY displays the history list. Move to the title of the 
website you want to select by pressing the Up or Down arrow. After you 
move to the desired website, press "Enter" to connect to it.	  	  

To delete an item from the history list, select the item and press "Delete".	  	  

To delete all the items in the history list, press "Control-A" to select all, and 
press "Delete".	  	  

The maximum number of items in the history list is 300. If the list exceeds 
300 items, the oldest item is deleted automatically and the new item is 
added to the top of the list.	  	  
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9.2.4.9 Find  
This feature is similar to the "Find" function in the word processor. The 
"Find dialog" allows you to find text on the current web page.	  	  

To execute the "Find" command, press "Alt" to open the menu, and 
navigate to the "Go To" menu by pressing the Down arrow. Press "Enter". 
Go to "Find" by pressing the Down arrow, and press "Enter", or you can 
press "Control-F" while the "Quick Browser" is loaded.	  	  

When "Find" is executed, the dialog containing the edit box for entering text 
and the search direction appears. As in any other dialog, you can press 
"Tab" or "Shift-Tab" to move from one control to another. Enter the text to 
search for, and select the search direction. Then, press "Enter". The Voice 
Sense QWERTY finds the text, and moves the cursor position to the 
location of the text.	  	  

The default search direction is set to "Forward". This means that the Voice 
Sense QWERTY searches for the specified text from the current cursor 
position to the end of the page. To change the search direction, select 
"Backward", and press "Enter". The selected search direction remains until 
the "Quick Browser" is closed, unless you change it.	  	  

	  

9.2.4.10 Find Again  
The "Find Again" function searches the text again in the direction that you 
have selected. To open "Find Again", press "Alt", and navigate to the "Go 
To" menu by pressing the Down arrow. Press "Enter". Move to "Find Again" 
by pressing the Down arrow. Press "Enter". Or, you can press "F3" while in 
a web page.	  	  

"Find Again" finds the text that you have entered in "Find". There is no edit 
box in "Find Again". It simply repeats the search you specified in "Find".	  	  

9.2.4.11 RSS Feed List  
You can use the "RSS Feed List" command to access the RSS feeds 
available on your current web page and add them to your RSS reader.	  	  
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To execute the "RSS Feed List" command press "Alt" to open the menu, 
navigate to "Go To" menu using the Down arrow and press "Enter". 
Navigate to "RSS Feed List" using the Down arrow and press "Enter". Or, 
you can activate the "RSS Feed List" command directly from a web page 
using "Control-J".	  	  

The available RSS feeds appear in a list. Navigate among them using the 
Up or Down arrow. If you wish to add an RSS feed to the RSS Reader, 
navigate to it and press "Enter". You are prompted, "You are not currently 
subscribed to this feed. Would you like to add it to your RSS reader?" The 
default is "Yes". To add the feed to your RSS reader, just press "Enter". If 
you do not wish to add the feed, press the Down arrow to navigate to "No", 
and press "Enter".	  	  

If you are already subscribed to the feed, you are prompted, "You are 
already currently subscribed to this feed", and you are returned to the RSS 
Feed List.	  	  

When you are finished using the RSS feed list, press "Escape" to return to 
the web page you were previously viewing.	  	  

9.2.5 Favorites  
To open "Favorites", press "Alt", and move to "Favorites" by pressing the 
Down arrow, and press "Enter". If there are websites that you frequently 
visit, it is inconvenient to enter the long address each time you want to visit 
the page. In such a case, you can add these website addresses to the 
"Favorites" list. Then, you can visit the websites by simply selecting the 
address from the "Favorites" list.	  	  

	  

9.2.5.1 Set Current As Home Page  
The "home page" is the website that you connect to automatically when the 
"Quick Browser" is opened. The user can set any website as the home 
page.	  	  

To set the "home page", Navigate to the web page you want to set as the 
home page. While the web page is loaded, press "Alt", and move to 
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"Favorites" by pressing the Down arrow. Press "Enter". "Set Current As 
Your Home Page" is displayed, as it is the first item in the "Favorites" menu. 
Press "Enter". The current website is saved as your home page 
automatically, and the Voice Sense QWERTY says, "Saved as home page", 
and displays the current web page. You can also press "Alt-s" to activate 
this function while your desired home page is loaded.	  	  

	  

9.2.5.2 Add to Favorites  
You can add the web page you are currently reading to the "Favorites" list. 
To add the web page to the "Favorites" list, press "Alt", and move to 
"Favorites" by pressing the Down arrow. Press "Enter". Move to "Add To 
Favorites" by pressing the Down arrow, and press "Enter". You can activate 
"Add To Favorites" by pressing "Alt-A" directly from the page you want to 
add.	  	  

"Add To Favorites" is a dialog that contains the following: the current 
favorites list (including the folders and files of your favorites), an edit box for 
the web address, confirm, and cancel. You can move among the controls 
by pressing "Tab" or "Shift-Tab".	  	  

When you open "Add To Favorites", the edit box is displayed. In this edit 
box, you can type the title of the current web page. The extension name 
(.URL) is attached automatically to the title name.	  	  

To edit the current title name, press the left-most cursor routing key. The 
current title name is displayed on the Braille display. You can press the 
cursor routing key where you want to edit the text, and modify it. Make sure 
that you do not use ?: in the title name.	  	  

The favorites list is saved in the "/flashdisk/favorites" folder. This folder is 
the default folder. Though you can create sub-folders in the "Favorites" 
folder, you cannot change the default folder to another folder at a higher 
level. To save your favorite to a different folder, navigate folders and files 
from the "Favorites" list using normal "File" list navigation keys.	  	  
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9.2.5.3 Favorites List  
The user can copy, delete, or rename the title of the sites in the favorites 
list, in addition to visiting any web page in the list.	  	  

To open the "Favorites" list, press "Alt", and move to "Favorites" by 
pressing the Down arrow. Press "Enter". Move to the "Favorites List" by 
pressing the Down arrow, and press "Enter". Or, you can press "Control-T" 
while in a web page. The Voice Sense QWERTY displays the Favorites list 
dialog. This dialog contains the following: the favorites list, an edit box for 
the title, a type combo box, a confirm button, and a cancel button. You can 
move from one item to the next by pressing "Tab" or "Shift-Tab".	  	  

When the "Favorites List" is open, an edit box is displayed. The edit box 
displays the message, "Name:". You can enter the title of one of your 
favorites, and you can open the web page by pressing "Enter"" If there are 
no titles that match what you entered, the Voice Sense QWERTY says, 
"invalid name" and returns to the edit box. If there is a title in the "Favorites 
list", the Voice Sense QWERTY connects to the web page. If you do not 
remember the exact title, you can find it from the "Favorites" list, using the 
method outlined below.	  	  

When the edit box appears, press "Shift-Tab" to move to the "Favorites list". 
The Voice Sense QWERTY displays the "file list". You can move among 
folders and files by pressing Up or Down arrow.	  	  

Press "Enter" on the title of the website you want to visit. On this list, 
folders are enclosed by quotation marks. Press "Enter" on a folder to open 
it.	  	  

In the favorites list, you can view only the files with the selected file format. 
Press "Tab" to move to the "Type" combo box. In the type combo box, 
there are two file formats; *** and "url". Press Up or Down arrow to select 
one. If you select *** then all types of files are shown.	  	  
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9.2.6 Page Navigation  
On the web page, there are links, controls, and other various elements, as 
well as text. To read web pages properly, the "Web Browser" should 
classify each element, and notify the user with its information.	  	  

When reading a web page by moving with the Up or Down arrow, one 
element is displayed on one line. The links and controls are displayed with 
their respective symbols so the user can distinguish each element.	  	  

	  

9.2.6.1 Moving Among Controls  
A control is a link, an edit box, a radio button, or a combo box. These same 
controls are found in Windows on a personal computer. Web pages also 
use various kinds of controls for user input. Each control has different 
purposes. Therefore, the user has to know exactly what type of control is 
being used. For example, in an edit box, the user enters a text string. In a 
combo box and list box, the user should select one of the items listed in the 
combo box or list box. The Voice Sense QWERTY "Web Browser" uses 
symbols to identify what type of control is used. To move from one control 
to another without reading the text between controls, the Voice Sense 
QWERTY provides the following movement commands:	  	  

1. Move to the previous control: "Control-Left arrow"	  	  

This command moves to the nearest previous control from the current 
position. If there are no more previous controls, the warning sound is heard.	  	  

2. Move to the next control: "Control-Right arrow"	  	  

This command moves to the next control from the current position. If there 
are no more controls, the warning sound is heard.	  	  

When you find controls in web pages, the Voice Sense QWERTY displays 
control symbols ahead of the contents of the control. The following is a list 
of control symbols.	  	  

Control name	  	  
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Symbol	  	  

Link	  	  

LN	  	  

Visited link	  	  

LNV	  	  

Anchor	  	  

ANC	  	  

Edit box	  	  

EB	  	  

Multi edit box	  	  

MEB	  	  

List Box	  	  

LB	  	  

Combo box	  	  

CB	  	  

Radio button select	  	  

SRB	  	  

Radio button unselect	  	  

URB	  	  

Check box check	  	  

SCHB	  	  

Check box uncheck	  	  

UCHB	  	  



367 
 

Button	  	  

BT	  	  

	  

1. Link: If you press "Enter" on link, you move to the page that the link is 
referencing.	  	  

2. Visited link: Alink that you visited previously.	  	  

3. Anchor: If you press "Enter" on anchor, you move to the referenced part 
of the web page.	  	  

4. Edit box: You can start entering the text at the cursor position. After you 
finish entering the text, press the Down arrow to move to the next item. If 
there is any text in the edit box, it is spoken and displayed on the Braille 
display.	  	  

5. Multi edit box: This is similar to the edit box. It is an edit box that allows 
you to enter multiple lines in one edit box. You can start a new line by 
pressing "Enter". After you finish entering the text, press "Tab" To move to 
the next item.	  	  

6. List box, combo box: To change a selection in the combo box, press "Alt-
Up arrow" or "Alt-Down arrow". You can move to the next item by pressing 
the Down arrow.	  	  

Also it renews a page automatically when you change a selection in a 
combo box.	  	  

7. Radio button, check box: To select or cancel the selection, press "Enter".	  	  

8. Button: If you press "Enter" on a button, you move to the referenced 
page.	  	  

	  

9.2.6.2 Moving to a Form Field  
A "form" is a page that has all of the controls, except the "link" control. The 
edit boxes, buttons, and combo boxes are included in a "form". When you 
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navigate some web pages, if there are many links, it is very cumbersome to 
navigate to a form because you have to push too many "tab" or "shift-tab" 
keys to get to the form fields. In this case, you can use the "move to form 
field" function.	  	  

1. Move to the previous form field: Control-F1	  	  

You can move to the previous form field by pressing this key. If there are 
no previous form fields, the Voice Sense QWERTY plays the warning 
sound.	  	  

2. Move to the next form field: Control-F2	  	  

You can move to the next form field by pressing this key. If there are no 
more form fields, The Voice Sense QWERTY plays the warning sound. If 
there are no form fields on a web page, the Voice Sense QWERTY says, 
"no control".	  	  

	  

9.2.7 Hot keys in the "Quick Browser"  
File Menu Commands:	  	  

Open URL: Control-u 1-3-6)	  	  

Exit: Alt-F 4	  	  

Read Menu Commands:	  	  

Read from beginning to cursor: Alt-G	  	  

Read from cursor to end: FN-Enter	  	  

	  

Edit Menu Commands:	  	  

Open Select Text Window: Control-S	  	  

Start selection: Control-B	  	  

Copy: Contol-C	  	  
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Add to clipboard: Control-P	  	  

	  

Go To Menu Commands:	  	  

Go to home page: Alt-H	  	  

Go to the previous page: Alt-Left arrow	  	  

Go to the next page: Alt-Right arrow	  	  

Go to previous heading: Control-F3	  	  

Go to next heading: Control-F 4	  	  

Go to previous text: Control-"F5	  	  

Go to next text: Control-F6	  	  

Refresh: Control-R	  	  

Open the history list: Control-H	  	  

Find: Control-F	  	  

Find again: F3	  	  

	  

Favorites Menu Commands:	  	  

Set current as your home page: Alt-S	  	  

Add to favorites: Alt-A	  	  

Favorites list: Control-T	  	  

	  

Page Navigation Commands:	  	  

Move between controls	  	  

Move to the previous control: Control-Left arrow	  	  
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Move to the next control: Control-Right arrow	  	  

Select the next item in the combo box (list box): Alt-Down arrow	  	  

Select the previous item in the combo box (list box): Alt-Up arrow	  	  

Moving to form fields	  	  

Move to the previous form field: Control-F1	  	  

Move to the next form field: Control-F2	  	  

	  

9.2.8 What the "Quick Browser" Does Not Support  
	  

1. Images are not supported.	  	  

2. Any executable files on websites cannot be executed. This is because 
the operating system on the Voice Sense QWERTY is different from the 
operating system on a personal computer.	  	  

3. A web page using flash can be opened, but the flash content may not be 
read.	  	  

4. Java script is not supported. Some web pages that use JavaScript 
cannot be opened. Others will allow you to open them, but many controls 
will not be accessible.	  	  

5. You cannot stream audio using the Quick Browser. You must download 
files and play them in the Media Player, or use the original Web Browser to 
stream the files.	  	  

	  

9.3 Google Search 
The Google Search program allows you to easily perform a search using 
Google’s Internet search service. To Open Google Search, navigate to “Web 
Tools” from the Main Menu, or press “B”. From the “Web Tools” menu, move 
to “Google Search” and press “Enter”, or press “G” to launch the Google 



371 
 

Search program. You can launch “Google Search” from anywhere on the 
unit by pressing “Windows-U”. 

	  	  

9.3.1 The Search Dialog 
The “Search” dialog contains 4 items: a “Category” combo box, a “Search 
Term” edit box, a “Search” button, and a “Close” button. To move through 
the items in the dialog, press “Tab” or “Shift-Tab”. 

When the Google Search application is launched, you are placed in the 
“Search Term” edit box. Type the term you wish to search for, and press 
“Enter” to launch the search; or Tab to the “Search” button and press “Enter”. 
If you wish to change the category of items being searched for, you can 
press “Shift-Tab” to access the “category” combo box.  

The “Category” combo box contains 3 items: “All”, “News”, and “Blogger”. 
Use the Up and Down arrows to move among the items in the combo box. 
When you have chosen your desired category, Tab to the “Search Term” edit 
box and follow the steps above to perform your search. 

If you wish to exit the program without performing s earch, Tab to the “Close” 
button and press “Enter”, or press “Alt-F4”. 

	  

9.3.2 The Results Dialog 
After a search is performed, you are placed in the “Results” dialog. The 
“Results” dialog contains 6 items: the “Category” combo box, the “Search 
Term” edit box, the “Title” list, the “Contents” text box, a “Search” button, and 
a “close” button. When the Voice Sense has finished searching the term you 
entered, you are placed in the “Title” list.  

The “Title” is the name of the web result that matches your search term. Use 
the Up and Down arrows to navigate the items in the “Title” list. The “Title” 
list can contain up to 64 items. To go to the current search result on the web, 
simply press “Enter” and the webpage for the current title is opened in the 
Web Browser. When you have finished viewing the webpage, press “Alt-F4” 
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to close the Web Browser, and you are returned to your results list in the 
Google Search program. 

The “Contents” text box contains information about the current title, just as 
you would receive if you were performing a search on the Google website. 
This information usually includes a quick preview of the content on the web 
page, and the URL of the web result.  

Use the “Category” combo box, “Search term” edit box, and “Search” button 
to launch a new search as described in the previous section. 

To exit the Google Search program, Tab to the “Close” button and press 
“Enter” or press “Alt-F4”. 

	  

9.4 RSS Reader 
	  

Really Simple Syndication (RSS" is a method for providing updates to web 
based content through what are called "feeds". The Voice Sense "RSS 
Reader" allows you to subscribe to RSS feeds and receive updates 
whenever the website for the feed you're subscribed to updates its content. 
RSS updates may include news articles, blog posts, podcasts, or just 
updated content for a website such as promotions or announcements. The 
Voice Sense QWERTY's RSS Reader is preloaded with 9 Google news 
feeds to get you started.	  	  

	  

To launch the "Rss Reader", navigate to the "Web Tools" menu using Up or 
Down arrow and press"Enter" or just press "B" from the main menu. From 
the "Web Tools" menu, navigate to the "RSS Reader" and press "Enter" or 
just type "R" You can also launch the "RSS Reader" from anywhere on the 
unit by pressing "Windows-N".	  	  

9.4.1 RSS Main Window  
When the "RSS Reader" is opened, you are placed in the main window of 
the application on the "Category" list. The main window consists of the 
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following: "Category" list, "Feeds" list, "Items" list, "Item Description" static 
box, "Read Whole Description" button, and, if the item is a podcast, a 
"Download" button. You can move among the controls using "Tab" or 
"Shift-Tab".	  	  

As you Tab forward in this window, you move forward a level in the content 
structure, and as you ShiftTab, you move back a level in the content 
structure. This means that, as you Tab, the content becomes more specific, 
and as you Shift-Tab, the content becomes more general.	  	  

To illustrate this, do the following:	  	  

1. Use the Down arrow to navigate to "Google RSS" in the "category" list.	  	  

2. Tab once. You are placed on the first feed in the "Google RSS" category, 
"Top Stories".	  	  

3. Tab again: you are placed on the first item in the "Top Stories" feed.	  	  

4. Tab once more, and you are placed on a short description of this item.	  	  

5. If you Shift-Tab, you will return first to the Item, then to the Feed, and 
finally, back to the "Google RSS" category.	  	  

Use the Up or Down arrow to navigate the "Category", "Feed" and "Item" 
lists. Press "Tab" to access content specific to your chosen category, feed, 
or item. Press "Shift-Tab" to move back a level and use Up or Down arrow 
to choose a different item, feed, or category.	  	  

9.4.2 The File Menu  
The "RSS Reader" "File" menu contains 4 items: "Receive New Headlines", 
"Import OPML", "Export OPML", and "Exit".	  	  

9.4.2.1 Receive New Headlines  
The "Receive New Headlines" option updates the selected categories or 
feeds. If your cursor is placed on a category and you execute this function, 
all feeds in the category are updated. If you are placed on a feed, or are in 
the list of items for a given feed, executing this function updates only the 
current feed. If you select multiple items in the category or feed list, all of 
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the selected items are updated when you execute "Receive New 
Headlines".	  	  

To activate this function, press "Alt" to open the menu, and press"Enter" on 
"File". Then, press "Enter" on "Receive New Headlines". Or, you can 
activate this function directly by pressing "Control-R".	  	  

Voice Sense prompts "Xx/yy processing", where x represents the number 
of the feed being processed, and y represents the total number of feeds to 
process. Voice Sense continues to update you as each new feed is 
processed. When the update is complete, Voice Sense announces, 
"Successfully updated y feeds".	  	  

9.4.2.2 Import OPML  
If you have an RSS reader on another device such as a smartphone or 
computer, you may wish to access the same feeds on your Voice Sense 
QWERTY. Most RSS readers allow you to export your feed information as 
a file with an OPML extension. This file is a directory of the feeds to which 
you are subscribed. You can import this directory into the Voice Sense 
QWERTY's RSS reader using the "Import OPML" function. The Voice 
Sense QWERTY can import OPML 1.0, 1.1, and 2.0 files.	  	  

To execute the "Import OPML" function, press "Alt" to open the menu, and 
press "Enter" on "File". Use the Down arrow to navigate to "Import OPML" 
and press "enTer". Or, you can activate this function directly by pressing 
"Control-O".	  	  

When you activate the "Import OPML" function, you are placed in the 
"Downloads" folder of the Voice Sense QWERTY in an "Open File" dialog, 
similar to the one in the Word Processor. Navigate the files and folders of 
your Voice Sense until you locate the file you wish to import and press 
"Enter".	  	  

When you have chosen the OPML file you wish to import, you are placed in 
the "Import" dialog. the "Import" dialog contains 4 items: "Category" list, 
"Feeds" list, "Confirm" button, and a "Cancel" button. You can move among 
the controls using "Tab" or "Shift-Tab".	  	  
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The "Category" list contains all the categories available in the OPML you 
are importing. The "Feeds" list contains all of the feeds in a chosen 
category. You can select as many or as few of the feeds in the OPML for 
importing. You may select just one feed in one category, or you may select 
all the categories and import everything. Press "Space" on individual 
categories or feeds you wish to select. If you want to import everything in 
the OPML, you can press "Control-A" in the "Category" list and all feeds in 
all categories will be imported.	  	  

When you have selected all of the items you wish to import, press "Enter" 
or Tab to the "Confirm" button and press "Enter". To cancel importing the 
OPML, Tab to the "Cancel" button and press "Enter" or press "Escape" or 
"Alt F 4".	  	  

When the import is complete, the new categories will appear in the 
"Category" list of the main window, and the feeds you chose to import will 
appear in the respective "feed" lists for those categories.	  	  

	  

9.4.2.3 Export OPML  
You may wish to save the directory of RSS feeds you are subscribed to on 
your Voice Sense QWERTY, either for use on another device, or as a 
backup in case you should need to restore your subscription information. 
You can save your directory of RSS categories and feeds using the "Export 
OPML" function.	  	  

To execute the "Export OPML" function, press "Alt" to open the menu, and 
press "Enter" on "File". Use the Down arrow to navigate to "Export OPML" 
and press "enTer". Or, you can activate this function directly by pressing 
"Control-S".	  	  

The Export OPML" dialog contains 4 items: "File" list, "File name" edit box, 
"Confirm" button, and "Cancel" button. You can move among the controls 
using "Tab" or "Shift-Tab".	  	  

You are placed in the "File name" edit box. You can enter your desired file 
name and press "Enter" to export the OPML, or Tab to "Confirm" and press 
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"Enter". If you wish to change the location where the file is saved, Shift-Tab 
to the "File" list and use normal file management navigation commands to 
choose a new location. If you wish to cancel exporting the OPML, Tab to 
"Cancel" and press "Enter" or press "Escape" or "Alt F 4".	  	  

9.4.2.4 Exit  
This command terminates the "RSS Reader" program and returns the 
Voice Sense QWERTY to the "program" menu. You can exit "RSS Reader" 
by pressing "Alt F 4", or by selecting "Exit" from the "RSS Reader" File 
menu.	  	  

	  

9.4.3 The Category Menu  
The "Category menu only appears when your cursor is placed in the 
"Category" list. The "Category" menu contains 3 items: "Insert Category", 
"Delete Category", and "Modify Category". These items are discussed in 
detail in the following sections.	  	  

9.4.3.1 Insert Category  
The "Insert Category function allows you to create and name a new 
category in the list. by Default, the RSS Reader contains 2 categories: 
"Google RSS" and "My Feeds". As stated previously, the "Google RSS" 
category contains 9 Google news feeds to get you started using RSS. The 
"My Feeds" category is where all new feeds you subscribe to are placed. 
Once you have subscribed to a few feeds, you may wish to create 
categories of your own choosing, and move feeds into these categories 
using the "Feed" menu discussed later in this section.	  	  

To execute the "Insert Category" function, press "Alt" to open the menu, 
and navigate to "Category" and press "Enter". Then, press "Enter" on 
"Insert Category". Or, you can press "Control-I" to execute this function 
directly from within the "Category" list.	  	  

The "Insert Category" dialog contains 3 items: "Category Name" edit box, 
"Confirm" button, and "Cancel" button. You can move among the controls 
using "Tab" or "Shift-Tab".	  	  
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To create a new category, type the name in the edit box and press "Enter", 
or Tab to the "Confirm" button and press "Enter". To cancel creation of a 
new category, Tab to "Cancel" and press "Enter" or press "Escape" or "Alt 
F 4".	  	  

	  

9.4.3.2 Delete Category  
If you wish to remove a category from your RSS directory, you can do this 
using the "Delete Category" function. Note: if you delete a category, all the 
feeds in that category are removed. If you wish to keep any of the feeds in 
the category, please move them to a different category as described later in 
this section.	  	  

To execute the "Delete Category" function, press "Alt" to open the menu, 
and navigate to "Category" and press "Enter". Then, navigate to "Delete 
Category" using the Down arrow and press "Enter". Or, you can press 
"Delete" to execute this function directly from within the "Category" list.	  	  

When you execute the "Delete Category" function, you are prompted, 
"DELETE XXXX Category?" where XXXX represents the category under 
your cursor. The default is "Yes". Press "Enter" to delete the current 
category. If you do not wish to delete the current category, press the Down 
arrow to navigate to "No" and press "Enter".	  	  

	  

9.4.3.3 Modify Category  
If you wish to rename a category to more appropriately express the feeds 
contained in it, you can do this using the "Modify Category" function. To 
execute the "Modify Category" function, press "Alt" to open the menu, and 
navigate to "Category" and press "Enter". Then, navigate to "Modify 
Category" using the Down arrow and press "Enter". Or, you can press 
"Control-M" to execute this function directly from within the "Category" list.	  	  

The "Modify Category" dialog contains 3 items: "Category Name" edit box, 
"Confirm" button, and a "Close" button. You can move among the controls 
using "Tab" or "Shift-Tab".	  	  
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To rename a category type the new name in the edit box, and press "Enter", 
or Tab to "Confirm" and press "Enter". If you wish to cancel modifying the 
category, Tab to the "Close" button and press "Enter" or press "Escape" 
and you are returned to the "Category" list.	  	  

9.4.4 The Feed Menu  
When you are in a "Feed" list or a list of items in a feed, the "Feed" menu 
appears instead of the "Category" menu. The "Feed" menu contains 5 
items: "Search for Feeds", "Insert Feed", "Delete Feed", "Modify feed", and 
"Move Feed". These items are discussed in detail in the following sections.	  	  

9.4.4.1 Search for Feeds  
The "Search for Feeds" item allows you to search a specified website for 
RSS feeds and add them to your RSS Reader. To execute the "Search for 
Feeds" function, press "Alt" to open the menu, and navigate to "Feed" 
using the Down arrow and press "Enter". Then, press "Enter" on "Search 
for Feeds" Or, you can press "Control-N" to execute this function" directly 
from within the "Feed" list.	  	  

The Search for Feeds" dialog contains 3 items: "Search feed URL" 
computer edit box, "Confirm" button, and a "Cancel" button. You can move 
among the controls using "Tab" or "Shift-Tab".	  	  

To search a website for available RSS feeds, type the URL of the website 
and press "Enter", or Tab to "Confirm" and press "Enter". The Voice Sense 
QWERTY displays a list of available feeds for the website you entered. Use 
Up or Down arrow to move among the feeds in the list. Press "Enter" on the 
feed you wish to add.	  	  

When you press "Enter" on your desired feed, you are placed in the "Insert 
Feed" dialog. the "Insert Feed" dialog contains 5 items: "Feed URL" 
computer edit box, "Category" list, "Insert Category" button, "Confirm" 
button, and a "Cancel" button. You can move among the controls using 
"Tab" or "Shift-Tab".	  	  

The "Feed URL" edit box displays the URL of the chosen RSS feed. The 
"Category" list allows you to choose which category into which to insert the 
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feed. Use the Up or Down arrow to move among the feeds in the list. The 
"Insert Category" button lets you create a new category in which to place 
the feed. Selecting this button opens the same dialog as described in 
section 9.4.3.1.	  	  

When you have completed setting your preferences for the feed, Tab to the 
"Confirm" button and press "Enter". If you wish to cancel the insertion of the 
feed, Tab to "Cancel" and press "Enter" or press "Escape" or "Alt F 4".	  	  

9.4.4.2 Insert Feed  
You can use the "Insert Feed" option if you know the exact URL of the feed 
you want to insert. To execute the "Insert Feed" function, press "Alt" to 
open the menu, and navigate to "Feed" using the Down arrow and press 
"Enter". Then, navigate to "Insert Feed" using the Down arrow and press 
"Enter". Or, you can press "Control-I" to execute this function directly from 
within the "Feed" list.	  	  

When you execute the "Insert Feed" function, you are placed in the same 
"Insert Feed" dialog as described in the above section. Type the exact URL 
of the RSS feed into the computer edit box, choose your category 
preferences, and press "Enter" on the "Confirm" button to insert the feed.	  	  

9.4.4.3 Delete Feed  
If you wish to remove a feed from your RSS Reader, you can do this using 
the "Delete Feed" function. To execute the "Delete Feed" function, press 
"Alt" to open the menu, and navigate to "Feed" using the Down arrow and 
press "Enter". Then, navigate to "Delete Feed" using the Down arrow and 
press "Enter". Or, you can press "Delete" to execute this function directly 
from within the "Feed" list.	  	  

When you execute "Delete Feed", you are prompted, "Delete XXXX feed?" 
where XXXX is the feed under your cursor. The default is "Yes". Delete the 
feed, press "Enter". If you do not wish to delete the feed, press the Down 
arrow to navigate to "No" and press "Enter".	  	  
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9.4.4.4 Modify Feed  
If you wish to rename a feed to more appropriately express the content for 
your reference, or the URL has changed and you need to modify it, you can 
do this using the "Modify Feed" function. To execute the "Modify Feed" 
function, press "Alt" to open the menu, and navigate to "Feed" and press 
"Enter". Then, navigate to "Modify Feed" using the Down arrow and press 
"Enter". Or, you can press "Control-M" to execute this function directly from 
within the "Feed" list.	  	  

The "Modify Feed" dialog contains 5 items: "Feed Name" edit box, "Feed 
URL" computer edit box, "Category" list, "Confirm" button, and a "Close" 
button. You can move among the controls using "Tab" or "Shift-Tab".	  	  

To rename a feed type the new name in the edit box, and press "Enter", or 
Tab to "Confirm" and press "Enter". If you need to modify the URL, Tab to 
the "Feed URL" computer edit box, and type the new URL. If you want to 
change the category in which the feed is located, Tab to the "Category" list 
and use Up or Down arrow to choose a different category. When you have 
finished setting your preferences, Tab to "Confirm" and press "Enter". If you 
wish to cancel modifying the feed, Tab to the "Close" button and press 
"Enter" or press "Escape" and you are returned to the "Feed" list.	  	  

	  

9.4.4.5 Move Feed  
If you wish to change the category in which a feed is located, but do not 
need to modify other information for the feed, you can use the "Move Feed" 
function. To execute the "Move Feed" function, press "Alt" to open the 
menu, and navigate to "Feed" and press "Enter". Then, navigate to "Move 
Feed" using the Down arrow and press "Enter". Or, you can press "Alt-V" to 
execute this function directly from within the "Feed" list.	  	  

The "Move Feed" dialog contains 3 items: "Category" list, "Confirm" button, 
and a "Cancel" button. You can move among the controls using "Tab" or 
"Shift-Tab".	  	  



381 
 

If you want to change the category in which the feed is located, Tab to the 
"Category" list and use Up or Down arrow to choose a different category. 
When you have finished setting your preferences, Tab to "Confirm" and 
press "Enter". If you wish to cancel modifying the feed, Tab to the "Cancel" 
button and press "Enter" or press "Escape" and you are returned to the 
"Feed" list.	  	  

9.4.5 Options  
The "Options" dialog allows you to set options related to receiving and 
displaying feed content. To open the "Options" dialog, press "Alt" to open 
the menu. Navigate to "Options" using Up or Down arrow and press "Enter". 
Or, you can press Backspace-O to open the "Options" dialog from 
anywhere in the RSS Reader.	  	  

The "Options" dialog contains 4 items: "View Mode" combo box, "Output 
Term" combo box, "Confirm" button, and a "Cancel" button". You can move 
among the controls using "Tab" or "Shift-Tab".	  	  

The "View Mode" lets you set how you want items in a feed to be displayed. 
The options are "Title" and "Title/Date". Use Up or Down arrow to navigate 
among the options.	  	  

The "Output Term" setting determines the length of time for which the RSS 
Reader will update feeds. The options are "none", "2 days", "3 days", "4 
days", "5 days", "6 days", and "7 days". If you set the output term to 5 days, 
this means when you update your RSS feeds, the RSS Reader will load all 
of the items posted in the last 5 days. If you choose "None", the RSS 
reader will load all available items when updating feeds regardless of how 
long ago they were posted. Use Up or Down arrow to choose the output 
term.	  	  

When you have finished setting your preferences, Tab to "Confirm" and 
press "Enter". If you do not wish to save your settings, Tab to "Cancel" and 
press "Enter" or press "Escape" or "Alt F 4".	  	  
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9.4.6 Hot Keys in RSS  
Receive new Headlines: Control-R	  	  

Import OPML: Control-O	  	  

Export OPML: Control-S	  	  

Download Podcast: Control-D	  	  

Read whole Description: Control-L	  	  

Options: Alt-O	  	  

	  

From Category List:	  	  

Insert Category: Control-I	  	  

Delete Category: Delete	  	  

Modify Category: Control-M	  	  

	  

From Feed List:	  	  

Search for Feeds: Control-N	  	  

Insert Feed: Control-i	  	  

Delete Feed: Delete	  	  

Modify Feed: Control-M	  	  

Move Feed: Alt-V	  	  
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10. Social Networking 
 
A social networking service is an online service, platform, or site that focuses 
on building and reflecting of social networks or social relationships among 
people who share interests and/or activities.  
 
To access the Social networking services on the Voice Sense QWERTY, 
follow these steps: 
(1) Make sure The Voice Sense QWERTY has an active Internet connection, 
as all of the services in this menu require online access. If you do not 
currently have an active Internet connection, you can set 1 up using the 
"Setup internet" dialog in the "Utilities" menu. Note: To set up an Internet 
connection, you must have Internet access available via a Wi-Fi network or 
LAN connection.  
(2) Press the short cut key, "c" from the "program" menu. Or use the 
navigation keys to move to "social networking" and press "Enter".  
 
10.1 Available Social Networking services 

 
The Social networking menu on the Voice Sense QWERTY provides access 
to the following services: 
1) Twitter (t) 
2) Google talk (g) 
3) Msn messenger (n) 
4) Sense Chat © 
Accounts for each of the first 3 services should be created via the websites 
for each service before attempting to use the service on the Voice Sense 
QWERTY.  
For Twitter: please visit www.twitter.com. 
For Google Talk: go to www.google.com. 
For MSN Messenger: visit www.msn.com. 
The Sense Chat program allows 2 sense notetaker users to connect their 
notetakers via Bluetooth and chat with each other. (see section 10.5) 
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In the "Social Networking" menu, you can navigate among the programs by 
pressing “up arrow” or “down arrow”. To open a program, press "Enter" on 
the program or type the shortcut key associated with the program.  
 
10.2 Twitter 

 
"Twitter" is a micro-blogging service that allows you to post messages in real 
time to those who follow you and read the posts of friends and family as well 
as news sites and other organizations that wish to post information for public 
reading.  
You can also send and receive replies to your posts, repost tweets from 
others, send direct messages to those who follow your tweets, and easily 
search and retrieve tweets by adding them to your favorites.  
 
To launch "Twitter", follow these steps: 
1) From the main menu, press "c" or navigate to "Social Networking" using 
“down arrow” and press "Enter".  
2) Press "t" or move to "Twitter" and press "Enter". 
You can also launch “Twitter” from anywhere on the unit using “Windows-I”. 
 

10.2.1 Twitter Terminology 
 
1) Tweet: A message posted in "Twitter". It is similar to posting on a 
message board. The difference is, there is no space to write a title.  
2) Tweets allow you to post 140 characters regardless of language. A tweet 
can also contain a URL.  
3) Mention: When you repost someone's tweet, reply to someone's tweet, or 
mention them in a tweet of your own.  
4) Reply: to answer a tweet, by a specific user.  
5) Follow: to follow other users. You can subscribe to other user's tweets 
thus, you are following them. 
6) Followers: other users who follow you, or rather, who subscribe to your 
tweets.  
7) Unfollow: to stop following another user. 
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8) Retweet: to deliver another user's tweet to your followers by reposting it. 
Abbreviated using "RT".  
9) Friend: users who follow each other.  
10) DM: Direct Message to or from a specific user. You can only send a 
"Direct Message" to someone who follows you. "Note: direct messages are 
private, thus can only be seen by those who exchange them. 
11) Timeline: a list of tweets in the order they were posted. 
 

10.2.2 Accessing "Twitter" 
 
To use the "Twitter" program, you must create a "Twitter" account. Visit the 
"Twitter" web site at www.twitter.com to create an account. If you already 
have a "Twitter" account, you can use the "Twitter" program after logging in 
To use "Twitter", the Voice Sense QWERTY needs to be connected to the 
Internet. Please be sure you have an active Internet connection before 
starting Twitter.  
 

10.2.2.1 Sign In 
 
When you launch "Twitter", the "Sign In" dialog appears. Move to the next 
control by pressing "Tab" or to the previous control by pressing "Shift-Tab".  
 
The "Sign In" dialog consists of the following: 
 
1) ID: a computer edit box, for typing a "Twitter" account Id.  
2) Password: a computer edit box, for typing your "Twitter" password. 
3) Automatically set the time from the Internet: a check box, to set whether 
the Voice Sense QWERTY Time is synchronized to an Internet Time Server. 
The default is "checked". 
4) Remember me: a check box, to choose whether you save your "Id". The 
default is "Uncheck".  
5) Save password: a check box, to choose whether you save your 
"password". The default is "Unchecked". 
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6) Auto Sign In: a check box, to choose whether you automatically sign in to 
"Twitter" when the program is launched. The default is "Unchecked". Note: to 
use the Auto Sign In function, "Remember me" and "Save Password" check 
boxes must be checked.  
7) Sign In: button, to log in to Twitter 
8) Cancel: button, to cancel log in and exit the "Twitter" program. 
 
To sign into Twitter: 
 
1) When the "Sign In" dialog appears you are placed in the "ID" computer 
edit box. Type your Twitter "Id".  
2) Press "Tab" to move to the "Password" computer edit box. Type your 
Twitter password. Again, you must use computer Braille.  
3) To save "Id" and "password", press "Space" to check both the "Remember 
me" check box and "Save password" check box. 
4) To automatically sign in to "Twitter", when the program opens, press 
"Space" to "check" the "Auto Sign In" check box.  
5) Press "Enter". Or move to the "Sign In" button using "Tab", and press 
"Enter" 
6) Voice Sense QWERTY displays, "Connecting" and tries to sign in to 
"Twitter". If sign-in is successful, "Refreshing Home Timeline" is displayed. In 
a couple of seconds, the list of tweets in your home timeline is displayed. If 
the Voice Sense QWERTY is not connected to the Internet, you are 
prompted, "Please check your internet connection" and you are placed back 
in the "Id" computer edit box. 
 

10.2.2.2 Sign out and Exit 
 
"Sign Out" allows you to sign out of the current Twitter account without 
closing the program. After you sign out, you are returned to the "Sign in" 
dialog. Press the hot key, "Ctrl-g" to sign out of the current Twitter account, 
or press "Enter" on the "Sign out" option located under the "File" menu.  
To exit the "Twitter" program, press "Alt-F4" or press "Enter" on the "Exit" 
option located under the "File" menu.  
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10.2.3 Main "Twitter" dialog 

 
If sign-in is successful, you are placed in the main "Twitter" dialog. The main 
"Twitter" dialog consists of 10 controls. Move among the controls using "Tab" 
or "Shift-tab". 
The main "Twitter" dialog contains the following items: 
 
1) Timeline: or list of tweets by those you follow in the order they were 
posted. 
The Timeline displays "User: Tweet" as follows. 
himsintl: Holiday greetings from HIMS International. 
 
In the case of a Mention, the tweet is displayed as "Sender ID: @ receiver Id, 
Tweet" as follows.  
Kimjk:@himsintl Greetings from HIMS International”. 
 
A "Retweet", is displayed as "Retweeter Id: RT @ original writer Id: Tweet" 
as follows. 
Bill:RT:@robin: Happy birthday!!. 
 
Use the following navigation keys in the Timeline. 
Move to the next tweet: down arrow  
Move to the previous tweet: up arrow 
Move to the first tweet in the current list: Ctrl-Home 
Move to the last tweet in the current list: Ctrl-End 
Move up 32 tweets: Page up  
Move down 32 tweets: Page down  
 
2) Time: Displays the date and time of the focused tweet.  
For example, "Friday, January 1, 2011, 3:00 pm" 
 
3) Next list: Pressing "Enter" on this button loads the next group of 32 tweets. 
You can also press the hot key, "Ctrl-n" to load the next list.  
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4) Refresh button: Press "Enter" on this button to refresh the Timeline to 
reflect any new tweets posted since you opened "Twitter", or performed your 
last refresh. You can also refresh your timeline by pressing "Ctrl-r".  
5) Tweet button: This button opens the "Tweet" dialog, and places you in the 
edit box where you can write a tweet. You can also open the "Tweet" dialog 
by pressing "Ctrl-t".  
6) Reply button: Use this button to reply to the focused tweet. You can open 
the "Reply" dialog by pressing "Ctrl-y".  
7) Remove button: Press "Enter" on this button when focused on one of your 
own tweets to delete a tweet that you posted. You can also remove the tweet 
by pressing "Del". This button appears, only when one of your own tweets is 
focused. When another user's tweet is focused, this button does not appear. 
8) Retweet button: Use this button to repost another user's tweet. You can 
retweet another tweet by pressing "Ctrl-e". The "Retweet" button does not 
appear when one of your own tweets is focused. 
9) Add to Favorite button: Add the focused tweet to your "Favorites" list. You 
can also add the tweet to your favorites by pressing "Ctrl-v".  
10) Tweet Information: Use this button to view detailed information for the 
focused tweet. You can also view tweet information by pressing "Alt-i".  
 

10.2.4 Timeline 
 

The Twitter program on the Sense notetakers allows you to access a 
Variety of Timelines. In the main "Twitter" dialog, the Timeline displays 
tweets according to the Timeline you have chosen. You can use hot keys to 
quickly bring up the Timeline you desire, whether it is your home timeline, 
all tweets that mention you, or the timeline for a specific user.	  	  

 
10.2.4.1 Available Timelines 

 
1) Home Timeline: Your "Home Timeline" is displayed when you sign in to 
"Twitter".	  	  
All tweets by those you follow are posted here. The hot key to access your 
"Home Timeline" is "Control-H" from anywhere in "Twitter".	  	  
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2) User Time line: This displays only the tweets posted by a specified user.	  	  
Use the hot key "Control-U" to access the user timeline. After pressing the 
hot key, "Control-U", an edit box appears in which to type the name of the 
user whose timeline you want to access. Press "Enter" to refresh that 
user's timeline.	  	  
3) Current User Timeline: Displays timeline for the user of the currently 
focused tweet. The hot key is "Alt-U".	  	  
4) Mention Timeline: Displays Tweets that mention you, either in reply, 
retweet, or because another user simply mentioned you in his or her tweet. 
The hot key is "Control-M".	  	  
5) Retweet Of Me: Displays tweets you have posted which have been 
reposted by your followers. The hot key is "Alt-O".	  	  
6) List Timeline: Use this function to view tweets from a list you have 
created or a list you follow. When you execute this function, you are 
presented with a list of available lists from which you can choose. The hot 
key is "Alt-P".	  	  
7) Favorite Timeline: displays the tweets you have saved as favorites. The 
hot key is "Control-L".	  	  
You can also access the various timelines from the "Timeline" menu in the 
"Twitter" program menu.	  	  

 
10.2.4.2. Refresh 

 
Refresh is a function to renew the list of tweets in the current timeline. When 
you activate this command, Voice Sense QWERTY loads any new tweets 
posted since you opened Twitter or last refreshed the timeline. The tweets 
are arranged in chronological order from newest to oldest. 
You can refresh a timeline by pressing the hot key "Ctrl-r". Or Press "Tab" 
from the main "Twitter" dialog to move to the "Refresh" button and press 
"Enter". 
 

10.2.4.3 Load Next list 
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Use this function to load the next list of 32 tweets. Each time you activate the 
"Next List" command, the next 32 tweets are added to the current list. The 
list continues to accumulate until you perform a refresh.  
To load the "Next List", use the hot key, "Ctrl-n", or tab to the "Next List" 
button and press "Enter". 
 

10.2.5. Managing "Tweets" 
 

10.2.5.1 Tweet 
 

This command allows you to post a message to the "Twitter" server so that 
your followers can access it next time they log in.	  	  
To open the "Tweet" dialog, press the hot key, "Control-T" from the main 
"Twitter" dialog, or move to the "Tweet" button using "Tab" and press 
"Enter". Or, you can open the menu and select "Tweet" from the "Tweets" 
menu.	  	  
The "Tweet" dialog consists of 5 controls. Move among the controls by 
pressing "Tab (F3 or Space-4-5)" or "Shift-tab (Space-F3 or Space-1-2)".	  	  
1) Tweet? : An edit box in which to write a tweet.	  	  
2) Characters: A status bar displaying the current number of characters 
used and maximum characters. For example, "Characters: 0/140T".	  	  
3) Add ID: A dialog with a list of those you follow from which you can 
choose an ID to mention in your tweet.	  	  
4) Tweet: A button used to post the tweet.	  	  
5) Cancel: button used to cancel the posting of a tweet.	  	  

  
To post a tweet, when the "Tweet" dialog is opened, type the message you 
want to post, and press "Enter", or tab to the "Tweet" button and press 
"Enter". Your time line is then refreshed, and you are returned to the list of 
tweets in your home timeline. 
 

10.2.5.2 Remove Tweet 
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If you post a tweet that contains mistakes, or about which you change your 
mind on posting, you can remove it. To do this, navigate to the tweet you 
wish to remove and press "Del" or tab to the "Remove" button and press 
"Enter". You are asked if you are sure you want to remove the tweet. Press 
"Enter" to continue with the removal. To cancel removing the tweet, press 
"Space" to change the button to "No" and press "Enter".  
 

10.2.5.3 Retweet 
 

"Retweet" is used to repost a tweet you have received so that those who 
follow you can see it. You may wish to repost a tweet containing an 
important notification, or something fun you wish to share with others.	  	  
To retweet a post, locate the post you want to retweet, and press "Control-
E". You are presented with a list of 3 choices: "Retweet", "Quote Tweet", 
and "Cancel". If you simply want to repost another's tweet, press "Enter" on 
"Retweet". If you want to quote another's tweet in your own post, press 
"Enter" on "Quote Tweet". If you want to cancel retweeting, press "Enter" 
on "Cancel".	  	  
If the retweet is successful, the unit announces Tweet completed" and you 
are returned to your timeline.	  	  

 
10.2.5.4 Mention 

 
"Mention" is a tweet in which another user is mentioned, either because you 
are retweeting one of his or her posts, replying to him or her, or because 
you've simply chosen to mention the user in a tweet you are posting. To 
mention a specific user in one of your tweets, use an at-sign in front of the 
user ID when typing it in your tweet.  
The below examples show tweets containing mentions.  
 
Example 1: @Robin Hello, teacher, good to see you on Twitter. 
Example 2: @Bill and @Robin will be featured on the technology show this 
evening". 
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Example addresses a specific user. Example 2 mentions 2 specific users 
and identifies their inclusion on an upcoming technology show.  
 

10.2.5.5 Reply 
 
A "Reply" is simply a reply to a posted tweet. To reply to a tweet, navigate to 
the tweet to which you want to reply, and press "Control -y" or tab to the 
"Reply" button and press "Enter". 
Or, from the menu, select "Reply" in the "Tweets" menu. 
 
The "Reply" dialog contains the same 4 controls as does the "Tweet" dialog. 
Move among the controls by pressing "Tab" or "Shift-tab". 
  
When the "Reply" dialog opens, you are placed in an edit box in which to 
enter the reply post. The user ID of the person you are replying to is already 
filled in with an at-sign preceding it. When you finish typing your reply, press 
"Enter", or tab to the "Tweet" button and press "Enter". If the reply is 
successful, "Tweet completed" is announced and displayed.  
 

10.2.5.6 Tweet Information 
 

The "Tweet Information" dialog provides information about the current 
tweet. If the tweet contains a link, you can open the link in the "Web 
Browser". You can also follow the user of the tweet, and view ID's and 
hashtags included in the tweet. You can also use the "Tweet Information" 
dialog to copy the content of a tweet.	  	  
To open the "Tweet Information" dialog, press "Enter" on the desired tweet.	  	  
The "Tweet Information" dialog consists of 6 controls. Move among the 
controls by pressing "Tab" or "Shift-tab".	  	  
1) Content: contains the content of the posted message.	  	  
2) URL: A list containing the various URL's included in a tweet. Using 
"Space-4" or "Space-1", select the URL you want to open and press "Enter". 
The "Web Browser" is automatically launched and you are taken to the web 
address of the URL.	  	  
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3) A list of hashtags included in the tweet.	  	  
4) A list of user ID's mentioned in the tweet.	  	  
5) User Timeline button for viewing the timeline of the ID on which your 
cursor is placed in the ID tab.	  	  
6) Close: A button to close the "Tweet Information" dialog and return to the 
Timeline. You can also use "F 4" or "Space-e" To close the dialog.	  	  

 
 
Use the following hot keys in the "Content" box. 
1) Start selection: Ctrl-b  
2) Select all: Ctrl-a 
3) Copy: Ctrl-c 
 

10.2.5.7 Add to Favorites 
 
"Add to Favorites" is a function to add a specific tweet to your "Favorite List". 
You can later access your favorite tweets quickly by bringing up the "Favorite 
list".  
 
To add a tweet to your favorites, navigate to the tweet you want to add, and 
press “Control-v", or tab to "Add Favorite" and press "Enter". You can also 
execute this command from the "Tweets" menu. If the addition is successful, 
the unit displays, "Completed" and you are returned to your timeline. 
 

10.2.5.8 Favorite List 
 
You can view your favorite tweets by opening the "Favorite list" dialog. To 
open the "Favorite List" dialog, press "Ctrl-l" or, from the menu, select 
"Favorite List" from the "Tweets" menu. The "Favorite List" dialog contains 4 
controls. Move among the controls by pressing "Tab" or "Shift-tab".  
 
1) Favorite list: list of tweets you have added to the "Favorite List" from 
newest to oldest. 
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2) Next list: Used to access the next 32 favorites in the list. Press "Ctrl-n" or 
"Enter" on the "Next List" button. 
3) Remove: A button to delete the focused favorite. You can also press "Del" 
to delete the favorite.  
4) Close: Closes the "Favorite List" dialog and returns you to your previous 
position. You can also use "Esc" to close the "Favorite List.. 
 

10.2.6. Managing Followers and following 
 

10.2.6.1 Follow User 
 
This command is used to start following the tweets of another user. To open 
the "Follow User" dialog, press "Alt-a". Or you can activate "Follow User" 
from the "Follow" menu.  
The "Follow User" dialog consists of 3 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Follow User id?: An edit box in which to enter the username of the person 
or organization you wish to follow. 
2) Confirm: A button to confirm or execute following the user.  
3) Cancel: A button to cancel following the user.  
 
When the "Follow User" dialog is opened, type the Twitter ID of the user you 
want to follow in the edit box and press "Enter". If the Voice Sense QWERTY 
is able to locate the user and follow them, the unit displays, "Follow 
complete" and returns you to your previous position. 
 

10.2.6.2 Following 
 

"Following" displays a list of those users you follow on Twitter.	  	  
To open the "Following" dialog, press "Alt-L" or choose "Following" from the 
"Follow" menu.	  	  
"Following" consists of 7 controls. Move among the controls by pressing 
"Tab" or "Shift-tab".	  	  
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1) Following: A list of those you follow on Twitter.	  	  
2) Next list: Loads the next 32 users you follow. You can also load the 
"Next List" by pressing Control-N".	  	  
3) Remove Follow: A button to remove the user from the list of those you 
follow, or rather, a button to stop following a user. You can also press 
"Delete" to delete the focused user from your "Following" list.	  	  
4) User Timeline: displays the posts by the current user.	  	  
5) User Information: displays information about the current user including 
Name, ID, About Me, Homepage and Following, follower, and Tweet counts.	  	  
6) Add User to List: opens a dialog allowing you to add the current user to 
one of your created lists.	  	  
7) Close: A button to close the "Following" dialog. You can also use 
"Escape" or "Alt-F 4" to close the dialog and return to your previous 
position.	  	  

 
10.2.6.3 Followers 

 
"Followers" is a list of Users who follow your tweets.	  	  
To open the "Followers" dialog, press the hot key, "Alt-E" or select 
"Followers" from the "Follow" Menu.	  	  
The "Followers" dialog consists of 7 controls. Move among the controls by 
pressing "Tab" or "Shift-tab".	  	  
1) Followers: A list of those who follow your tweets.	  	  
2) Next list: a button to load the next 32 followers in the list. You can also 
load the "Next List" by pressing "Control-N".	  	  
3) Follow User: A button to start following the focused user.	  	  
4) User Timeline: displays the posts by the current user.	  	  
5) User Information: displays information about the current user including 
Name, ID, About Me, Homepage and Following, follower, and Tweet counts.	  	  
6) Add User to List: opens a dialog allowing you to add the current user to 
one of your created lists.	  	  
7) Close: A button to close the "Followers" dialog. You can also close the 
dialog by pressing "Escape".	  	  
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10.2.7. Using Direct Messages 
 
THE direct Message function allows you to send and receive Direct 
Messages to and from a specific user. Direct messages can only be seen by 
those who exchange them. You can only exchange direct messages with 
those who follow you.  
  

10.2.7.1 Send Direct Message  
 
Use the "Send Direct Message" dialog to send a "Direct Message" (DM) to 
one of your "followers". To open the "Send Direct Message" dialog, press 
“Ctrl-s”, or select "Send Direct Message" from the "Tweets" menu. The 
"Send Direct Message" dialog consists of 6 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) Followers: The list of those who follow you. Select a user from this list to 
send a direct message to that person. 
2) Next list: loads the next 32 followers in your list. Press "Ctrl-n" or "Enter" 
on this button to load the next list. 
3) Message: An edit box in which to type the message you wish to send. 
When done, you may press "Enter" to send the message and return to the 
"followers" list. 
4) Characters: A status bar displaying current characters and maximum 
characters: for example, "Characters: 0/140T". 
5) Send: A button used to send the direct message. Press “Ctrl-s” or "Enter" 
on this button to send your message and return to the "followers" list.  
6) Close: use this button to close the dialog without sending a message. You 
can also use "Esc" to close the dialog. 
 
 

10.2.7.2 Accessing Received Direct Messages 
 

This function allows you to view Direct Messages you have received from 
those you follow.	  	  
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To open the "received messages" dialog, press "Alt-R" or select the 
"Received Direct messages" item located in the "Tweets" menu.	  	  
The "Received Direct Messages" dialog consists of 6 controls. Move 
among the controls by pressing "Tab" or "Shift-tab".	  	  
1) Received Direct Messages: A list of the messages you have received, 
shown from newest to oldest. Messages are displayed as "ID: message"	  	  
2) The date the message was filed.	  	  
3) Next list: Loads the next 20 messages in the list. Press "Control-N" or 
press "Enter" on the button to load the next list.	  	  
4) Reply: Use this button to compose a reply to the focused message. You 
can also open the "Reply" dialog by pressing "control-Y".	  	  
5) Remove direct message: Use this button to delete the message from the 
list.	  	  
6) Close: A button to close the "Received Direct Messages" dialog and 
return to your previous position. You can also use "Escape" to close the 
dialog.	  	  

 
10.2.7.3 Sent Direct Messages 

 
"Sent Direct Messages" is a dialog displaying the "Direct Messages" you 
have sent to users who follow you.	  	  
To open the "Sent Direct Messages" dialog, press "Alt-S" or select the 
"Sent Direct Messages" item located in the "Tweets" menu.	  	  
The "Sent Direct Messages" dialog contains 5 controls. Move among the 
controls by pressing "Tab" or "Shift-tab".	  	  
1) Sent Direct Messages: A list of messages you have sent to users who 
follow you, displayed from newest to oldest. "Direct Messages" are 
displayed as "Sender Id: Message".	  	  
2) Date the message was filed.	  	  
3) Next list: Loads the next 20 messages in the list. Press "Control-N" or 
"Enter" on this button to load the next list.	  	  
4) Remove Direct Message: Use this button to remove the message from 
the list.	  	  
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5) Close: Use this button to close the "Sent Direct Messages" dialog and 
return to your previous position. You can also use "Escape" to close the 
dialog.	  	  

 
10.2.8. Using Search functions 

 
The "Search" function in the "Twitter" program allows you to search 
registered users as well as words contained in tweets posted to the public 
timeline. 
It also offers a "Save Search" function to save words used frequently. 
 

10.2.8.1 Global Search 
 
The "Global Search" launches a search for entered text among all "Twitter" 
timelines. You can also follow the user of a tweet in the results of your 
"Global Search".  
To open the "Global Search" dialog, press "Ctrl-f" or select the "Global 
Search" item from the "Search" menu.  
The "Global" search dialog contains 6 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) Search word?: An edit box into which you can enter the word for which 
you want to search. 
2) Next list: Loads the next 20 results in the list. You can load the "Next list" 
by pressing "Ctrl-n" or press "Enter" on the button. 
3) Search results: A list containing the results of your search, such as "User 
Id: Self-introduction". The "Search result" button appears only when there 
are results to display. 
4) Follow User: Select this button to follow the focused user. The "Follow 
User" button appears only when there are search results displayed. 
5) Confirm: Use this button to execute a search.  
6) Cancel: This button closes the "Global Search" dialog and returns you to 
your previous position. You can also cancel by pressing "Esc".  
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Use the following steps to search for and follow a user. 
(1) Open the "Global search" dialog and you are placed in the "Search word" 
edit box. Type your desired search term.  
(2) Press "Enter", and "Searching" is displayed. 
(3) If the search is successful, search results appear. If no results match your 
search, "No search results" is displayed and you are returned to the "Search 
word" edit box. 
(4) In the search results list, navigate to user whom you want to follow, by 
pressing “down arrow” or “up arrow”. 
(5) Press "Alt-a" to follow the focused user. 
 

10.2.8.2 User search 
 

"User search" lets you specifically search for text among users' profiles, id's, 
and names registered on Twitter. This is useful if you're trying to find a 
specific person , or a specific company or informational site.	  	  
To open the "User Search" dialog menu, press "Alt-F" or select the "User 
Search" item located in the "Search" menu. It is similar to the "Global 
search" dialog.	  	  
The "User Search" dialog consists of 8 controls. Move among the controls 
by pressing "Tab" or "Shift-tab".	  	  
1) Search word?: An edit box into which you can enter the term for which 
you want to search.	  	  
2) Next List: Loads the next 20 results in the list. You can load the "Next 
list" by pressing "Control-N" or "Enter" on this button.	  	  
3) Search results: a list of results matching your search. Results appear as, 
"User Id: About me". The "Search results" button appears only when there 
are search results to display.	  	  
4) Follow User: Use this button to follow the focused user. The "Follow 
User" button appears only when there are search results. You can also 
press "Alt-A" to follow the focused user.	  	  
5) User Timeline: displays the posts of the current user.	  	  
6) User Information: displays information about the current user including 
Name, ID, About Me, Homepage and Following, follower, and Tweet counts.	  	  
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7) Confirm: Use this button to execute a search.	  	  
8) Cancel: This button closes the "User Search" dialog and returns you to 
your previous position. You can also use "Escape" to close the dialog.	  	  

  
10.2.8.3 Using the "Search word list" dialog 

 
The "Search word list" saves words frequently searched for and helps you 
search tweets and User Id's quickly.  
To open the "Search word list" dialog, press "Alt-w" or select the "Search 
word list" item from the "Search" menu.  
The "Search word list" dialog consists of 6 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) Word list: a list of your saved search words. 
2) Global search: Use this button to search tweets for the focused word. 
3) User search: Use this button to search user profiles for the focused words. 
4) Add search word: Use this button to add a new word to the list. 
5) Remove search word: Delete the focused word from the list using this 
button. 
6) Close: This button closes the "Search word list" dialog and returns you to 
your previous position. You can also use " Esc" to close the dialog.  
" 
Use the following steps to add a word to the "Search word" list: 
(1) From the "Search word list" dialog, press "Enter-a" 
(2) "Save Search?" edit box appears.  
(3) Type the word you wish to add to the list and press "Enter". 
(4) When the entered word is saved, "save completed" message is displayed. 
 
Use the following steps to delete a word from the "Search word list": 
(1) Navigate to the word you want to delete from the list using “down arrow” 
or “up arrow”. 
(2) Press "Del". Or tab to the "Remove Search word" button and press 
"Enter". 
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(3) "Do you want to delete? Yes" message appears, if you press "Enter", the 
word is deleted. To cancel deletion, toggle the option to "No" using "Space" 
and press "Enter". Or press "Esc". After canceling, you are returned to the 
"Search word list". 
  

10.2.8.4 Find Tweets from the Current Timeline  
	  

The "Find Tweets from the Current Timeline" option allows you to search 
for text among the tweets of the timeline currently displayed. To open the 
"Find Tweets from the Current Timeline" dialog, press "Control-Alt-F" or 
select the "Find Tweets from the Current Timeline" item located in the 
"Search" menu.	  	  
The "Find" dialog contains 5 controls:	  	  
1) Find: edit box for typing your search term.	  	  
2) Search radio buttons: lets you choose to search the "Tweet message", 
"ID", "Date" or "All".	  	  
3) Direction radio buttons: lets you choose to search backward or forward 
in the current timeline.	  	  
4) Confirm: Use this button to execute a search.	  	  
5) Cancel: This button closes the "Find" dialog and returns you to your 
previous position. You can also use "Escape" to close the dialog.	  	  
	  

10.2.8.5 Find Again Tweets from the Current Timeline  
	  

The "Find Again" option repeats the search you initiated using the "Find 
Tweets from the Current Timeline". To activate the "Find Again Tweets 
from the Current Timeline", press "Alt-Shift-F" or select the "Find Again 
Tweets from the Current Timeline" item located in the "Search" menu. 
When you activate this option the search is instantly performed using the 
options chosen previously in the "Find Tweets from the Current Timeline" 
dialog.	  	  
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10.2.9. Additional Functions 
 

10.2.9.1 Viewing and Editing Personal Information 
 
The "Personal Information" dialog allows you to check and edit your personal 
account information. 
To open the "Personal Information" dialog, press "Ctrl-I" or move to the 
"Personal Information" item in the "File" menu and press "Enter". 
 
The "Personal Information" dialog contains the following items. Move among 
the controls by pressing "Tab" or "Shift-tab". 
 
1) Name 
2) ID 
3) Homepage 
4) About me 
5) Follow count 
6) Follower count 
7) Tweet Count 
8) Edit 
9) Close 
 
In the "Personal Information" dialog, you can edit name, homepage, and 
"about me". Use the following steps to modify your personal information.  
(1) When the "Personal Information" dialog is open, move to the "Edit" button 
by pressing "Tab". 
(2) Press "Enter". You can now modify your personal information using the 
edit boxes displayed: Name EB, Homepage CEB, About me EB. This dialog 
also contains a Save button, and a Close button. 
(3) Type the desired information in the edit boxes.  
(4) Press "Enter" on the "Save" button and a "Refreshing user information" 
message is displayed.  
(5) If the modification is successful, "Save complete" is displayed and you 
are returned to your previous position. 
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10.2.9.2 Save Current Timeline 

 
The "Save Current Timeline" allows you to save the current timeline as a text 
file. To open the "Save Current Timeline" dialog, press "Alt-s" from the 
"Tweet" dialog or press "Enter" on the "Save Current Timeline" menu item 
located in the file menu.  
The "Save Current Timeline" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) File name: A combo edit box, in which to enter your desired file name. 
The default is "Timeline name current date". For example, "Home Timeline 
20110310". 
2) Confirm: Press this button to save the current timeline.  
3) Cancel: Use this button to exit the "Save Current Timeline" dialog and 
return to the "Tweet" dialog.  
4) File List: A file browser control in which you can change the storage path. 
If you do not change the storage path, the file is automatically stored in the 
"My Documents" folder in the flashdisk. 
 

10.2.9.3 Set Options  
	  

The "Set Options" dialog allows you to set the number of tweets to receive 
each time you refresh your timeline or use the "Next List" command. To 
open the "Set Options" dialog, press "Alt" to open the "File" menu, and 
navigate to "Set Options" using the Down arrow. Or press "Alt-O" directly 
from within Twitter.	  	  
The "Set Options" dialog contains 3 items, "Number of Tweets to Receive" 
combo box, a "Confirm" button, and a ""cel" button. You can move among 
the items using "Tab" or "Shift-Tab".	  	  
Use the Up and Down arrows to navigate the options in the combo box. 
You can choose to receive 32, 64, or 100 tweets at a time. When you have 
chosen the number of tweets you want to receive, Tab to the "Confirm" 
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button and press "Enter". If you do not wish to save your settings, Tab to 
"Cancel" and press "Enter" or press "Escape" or "Alt-F 4".	  	  

 
10.2.10 Managing Lists  
Twitter allows you to group people you follow into lists, and to follow or view 
lists created by others. Most of the list-related functions in the "Twitter" 
program are located in the "List" menu. The "List" menu contains 4 items: 
"List Manager", "Add User to List", "List User View" and "List View in 
Current Tweet". These items are discussed in detail in the following 
sections.	  	  

10.2.10.1 List Manager  
The "List Manager" allows you to create, modify, remove, and unfollow lists. 
To execute the "List Manager", press "Alt" to open the menu. Navigate to 
"List" using the Down arrow and press "Enter". Then, press "Enter" on "List 
Manager". You can also open the "List Manager" by pressing "Control-P" 
from anywhere in the "Twitter" program.	  	  

The "List Manager" dialog contains the following items: "List" list, "List 
Information" button, "Create List" button, "Modify List" button, "Remove 
List" button and "Close" button. If your cursor is placed on a list you follow, 
but is not a list of your own creation, the "Unfollow" option appears, and the 
"Modify" and "Remove" options do not appear.	  	  

You can move among the controls using "Tab" or "Shift-Tab". To move 
through the items in the "List" list use Up or Down arrow.	  	  

10.2.10.1.1 List Information  
The "List Information" dialog contains the following items: "Information" list 
and a "Close" button. The "Information" list contains the "List name", "List 
Description", "List Date", "List Member Count" and "List Mode (Private or 
Public)". You can move among the items using the Up or Down arrow. To 
close the "List Information" dialog, Tab to "Close" and press "Enter" or 
press "Escape".	  	  
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10.2.10.1.2 Create List  
To create a new list, Tab to "Create List" in the "List Manager" dialog, and 
press "Enter", or press "Control-A".	  	  

The "Create List" dialog contains 3 controls: "Information" list, "Confirm" 
button, and a "Cancel" button. You can move among the controls using 
"Tab" or "Shift-Tab".	  	  

The "Information" list contains 3 items: "List Name" edit box, "List 
Description" edit box and "List Mode" radio button. Use the Up or Down 
arrow to move among the items in the list. Type your desired name and 
description in the respective edit boxes. Press "Space" on the "List Mode" 
radio button to toggle between "Private" and "Public". Choose "Public" if 
you want the list to be available for other user to view and follow. Choose 
"Private" if you do not want others to be able to view and follow your list.	  	  

When you have finished setting your preferences for the list, Tab to 
"Confirm" and press "Enter". If you wish to cancel creation of the list, Tab to 
"Cancel" and press "Enter" or press "Escape" or "Alt F 4".	  	  

	  

10.2.10.1.3 Modify List  
To modify information for a list you created, use the Down arrow to 
navigate to it in the "List Manager" dialog, Tab to "Modify List", and press 
"Enter. Or just press "Control-M" when your cursor is on the list you want to 
modify.	  	  

The "Modify List" dialog is exactly the same as the "Create List" dialog, 
except that the information is filled in for the current list. When you have 
finished modifying the information in the list, Tab to "Confirm" and press 
"Enter". To cancel modifying the list, Tab to "Cancel" and press "Enter" or 
press "Escape" or "Alt F 4".	  	  

10.2.10.1.4 Removing a List  
To remove a list you created, navigate to it using Up or Down arrow in the 
"List Manager" dialog, Tab to "Remove List" and press "Enter". Or, you can 
press "Delete" when the list is under your cursor.	  	  
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When you execute the "Remove List" function, you are prompted, "Delete 
the XXXX List?" where XXXX is the name of the current list. The default is 
"Yes". To remove the list, press "Enter". If you do not want to rcoove the list, 
press the Down arrow to navigate to "No" and press "Enter".	  	  

10.2.10.1.5 Unfollowing a List  
If you have chosen to follow someone else's list, you can unfollow the list 
using the "List Unfollow" function. To unfollow a list, navigate to it using Up 
or Down arrow in the "List Manager" dialog, Tab to "List Unfollow" and 
press "Enter".	  	  

When you execute the "List Unfollow" function, you are prompted, 
"Unfollow XXXX List?" where XXXX is the current list. The default is "Yes". 
If you wish to unfollow the list, press "Enter". If you do not wish to stop 
following the list, use the Down arrow to navigate "No" and press "Enter".	  	  

	  

When you are finished managing lists, Tab to the "Close" button and press 
"Enter", or press "Escape".	  	  

	  

10.2.10.2 Add User to List  
Once you have created lists, you will want to add users to your lists. You 
can do this using the "Add User to List" function.	  	  

To execute "Add User to List", press "Alt" to open the menu. Navigate to 
"List" using the Down arrow and press "Enter". Then, Navigate to "Add 
User to List", and press "Enter". You can also execute this function by 
pressing "Control-K" from anywhere in the "Twitter" program.	  	  

The "Add User to List" dialog contains 4 items: "List" list, "User ID" edit box, 
"Confirm" and "Cancel". You can move among the controls using "Tab" or 
"Shift-Tab".	  	  

Use Up or Down arrow to choose the list to which you want to add the user. 
By default, the "ID" edit box contains the ID of the current user. If you wish 
to add the current user to your list simply Tab to "Confirm" and press 
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"Enter". If you wish to add a different user, type the ID of the user you wish 
to add and Tab to "Confirm" and press "ENTER". To cancel adding a user 
to a list, Tab to "Cancel" and press "Enter" or press "Escape" or "Alt F 4".	  	  

	  

10.2.10.3 List User View  
The "List User View" function allows you to view and manage list members. 
To execute "List User View", press "Alt" to open the menu. Navigate to 
"List" using the Down arrow and press "Enter". Then, Navigate to "List User 
View" and press "Enter". You can also execute this function by pressing 
"Control-J" from anywhere in the "Twitter" program.	  	  

The "List User View" dialog contains the following items: "List" list, "List 
Member" list, "Next List" button, "Member Information" button, "Delete List 
Member" button, "Follow User" button, and a "Close" button. If you are 
viewing a list you are following, the "Delete List Member" button does not 
appear. You can move among the controls using "Tab" or "Shift-Tab". Use 
Up or Down arrow to move among items in a list.	  	  

Use the "Delete List Member" button to remove a member from the list. 
Use the "Member Information" button to view the User Information" for the 
current list member. The information in the "Member Information" dialog is 
the same information available in the "User Information" dialog previously 
described. If you are not following a user in a list, and you wish for their 
tweets to appear in your timeline, use the "Follow User" button to add this 
user to your "Following" list.	  	  

	  

10.2.10.4 List View in Current Tweet  
The "List View in Current Tweet" function allows you to view the public lists 
created by the user of the current tweet, as well as the lists he or she 
follows. To execute "List View of Current Tweet", press "Alt" to open the 
menu. Navigate to "List" using the Down arrow and press "Enter". Then, 
Navigate to "List View of Current Tweet" and press "Enter". You can also 
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execute this function by pressing "F3" from anywhere in the "Twitter" 
program.	  	  

The "List View of Current Tweet" dialog contains the following controls: 
"List" list, "List Timeline" button, "List User View" button, "List Follow" 
button, and a "Close" button. You can move among the controls using 
"Tab" or "Shift-Tab".	  	  

The "List Timeline" option gives you the Timeline for the current list as 
described in the "Timeline" section of this chapter. The "List User View" 
opens the "List User View" dialog for the current list as described in the 
previous section. The "List Follow" button adds the current list to the lists 
you currently follow. You can close the "List View of Current Tweet" dialog 
by tabbing to the "Close" button, and pressing "Enter", or by pressing 
"Escape".	  	  

 
10.3 Google talk 

 
Google Talk is a messaging service that allows you to text or voice chat in 
real time with other Google Talk users as well as easily and quickly send 
files to your Google Talk contacts.  
To launch Google Talk, do the following:  
1) From the main menu, press "c" or move to "Social Networking" using 
“down arrow” and press "Enter".  
2) Press "g" or move to "Google Talk" and press "Enter". 
You can also launch “Google Talk” from anywhere on the unit by pressing 
“Windows-G”. 
 

10.3.1 Before you launch Google Talk 
 
To use the Google Talk service, you must have a Gmail account. If you do 
not have a Gmail account, visit the Gmail website (http://gmail.google.com) 
and create a Gmail account. If you have a Gmail account registered, you can 
use your Gmail ID and password to log into Google Talk.  
You must also have an active connection to the Internet to use Google Talk,  
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10.3.1.1 Sign In 

 
When you launch Google Talk, the "Login" dialog appears. The "Login" 
dialog consists of 7 controls. Move among the controls by pressing "Tab" or 
"Shift-tab". 
 
1) E-mail: A computer edit box in which to enter your Gmail address. 
2) Password: A computer edit box to input your Gmail password.  
3) Remember me: A check box for choosing whether or not to save your 
user ID. The default is set to "Uncheck". You can check the box by pressing 
"Space". 
4) Save password: This is a check box for choosing whether or not to save 
your password. The default is set to "Uncheck". You can check the box by 
pressing Space".  
5) Auto Sign In: This is a check box for choosing whether or not to sign in 
automatically. 
If you check this box, the program will sign you in automatically when you 
open it using the registered e-mail account. Note: to use this function, you 
must check the "Remember me" and "Save password" check boxes. If you 
do not check these boxes, the auto sign in function will not work. 
6) Sign in: A button to initiate log in to Google Talk.  
7) Cancel: This button cancels login and closes the Google Talk program. 
 
  
Once you are logged in to Google Talk, the contact list appears. The contact 
list is displayed in Braille as "(Status) ID XX/YY" and "chat name, status, 
XX/YY" is announced. "YY" represents the total number of contacts and "xx" 
refers to the placement of the current contact in the list. When a contact is 
online, the status is displayed as "NLN". When a contact is offline, the status 
is displayed as "FLN". If a contact is Idle, the status is displayed as "idle".  
 
Use the following keys to navigate the "contacts list" dialog. 
Move to the previous contact: Up arrow  
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Move to the next contact: down arrow 
Move up 32 items in the contact list: Page up 
Move down 32 items in the contact list: Page down 
Move to the first item in the contact list: Ctrl-Home  
Move to the last item in the contact list: Ctrl-End  
 

10.3.1.2 Sign Out & Exit 
 
Use the "Sign Out" function to sign out of the current account without closing 
the Google Talk program. When you sign out of the current account, you are 
returned to the "Sign in" dialog where, if you wish, you may log in with a 
different Google account. You can execute "Sign Out" by pressing "Ctrl-l" or 
by pressing "Enter" on "Sign Out" from the "File" menu.  
To exit the Google Talk program, press "Alt-F4" or press "Enter" on "Exit" in 
the "File" menu.  
  

10.3.2 Managing Contacts 
 
When you log in to Google Talk, your contact list appears. When you use 
Google Talk for the first time, your contact list is empty. The sections below 
describe how to add, delete, and interact with contacts.   
 

10.3.2.1 Add Contact 
 
Use the "Add Contact" function to add a new contact to your contact list.  
To open the "Add Contact" dialog, press "Alt-q or open the menu by pressing 
F2, navigate to the "Contact" menu, "Contact" and press "Enter" on "Add 
Contact".  
  
The "Add Contact" dialog consists of 3 controls. Move among the controls by 
pressing "Tab" or "Shift-tab". 
 
1) E-mail: A computer edit box, into which you can input the e-mail address 
of the user you want to add.  
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2) Confirm: A button to save the new contact to your contact list. You can 
also press "Enter" after typing the e-mail address to add the contact.  
3) Cancel: Use this button to close the "Add contact" dialog and return to 
your contact list. 
  
  
After you add a contact, the contact displays as "off-line" until he or she 
accepts your contact invitation.  
After the contact accepts your request, the contact's status is reflective of his 
or her actual status.  
 

10.3.2.2 Delete Contact 
 
Use the "Delete Contact" function to delete a contact from your contact list. 
When you delete a contact, the user can no longer send you messages or 
see your status. 
To delete a contact, do the following: 
 
1) Navigate to the contact you want to delete in the contact list.  
2) Press "Del" or press "Enter" on "Delete Contact" from the "Contact" menu.  
3) You are prompted, "Do you want to delete XXX in the contact list? Yes". 
"XXX" is the user ID to delete. If you press "Enter", the contact is deleted.  
To cancel deletion of the contact, press "Space" to change to "No" and press 
"Enter". Or press "Esc" to cancel deletion. After canceling deletion, you are 
returned to the contact list. 
 

10.3.2.3 Block Contact 
 
You can block a contact in your "Contact list" from sending messages to you 
or seeing your status. Block is different from delete in that after blocking a 
contact, the contact ID remains in the Block list. When you delete a contact, 
the contact ID disappears from the contact list completely, yet the person 
may send you future contact invitations.  
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To block a contact, do the following: 
 
1) Navigate to the contact you want to block in the contact list.  
2) Press "Alt-b" or press "Enter" on "Block Contact" from the "Contact" menu.  
3) You are prompted, "Block XXX? Yes". "XXX" is the user ID to block. If you 
press "Enter", the contact is blocked.  
To cancel blocking the contact, press "Space" to change to "No" and press 
"Enter". Or press "Esc" to cancel blocking the contact. You are then returned 
to the contact list. 
 

10.3.2.4 Manage Block List 
 
The Block list contains the contacts you have blocked. You are able to 
unblock contact that you have blocked using this list. 
To open the "Manage Block list" dialog, press "Alt-m" or press "Enter" on the 
"Manage Block list" item in the "Contact" menu.  
  
The "Manage Block list" dialog consists of 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) E-mail: A list displaying the e-mail addresses of your blocked contacts.  
2) Unblock: this button unblocks the focused contact.  
3) Cancel: A button to close the "Block contact"  dialog and return you to 
your previous position. 
 

10.3.2.5 Contact Information 
 
Use the "Contact Information" function to display the on-line ID and E-mail of 
the selected contact and the contact request status. To open the "Contact 
Information" dialog, navigate to the contact in the list you want to view using 
“up arrow” or “down arrow” and press "Ctrl-I". Or you can open the menu and 
press "Enter" on "Contact Information" from the "Contact" menu.  
The "Contact Information" dialog consists of 2 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
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1) Contact Information: A Status area containing several pieces of 
information about the contact. Move to each item using “up arrow” or “down 
arrow”. 
 
A. Display name: Displays on-line ID set on the "My Status Options". 
B. E-mail: Displays E-mail account.  
C. Chat: Displays whether chat is "Enabled" or "Disabled". 
D. File sharing: Displays whether it is possible to send/receive files with this 
contact.  
E. Voice Chat: Displays whether voice chatting is possible.  
F. Status contact: Displays current contact request status such as 
"acceptance" or "standby".  
2) Close: A button to close the "View Contact Information" dialog and return 
you to the "Contact" list. 
 

10.3.2.6 Manage Contact List 
 
When you log into “Google Talk”, if you have pending contact requests 
dialogs pop up asking whether you accept each invitation.  All unanswered 
contact requests appear and can be acted on in the "Manage Contact List". 
Access the "Manage Contact List" to accept or reject pending contact 
requests.  
To open the "Manage Contact List" dialog, Press "Ctrl-p" or Press "Enter" on 
"Manage Contact List" from the "Contact" menu. 
The "Manage Contact List" dialog consists of 4 controls.  
1) E-mail: A list displaying user ID's of those requesting you to add them as a 
contact. 
2) Accept: A button to accept the focused user ID as a contact.  
3) Reject: A button to reject the focused user ID as a contact.  
4) Close: A button to close the dialog and return to the ""contact" list. 
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10.3.3 Start Chat 
 
Use the "Start Chat" function to open a conversation window through which 
you can send and receive text messages with the focused contact in your 
"Contact" list.  
To send a message to the focused contact, press “Ctrl-s” or navigate to the 
desired user ID, using “up arrow” or “down arrow” and press "Enter". Or open 
the "Actions" menu, and press "Enter" on the "Start Chat" option.  
 
 
The "Chat" dialog consists of 2 controls. Move among the controls using 
"Tab" and "Shift-tab" 
1) Input: An edit box into which to type your message.  
2) History: A read only edit combo box to view messages sent and received 
in chronological order. Messages are displayed as "Writer ID: message 
content".  
  
Use the following navigation keys in the "History" list. 
Move to the previous message: “up arrow” 
Move to the next message: “down arrow” 
Move to the first message: “Ctrl-Fn-Left arrow” 
Move to the last message: “Ctrl-Fn-Right arrow” 
 
To move to the "Contact list" while in a "Chat", press "Ctrl-t". Or choose 
"Contact list" from the "Actions" menu. If you select another contact from the 
"Contact list" and press "Enter", a new "Chat" window is opened.  
  
When multiple chat windows are opened, you can move among them using 
the following hot keys: 
Move to previous "Chat" window: "Ctrl-Shift-Tab key" 
Move to next "Chat" window: "Ctrl-Tab key" 
You can also move among chat windows by choosing the "Move to Next 
Chat" or "Move to Previous Chat" options from the "Actions" menu.  
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While in your "Contact list", you can press "Ctrl-t", to return to the most 
recently used "Chat" window. Or press "Enter" on the "Move to Recent Chat" 
option in the "Actions" menu.  
To exit "Chat" windows, press "Alt-F4” or "Esc" 
 

10.3.4 Start Voice Chat 
 
Use the "Start voice chat" function to start a real time voice conversation with 
a contact in your contact list. Unlike text chat, it is only possible to converse 
with one contact at a time using voice chat. However, you can send and 
receive text messages while having a voice conversation.  
Use the following steps to request a voice chat with one of your contacts: 
 
(1) Navigate to the contact in your list with whom you wish to have a voice 
chat, and press "Ctrl-h". Or press "Enter" on the "Start Voice Chat" item in 
the "Actions" menu. 
(2) The "Chat" window is opened, and "Calling" is displayed and a ringing 
sound is heard as the contact is alerted to the incoming chat request. The 
voice chat starts immediately, after the contact accepts your chat request. 
You can request a voice chat from the text "Chat" window as well as from the 
contact list.  
If you press "Enter" on "Cancel" (Esc while the "calling" message is 
displayed, you are returned to your previous position, and the voice chat 
request is canceled.  
 
When you receive a voice chat request, you can accept or reject as follows. 
(1) When you receive a request to start a voice chat, you are prompted, 
"calling from XXX? Accept question button". "XX" refers to the user 
requesting the voice chat.  
(2) Press "Enter" to accept the request and start the voice conversation. To 
reject the request, press "Space" to change the button to "Reject" and press 
"Enter". After rejecting, you are returned to your contact list. 
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10.3.5 Sending/Receiveing a file 
 
The Google Talk program on the Voice Sense QWERTY supports the ability 
to send and receive files. With this function, you can send your files to your 
Google Talk contacts and save files from your contacts on your Voice Sense 
QWERTY. 
 

10.3.5.1 Sending a file 
 
Use the "Send File" function to send files to your contacts. It allows you to 
send multiple files at one time, as well as to exchange messages in the 
"Chat" dialog while sending files.  
To send a file(s) to one of your contacts, do the following: 
 
(1) Navigate to the contact in your list to whom you want to send a file and 
press "Enter". The "Chat" window is opened.  
(2) Press the hot key, "Ctrl-f". Or select the "Send File" option in the 
"Actions" menu.  
(3) You are placed in a file browser area. Use normal File Management 
commands to navigate to and select files you wish to send. 
(4) Sending File Information appears. It is displayed in the "Received 
message" area of the chat-window. The information is displayed as "Send: 
Pending acceptance XX File, file name". "XX" represents the number of files 
which you have requested to send. 
(5) If your contact accepts receipt of the file or files, transfer begins. Once 
sending starts, progress rate and file name are displayed on the 
"Sending/receiving file information" list.  
(6) When file transfer is completed, you are return to the Sending/Receiving 
File Information list. It is displayed as "Send: complete XX File, file name".  
To cancel sending files, move to the desired file on the "Sending/Receiving 
File Information list" and press "Esc". File transmission is canceled and the 
"Sending File Information list" displays "Send: Me canceled. XX, file name". 
If your contact cancels receiving files during transfer, the "Sending File 
Information list" displays "Send: To canceled. XX, file name". 
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10.3.5.2 Receiving a file 

 
In addition to sending files to contacts, you can receive files they wish to 
send to you. You can receive multiple files at once, and exchange messages 
in the "Chat" dialog while receiving files.  
Use the following steps to receive files from one of your contacts: 
  
(1) When a contact requests to send you a file, "XXX send to file" message 
is displayed.  The "Chat" window is opened and the "Receiving File 
Information list" is focused.  
(2) The "Receiving File Information list" displays "Receiving: Pending 
acceptance XX file name". "XX" refers to the number of files your contact is 
requesting you receive. 
(3) To accept file transmission, press "Enter". File transfer begins.  
Once sending starts, progress rate and file name are displayed on the 
"receiving file information" list.  
(4) When Receiving File is completed, you are return to the Receiving File 
Information list. It is displayed as "Receive: complete XX File, file name".  
To cancel receiving a file, move to the file on the "Receiving File Information 
list" and press "Esc". File transmission is canceled and the "Receiving File 
Information list" displays "Receive: Me canceled. XX, file name". If your 
contact cancels sending files while receiving, the "Receiving File Information 
list" displays "Receive: To canceled. XX, File name". 
 

10.3.6 Other functions 
 
The Google Talk Program on the Voice Sense QWERTY supports additional 
features such as "Save conversation" and "Export/ Import Contact list", etc. 
The following is a detailed explanation of these additional features. 
 

10.3.6.1 Save Conversation 
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"Save Conversation" is a function to save messages exchanged with a  
contact as a text file. 
To execute this function, press "Alt-s" from the "Chat" window or select the 
"Save Conversation" item located in the "File" menu. 
 
The "Save Conversation" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab".  
 
1) File Name: A combo edit box in which to type in the name you want to 
give the conversation file.  
2) Confirm: A button to confirm and save the conversation.  
3) Cancel: Use this button to cancel saving the conversation and return to 
the "Chat" window.  
4) File list: A file browser area in which to set the path to save the 
conversation. By Default, the conversation is saved to the "My Documents" 
folder on the flashdisk. Use normal file and folder navigation to choose a 
different location.   
 

10.3.6.2 Manage Chat 
  
"Manage Chat" Allows you to view information about the open chat windows 
and to move directly to the selected window. You can also view the status of 
file transfers using this dialog. To open "Manage Chat" press "Ctrl-m” from 
the contact list or press "Enter" on the "Manage Chat" item in the "Actions" 
menu. 
"Manage Chat" consists of 5 controls. Move among the controls by pressing 
"Tab" or "Shift-tab". 
 
1) Chat list: a list of the currently open chat windows. You can navigate to a 
specific chat window using “up arrow” or “down arrow” and press "Enter".  
2) Status of sending File: A status bar displaying the status of 
sending/receiving files. This status bar only appears if you are currently 
sending or receiving files. 
3) Move to Chat: Use this button to move to the selected chat window.  
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4) Close chat: Use this button, to close the selected chat window.  
5) Cancel: Use this button to exit the "Manage Chat Window" dialog and 
return to the "Contact list". 
 

10.3.6.3 Find 
 
The "Find" command searches for a word or character string in the "History" 
edit box of the chat window. This can be useful in a situation where many 
messages are exchanged.  
To Execute "Find", press "Ctrl-f” from the chat window or press "Enter" on 
the "Find" item in the "Edit" menu.  
  
"Find" consists of 4 controls. Move among the controls by pressing "Tab" or 
"Shift-tab". 
 
1) Text to find: An edit box into which to enter the word you want to find. 
2) Search direction: A prompt button for choosing your search direction: 
"Forward" or "Backward". If you choose "Forward", the search is performed 
from the current position to the top of the chat. And if you choose "Backward", 
the search is performed from the current position to the end of the chat. You 
can change the search direction by pressing "Space" or "Backspace".  
3) Confirm: A button to execute "Find". 
4) Cancel: Use this button to exit the "Find" dialog and you are returned to 
the "Chat" window. 
  

10.3.6.4 Export Contact List  
 
You can use the "Export Contact list" function to save your "Contact list" as a 
CSV file. 
To open the "Export Contact list" dialog, press "Alt-x" from the "Contact list" 
or press "Enter" on the "Export Contact list" item in the "File" menu.  
  
The "Export Contact list" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
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1) File name: A combo edit box into which you can type the name for the 
contact list file.  
2) Confirm: Use this button to execute the "Export Contact list" function. 
3) Cancel: Use this button to exit the "Export Contact list" dialog and return 
to the "Contact list".  
4) File list: A file browser control in which you can set the path to save the 
"Contact list". Use normal file and folder navigation commands to navigate 
this list.   
 

10.3.6.5 Import Contact List  
 
You can use the "Import Contact List" function to import a CSV formatted 
contact list.  
To open the "Import Contact List" dialog, press "Alt-I" from the "Contact list" 
or press "Enter" on the "Import Contact list" item in the "File" menu.  
The "Import Contact List" dialog consists of 4 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) File name: A combo edit box into which you can type the name of the file 
you want to import.  
2) Confirm: Use this button to execute the "Import Contact list" function. 
3) Cancel: Use this button to exit the "Import Contact list" dialog and return to 
the "Contact list".  
4) File list: A file browser control from which you can select the desired 
contact list file (CSV). Use normal file and folder navigation commands to 
navigate the file list. When you locate the file you want to import, press 
"Enter". 
 

10.3.7 Setup Options 
 
The Google Talk Program on the Voice Sense QWERTY contains several 
option settings, including "My status options", "on-line ID", "auto-reply" 
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"notification and sound". Below is a detailed explanation of each of these 
option settings.  
 

10.3.7.1 My status Options 
 
This menu allows you to set how your status and on-line ID is displayed to 
your contacts.  
To open the "My status options" dialog, press "Alt-u" from the contact list or 
press "Enter" on "My Status Options" from the "Options" menu. 
 
The "My Status Options" dialog consists of 3 controls. Move among the 
controls by pressing "Tab" or "Shift-tab". 
 
1) My Status: A list from which you can select one of 5 status options: On-
line, Away, Idle, DND, Chat, or Off-line. Navigate among the options using 
“up arrow” or “down arrow”. 
2) Confirm: Use this button to save the setting. 
3) Cancel: Use this button to exit the "My status Options" dialog and return to 
your "Contact list".  
 

10.3.7.2 Action Options 
 
The "Action Options" dialog allows you to set auto-reply, idle time Display 
Contact List, etc.  
To open the "Action Options" dialog, press "Alt-a" from the contact list or 
press "Enter" on the "Action Options" item in the "Options" menu.  
  
The "Action Options" dialog consists of 5 controls. Move among the controls 
by pressing "Tab" or "Shift-tab". 
 
1) Action setting: A list of various option settings. Move among the settings 
using up arrow or down arrow.  
A. Display contact list: Choose whether the contact list displays all contacts 
or only online contacts. Use "Space" or "Backspace" to change the setting.  



422 
 

B. Contact request: Setup how to respond to an incoming contact request. 
The options are, "notification", "accept" and "reject". If you choose 
"notification", you are notified of the request and prompted to "accept" or 
"reject" the request. If you choose "accept", the request is automatically 
accepted. If you choose "reject", the contact is rejected automatically. Use 
"Space" and "Backspace" to change the value of the setting.  
C. Incoming chat request: Choose how to respond to an incoming chat 
request. You can choose to move to the chat-window immediately or for your 
focus to remain in the contact list. You can choose between "Move to the 
chat" and "Don't move". Use "Space" and "Backspace" to change the setting.  
D. File transfer request: This option allows you to set how to respond when 
one of your contacts requests to send you a file. The options are, "Alerts", 
"accept" and "reject". If you choose "Alerts", you are notified of the file 
transfer request and prompted to choose "Accept" or "Reject". If you choose 
"Accept", the transfer request is accepted automatically. If you choose 
"Reject", the request is automatically rejected. You can change the setting 
using "Space" or "Backspace". 
E. Incoming voice chat request: Choose how to respond when a contact 
requests to voice chat with you. Again, the options are, "Alerts", "accept" and 
"reject". If you choose "Alerts", you are notified of the voice chat request and 
prompted to choose "accept" or "reject". If you choose "accept", the voice-
chat request is accepted automatically. If you choose "reject", the voice chat 
request is rejected automatically. Use "Space" or "Backspace" to change the 
value of the setting.  
F. Auto reply to incoming chat request: You can set whether you send an 
auto-reply message when one of your contacts requests  a chat. You can 
choose between "Yes" and "No". Use "Space and "Backspace" to change 
the setting.  
2) Auto-reply message: An edit box into which to type a message for use 
with the auto reply function.  
3) Show me as "Away" when I’m inactive for: When there is no input for the 
specified amount of time, your status is automatically displayed as "Idle". 
Enter time in minutes. 
4) Confirm: A button to save the settings. 
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5) Cancel: A button to exit the "Action Options" dialog and return to the 
"Contact list".  
 

10.3.7.3 Alert Options 
 
The "Alert Options" dialog lets you set whether you use Message Sound 
Notifications While in Current Window and whether to play the keyboard 
sound when someone is typing. To open the "Alert Options" dialog, press 
"Alt-o" from the contact list or press "Enter" on the "Alert Options" item from 
the "Options" menu.  
The "Alert Options" dialog consists of 3 controls. Move among the controls 
by pressing "Tab" or "Shift-tab". 
 
1) Setting list: A list of various option settings. Move among the options using 
“up arrow” or “down arrow”. 
A. Play keyboard sound: You can select whether the keyboard sound is 
heard when you are typing a message. You can choose between "Yes" and 
"No"  by pressing "Space" or "Backspace". 
B. Message Sound Notification While Google Talk is In the Background: You 
can set whether notification sounds are heard to alert you of events such as 
incoming chats, requests for file transfers, or changes in contact status while 
Google Talk is running in the background. You can choose between "Yes" or 
"No" by pressing "Space".  
C. Message sound Notification: You choose whether you hear notification 
sounds to alert you to Google Talk events.  You can choose between "Yes" 
and "No".   
2) Confirm: Use this button to save your settings. 
3) Cancel: Use this button to close the dialog without saving your changes 
and return to the "Contact list".  
 

10.3.7.4 Path Options 
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The "Path Options" Allows you to set the path for saving conversations, file 
transfers, and temporary storage. To open the "path options" dialog, press 
"Alt-p" or press "Enter" on the "Path Options" item from the "Options" menu. 
The "Path Options" dialog consists of 5 controls. Move among the controls 
by pressing "Tab" or "Shift-tab".  
 
1) Set download path: A button to set the path for saving messages. If you 
press "Enter" on the button, the "Set path" dialog appears. Navigate to your 
desired folder and press "Enter".  
2) Set temporary path: A button to set the path for saving temporary files. If 
you press "Enter" on this button, the "Set path" dialog appears. Navigate to 
your desired folder and press "Enter".  
3) Saving download path: A button to set the path for saving received files. If 
you press "Enter" on this button, the "Set path" dialog appears. Navigate to 
your desired folder and press "Enter".   
4) Confirm: Use this button to save your settings. 
5) Cancel: Use this button to close the "Path Options" dialog without saving 
changes and return to the "Contact list".  
 
 
10.4 Sense Chat 

 
The Sense Chat program operates in a similar fashion to text chatting with 
Google talk or MSN Messenger, except that the connection occurs between 
2 Sense notetakers via Bluetooth. This means, rather than sending 
messages over the internet, messages are transmitted directly from one 
notetaker to the other via the Bluetooth connection. While any 2 people with 
any 2 Sense notetakers can use the program, this program is especially 
useful for the Deaf-Blind, as 2 Deaf-Blind users can communicate face-to-
face using 2 Voice Sense notetakers to type messages, and can read 
received messages on the Braille display (When connected to SyncBraille)s.  
To launch Sense Chat, use the Up or Down arrow to navigate to “Sense 
Chat” in the “Social Networking” menu, and press “Enter”. Or, press “c” to 
execute Sense Chat directly from the “Social Networking” menu. You can 
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also launch “Sense Chat” from anywhere on the unit by pressing “Windows-
C”. 
Please ensure that Bluetooth is turned on before attempting to connect with 
another notetaker via Sense Chat. If Bluetooth has not been activated and 
you try to connect with another notetaker, you are prompted, “Please turn on 
Bluetooth”. 
 

10.4.1 Connecting the Notetakers 
When “Sense Chat” is launched, you are placed in the conection options 
menu. The menu contains 2 options, “Bluetooth Serial Port(Send)” and 
“Bluetooth Serial Port(receive)”. For connection to be successful, one Sense 
notetaker must choose “Send” and the other must choose “Receive”. Once 
you and your partner have agreed which option each of you will take, 
navigate to your choice using the Up or Down Arrow and press “Enter”. Or, 
press “t” for “Send” or “r” for “Receive”. 
 
When the “Receive” option is chosen, the unit announces and displays 
“Waiting….” And waits for the send device to request a pairing code. 
When the “Send” option is chosen, the unit announces and displays, 
“Searching forVoice Sense notetaker”. Full cells appear on the Braille display 
(When connected to SyncBraille) to note progress, and when the search is 
finished, a list of available devices is displayed. Use the Up or Down arrow to 
navigate the devices in the list, and press “Enter” on the one with which you 
wish to connect. You are then prompted to “Enter pin code”. Enter a 4 digit 
number of your choosing, and press “Enter”. 
The “Receive” device is then prompted to, “Enter pin code”. Please enter the 
same 4 digit number in to the “Receive” device and press “Enter”.  
If the pin codes match, the “Send” device announces and displays, 
“Authentication code accepted.”  
Shortly, both devices should announce and display “connected”. Both 
devices also play a chime indicating connection success. Immediately after 
the “connected” message and connection sound, both devices are placed in 
the Chat window. 
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10.4.2 Using the Chat Window 
The “Chat” dialog consists of 3 items: the “Sen Message” edit box, the 
“Received Message” multi-line edit box, and the “Close” button. Use “Tab” 
and “Shift-Tab” to navigate among the items in the dialog. 
Once the Sense notetakers are connected and both notetakers display the 
“Chat” dialog, both users can send and receive messages. To send a 
message, type it in to the “Send MSG” edit box, and press “Enter” to send 
the message. By default, when a message is sent, a sound plays to indicate 
the message was sent successfully.  
By default, when a message is received, it automatically appears, and 
remains displayed until you begin typing a new message. The message is 
also spoken, and a sound alerts you as well. You can configure how you 
wish to have the Voice Sense alert and act when sending and receiving 
messages in the “Options” menu described later in this section. 
To view the message history, tab to the “received Msg” multi-line edit box. 
The messages appear in a list in the order in which they were written. 
Messages you have sent are labeled, “Sent msg”, and messages you have 
received are labeled, “receive msg”. Use the Up and Down arrows to move 
among the items in the list. 
To exit Sense Chat, tab to the “Close” button and press “Enter” or press “Alt-
F4”. 
 

10.4.3 The Sense Chat File Menu 
The “Sense Chat” program contains 2 menus: “File” and “Options”.  
The “File” menu contains 3 items: “Save”, “Save As”, and “Close. 
The “Save” option allows you to save a log of your current conversation. To 
activate “Save”, press “Alt” to open the menu. Use the Down arrow to 
navigate to “Save” and press “Enter”. Or, you can press “Control-s” directly 
from the Chat Window.  
The “Save” dialog is similar to that which exists in the Word Processor. It 
contains a “File name” edit box, a “Confirm” button, a “Cancel” button, and a 
“File list” control. By default, the chat log is named “chatting.txt” and is saved 
in the “My Documents” folder. You can type a new name in the edit box, and 
choose a different location in the file list control. To save the file press “Enter” 
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or tab to the “confirm” button and press “Enter. To cancel saving, tab to the 
“Cancel” button and press “Enter”, or press “Alt-f4”. 
The “Save As” option operates exactly as does the “Save” option described 
above, but can be used to save the currently saved chat log under a different 
name or in a different location. To activate “Save As”, press “Alt” to open the 
menu. Navigate to “File” and press “Enter”. Navigate to “Save As” and press 
“Enter”. Or, you can type “Alt-s” to activate “Save As” directly from the Chat 
Window. 
Use the “Close” option in the “File” menu to close “Sense Chat” or type “Alt-
F4”. 
 

10.4.4 Sense Chat Options 
The “Options” menu allows you to set the way you want sense Chat to 
behave in regards to alerts and messages. To Bring up the “Options” dialog, 
press “Alt” to open the menu. Use the Down arrow to navigate to “Options”, 
and press “Enter”.  
The “Options” dialog contains 3 controls: the Settings list, a “confirm” button, 
and a “Cancel” button. Move among the controls using “Tab” and “Shift-Tab”.  
The Settings list contains the following items: “Message Alert”, “Received 
message alert setting”, “Send message alert setting”, “Use alert when 
connected to user”, “Use alert when disconnected from user”, “Use alert 
when sending message”, and “Use alert when receiving message”. Use the 
Up and Down arrows to navigate among the settings in the list. Use “Space” 
to change the value of the setting. 
The “Message Alert” setting allows you to choose whether you want Sense 
Chat to alert and display messages when they are received, or simply to 
alert you that they are there. If you choose “Alert and display”, and you are 
either typing a message in Sense Chat or running sense Chat in the 
background while you perform another task, you are interrupted, and the 
chat message is displayed. In this case, pressing any key returns you to your 
previous task. If you set this option to “Alert only”, a sound is played when a 
Sense Chat message is received, however, the message is not displayed. 
The “Received message alert setting” allows you to define how you wish to 
be alerted of incoming messages. You can choose among 2 different sounds 
(Sound 1 and Sound 2),. Press “Space” to cycle among the choices. 
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The “Send message alert setting” is similar to the “received message alert 
setting” described above, but applies to the alert you receive when you send 
a message successfully. 
The “Use alert when connected to user” setting allows you to define how the 
Voice Sense behaves when you have successfully connected to another 
Sense notetaker user. You can set this option to “Sound”, or “Off” in which 
case you will receive no alert other than the brief message that is displayed 
when connection is successful. Press “Space” to cycle among the choices. 
The “Use alert when disconnected from user” setting is similar to the setting 
above, but applies to how the Voice Sense behaves when you are 
disconnected from the Sense notetaker user you are currently chatting with. 
The final two settings allow you to choose whether you want any alert when 
sending or receiving messages. The choices are “On”, and “Off”. Press 
“Space” to adjust the setting. 
When you have finished setting your preferences, press “Enter” to save the 
settings, or tab to the “Confirm” button and press “Enter”. If you do not want 
to save your changes, tab to the “Cancel” button and press “Enter” or press 
“Alt-F4”. 

 
10.5 Hot Keys in Social Networking 

 
 

10.5.1 Twitter 
 
Sign Out: Ctrl-g  
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s  
Home Timeline: Ctrl-h  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u  
Mention Timeline: Ctrl-m  
Retweet Of Me: Alt-o  
List Timeline: Alt-P  
Favorite Timeline: Control-L  
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Tweet: Ctrl-t  
Remove Tweet: Delete  
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w  
Find Tweets from the Current Timeline: Control-Alt-F  
Find Again Tweets from Current Timeline: Alt-Shift-F  
List Manager: Control-P  
Add User to List: Control-K  
List User View: Control-J  
List View in Current Tweet: F3  
Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-Fbled  
Escape: Esc key  
 
Move to the next tweet: Down arrow  
Move to the previous tweet: Up arrow  
Move to the first tweet on the refreshing list: Ctrl-Home  
Move to the last tweet on the refreshing list: Ctrl-End  
Move to the previous 32 list: Fn-Un arrow  
Move to the next 32 list: Fn-Down arrow  

 
10.5.2 Google talk 
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File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Send File: Alt-f  
Move to Recent Chat: Ctrl-t  
Manage Chat: Ctrl-m  
 
Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
 
Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
 
Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
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Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
Navigation keys in Google Talk. 
Move to the previous item: Up arrow  
Move to the next item: Down arrow 
Move to the previous 32-items: Fn-Up arrow 
Move to the next 32-items: Fn-Down arrow 
Move to the first item: Ctrl-Home 
Move to the last item: Ctrl-End 

 
10.5.3 Sense Chat 

Chat Window Commands: 
Move among the controls: Tab and Shift-Tab 
Send message: type message and press Enter 
Move among messages in history: Up and Down arrows 
Move to top of list: Control-Home 
Move to bottom of message list: Control-end 
Save conversation: Control-s 
Save conversation under different name: Alt-s 
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Start selection: Control-b 
Select all: Control-a 
Copy: Control-c 
Paste: Control-v 
Exit Sense Chat: Alt-F4 
 
Sense Chat Options commands: 
Move among the Controls: Tab and shift-Tab 
Move among items in the settings list: Up and down arrows 
Change the value of a setting: Space 
Save settings: Enter 
Cancel saving settings: Escape or Alt-F4 
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11. EXTRAS 
	  

11.1 Sense Dictionary 
	  

The Sense Dictionary is an add-on piece of software for the Sense 
notetakers available for purchase from HIMS. The basic package 
includes the New Oxford American Dictionary, and the Concise Oxford 
American Thesaurus. You can also purchase the following additional 
bilingual dictionaries: the Concise Oxford Paravia Italian Dictionary, the 
Concise Oxford Hachette French Dictionary, the Concise Oxford Spanish 
Dictionary, and the Oxford Essential Arabic Dictionary. 
 
Note: If you have not purchased the dictionary package containing the 
dictionary data and license key, pressing "Enter" on the Sense Dictionary 
option in the "Extras" menu results in the message, "Authentication 
failed". For pricing and purchasing information, please contact HIMS, Inc. 
Call us by phone at 888-520-4467, or e-mail sales@hims-inc.com. 

 
 
11.2 BookShare Download 
	  

The “BookShare Download” program provides direct search and 
download access to the repository of books and periodicals available 
from www.bookshare.org. 

 

11.2.1 What is BookShare? 
	  

BookShare is a repository of books and periodicals in accessible formats 
containing over 150,000 titles at the time of this writing. The collection is 
increased through the work of volunteers who scan and proofread books, 
federal grants funding the purchasing and digitizing of various types of 
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material, and contributions from book publishers of electronic versions of 
their published texts. 
 
BookShare titles are available in various formats including DAISY, BRF, 
NIMAC, and audio. The Voice Sense QWERTY supports access to the 
DAISY and BRF formats via “BookShare Download”.  
 
To become a BookShare member, you must complete BookShare’s 
application process, including providing proof of reading disability, and 
pay the associated yearly membership fees. Payment can be monitary, or 
users can earn credit toward their membership fees by scanning material 
for the collection and/or proofreading material scanned by others. While 
the majority of the BookShare titles require you to have a membership to 
access them, several thousand titles in the collection are public domain 
works, and thus, can be accessed by anyone, regardless of whether you 
have a bookShare membership. 
 
For more information about BookShare, the application process, or the 
collection, please visit www.bookshare.org. 

 

11.2.2 Executing BookShare Download 
 

To open the “BookShare Download” program, from the Main Menu, use 
“Down arrow” to navigate to “extras” and press “Enter” or press “x” to 
jump to and open the “extras” menu. In the “Extras” menu, use “Down 
arrow” to navigate to “BookShare Download” and press “Enter”, or press 
“b” to jump to and open “BookShare Download” directly from the “Extras” 
menu. 
You can launch “BookShare Download” from anywhere on the unit by 
pressing “Windows-K”. 
 
When you first open “BookShare Download”, you are placed in the “login 
Settings” dialog in which you can enter your BookShare account 
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information. Press “Tab” and “Shift-Tab” to move among the items in the 
“Login Settings” dialog.  
 
The “login Settings’ dialog contains the following items: “Login ID” 
computer edit box, “Login password” computer edit box, “anonymous 
Mode” checkbox, “Save” button, and “Cancel” button. 
 
Enter your BookShare user account ID and password in to the computer 
edit boxes. To save the information, press “Enter” or Tab to the “Save” 
button and press “Enter”. If you do not have a BookShare account, you 
can still access the public domain material in “anonymous Mode”. To 
connect to “BookShare Download” using “Anonymous Mode”, leave the 
computer edit boxes for ID and password blank, and press “Space” on 
the “Anonymous Mode” check box. Press “Enter” to save the setting, or 
Tab to the “Save” button and press “Enter”.  
 
If you choose to log in using “Anonymous Mode” you are warned that 
there will be download restrictions when using Anonymous Mode. When 
you have saved your login information, you are placed in the main 
“BookShare Download” dialog on the “Select Search Mode” combo box. 

 

11.2.3 The main BookShare download Dialog 
	  

The “BookShare Download” dialog contains 7 items: 

1. “Select Search Mode” combo box: you can choose to search “Books”, 
“periodicals”, or your download “History”. Use “Space” to change the 
value of the setting. 

2. “Select Search Method” combo box: (only appears when “Books” is 
chosen from the “Select search Mode” combo box. You can choose 
to search BookShare’s book collection by word (Title, Author, or 
ISBN), by category or to search the full text of the materials in the 
collection. Use “Space” to change the value of the setting. 
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3. Search term Edit box: If you have chosen to search by periodical, you 
are asked to enter the “periodical ID”. If you have chosen to search 
the book collection for a title, author, or ISBN, the edit box asks for 
“title, Author, or ISBN”. If you have chosen to do a full text search, 
you are asked to “Enter text”. 

4. “Search” button: Press “Enter” on this button to initiate a search. 
5. “Login Settings” dialog” Opens the same dialog as described above, 

allows you to change your BookShare account information or switch 
to “Anonymous mode”. You can open this dialog using “”control-s”. 

6. “Options” button” Opens the “Options” dialog where you can set 
default download type, download location, and whether the Voice 
Sense QWERTY automatically unpacks BookShare books. You can 
also open this dialog using “Control--o”. 

7. “Exit” button: Exits the “BookShare Download” program. You can also 
press “Alt-F4”. 

 

Press “Tab” and “Shift-Tab” to move among the items in the dialog. 
 

11.2.4 Searching for Books 
When you choose “Books” from the “Select Search Mode” combo box 
described above, the next item in the dialog is “Select Search Method”. 
Press “Space” to choose between “Search word”, “Category search” and 
“Search full text”.   
When you choose to “Search word”, the next item in the dialog is an edit 
box in to which you should enter a keyword for which you want title, 
author, or ISBN results. When you have entered the word you want to 
search, press “Enter” or Tab to the “Search” button, and press “Enter”. 
 
If you choose “Category Search” the next item in the dialog is a list box 
containing the 36 available categories. Press “Up arrow” and “Down 
arrow” to navigate the category list. Press “Enter” to initiate the search, or 
Tab to the “Search” button and press “Enter”. 
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When you choose “Search full text”, you are presented with an edit box 
just like when choosing “Search Word”, but, instead of entering author, 
title, or ISBN information, you should enter a term by which you want to 
search the full text of the books in the collection. 
The Voice Sense QWERTY announces, “searching…” and progress 
beeps are heard as the unit searches the BookShare library for items that 
match your search terms or chosen category. When the search is 
complete, you are placed in a list of results that match your search. 
Navigate the list using “Up arrow” and “Down arrow”.  
 
 The “BookShare Download” dialog now contains 3 additional items: the 
“Search Results” listbox you are now in, a “Detail information” button”, 
and a “Download” button. If the results list contains more than 250 items, 
an additional button, “Next list”, appears after the results list in the tab 
order, also accessed by pressing “Control-n”. 
 
Use “Up arrow” and “Down arrow” to navigate the list of items in the 
“Search Results” list. If you press “Enter on the “Detail information” 
button, or press its shortcut key, “Control-I”, you are placed in a dialog 
providing more information about the book. 
 
The “Detail Information” dialog contains the following items: 
A list box containing, “title”, “Author”, “ISBN”, “Brief Synopsis”, “Complete 
Synopsis”, “Category”, “Language”, “Publisher”, “publish date”, “Quality”, 
and “Free”. 
“close” button: closes the “Detail information” dialog, and returns you to 
the main dialog. 
 
The “Detail information” listbox contains the following information: 
“Title” shows the complete title of the book. 
“author” lists the author or authors of the work. 
“ISBN” lists the International Standard Book Number. 
“Brief Synopsis” gives a short or partial synopsis of the book. 
“Complete synopsis” provides a more detailed overview of the work. 
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“Category” lists the category the book is logged under in the BookShare 
library. 
“Language” lists the language in which the book is printed. 
“Publisher” lists the publisher of the book. 
“publish date” lists the copyright date of the work. 
“Quality” refers to the quality of the scanned material. 
“free” shows whether the book is part of the free, public domain 
collection, or requires a membership to download (indicated by “not 
free”). 
 
You can download a book in the “search Results” list either by pressing 
“Enter” on the book title in the list, or by navigating to the “Download” 
button and pressing “Enter”. If you are logged in in “anonymous Mode” 
and pres “Enter” if the book is not part of the public domain collection, the 
Voice Sense announces and displays, “This content is not free” and 
returns you to the “Search Results” list. 

 

11.2.5 Searching for periodicals 
	  

If you select “periodicals” from the “select search Mode” combo box, the 
next item in the dialog is an edit box in to which you can enter a 
“periodical ID”. Each periodical in the BookShare collection contains a 
numerical ID you can use to quickly access it. Enter the ID in the edit box, 
and press “Enter” to initiate the periodical search, or tab to the “Search” 
button and press “enter”. When the search is complete, a list of available 
issues of that periodical is displayed. 
 
If you do not know the ID of the periodical you wish to find, simply leave 
the edit box blank and press “Enter”. If you have typed nothing in to the 
edit box, the entire list of available periodicals is displayed in alphabetical 
order. Use “Up arrow” and “Down arrow” to navigate the list. Press 
“Enter” on your desired periodical, and the list of available issues  for that 
periodical is displayed. 
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The issues list also contains a “detail Information” button for each item. 
The “Detail information” for periodical issues contains the following 
information: 
“Title”: the title of the periodical issue. 
“Edition”: The edition date of the periodical issue. 
“Revision”: the number of the revision of the online version of the 
periodical posted to Bookshare. 
“Revision time”: the time the most current revision was posted to 
BookShare. (Useful if a revision contains errors in DAISY structure or 
text, as you can determine whether you have downloaded the most 
recent version) 
“Category”: the type of periodical (newspaper, magazine, etc). 
 
As with a book, to download an issue of a periodical in the list, simply 
press “Enter” on it, or Tab to the “Download” button, and press “Enter”. 

	  

11.2.6 Searching History 
 
To search your download history, choose “History” from the “Search Mode” 
combo box, Tab to the “Search” button, and press “Enter”. You are 
presented with a book list just like the one that appears when you receive 
results in the “Books” search mode. The book list contains the list of books 
you’ve downloaded in the last month from any device you have connected 
to BookShare. As with the results from the “Books” search, you can get 
detailed information for a book and download it.  
 
11.2.7 Option Settings 

The “Options” dialog allows you to set items such as download location, 
default download type, and whether the Voice Sense QWERTY 
automatically unpacks the BookShare book or periodical. 
 
To open the “Options” dialog, Tab to the “Options” button and press 
“Enter” or press “Control-o” to open the “Options” dialog directly from 
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anywhere in “BookShare Download”. The “Options” dialog contains the 
following items: 
 Option settings list: contains “Default download type” and “Auto unzip” 
on/off.  
“default download folder” button: opens a dialog for selecting default 
download location. 
“Save” button: Press “Enter” on this button to save your settings. 
“Cancel” button: Press Enter on this button to exit the “Options” dialog 
without saving your changes. 
 
The option Settings list contains 2 items: “Default Download Type” and 
“Auto unzip” on/off. Use “Up arrow” and “Down arrow” to move among the 
settings in the list. Press “Space” to change the value of each setting. 
 
There are 3 options for the default download type: “DAISY”, “BRF”, and 
“Prompt”. If this option is set to “DAISY”, whenever you initiate the 
downloading of a book or periodical, the DAISY version is automatically 
downloaded. In the same way, if you choose “BRF”, the BRF version is 
automatically downloaded. If you set this option to “Prompt”, each time 
you initiate a download, you are prompted for the download type. 
 
The “Auto unzip” on/off option lets you choose whether you want the 
Voice Sense QWERTY to automatically unpack books or periodicals 
when they are downloaded. If this is set to “on”, when the download 
completes, the Voice Sense QWERTY announces, “unzipping 
bookname….” And automatically unpacks the contents and places it in a 
folder with the same name as the zip file. If you set this to “Off”, you are 
returned to the main dialog immediately after downloading, and you must 
extract the zip file manually from the “File Manager”. 
 
The “Default Download folder” button opens a File Manager dialog in 
which you can choose the default download location for your BookShare 
material. For example, you may wish to create a “DAISY” folder and have 
all your BookShare material automatically download to that location. Use 
normal file/folder navigation commands to select the folder in which you 
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want BookShare material to be stored, and press “Space” to select your 
desired folder. Press “Enter” to save the location and return to the 
“Options” dialog. By default, the “Default Download Folder” is set to 
“flashdisk/downloads”. 
 
When you have chosen your desired settings, press “Enter” to save them, 
or Tab to the “Save” button, and press “Enter”. If you want to exit the 
“Options” dialog without saving your settings, press “Enter” on the 
“Cancel” button, or press “Alt-F4”. 

 

11.3 Google Maps 
	  

11.3.1. What is “Google Maps”? 
Google Maps is web-based route planning software, used to provide you 
text directions for navigating from one place to another, using a 
combination of Internet-based maps and GPS location information. You 
can use Google Maps to plan a walk to a store 2 blocks away, or a drive 
to a relative’s house in another state.  

 

11.3.1.1 Terms used in Google Maps 
The following terms are used in the Google Maps application and also in 
the subsequent documentation: 
 
POI: Point of Interest, a business or location falling under 1 of many 
categories such as “restaurant” or “medical clinic”. 
Category: Type of business or location being searched, for example, 
florist, movie rental, contractor, beauty, etc. 
Start position: The position at which the route begins. 
Destination: The position at which you intend to arrive at the end of the 
route. 
Waypoint: a point between the start position and destination at which you 
intend to stop for any reason. 
Route: the travel directions from the start position to the destination. 
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11.3.2. Pairing a GPS Receiver 
	  

The Voice Sense QWERTY contains an internal GPS receiver. However, 
sometimes you may wish to use an external Bluetooth receiver as it may 
provide a stronger signal in areas where satellite reception is weak. To 
pair your Voice Sense with a Bluetooth receiver, follow these steps: 
1. Make sure your Bluetooth receiver is powered on and is discoverable. 
2. On the Voice Sense, from the Main menu, press “l” to launch the 

Bluetooth Manager. 
3. The Bluetooth Manager automatically begins searching for devices. 

While the search is performed, progress beeps are heard and 
progress is displayed on the Braille display (When connected to 
SyncBraille) in the form of full cells. 

4. When the search is complete, the names of the available Bluetooth 
devices are announced, and you are placed in the Bluetooth devices 
list. 

5. Navigate to your Bluetooth receiver using “Up arrow” and “Down 
arrow” and press “Enter” on your receiver’s Bluetooth name. 

6. The Voice Sense QWERTY announces “Scanning for services”. 
7. When the scan is complete, the services list is shown. 
8. Navigate to “Serial” and press “Enter”. 
9. If your Bluetooth receiver requires a pin code, you are asked for this. 

Enter it and press “Enter”. 
10. The Voice Sense QWERTY should connect to your receiver, and 

announce, “Connected”. 
 

11.3.3. Executing “Google Maps” 
	  

The “Google Maps” application is located in the “Extras” menu of the 
Voice Sense QWERTY. To open “Google Maps”, press “x” from the Main 
Menu, or navigate to the “extra’s” menu, and press “Enter”. From the 
“Extras” menu, use “Up arrow” or “Down arrow” to navigate to “Google 
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Maps” and press “Enter”, or press “g” to jump to and open “Google 
Maps”. 
You can launch “Google Maps” from anywhere on the unit by pressing 
“Windows-P”. 
 
When “Google Maps” is launched, the Voice Sense QWERTY 
immediately attempts to connect to the GPS receiver. If GPS connection 
is successful, the unit announces, “Successfully connected GPS, 
searching for location”. When your position is acquired, the unit says, 
“Current position information:” and announces your current position. If the 
GPS signal is too low to acquire a position, the unit says, “GPS signal 
strength is low”, and no position information is given. 
 
The position information displayed includes, “current position 
information”, “Latitude”, and “Longitude”.  

 
11.3.3.1 Google Maps main window. 

 

The main “Google Maps” dialog consists of 4 areas: “current position 
information”, “Start position”, “Destination information”, and “Near POI’s”. 
Move among the 4 areas of the dialog by pressing “Tab” and “Shift-tab.  
 
Use the following keystrokes to navigate the Google Maps main window: 
1) Move to next information element: Down arrow 
2) Move to previous information element: Up arrow 
3) Move to first information element: Home 
4) Move to last information element: End 
5) Move between  “Current position information” to “start 

position/Destination Information”:  Tab/Shift-Tab 
6) Open program menu: Alt 

 

The Google Maps Menu consists of 5 submenus: “Search”, Position 
Setting”, “User POI’s”, “Route”, and “Options”. 
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11.3.3.2 Search 
	  

The “Search” menu allows you to search for locations by address (Search 
for Address) or points of interest (Advanced POI Search). 

 
11.3.3.2.1 Search address 
	  

You can search for a location using a specific address using the “Search 
for Address” item in the “Search” menu. To open the “Search for Address” 
dialog, press “Alt”to open the “Google Maps” menu. Navigate to “Search” 
and press “Enter” or press “s” to open the “Search” menu. Press “Enter 
on “Search for Address” or press “a” to open the “Search for Address” 
dialog. You can also open the “Search for “Address” dialog by pressing 
“Control-f” from the “Google Maps” main window. 
  
The “Search for Address” dialog consists of 9 controls and you can move 
among them with “tab” and “Shift-tab” . 
 

1) Area selection:  dialog for choosing the State and city you wish to 
search. 

2) Street address: An edit box for typing the exact street address of the 
location you want to search. 

3) Search button: Press “Enter on this button to initiate the search. 
4) Address information: (appears after a search has been performed) 

shows the address of the point of interest that is closest to the location 
you typed. 

5) Set as Start Position button: Press “Enter” on this button to set the 
address in “Address Information” as your route’s start position. You can 
also activate this button by pressing “Alt-s”. 

6) Set as destination button: Press “Enter” on this button to set the address 
in “Address information” as the destination, or end point of your route. 
You can also activate this button by pressing “Alt-d”. 
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7) Set as Waypoint button: Pres “Enter” on this button to set the address in 
“Address information” as a “Waypoint” or stop in the middle of your 
route. You can also activate this button by pressing “Alt-w”. 

8) Add to User POI button: Press “Enter” on this button to add the address 
in “Address information” to your personal points of interest. You can also 
activate this button by pressing “Alt-u”. 

9) Close button: Press “Enter” on this button to close the “Search for 
Address” dialog. You can also exit the dialog by pressing “Escape”or 
“Alt-F4”. 

 
Note) If there are no search results, “Address information”, “Set as Start 
position”, “Set as destination”, “Set as Waypoint”, and “Add to User POI” 
controls do not appear.  
 
To search for an address, please follow these steps: 
 

1. Open the “Search for Address” dialog as described above. 
2. If the Area Selection is as you desire, Tab to the Address field. if you 

need to change the area selection, press “Enter” to open the “Area 
selection” dialog. 

3. In the “Area Selection” dialog, Use “Up arrow” and “Down arrow” to 
move among the items in the “State” and “City” combo boxes. 

4. Tab to the “Confirm” button and press “Enter” to return to the “Search 
for Address” dialog. 

5. Tab to the “address” edit box, and type the street address of the 
location you want to search. 

6. Tab to the “Search” button and press “Enter” to initiate the search. 

 

Once the results are displayed, move among them using “Up arrow” and 
“Down arrow”. Use the buttons described above to set your desired 
location as “Start position”, “Waypoint”, “Destination”, or “User POI”. 
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11.3.3.2.2 Search by category 
 

You can use the “Advanced POI Search” option in the “Search” menu to 
search for a location according to a specific type of business or 
establishment by specifying a category by which to search.  
 
To open the “Advanced POI Search” dialog, press “Alt”to open the 
“Google Maps” menu. Navigate to “Search” and press “Enter” or press “s” 
to open the “Search” menu. Press “Enter on “Advanced POI Search” or 
press “f ” to open the “Search for Address” dialog. You can also open the 
“Advanced Poi Search” dialog by pressing “Alt-f ” from the “Google Maps” 
main window. 
 
The “Advanced POI Search” dialog contains the following controls: 

1) Area Selection: a dialog for choosing the city and state in which you 
want to search. 

2) Category Selection combo box: A combo box from which to choose the 
type/category of POI for which you want to search. Navigate the items in 
the combo box using “Up arrow” and “Down arrow”. 

3) POI range edit box: enter the range (radius) in number of feet to define 
the size of the area you want to search. 

4) POI Name edit box: If you know all or part of the name of the 
establishment for which you want to search, type it in this edit box. 

5) Search button: Press “Enter” on this button to initiate the search. 
6) POIs list box: (appears after the search is completed) list of points of 

interest matching the search. Navigate the list using “Up arrow” and 
“Down arrow”. 

7) POI Information list box: Lists the POI name, type, phone number, and 
address. Use “Up arrow” and “Down arrow”to navigate among the 
information elements.  

8) Set as Start Position button: Press “Enter on this button to set the 
currently focused POI as the start position of your route. You can also 
activate this button by pressing “Alt-s”. 
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9) Set as destination button: Press “Enter on this button to set the currently 
focused POI as the endpoint (destination) of your route. You can also 
activate this button by pressing “Alt-d”. 

10) Set as Waypoint button: press “Enter” on this button to set the currently 
focused POI as a Waypoint, or stop in the middle of your route. You can 
also activate this button using “Alt-w”. 

11) Add to User POI button: Press “Enter” on this button to add the 
currently focused POI to your user points of interest. You can also 
activate this button by pressing “Alt-u”. 

12) Close button: Press “enter” on this button to close the “Advanced POI 
Search” dialog and return to the “Google Maps” main window. You can 
also exit the dialog by pressing “Escape” or “Alt-F4”. 

 

Note) If there are no search results, “POI list”, “POI Information”, “Set as 
start position”, “Set as destination”, “Set as Waypoint”, and “Add to User 
POI” controls do not appear.  

 

11.3.3.3 Setting Position 
	  

The “Position Setting” menu contains the following items: “Add New User 
POI”, “Synchronize GPS and start Position”, and “Location information”,  

 
11.3.3.3.1 Add new User POI.  

 
The “Add New User POI” option in the “Position Setting” menu allows you 
to save your current position as a point of interest.  
 
To open the “New User POI” dialog, press “Alt” to open the menu, and use 
“Down arrow” to navigate to “Position Setting” and press “Enter”: then press 
“Enter” on “New User Poi”. 
The “Add New User POI” dialog contains 9 controls. you can move among 
them with “tab” and “Shift-tab” .  
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1) POI name edit box: An edit box in to which you can type a name for the 
point of interest if it is not already filled in. 

2) Latitude static box: shows the latitude of the POI. 
3) Longitude static box: lists the longitude of the POI. 
4) Phone edit box: an edit box for entering the phone number of the 

location. 
5) Address edit box: An edit box for entering the street address for the POI. 
6) POI explanation edit box: An edit box in to which you can type 

information you wish to remember or associate with this point of interest. 
7) Select Media file button: Press “Enter” on this button to open the “Select 

Media File” dialog. You are placed in a File Manager control in which 
you can use normal file/folder navigation commands to access any 
media file you wish to associate with the POI. Press “Space” on the 
desired file to select it, and press “Enter”. 

8) Add button: Press “Enter” on this button to add the point of interest to 
your saved POI’s. 

9) Close button: Press “Enter” on this button to exit the “New User POI” 
dialog. 

 
11.3.3.3.2 Synchronize GPS and Start Position 
	  

This menu item option does just what its name suggests, it synchronizes 
the current GPS location to the start position of the current route. 
 
To synchronize your GPS location with the start position, press “Alt” to 
open the menu, and use “Down arrow” to navigate to “Position Setting” 
and press “Enter”: then press “Enter” on “Synchronize GPS with Start 
Position”. You can also press “s” to synchronize the GPS location with the 
Start Position directly from the “Google Maps” main window.  

 

11.3.3.3.3 location Information.  
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The “Location Information” dialog provides you information about your 
current position, and allows you to set the current position as the Start 
Position, destination, Waypoint, or view near POI’s.  
 
To open the “Location Information” dialog, press “Alt” to open the menu, 
and use “Down arrow” to navigate to “Position Setting” and press “Enter”: 
then press “Enter” on “Location Information”. You can also open the 
“Location information” dialog directly from the “Google Maps” main 
window by pressing “Control-i“  
 
The “Location information” dialog contains 5 controls. Move among the 
controls using “Tab”, and “Shift-Tab”. 
1) Current Position Information static box: contains the address of your 

current position. 
2) Near POI list box: Contains the list of POI’s near your current location. 

Use “Up arrow” and “Down arrow” to navigate among the POI’s in the 
list. 

3) Set as Destination button: Press “Enter” on this button to set your 
current position as the endpoint (destination) of your route. You can 
also activate this button by pressing ““Alt-d”. 

4) Add to Waypoint button: Press “Enter on this button to set the current 
position as a Waypoint or stop in the middle of your current route. You 
can also activate this button by pressing “Alt-w” 

5) Close button: Press “Enter” on this button to close the “Location 
Information” dialog. You can also press “Escape” or “Alt-F4”to exit the 
dialog and return to the main window. 

 
11.3.3.4 User POI 
The “User POI’s” menu contains 3 items: “User POI’s Manager”, “Save 
User POI’s,” and “Load User POI’s. 

 
11.3.3.4.1 User POI’s Manager 
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The “User POI’s Manager” allows you to view previously created POI’s as 
well as add, modify, and delete POI’s.  
 
To open the “User POI’s Manager”, press “Alt” to open the “Google Maps” 
menu. Navigate to “User POI’s” using “Up arrow” or “Down arrow” and 
press “Enter” or press “u ” to quickly jump to and open the “User POI’s” 
menu. Navigate to “User POI’s Manager” and press “Enter”. You can also 
open the “User POI’s Manager” directly from the “Google Maps” main 
window by pressing “Control-u”.  
 
The “User POI’s Manager” dialog contains 9 controls. You can move 
among the controls using “Tab” or “Shift-Tab”. 
1. POI list box: the list of currently saved user POI’s. Navigate among the 

POI’s using “Up arrow” and “Down arrow”. 
2. POI Information list box: Contains POI name, Latitude, Longitude, 

Phone, Address, POI Explanation, and Media File. Move among the 
various information elements using “Up arrow” and “Down arrow”. 

3. Set as Start Position button: Press “Enter on this button to set the 
currently focused POI as the start position of your route. You can also 
activate this button by pressing “Alt-s”. 

4. Set as destination button: Press “Enter on this button to set the 
currently focused POI as the endpoint (destination) of your route. You 
can also activate this button by pressing “Alt-d”. 

5. Set as Waypoint button: press “Enter” on this button to set the currently 
focused POI as a Waypoint, or stop in the middle of your route. You 
can also activate this button using “Alt-w”. 

6. Add button: Press “Enter” on this button to open the “Add New User 
POI” dialog” as described above. You can also activate this button by 
pressing “Alt-I”. 

7. Modify button: Opens the “Modify User POI” dialog. This dialog 
consists of the same controls as does the “Add User POI” dialog with 
the information of the currently focused POI already filled in. You can 
also activate this button by pressing “Alt-m”. 
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8. Delete button: Press “Enter” on this button to delete the currently 
focused POI. You can also activate this button by pressing “Del” from 
the POI’s list. 

9. Close button: Press “Enter” on this button to close the “User POI’s 
Manager”. You can also exit the dialog by pressing “Escape” or “Alt-
F4”. 

 
11.3.3.4.2 Adding a User POI 
	  

You can add POI’s in two ways: 
1) You can add POI’s from “Google Maps” search results as described 

above. 
2) You can add a POI manually using the “User POI’s Manager” as 

described in the previous section. 

 
No matter which way you access the “New User POI” dialog, it contains 
the same controls: 
1) POI name edit box: An edit box in to which you can type a name for 

the point of interest if it is not already filled in. 
2) Latitude static box: shows the latitude of the POI. 
3) Longitude static box: lists the longitude of the POI. 
4) Phone edit box: an edit box for entering the phone number of the 

location. 
5) Address edit box: An edit box for entering the street address for the 

POI. 
6) POI explanation edit box: An edit box in to which you can type 

information you wish to remember or associate with this point of 
interest. 

7) Select Media file button: Press “Enter” on this button to open the 
“Select Media File” dialog. You are placed in a File Manager control in 
which you can use normal file/folder navigation commands to access 
any media file you wish to associate with the POI. Press “Space” on 
the desired file to select it, and press “Enter”. 
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8) Add button: Press “Enter” on this button to add the point of interest to 
your saved POI’s. 

9) Close button: Press “Enter” on this button to exit the “New User POI” 
dialog. 

 
11.3.3.4.3 Managing User POI’s 
	  

 

In addition to the “User POI Manager”, the “User POI’s” menu also 
contains “Save User POI’s”, and “Load User POI’s”. These 2 options 
allow you to import and export POI information to and from CSV (comma 
separated value) files. 
 
To export your saved User POI’s as a CSV file, choose “Save User POI’s 
from the “User POI’s” menu, or press “Alt-s” from the main “Google Maps” 
window. You are placed in an edit box and prompted for the name of your 
file.  
The “Save User POI’s” dialog contains 4 items: 

1) File list control: A normal File Manager control in which you can 
navigate to choose the location in which you wish to save your POI 
file. 

2) File Name edit box: Type your desired name in computer Braille. 
3) Confirm button: Press “Enter” on this button to save the file. 
4) Cancel button: Press “Enter” on this button to cancel saving of the 

file. 

 
To load a User POI file, navigate to “Load User POI’s” in the User POI’s” 
submenu of the “Google Maps” menu. When you press “Enter” on “Load 
User POI’s”, a standard Open File dialog opens from which you can 
choose the file. Use Normal file/folder navigation commands to locate the 
file containing your Poi information, and press “Enter” to load the file. If 
the loading is successful, the unit announces, “successfully loaded user 
POI”. 
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11.3.3.5 Route Menu 
	  

The “Route” menu in “Google Maps” allows you to create, view, and 
initialize routes, as well as to queery information about your current route 
and the distance and direction to your final destination. The “Route” menu 
contains the following items: “Create Route”, “View Traveled Route”, 
“Initialize Route”, “Route Information”, and “Direction and Distance to 
Destination”. 

  
11.3.3.5.1 Create route 
	  

To access the “Create Route” dialog, press “Alt” to open the menu, and 
navigate to “Route” using “Up arrow” or “Down arrow”. Press “Enter” on 
“Route” and navigate to “Creat Route”. Press “Enter” to open the “Create 
Route” dialog. You can also open the “Create Route” dialog by pressing 
“Control-r” directly from the “Google Maps” main window.  
 
Note: before you can create a route, you must have set a start position 
and destination as described previously in this chapter.  
 
The “Create Route” dialog contains a single combo box with 2 options: 
“Walking” and “Vehicle”. Navigate among the 2 options by pressing “Up 
arrow” or “Down arrow”. When you are placed on the desired route type, 
press “Enter”. You are placed in the “Route” dialog on the “Route 
Information” tab.  
 
The “Route” dialog contains 6 controls. You can move among the controls 
using “Tab” or “Shift-Tab”.  
1. Route Information list box: Contains Start, Destination, Estimated time 

of arrival, and Estimated distance. Use “Up arrow” and “Down arrow” to 
navigate among the items in the information list. 

2. Step Route Information list box: Contains numbered step by step 
directions for traveling from your start position to your destination, each 
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with an estimated travel time. Navigate among the steps using “Up 
arrow” and “Down arrow”. 

3. Start notice button: Press “Enter” on this button when you depart from 
your Start Position. You can also activate this button by pressing “Alt-
m”.  

4. Save Route button: Press “Enter” on this button to save the current 
route for later use. You can also activate this button by pressing “Alt-s”. 
Activating this button opens a dialog with a “File Name” edit box, a 
“confirm” button, and a “Cancel” button. You can simply type a file 
name for the route, and press “Enter”. 

5. Load Route list box: A list of all your previously-saved routes. Navigate 
the list using “Up arrow” and “Space”4. Press “Enter” on a route to load 
it. 

6. Close button: Press “enter” on this button to close the “Route” dialog 
and return to the “Google Maps” main window. You can also activate 
this button by pressing “Escape” or “Alt-F4”. 

 

11.3.3.5.2 View traveled route 
	  

You can view previously traveled routes using the “View Traveled Route” 
option in the “Route” menu. Press “Alt” to open the “Google Maps” menu 
and use “Down arrow” to navigate to “Route” and press “Enter”. From the 
“Route” menu, use “Down arrow” to navigate to “View Traveled Route” 
and press “Enter”. You can also bring up the “View Traveled Route” 
dialog by pressing “Control-h” from the “Google Maps” main window.  

 
The “View Traveled Route” dialog contains 3 items: 

1. View Traveled Routes list box: a list of the previously traveled routes. 
Navigate the list using “Up arrow” and “Down arrow”. Press “Enter” on 
a route to load it. 

2. Initialize Route button: Deletes all the previously-traveled routes. 
3. Close button: Closes the “View Traveled Route” dialog. You can also 

press “”Escape” or “Alt-F4”to close the dialog. 
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11.3.3.5.3 Route Information Initialization 
	  

At times, you may wish to clear the current route information and begin 
creating a route from scratch. You can do this using the “Initialize Route” 
option in the “Route Menu.  
 
Press “Alt” to open the “Google Maps” menu and use “Down arrow” to 
navigate to “Route” and press “Enter”. From the “Route” menu, use 
“Down arrow” to navigate to “Initialize Route” and press “Enter”. You can 
also initialize the route directly by pressing “Alt-I”. When you activate this 
command, the route information is cleared, and you may create a new 
route using the same information, or set other start, destination, or 
waypoint locations. 

 

11.3.3.5.4 Route Information  
	  

Choosing the “Route information” option in the “Route” menu brings up 
the same “Route” dialog as is shown when you initially create a route. To 
bring up “Route information”, Press “Alt” to open the “Google Maps” 
menu and use “Down arrow” to navigate to “Route” and press “Enter”. 
From the “Route” menu, use “Down arrow” to navigate to “Route 
Information” and press “Enter”. You can also access route information 
directly by pressing “Control-c”. 

 

11.3.3.5.5 Distance and Direction to Destination 
	  

Use the “Direction and Distance to Destination” menu item to queery the 
remaining distance to your destination while traveling as well as the 
direction of travel.  
 
To activate the “Direction and Distance to Destination” command, Press 
“Alt” to open the “Google Maps” menu and use “Down arrow” to navigate 
to “Route” and press “Enter”. From the “Route” menu, use “Down arrow” 
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to navigate to “Direction and Distance to Destination” and press “Enter”. 
You can also queery the “Direction and Distance to Destination” directly 
by pressing “Control-d”.  

 
11.3.3.6 Options 
	  

The “Options” menu contains 2 items: “Notice and Distance Setting”, and 
“Select GPS receiver”. 

 
11.3.3.6.1 Notice and Distance Setting 
	  

The “Notice and Distance Setting” dialog contains 6 controls. Move 
among the controls using “Tab”, and “Shift-Tab”. 

 

1. Display and notice settings: a list box in which you can set 4 options. 
o Latitude/longitude Display Mode: short or detailed. 
o Notice User POI: Yes or no.  
o Notice sound play: Yes or no. 
o Notice POI Information on the Status: Yes or no. 
o Press Space to change the value of the settings. 

2. Turn Range Setting (feet): an edit box in to which you can type the 
number of feet before which you wish to be notified of a turn. The 
default is 66. 

3. POI Range (feet): An edit box in to which you can type the number of 
feet before a  POI you wish to be alerted. The default is 656. 

4. Save Options button: Press “Enter” on this button to save the changes 
you’ve made to the settings. 

5. Reset to Factory Defaults button: Press “Enter” on this button to reset 
all settings to the factory defaults. 

6. Close button: Press “Enter” on this button to close the dialog without 
saving your chages. You can also exit the dialog by pressing “Escape” 
or “Alt-F4”. 
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11.3.3.6.2 GPS Settings 
 

1) Select GPS Receiver settings: Settings list containing 3 options. 
 
(1) GPS connection way: Press “Space to choose between “Internal 

GPS”, Bluetooth ActiveSync”, and “Bluetooth Serial”. 
 
(2) Notice that GPS Receiver Signal Strength is Low: Press “Space” to 

choose between “yes”, and “no”.  
 
(3) Interval Reconnecting to GPS Receiver: Press “Space” to choose 

among the available values: No reconnection, 10 seconds, 30 
seconds, 1 minute, 3 minutes, and 5 minutes. 

 
2) Save Options button: Press “Enter” on this button to save your changes. 
3) Reset to Factory Defaults button: Press “Enter” on this button to restore 

these settings to the factory defaults.   
4) Close button: press “Enter” on this button to exit the “Select GPS 

receiver” dialog without saving your changes. You can also exit the 
dialog using “Escape” or “Alt-F4”. 

	  

	  

	  

11.4 Dropbox 
	  

Dropbox is an Internet file sharing service that allows you to store files on 
the Dropbox server and access them with a computer or smartphone 
containing a Dropbox program as well as the Voice Sense QWERTY. For 
more information about Dropbox or to sign up for a Dropbox account, 
please visit www.dropbox.com.	  	  
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To open the "Dropbox" program, from the Main menu, press "X" to open 
the "Extras" menu, then press "R" to launch "Dropbox". You can launch 
"Dropbox" from anywhere on the unit by pressing "Windows-O".	  	  

When "Dropbox" is launched for the first time, you are placed in the "Sign 
In" dialog. The "Sign In" dialog contains the following items: "e-mail" 
computer edit box, "Password" computer edit box, "Remember Me" check 
box, "Save Password" check box, "Auto Sign In" check box, "Sign In" 
button and a "Cancel" button. You can move among the controls using 
"Tab" or "Shift-Tab".	  	  

to Sign into Dropbox, enter the e-mail address and password associated 
with your Dropbox account in the respective computer edit boxes. Use 
Space" to check or uncheck the boxes concerning the saving of your 
information and automatic sign in. When you have entered your information, 
and chosen your preferences, Tab to Sign In" and press "Enter".	  	  

Voice Sense prompts, "Signing in, please wait". After a few seconds, if sign 
in is successful, the Voice Sense announces, "Successfully signed in" soon 
followed by "Building file list". In another few seconds, the files and folders 
in your Dropbox account are displayed. You can navigate your files and 
folders on "Dropbox" in the same manner as those in the "File Manager".	  	  

	  

11.4.1 The File Menu  
The "Dropbox" "File" menu contains the following items: "User Information", 
"Sign Out", and "Exit".	  	  

	  

11.4.1.1 User Information  
To open the "User Information" dialog, press "Alt", and press "Enter" on 
"File". Press "Enter" on "User Information". You can activate this command 
directly using "Control-I".	  	  

The "User Information" dialog contains 2 items: the "Information" list, and 
the "Close" button. The "Information" list contains 4 items: "Nickname", "e-
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mail", "Country" and "Size". Use the Up and Down arrows to move among 
the items in the "Information" list. The first 3 items provide information you 
entered when creating your account. The "Size" item shows how much total 
space you have available on Dropbox and how much is being used.	  	  

	  

11.4.1.2 Sign Out  
If you wish to sign out of your current Dropbox account, you can do this 
using the "Sign Out" command in the "File" menu. To execute the "Sign 
Out" command, press "Alt", and press "Enter" on "File". Navigate to "Sign 
Out" using the Down arrow and press "Enter". Voice Sense prompts, 
"Successfully signed out", and places you in the "Sign In" dialog described 
previously.	  	  

	  

11.4.1.3 Exit  
This command terminates the "Dropbox" program and returns the Voice 
Sense QWERTY to the "program" menu. You can exit "Dropbox" by 
pressing "Alt F 4", or by selecting "Exit" from the "Dropbox" File menu.	  	  

	  

11.4.2 The Edit Menu  
The "Edit" menu contains the following items: "Search", "File Download", 
"File Upload", "Copy", "Cut to clipboard", "Paste", "Delete", "File Link" and 
"New Folder". These items are discussed in detail in the following sections.	  	  

	  

11.4.2.1 Search for File  
Use the "Search for File" function to locate a file or folder on Dropbox for 
which you know all or part of the name, but not the location. You can press 
"Alt" to open the menu and move to "Edit" using the Down arrow and Press 
"Enter". Press "Enter" on "Search for File". You can press "Control-F" to 
activate this function directly from the file list. The Voice Sense QWERTY 
displays the "file for find" dialog box.	  	  
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The dialog box consists of the "edit box for entering the text of the name to 
search", a "search button", a "cancel button" and the results list. You can 
use "Tab" or "Shift-Tab" to move through the controls.	  	  

When you activate the file search, the unit prompts "File for find:" you are 
placed on the edit box for entering the file name to search". Type all or part 
of the file name and press "Enter". Voice Sense QWERTY searches for all 
files containing the text you entered. When the file search is complete, you 
are placed in the results list.	  	  

You can navigate among the items in the results list with the up and down 
arrows. If you press "Enter" on a file, you are placed on the path where the 
file is stored and the file search dialog box is closed. You can move to the 
file location by pressing "Enter" on the file name again.	  	  

	  

11.4.2.2 File Download  
Use this option to download the selected file to your Voice Sense QWERTY.	  	  

To execute the "File Download" command, press "Alt", navigate to "Edit" 
using the Down arrow, and press "Enter". Navigate to "File Download" 
using the Down arrow and press "Enter". You can activate this command 
directly from the "File" list by pressing "Control-T".	  	  

When you activate the "File Download" command, The Voice Sense 
prompts, "Files will be saved to Flashdisk/Downloads, do you want to 
change this location?". The Default is "No". If you want to change where 
the selected file is saved, press the Down arrow to navigate to "Yes", and 
press "Enter". Navigate to the folder into which you want the files to be 
saved, press "Space" to select it, and press "Enter" to start the download.	  	  

The Voice Sense announces "Ready for download", and displays download 
progress while the file is downloaded. When the download is complete, 
Voice Sense announces, "File successfully downloaded".	  	  
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11.4.2.3 File Upload  
Use this command to upload a file from your Voice Sense QWERTY to 
Dropbox so that you may access it on other devices you have connected to 
Dropbox.	  	  

To execute the "File Upload" command, press "Alt", navigate to "Edit" using 
the Down arrow, and press "Enter". Navigate to "File Upload" using the 
Down arrow and press "Enter". You can activate this command directly 
from the "File" list by pressing "Control-U".	  	  

When you execute "File Upload", Voice Sense promts, "Select file to 
upload" and places you in the file/folder list of your flashdisk. Use normal 
file/folder navigation to locate the file you want to upload, and press"Enter" 
to begin the upload process. You may select multiple files by pressing 
"Space" on each of the files you wish to upload.	  	  

When you press "Enter", the Voice Sense announces, "Start uploading 
XX/YY where X is the number of the current file being uploaded, and Y is 
the total number of files to upload. AS the files are uploaded, the number of 
the file being uploaded is displayed along with the progress of the total 
upload in the form of a percentage. When the upload is finished, Voice 
Sense announces, "Y files uploaded" where Y is the number of files 
uploaded to Dropbox.	  	  

	  

11.4.2.4 Copy, Cut and Paste  
Note: When using "Copy", "Cut", or "Paste" in Dropbox, you are able to 
manipulate only the files and folders in your Dropbox file/folder list. You 
cannot copy or paste files from Dropbox to storage locations on your Voice 
Sense. To move files to and from your Voice Sense and Dropbox, please 
you the "File Download" and "File Upload" commands described previously.	  	  

"Copy" leaves the selected files and folders in their original locations, and 
creates copies of them in your chosen destinations. "Cut" removes the 
selected files and folders from their original locations. You can use the 
"Paste" command to place them in new locations you have chosen.	  	  
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Use the Copy/Cut function as follows:	  	  

1. Select the files and folders you wish to copy. If you wish to select only 
one file or folder, simply place your cursor on it. If you wish to select 
multiple files and folders, press "Space" on each item you wish to select.	  	  

2. Open the menu with "Alt" and navigate to "Edit" using the Down arrow 
and press "Enter"" Navigate to "Copy" and press "Enter" to copy the 
selected files and folders. You can execute the "Copy" command directly 
from the file list by pressing "Control-c". If you want To cut the selected files 
and folders, choose "Cut" from the "Edit" menu. Use "Control-x" to execute 
the "Cut" command directly from the file list. When the "Copy" or "Cut" 
command is executed, the Voice Sense QWERTY returns to the file list.	  	  

3. Navigate to the destination folder using normal file/folder navigation.	  	  

4. Open the "Edit" menu as described in step 2, and choose "Paste". Press 
"Enter" on "Paste," and your selected files and folders are copied or moved. 
You can press "Control-v" to execute the "paste" command directly from 
the file list.	  	  

If your destination folder has the same name as the file you are copying, 
the Voice Sense QWERTY prompts "File xxx already exists. Overwrite? 
Yes". Press "Enter" if you want to replace the file. If you do not want to 
overwrite the file, select "No," and press "Enter". When "No" is selected, the 
"Paste" function is canceled.	  	  

	  

11.4.2.5 Delete Files or Folders  
To delete files or folders from Dropbox, navigate to the folders or files you 
want to delete, and select them using "Space". If you wish to delete only 1 
file or folder you need not select it, rather, you can simlly place your cursor 
on it.	  	  

Open the menu by pressing "Alt", navigate to "Edit" using the Down arrow 
and press "Enter". Use Up or Down arrow to navigate to "Delete" and press 
"Enter". You can also delete selected files or folders by using "Delete".	  	  
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11.4.2.6 File Link  
Dropbox allows you to create links to the files stored in your Dropbox 
account. This is a useful way of sharing files with others while protecting 
the rest of the files on your account. You can use the "File Link" option to 
create a link to a file which another person can use to download that file 
from your Dropbox account.	  	  

To execute the "File Link" command, press "Alt", navigate to "Edit" using 
the Down arrow, and press "Enter". Navigate to "File Link" using the Down 
arrow and press "Enter". You can activate this command directly from the 
"File" list by pressing "Control-L".	  	  

The "File Link" dialog contains 3 controls: "File Link" edit box, "Copy" button, 
and a "Close" button. You can move among the controls using "Tab" or 
"Shift-Tab".	  	  

The "File Link" edit box contains the download link for the selected file. The 
"Copy" button copies this link to the clipboard for pasting into a document 
or into an e-mail to someone to whom you wish to send the link. To close 
the "File Link" dialog, Tab to Close" and press "Enter" or press "Escape" 
and you are returned to the Dropbox file/folder list.	  	  

	  

11.4.2.7 New Folder  
Use this option to create a new folder on your Dropbox account. To 
execute the "New Folder" command, press "Alt", navigate to "Edit" using 
the Down arrow, and press "Enter". Navigate to "New Folder" using the 
Down arrow and press "Enter". "Control-N" is the hot key for accessing this 
feature directly from the file list.	  	  

The Voice Sense QWERTY prompts, "New folder name:,". Enter your 
preferred new folder name and press "Enter". Your new folder is created. 	  

When creating a new folder name, you cannot use the following characters: 
"|, <, >, ?, :, *	  	  
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11.4.3 Options  
The "Options" menu contains 1 item: "Set Login Information". To open the 
"Set Login Information" dialog, press "Alt" to open the menu, and use the 
Down arrow to navigate to "Options" and press "Enter". Then, press "Enter" 
on "Set Login Information".	  	  

The "Set Login Information" dialog contains all of the same as are present 
in the "Sign In" dialog except the username and password. This allows you 
to modify your options for saving login information and automatic sign in. 
When you have set your preferences for the "Remember Me", "Save 
Password", and "Auto Sign In" check boxes, Tab to "confirm", and press 
"Enter". If you do not wish to save your settings, Tab to "Cancel" and press 
"Enter" or press "Escape" or "Alt F 4".	  	  

	  

11.4.4 Hot Keys in Dropbox  
Open User Information dialog box: Control-I	  	  

Search for File: Control-F	  	  

File Download: Control-T	  	  

File Upload: Control-U	  	  

File Link: Control-L	  	  

Copy: Control-C	  	  

Cut to Clipboard: Control-X	  	  

Paste: Control-V	  	  

Delete: Delete	  	  

New Folder: Control-N	  	  

Set Login Information: Alt-I	  	  
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11.5 Online DAISY 
	  

The Online DAISY program allows patrons of the Canadian National 
Institute for the Blind library to access and download DAISY books 
available through their online bookshelf. Note: you cannot search for books 
using this program as this capability is only available when accessing the 
library via its website. However, this program will allow you to access and 
interact with your electronic bookshelf, download and return books. 
To execute the Online DAISY program, press “X” from the Main Menu to 
open the Extras menu, then navigate to “Online DAISY” and press “Enter”, 
or press “o” to directly jump to and open it. 
When you execute the Online DAISY program for the first time, you are 
asked for your login information. Please type “CNIB_” followed by your user 
number in the ID field. Tab to the “Password” field and type it in computer 
Braille. Press “Space” to toggle the check boxes for “Remember Me”, and 
“Save password”. When you have chosen your login settings, Tab to 
“Login” and press “Enter”. 
You are presented with a combo box with 3 items: “Expired”, “New”, and 
“Issued”. Press the Up and Down arrows to navigate among the options. 
Press “Tab” to access the list in your desired category. You can navigate 
the book list using “Space-1” and “Space-4”. 
You may download books that are issued to you. To download a book in 
the “Issued” list, navigate to it and press “Enter”. The unit announces 
“Download start” and shows progress indicators to let you know the 
progress of the download process. When the book is finished downloading, 
you may play it using the DAISY Player. Books downloaded using the 
Online DAISY program are available in the “Online DAISY” folder from the 
“Open DAISY” dialog of the DAISY Player. For reasons of copy protection, 
these books are only visible from the DAISY Player and cannot be 
accessed from the File Manager. 
If you wish to return a book, navigate to it in the “Issued” list, and press 
“Control-R”. This will return the book to the CNIB’s virtual library so that 
others can be issued to you. 
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12. Games 
	  

12.1 Sense Dice game 
	  

Ever been at a party and wanted to play "Quarters", but had no dice? You 
don't need to worry about such things anymore. With Voice Sense 
QWERTY you always have virtual dice with you anywhere, any time! 

	  

12.1.1 Executing the Dice Game 
	  

1) The Dice Game is located in the "Games" menu under the main menu. 
Press enter on "Games" or press "G" from the main menu.  
2) Press "D" or move to "Sense Dice Game" by pressing “Down arrow” 
and press "Enter" to start the game. 

You	  can	  launch	  the	  “Sense	  Dice	  Game”	  from	  anywhere	  on	  the	  unit	  by	  pressing	  “Caps	  Lock-‐D”.	  

	  

12.1.2 How it works 
	  

When the game starts, a cute little tune is played followed by the 
announcement, "Select the number of dice". You can select 1, 2, or 3 
dice using “Up arrow” and “Down arrow” and press "Enter".   
 
The number of dice selected is announced, and a popping sound is heard 
for each die you selected. 
Press "Enter" to roll the dice, or gently shake your Voice Sense 
QWERTY, and the accelerometer recognizes your motions and activates 
the dice roll.  
A sound is heard to indicate the rolling of the dice, and after a couple of 
seconds, the result is displayed. 
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After the result is displayed, the Voice Sense QWERTY announces, 
"Press Space to go on". If you press "Space", you will hear the dice 
selection announcement and sound once again, and you can repeat the 
dice roll.  
You can also press “Escape" to return to the "Dice Selection" list and 
choose a different number of dice to roll. 
Press “Alt-F4” to exit the game.  
 

12.2 Sense Brain Game 
	  

The Sense Brain Game contains 4 different games. You can play 
anywhere, any time and train your brain to be sharper and quicker. Have 
fun and be smarter. 

	  

12.2.1 Executing the Sense Brain Game  
	  

1) The Sense brain game is located in the "Games" menu under the main 
"program" menu. To enter the "Games" menu, press enter on "Games" or 
press "G" from the "program" menu. 
2) To start the Sense Brain Game, press "Enter" on "Sense Brain Game" 
or press "B". 

You	  can	  launch	  the	  “Sense	  Brain	  game”	  from	  anywhere	  on	  the	  unit	  by	  pressing	  “Caps	  Lock-‐B”.	  

	  

12.2.2 Game menu 
	  

There are 5 items in the Sense Brain Game menu: 4 games (Memory 
game, Reverse game, Chase a criminal, and Multiplication table) and 
"View ranking". To start playing a game, press enter on a game you want 
to play. If you want to view your past scores, you can access them under 
"View ranking". 

	  



469 
 

12.2.3 Playing a Game 
	  

When you start each game, an opening song is played followed by 
instructions for playing. Press "Enter" to start the game or press space to 
repeat the instructions. 

	  

12.2.4 Memory game 
	  

When the game starts, a group of numbers and letters is announced.  For 
example, at level 1, groups of 3 letter-number combinations are spoken. 
Make sure to memorize these letters and numbers in the order they are 
spoken. 
You are then prompted, "Type the answer", at which time you must write 
the numbers in the order they were given to you and press enter. If the 
answer is correct, The Voice Sense QWERTY applauds you, and you are 
allowed to proceed to the next set of letters and numbers. If the answer is 
incorrect or you take too long to enter the answer, the buzz of failure 
sounds and the game is over. You must type the answer within 10 
seconds to avoid the despicable buzz and a constructive warning that you 
may be losing your mind.  
When the game is over, your score is announced. If your score ranks 
between 1 and 5, you are asked to "Type your ID". Write your name and 
press enter to record your score. (You can view your recorded scores 
under "View Ranking" in the Sense Brain Game menu. Or press “Escape” 
or “Alt-F4" to ignore this dialog. 
Finally, you are asked, "Do you want to play again?" Press enter on "Yes" 
to play the game again. Or press enter on "No" to return to the game 
menu. 

	  

12.2.5 Reverse game 
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This game is similar to the memory game, but as its name denotes, in 
"reverse". When you are prompted to "Type the answer", write the 
numbers and letters in reverse order and press "Enter". If the answer is 
correct, you are applauded and honored with a new challenge. If the 
answer is incorrect or you're too slow, the buzz of shame sounds and the 
game is over.  

	  

12.2.6 Chase a criminal 
	  

When the game starts, you hear the sound of footsteps. A thief is hidden 
in a 10-story building. A policeman says on which floor the thief is hiding. 
But, any smart thief won't stay in one place too long, and your job is to 
catch him. As the criminal runs up and down the stairs, the policeman 
says, "Up" and "down" repeatedly to let you know how many floors the 
criminal is traversing. Listen carefully and type the floor on which the thief 
has chosen to hide again. When you are asked to type the answer, type 
the number of the floor on which the thief stowed himself within 10 
seconds. Be sure to think fast, or that droning buzz reminds you that your 
brain is failing and the patronizing policeman complains that you are 
interrupting his inspection.   

	  

12.2.7 Multiplication table 
	  

When the game starts, you are given a set of numbers. Level 1 starts you 
off with two. Multiply these numbers.  
When you are prompted to, "Type the answer", type the result and press 
"Enter". If the answer is correct, your math genius continues to be 
challenged. If the answer is incorrect, or you take too long to enter it, the 
pretentious buzz is heard, and the Voice Sense QWERTY helpfully 
suggests you may wish to master the simplicity of addition before 
attempting the complexity of multiplication.    
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12.2.8 View ranking  
	  

Enter the "View Ranking" menu to view your scores for any of the brain 
games described above. Press “Up arrow” or “Down arrow” to navigate 
among the games, and press enter on the name of the game on which 
you want information. 
The ranking list is displayed. It shows rank, name and score. Press space 
to view the next record. To return to the "View ranking" menu, press 
enter. 
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13. Utilities 
 
The "Utilities" menu provides several special functions and settings for the 
Voice Sense QWERTY. The "Utilities" menu contains the following items: 
 
1) Calculator (for doing simple math equations as well as scientific 
calculations) 
2) Display Compass heading (for displaying your current cardinal direction 
3) Display Time and Date (for viewing the date and time)  
4) Wake up alarm (for setting an alarm) 
5) Calendar (for checking dates according to the lunar and solar calendar) 
6) Stopwatch (for timing events) 
7) Terminal for screen reader (for connecting your Voice Sense QWERTY to 
your PC for use as a Braille display, external speaker, etc)  
8) Display Network Status (for displaying the status of your Internet 
connectivity) 
9) Display power status (for discovering the amount of battery charge on the 
unit) 
10) Format (for formatting the flashdisk as well as external storage devices) 
11) Set Sleep Timer (for defining the time before the unit automatically goes 
to sleep) 
12) Upgrade Voice Sense Firmware (for upgrading the Firmware) 
 
To access the menu items, 
1) Press “up arrow” or “down arrow” in the "program" menu. 
2) Press "Enter" on the "Utilities" menu. Or, press "u" from the "program" 
menu to open the Utilities menu.  
3) The "Utilities" menu contains many small applications. 
The following sections discuss each of these menu options and their 
functions in greater detail. 
 
13.1 Calculator 
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Using the calculator on the Voice Sense QWERTY you can do simple math 
equations as well as complex scientific calculations. The results and 
expressions are displayed in Braille, and spoken by the Voice Sense 
QWERTY. While using the calculator, you can access the "help" menu by 
pressing "F1" for hot key information on the various calculator functions.  
 
To use the calculator, press "c" from within the "Utilities" menu. You can also 
launch the “Calculator” from anywhere on the unit by pressing “Caps Lock-C”. 
When using the calculator on the Voice Sense QWERTY, expressions can 
be displayed in either Computer Braille or Nemeth Braille. You can change 
the Braille code using “Fn-g”. You can clear the calculator by pressing "Alt-c". 
If you insert numbers or a function into a result, the result disappears; and if 
you enter operators, you move to the next step. In addition, you can keep 
your result in the calculator's memory, and recall it later. You can activate the 
functions and operators via the calculator menu or you can use the hot keys 
associated with the various functions.  
The calculator functions are explained in greater detail below. 
 

13.1.1 General Functions 
 
"General functions" is a dialog box that contains the "general function list", a 
"Confirm" button, and a "Cancel" button. In the dialog box, you can navigate 
among the controls using “Tab” and "shift-tab". In the general function list, 
you can navigate the operators using “up arrow” or “down arrow”. Or, in the 
list, you can press the first letter of the operator you want to access. In the 
"Calculator", you can open the menu by pressing “Alt”, and press "Enter" on 
"General Functions". Or, you can press "g" from the menu to access 
"General Functions". When the calculator is opened, 0 is displayed in 
computer Braille. From the calculation line, you can access the "General 
Functions" using the hot key, "Ctrl-g".  
 
When the dialog opens, you are placed on the general function list. Once 
there, you can select your desired operation and press "Enter" to run it. You 
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can cancel the operator selection by pressing "Enter" on "Cancel", "Alt-F4", 
or "Esc". You can also use hot keys to quickly execute operations.  
 
Use the following hot keys to perform basic calculations: 
 

Plus: + 
Minus: - 
Divided by: / 
Multiply by: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal point: . 
Left parenthesis: ( 
Right parenthesis: ) 
PI: Ctrl-p  
Exponent: Ctrl-e  

 
To enter negative numbers type minus and the number in parentheses. For 
example, type in minus 2 in the following manner: (-2). 
For the percent operation, type the numbers first followed by the percent 
sign. Immediately after you type the percent sign (%), the number you have 
typed in is converted into a percent value. For example, 90 + 20% equals 90 
+ 18. The number 18 is displayed immediately on entering the % sign. The 
result of this expression is 108. 
13.1.2	  Fractional	  arithmetic	  	  

The Voice Sense QWERTY can perform fractional operations such as 
simplifying and multiplying fractions as well as converting fractions to 
decimals.  
 
When entering fractions, use “Alt-/” for over. To enter one over two, type “1, 
Alt-/, 2”. When entering a mixed number, such as one and one-half, press 
space between the whole number and fraction. To enter one and one-half, 
type “1, Space, 1, Alt-/, 2”. 
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To multiply two-thirds by three-eighths, type, “2, Alt-/, 3, *, 3, Alt-/, 8”. Press 
Enter to perform the calculation. The result, 6/24, is automatically simplified 
to ¼.  
 
You can also convert fractions to decimals, decimals to fractions, improper 
fractions to mixed numbers, or mixed numbers to improper fractions. When 
your result is fractional, you can bring up the “fraction options” by pressing 
“Control-/”. Press “Up arrow” or “Down arrow” to move among the available 
options. If the fraction is a simple fraction, your options are “”fraction to 
decimal” and “return original fraction”. If the fraction is an improper fraction, 
you also have an option to return “improper fraction to mixed number”. If 
your fraction is a mixed number, the “mixed number to improper fraction” 
appears. Finally, if your result is a decimal and you press “Control-/”, the 
decimal is converted to a fraction.  

 
 13.1.3 Memory Functions 
 
The "Memory Functions" store your resulting answers and calculations in 
memory for later use. The "Memory Functions" menu has four items: "Recall 
Item", "Delete All Saved Items", "Save Item", and "Statistics Functions". You 
can move among these items by pressing “down arrow” or “up arrow” 
repeatedly, and press "Enter" on the desired feature. To access these menu 
items, press “Alt” to open the menu, and press "Enter" on "Memory 
Functions". Or, you can press "v" from the menu. 
 

13.1.3.1 Recall Items 
 
"Recall Items" is a dialog, containing the following: "Variable list", "Delete", 
"Display detail", "Confirm", and "Cancel". You can navigate among these 
items by pressing tab or shift-tab. You can access "Recall Items" by pressing 
"r" from the "Memory Functions" menu. Or, you can access the dialog by 
pressing "Alt-r" in the calculation line.  
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The "Variable list" displays "item name: the result value". You can move 
through the "Variable list" by pressing “up arrow” or “down arrow”. You can 
insert the result value into your calculation by pressing "Enter" on the item 
name. You can also copy items in the "Variable list". Press "Space" to select 
an item in the "Variable list". Then, press "Ctrl-Insert" to copy the selected 
items to the clipboard.  
 
The "Display detail" shows the item name and its result with the default set to 
"No". To review the detailed information, press "Space" to switch to "Yes". 
Then, it displays "item name: the expression = its result value" in Braille.  
"Delete" is used to remove a variable item. To delete an item, select the item 
you want to be deleted, and press "Enter" on "Delete". You can also select 
any number of individual items by pressing "Space" on each of them.  
 

13.1.3.2 Delete All Saved Items 
 
You can delete all of the saved items stored in the "Recall Items". To do this, 
open the menu by pressing “Alt”. Then, use “up arrow” or “down arrow” to 
move to the "Memory Functions" menu, and press "Enter". Next, use “up 
arrow” or “down arrow” to move to "Delete All Saved Items", and press 
"Enter". You can also press "Ctrl-d" while in the calculation line. 
 

13.1.3.3 Save Items 
 
"Save Items" is a dialog that allows you to define variables according to the 
current expression or result in the calculator and save them for future use. 
The dialog contains an edit box for typing in the variable name, a "Confirm" 
button and a "Cancel" button. You can move among the controls by pressing 
“Tab” or "shift-tab". From the "Memory Functions" menu, you can access 
"Save Items" by pressing "s". From the calculation line, use the hot key, "Alt-
s" to open the save items dialog.  
 
When the dialog is opened, the "item name" edit box is focused. Type a 
name for the variable, and press "Enter" or move to "confirm", and press 
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"Enter". The current expression or result is then saved under the variable 
name you just specified. 
If you type names under variables which have already been created, you are 
prompted, "Replace variable xx with current value? Yes". To change the 
value, press "Enter" on "Yes". If you do not want to change the value, press 
"Enter" on "No". Press "Space" to toggle between "Yes" and "No". 
If you type function names like "sin", "coos", or "pi" as a variable name, you 
are warned, "Invalid item name", as you cannot use these functions in 
variable names.  
 
When you are on the calculation line, you can also define variables directly 
by typing "variable=expression" and press "Enter" to save the variable. For 
example: "a=2+sin(30)" or "a=591",   
 

13.1.3.4 Statistics Functions 
 
If you select this menu item, a dialog opens, which consists of a list box 
containing all the stored variables, a list box displaying the results of several 
functions, and a "Close" button. You can move among these elements by 
pressing “Tab”, or "shift-tab". You can open this dialog by pressing "Alt-t" 
from the calculation line, or by pressing "t" in the "Memory Functions" menu. 
In the variable list, the variable names and their current values are displayed. 
You can move among these variables by pressing “down arrow” or “up 
arrow”. In order to select a variable to be used in the calculation, press 
"Space" on it. This list is the same as the one in the "Recall Items" dialog. 
The only difference is that this dialog always displays variable names and 
values, regardless of the value of "Detail display" option. After you select all 
of the variables to be used in the calculation, you can press “Tab” to move to 
the "result" list. The "result" list displays the sum, average, variance, and 
standard deviation of the selected variables. You can move among these 
items by pressing “down arrow” or “up arrow”. To copy results from the list to 
the clipboard, press "Space" on the items you wish to select 
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13.1.4 Sine Functions 
 
The "Sine Functions" menu is activated when you press "Enter" on "Sine 
Functions", or press "s" from the menu. You can open the menu by pressing 
“Alt”. Or, you can activate the "Sine Functions" menu by pressing “Ctrl-s” in 
the calculation line. The "sine function" list consists of "Sine", "Arc sine", and 
"Hyperbolic sine". If you press "Enter" on one of the three functions while 
moving with “up arrow” or “down arrow”, or if you press "Enter" on "Confirm" 
while one of the functions is focused, you can insert it into your calculation 
line after selecting one of the sine functions. Or, you can insert one of the 
three sine functions by pressing the first letter of each from the list. 
 

13.1.5 Cosine Functions 
 
You can activate the "Cosine Functions" by pressing "Enter" on "Cosine 
Functions" or by pressing "i" from the menu. Or, in your calculation line, you 
can open the "Cosine Functions" by pressing "Ctrl-i". The "cosine function" 
list consists of "Cosine", "Arc cosine", and "Hyperbolic cosine". If you press 
"Enter" on one of the three functions while moving with “up arrow” or “down 
arrow”, or press "Enter" on "Confirm" while one of the functions is focused, 
the calculation is performed. Or, you can activate one of the three cosine 
functions by pressing the first letter of each from the list. 
 

13.1.6 Tangent Functions 
 
You can activate the "Tangent Functions" when you press "Enter" on 
"Tangent Functions", or if you press "t" from the menu. You can also open 
the menu by pressing “Alt”. Or, in your calculation line, you can open the 
"Tangent Functions" by pressing "Ctrl-t". The "tangent functions" list consists 
of "Tangent", "Arc tangent", and "Hyperbolic tangent". If you press "Enter" on 
one of the three functions while moving with “up arrow” or “down arrow”, or 
press "Enter" on "Confirm" while one of the functions is focused, you can 
insert this function into your calculation. Or you can insert one of the three 
tangent functions by pressing the first letter of each from the list. 
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13.1.7 Logarithm Functions 

 
The "Logarithm Functions" is a dialog, which contains the following: "function 
list", a "Confirm" button, and a "Cancel" button. You can move among the 
three items by pressing “Tab” or "shift-tab". The function list consists of 
"Common logarithm" and "Natural logarithm", in which you can move by 
pressing “up arrow” or “down arrow”. 
You can activate the "Logarithm Functions" menu by pressing "Enter" on 
"Logarithm Functions", or by pressing "l" from the menu.  Or, in your 
calculation line, you can open the "Logarithm Functions" by pressing "Ctrl-l". 
If you press "Enter" on one of the logarithm functions, or "Tab" to "confirm" 
while one of the functions is focused, you can insert this function into your 
calculation. Or, you can run a "Natural logarithm" by pressing "n" from the list. 
You can run a "Common logarithm" by pressing "c". 
 

13.1.8 Convert Unit  
 

The "Convert Unit" dialog allows you to convert measurements of mass, 
area, volume, distance, and temperature from metric measure to imperial 
measure as well as other standards of measurement and units of 
measurement within the same system.  

To open the "Convert Unit" dialog, press "Alt" to open the menu, navigate 
to "Convert Unit" using the Down arrow and press "Enter". Open the 
"Convert Unit" dialog from anywhere in the calculator by pressing "Control-
U".  

The "Convert Unit" dialog contains the following items: "Unit Category" 
combo box, "Current Unit" combo box, "Change Unit" combo box, "Input 
Number" edit box, "Convert" button, "Cancel" button and the "Result" static 
box. You can move among the controls in the dialog using "Tab" or "Shift-
Tab". Use the Up or Down arrow to move among the items in the combo 
boxes.  
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The available unit categories are Distance, Area, Mass, Volume and 
Temperature. When you have chosen your measurement category, the 
"Current Unit" and "Change Unit" combo boxes will contain measurement 
units according to your chosen category. The available distance units are: 
Millimeters, Centimeters, Meters, Kilometers, Inches, Feet, Yards, and 
Miles. The available units of area are: Square Meters, Are, Square feet, 
Square Yards, Acres, and Hectares. The available units of mass are: 
Grams, Kilograms, Tones, Grains, Ounces, and Pounds. The available 
units of volume are: Deciliter, Milliliter, Liter, Cubic Centimeter, Cubic Meter, 
Cubic Inch, Cubic Foot, Cubic Yard, Gallon, Fluid oz, Cups and Quarts. 
The available units of temperature are: Celsius, Fahrenheit and Kelvin.  

Choose your unit to convert from in the first combo box. Choose your unit 
to convert to in the "Change" combo box. Type the number of the 
measurement you want to convert in the "Input Number" edit box. Finally, 
to convert the measurement, Tab to the "Convert" button and press "Enter". 
If you wish to cancel the conversion, Tab to the "Cancel" button and press 
"Enter". When you activate the "Convert" button, the conversion result is 
displayed in the "Result" static box.  

 
13.1.9	  Nemeth	  Braille	  code	  

	  

In addition to viewing expressions in the Calculator in computer Braille, The 
Voice Sense QWERTY allows you to view mathematical expressions and 
symbols using the Nemeth Braille code. The Nemeth code is a 6-dot Braille 
code developed by Abraham Nemeth used to encode mathematic and 
scientific symbols in Braille. Most students learn to read and write 
mathematical expressions using the Nemeth code, thus, it is useful to be 
able to view expressions in the calculator in the same manner they are 
learning to read and write them in hard copy Braille. You can toggle between 
computer Braille and Nemeth Braille using “FN-g”. 
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The following dot combinations represent the associated operators when 
viewing mathematical expressions in Nemeth Braille: 
Plus: + 
Minus: - 
Divided by: / 
Multiply by: *  
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal point:. 
Left parenthesis: ( 
Right parenthesis: ) 
PI: Ctrl-p  
Exponent: Ctrl-e 
Fraction begin: [ 
Fraction end: ]  
Over: FN-/ 
Equals: = 
	  

For example: if you entered an expression to calculate the square root of 2 
times 8, it would appear as below: 
“square root begin, (Ctrl-q)”, “multiply by, (*)”, “8”, “square root end (Alt-q)”. 

 
13.1.10 Copy to Clipboard 

 
The "Copy to Clipboard" function is used to copy your expression or result to 
the clipboard for pasting your expression or result in a document. You can 
activate it by pressing "Enter" on the "Copy to Clipboard" option, or by 
pressing "c" from the menu. Or, in the calculation line, you can press "Ctrl-c" 
to quickly copy your calculation to the clipboard. After copying, you can 
paste the calculation in a document.  
When you activate "Copy to Clipboard", you hear "Copy completed", and the 
Voice Sense QWERTY returns to your calculation line.  
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13.1.11	  Return	  formula	  	  

There may be times, after viewing a result, that you wish to be reminded 
what expression you used to obtain that result. The “return formula” function 
allows you to return the expression you just entered 
 
When your result is displayed, you can activate the “return Formula” function 
by pressing “Control-r”. You can also activate this function by pressing “Alt” 
to enter the menu, navigating to “return Formula” and pressing “Enter”. 
 
When you activate “Return Formula”, the expression you entered to obtain 
your current result is displayed. 

 
13.1.12 Option Settings 

 
You can access the "Option Settings" by pressing "Enter" on the menu 
option or press "o" from the menu.  Or, in your calculation line, you can 
activate the "Option Settings" by pressing “Ctrl-o”. 
When the "Option Settings" are open, if you press "Enter" on the option you 
want, or press "Enter" on the "Confirm" button associated with it, the option 
is set according to your preference.  
 
 "Option Settings" is a dialog, which contains the following: "setting list", a 
"Confirm" button, and a "Cancel" button. You can move among the three 
items by pressing “Tab” or "shift-tab".  
The "setting list" consists of "Angle unit" and "Calculator Braille code", which 
you can navigate by pressing “up arrow” or “down arrow”. 
When setting the Angle Unit, if you select "Radian", you can get the PI value 
while using the trigonometric function. If you select "Degree" and activate PI, 
you will get a wrong answer as this is not a valid calculation.  
 
You can set the Braille code as Computer Braille or Nemeth Braille as 
described previously. Use “Fn-g” to change the Braille code from anywhere 
in the Calculator. 
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13.1.13 Exit 
 
This is used to exit the calculator. You can close the calculator by pressing 
"Enter" on "Exit Calculator" or press z in the menu. Or, in your calculation 
line, you can exit by pressing "Alt-F4". 
 

13.1.14 Sample Math Calculations 
 
The following are examples of expressions for some of the math functions 
you can perform when using the calculator on the Voice Sense QWERTY. 
 

1. Addition Plus 
For Plus press “+” 
For example, to add the numbers 10 and 20, you would enter: 10+20. 
The result is displayed as 30. 

 
2. Subtraction Minus 

For Minus, press “-” 
For example, to add the numbers 10 and 20, and then subtract 5, you 
would enter: 10+20-5. The result is displayed as 25. 

 
3. Multiplication 

For multiplication, press “*” 
For example, to multiply 10 by 20, you would enter: 10*20. 
The result is displayed as 200. 

 
4. Division 

For Division, press “/” 
For example, to divide 20 by 10, you would enter: 20/10. The result is 
displayed as 2. 

 
5. Percent 

For Percent, press “%” 
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If you want to calculate, what a 10 percent mark-up of 20 would be, 
enter the following, 20+10% which gives you the result 22. You get this 
answer because, 2 is 10percent of 20. 

 
To calculate a 10 percent mark-down on 20, press: 20-10% which gives 
the result 18. 
You get this answer because, 2 is 10 percent of 20. 

 
To calculate what percentage 20 is of 10, press: 20/10% which gives 
you the result 200.  

 
To calculate 10 percent of 20, press: 20*10% which gives the result 2. 
That is, 10 percent is 0.1. 20*0.1 = 2. 

 
6. Power 

For Power, press “^” 
For example, to calculate 2 to the power of 10, you would press: 2^10. 
The answer will be given as 1024. 

 
7. Calculating Square Root 

To perform the Square root function, you can press “Ctrl” with “q” 
For example, to calculate the square root of 16, you press: “Ctrl” with q, 
16 “)”. Then, press enter. 
Your answer will be given as 4. 

 
8. Exponent 

For Exponent you can press “Ctrl” with “e” 
For example, to calculate the Exponent of 2, you would press: Ctrl with e 
then 2, followed by the “)” and “Enter”. That is, exp (2) which gives the 
result 7.3890561. 

 
1. Trigonometric Functions 
 
Sine Functions: 
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For Sine, press “Ctrl” with “s,” and then “s”. This is shown on the Braille 
display (When connected to SyncBraille) as, sin(. 
 
For Arc Sine, press “Ctrl” with “s,” then “a”. This is displayed as asin(. 
 
For Hyperbolic sine, press “Ctrl” with “s,” then “h”. This is displayed as 
sinh(. 
In order to calculate the sine of a 30 degree angle you would type the 
following: Ctrl with s, then “s,” 30 and then” )”. Press “Enter” and your 
answer is displayed as 0.5. 
 
Cosine Functions: 
 
For Cosine, you would press “Ctrl” with “i” and then you would press “i” This 
is displayed as cos(. 
 
For Arc cosine, press “Ctrl,” with “i” then, “a”. This is displayed as acos(. 
 
For Hyperbolic cosine, press “Ctrl” with “i” then, “h”. This is displayed as 
cosh(. 
For example, to calculate the cosine of the 30 degree angles, you press: 
Ctrl with i, I, 30 and then “)”. Then, press “Enter”. Your answer will be given 
as 0.8660254. 
 
Tangent Functions: 
 
For Tangent, press “Ctrl” with “t” and then “t”. This is displayed as tan(. 
For Arc tangent, press “Ctrl” with “t” then “a”. This is displayed as atan(. 
For Hyperbolic tangent, press “Ctrl,” with “t,” then, “h”. This is displayed as 
tanh(. 
For example, to calculate the tangent of the 30 degree angles, you press: 
Ctrl with t, T, 30 and then “)”. That is, tan(30) which gives you the result of 
0.57735027. 

 
Logarithm Functions: 
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Common logarithm 
For Common logarithm, press “Ctrl” with “l,” and then “n”. This is displayed 
as log(. 
For example, to calculate the common logarithm of the 100, you press: Ctrl 
with l, N, 100 and then “)”. That is, log(100) which gives the result 2. 
 
Natural Logarithm 
For Natural logarithm, press “Ctrl” with “l,” and then, “e”. This is displayed 
as ln(. 
For example, to calculate the natural logarithm of the 100, you press: Ctrl 
with l, E, 100 and then “)”. That is, ln(100) which gives the result 
4.60517019. 

 
13.2 Display Compass Heading 

 
Use this option to display the direction of the compass on the Voice Sense 
QWERTY. You can display the compass heading from anywhere on the unit. 
 
To display the compass heading, do the following: 
Press "FN-Space" from anywhere on the Voice Sense QWERTY. 
The current status of the compass is displayed. 
 
You can also access compass status in the "Utilities" menu. Move to 
"Display Compass Heading" by pressing “down arrow”. Press "Enter" on the 
"Display Compass Heading" or simply press "h". 
 
 As you change direction, to check the current compass status, press 
"Space". The current direction is announced.  
To exit this function, press "Esc" or Alt-F4. 
 
Note: It will take about 15 minutes to initialize the unit should the following 
situations occur: 
1. The unit discharges a great distance from the location where the compass 
was  last used. 
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2. The unit remains discharged for more than a month. 
 

13.2.1 Options of gyrocompass 
 
There are 2 option settings available when viewing compass status: 
"Refreshing time" and "Compass display type".  
Refreshing time: 
You can set the interval of the automatic announcement of the compass 
status. To set this option, follow these steps: 
1) Execute "Display Compass Heading". 
2) The Voice Sense QWERTY displays the current compass status.  
3) Press "Tab". 
4) You are placed in the "Refreshing time" edit box. 
5) Type the number of seconds between compass status announcements. 
By default, it is set to 0. You may type a number between 0 and 120. 
 
Compass display type: 
You can set the type of the compass display. To set, follow these steps: 
1) Execute "Display Compass Heading". 
2) The current compass status is displayed. 
3) Press "Tab" to move to "Compass display type". 
4)  The setting values are "cardinal and degrees", "cardinal only" and 
"degrees only". By pressing "Space", you can change the value of the setting. 
By default, it is set to "cardinal and degrees". 
 
 
13.3 Display Time and Date 

 
Use this function to check the current date and time. To activate this function, 
press "up arrow” or “down arrow” to navigate to "Display Time and Date" in 
the "Utilities" menu, and press "Enter". Or, you can activate this function by 
pressing d from the menu. You can also query the time and date from 
anywhere on the Voice Sense QWERTY. Press "Fn-t " to check the time. 
Press “Tab”, and today's date is displayed. 
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13.4 Wake up alarm 

 
You can set a "Wake up alarm" so that an alarm sounds on the Voice Sense 
QWERTY at a specified time every day. To open "Wake up alarm", from the 
"Utilities" menu, use “up arrow” or “down arrow” to navigate to "Wake up 
alarm", and press "Enter". You can launch the “Wake Up alarm” application 
from anywhere on the unit by pressing “Caps Lock-A”. 
If this is the first time you have opened "Wake up alarm", and you have not 
yet set the time or date in the Voice Sense QWERTY, the unit prompts, "Set 
time:" After you set the time, the Voice Sense QWERTY displays the "Wake 
up alarm" dialog. You are then prompted, "Set time:" The "Wake up alarm" 
dialog contains the following: "Set time", "Bell", "Term", "Alarm duration", 
"Repeat interval", "Wake up call times", a "Confirm" button, and a "Cancel" 
button. You can move among the controls by pressing “Tab” and "shift-tab".  
When the alarm sounds, the Braille display (When connected to SyncBraille) 
also displays the message "Wake up call. Press “Ctrl” to stop the alarm". As 
the message indicates, to stop the alarm, press "Ctrl".  
 

13.4.1 Set Time 
 
When you open the "Wake up alarm" dialog, the Voice Sense QWERTY 
displays the "Set time" field. The value is set to the current time or the time 
specified previously. Here you can directly type the time, or set the time 
using the shortcut keys, as explained in section 6.3. After you set the time 
press “Tab” to move to the next field.  
 

13.4.2 Alarm Sound 
 
You can select from 1 of 3 alarm sounds for the wake up alarm. If you press 
“Tab” from "Set time", the current alarm sound plays. Press “up arrow” or 
“down arrow” to change the alarm sound. As you move among the sounds, 
the different alarm sounds are played.  
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When you have selected your desired alert, press “Tab” to move to the next 
field. 
 

13.4.3 Term 
 
In this field, you can set which days of the week the alarm sounds. There are 
four options: "Off", "Once", "Week days", and "Every day". Move among 
these options by pressing “up arrow” or “down arrow”. If the "Term" is set to 
"Off", the alarm does not go off at the specified time, no matter how the other 
options in the dialog are set. If the "Term" is set to "Once", the alarm goes off 
only once. If the "Term" is set to "Week day", the alarm goes off at the same 
time every weekday, Monday through Friday. If the "Term" is set to 
"Everyday", the alarm goes off at the specified time 7 days a week. When 
you have selected your preference, press “Tab” to move to the next field. 
 

13.4.4 Ringing Duration 
 
This option sets the amount of time that the alarm sounds. The options are 1 
minute, 2 minutes, or 3 minutes. Move among these options by pressing “up 
arrow” or “down arrow”. If you set the ringing duration to "1 minute", the 
alarm sounds for one minute, then is silent. To stop the alarm before a 
minute has passed, press "Ctrl". 
 

13.4.5 Repeat Interval 
 
This option sets the amount of time between the times that the alarm sounds. 
For example, if you set the repeat interval to three minutes, after the alarm 
has stopped sounding, it rings again in 3 minutes, . The available settings 
are 1, 3, 5, 10, 15, or 20 minutes. Move among these options by pressing 
“up arrow” or “down arrow”.  
 

13.4.6 Wake up Call Times 
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This option allows you to decide how many times the alarm sounds. If the 
alarm is not turned off by pressing "Ctrl", it repeats according to the number 
of times you set for this option. The available settings are 1 to 10. Move 
among these options by pressing “up arrow” or “down arrow”.  
 

13.4.7 Confirm/Cancel 
 
If you press "Enter" on the "Confirm" button, the changes are saved, and the 
dialog is closed. If you do not want to save the changes, press "Enter" on the 
"Cancel" button. The Voice Sense QWERTY keeps the previous alarm 
settings, and closes the dialog. 
 
13.5 Calendar 

 
You can open the calendar by pressing "Enter" on "Calendar" in the 
"Utilities" menu, or by pressing "l". You can launch the “Calendar” from 
anywhere on the unit by pressing “Caps Lock-L”. 
The following options are available: "Solar calendar", and "Lunar calendar"". 
In the calendar, you can check three kinds of information starting from the 
year 1841 to the year 2043. If you type a date that is not in the range and 
press "Enter", you get the message, "Invalid date", and return to the "Date" 
edit combo box.  
 

13.5.1 Using the Calendar 
 
The "Calendar" is composed of the "Solar calendar", and the "Lunar 
calendar". In the "Lunar calendar", a leap month is displayed with "l". The 
calendar works according to a date unit. The default is the date set on the 
Voice Sense QWERTY.  
The following is an explanation of how to check the dates. 
 
1. Moving items 
You can switch among "Solar calendar", and "Lunar calendar" by pressing 
“Tab” or "shift-tab". 
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2. Typing date 
In the calendar, you can type a month, date, and year in the form of 
mm/dd/yyyy. Use 2 digits for the day, 2 digits for the month, and 4 gigits for 
the year, separating them using a slash or space. If you press "Enter" after 
typing a date, the date is announced in one calendar, and you can press 
"Tab”  to move to the equivalent date in the other calendar.  
3. Hotkeys for switching dates 
 
After typing a date, you can check the "Solar calendar", "Lunar calendar", 
and "Day of week" by pressing “Tab” or "shift-tab". 
Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-left arrow 
Move to the next month: Down arrow 
Move to the previous month: Up arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
 
 
13.6 Stopwatch 

 
Launch the “Stopwatch” by pressing “enter” on “Stopwatch” in the “Utilities” 
menu. Or, you can launch the “Stopwatch” from anywhere on the unit by 
pressing “Caps Lock-W”. 
When you press "Enter" on the "Stopwatch", "00:00:00" is displayed. Press 
"Enter", to start the stopwatch running. Press "Enter" again, to pause, and 
the Voice Sense QWERTY announces the elapsed time, and displays it in 
Braille. Pressing "Enter" again restarts the stopwatch running. 
If you press "Backspace" while the stopwatch is paused or running, The 
Voice Sense QWERTY announces the elapsed time and clears to "00:00:00". 
While the stopwatch is running, pressing "Space" gives you the elapsed time. 
As the stopwatch is still running, the Braille display (When connected to 
SyncBraille) continues displaying the time second by second as it passes.  
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Press "Fn-Space" to stop displaying the time. If you press "Fn-Space" once 
more, the time is displayed again. 
 
If you press “Tab” or "shift-tab" when the stopwatch is idle or while it is 
running, you switch to the "Countdown timer". If you activate the "Countdown 
timer", you are asked to type hours, minutes, and seconds. When typing the 
hours, minutes, and seconds, type a two-digit number for the hour, minute, 
and the second. If you press "Enter" without typing any numbers, the 
"Countdown timer" starts counting down by the default time, which is set to 
one minute. When started, the "Countdown timer" displays "countdown xx 
minute", and begins running. 
Press "Enter" on the "Countdown timer", and the Voice Sense QWERTY tells 
you the remaining time, and pauses countdown. Press "Enter" again to 
restart the timer. Pressing "Backspace" clears the "Countdown timer". If the 
timer reaches zero, a 10-second alarm sounds, and the "Countdown timer" 
clears. If you press "Ctrl" while the alarm is sounding, the alarm stops and 
your timer clears, and is ready to accept a new time. 
Press “Tab” or "shift-tab", to return to the stopwatch. To exit the "Stopwatch" 
or "Countdown timer", press "Alt-F4", and you return to the "Stopwatch" item 
in the "Utilities menu. 
13.7 Terminal for Screen reader 

 
The "Terminal for screen reader" function allows the Voice Sense QWERTY 
to be used as a Braille display when connected to a computer or cell phone 
that uses a compatible screen reader such as Window-Eyes, Supernova, or 
Apple's VoiceOver. Before using this function, make sure that the Voice 
Sense QWERTY is connected to your personal computer or smart phone via 
a Bluetooth serial connection, or to the USB client port. To turn on this 
function, from the "Utilities" menu, press “down arrow” repeatedly to reach 
"Terminal for screen reader". Then press "Enter". Or, you can press “S” from 
the “Utilities” menu to quickly jump to and execute the “Terminal for Screen 
Reader”. 
You can launch the “terminal for Screen reader” from anywhere on the unit 
by pressing “Caps Lock-S”. 
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 When you activate "terminal for screen reader", the list of connection 
options is displayed. The options are "Bluetooth serial port" and "USB port". 
Press “up arrow” or “down arrow” to reach your desired connection type. 
Press "Enter" and the unit announces, "Terminal mode". If you choose the 
Bluetooth Serial connection and Bluetooth is not activated, the Voice Sense 
automatically activates Bluetooth before entering Terminal Mode. 
When in Terminal Mode, the Voice Sense QWERTY no longer speaks as it 
is now simply acting as a Braille display for your computer or smart phone. If 
the connection fails, you are returned to the list of connection methods. 
To exit the "Terminal for Screen reader" press "Alt-x". 
 

13.7.1 Connecting to a Screen reader 
	  	  

13.7.1.1 Connecting to PC via USB 
	  	  

To connect the Voice Sense to a Windows screen reader such as Jaws, 
NVDA, System Access or Window-Eyes via USB, you must install the proper 
USB driver on your PC. Below are steps for installing the USB driver.  
 
Note: for JAWS for Windows version 14 or lower, you must download and 
install 2 drivers: the generic HIMS USB driver, and the JAWS specific driver. 
For all other screen readers, and when using JAWS 15 or higher, you need 
only the generic Voice Sense USB driver. 

	  	  

1) Download the USB driver for Voice Sense from the HIMS website:   
Generic USB driver:  
http://www.himsintl.com/upload/HIMS_USB_Driver_v25.zip 
JAWS specific driver for V14 or lower:   
http://www.himsintl.com/upload/JAWS/HIMS_Braille_Driver_For_Jaws_V2_1.zip 
2) Unzip the compressed file and execute “Braille_SENSE_USB_Driver.exe. 
3) When the “Voice Sense USB Driver Setup wizard” appears, select the 
“Install” button.  
4) When the installation wizard appears, select the “Next” button.  
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5) When the drivers are successfully installed, press the “Finish” button.  
6) Connect the Voice Sense to the PC via the USB cable, and make sure it 
is in Terminal Mode.  
7)   
A. if using windows 7/8, Windows will locate and automatically install the 
drivers. If running XP, please use step B, and the subsequent numbered 
steps. 
B. When the “Found New Hardware Wizard” appears, select “Install from a 
specific location” using the “Down arrow”, and then press the “Next” button.  
8) When the “Please choose your search and install option” message 
appears, select “Don’t search. I will choose the driver to install”, and press 
the “Next” button.  
9) You are prompted to “Select the device driver you want to install for this 
hardware”, select “HIMS USB DRIVER” and press the “Next” button.  
10)  “Completing the Found New Hardware Wizard” should appear. Select 
the “Finish” button.  
  
When you have finished installation of the USB driver on the PC, please 
follow the instructions for connecting the display with your screen reader via 
USB. 

	  	  

13.7.1.2 Connecting to PC via Bluetooth serial port 
	  	  

The following steps will walk you through setting up the Voice Sense to be 
used as a Bluetooth Terminal for Screen Reader. These instructions assume 
that you already have Bluetooth installed on your computer. The following 
instructions also assume that you are running at least Windows XP, Service 
Pack 2. 
  
Before you begin, make sure that your Voice Sense is turned on and be 
aware of the unit’s designated Bluetooth name. 
  
1. Instructions for windows XP 
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1) Navigate to the Bluetooth icon in the System Tray. You may open the 
system tray by pressing "windows key-b", then press the Right or Left Arrow  
Key until you reach the Bluetooth icon. Then, press the "Applications” key".  
Note: If the Bluetooth icon does not appear in the System Tray, you may 
have to change the settings for the Bluetooth icon to appear. Go to the 
Windows Control Panel, Bluetooth Devices, Options, and check the check 
box that says "Show the Bluetooth Icon in the Notification Area". 
 2) Press the "up or down arrow" key until you get to "Open Bluetooth  
settings", and press "Enter". 
 3) Fromt the tabs list, use “Control-Tab” to select the Device tab. 
 4) Tab to the Add button, and press "Enter". 
 5) Press "Space" to check the checkbox for "My device is setup and ready 
to be found", and then press enter". 
 6) The XP machine should find the Voice Sense under the name "”Voice 
Sense----“where --- represents a numeric value.  
 7) Press the "down arrow" key to focus the name of your HIMS Braille 
device. 
 8) Tab to the Next button, and press "Enter". 
 9) The PC should ask for the PIN code. Type a 4 digit code of your choosing, 
and press Enter. Voice Sense will then prompt you for the same pin code; 
type it in computer Braille and press Enter. 
10) The computer should display the message, "Found new hardware" and 
the finish dialog should appear. 
 If the connection is successful, the dialog should display that the  
Bluetooth device was successfully set up. Please note the numbers for the 
incoming and outgoing com ports. For example, the outgoing COM port may 
be  
COM 5, and the incoming COM port may be COM 6. Do not be surprised if 
your COM ports are not set to COM 5 and COM 6. The COM ports used can 
vary from computer to computer. 
 11) Press "tab" to get to the Finish button, and press "Enter" to activate it. 
 12) You are returned to the Bluetooth device settings dialog. From the tabs 
list, press Ctrl-Tab twice to focus the COM ports tab control. 
 13) Press "tab" to get to the list of COM ports, and press the Down Arrow to 
move through the list of COM ports to verify the com port numbers. 
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 14) Tab to the OK button, and press Enter. 
  
2. Connecting via Bluetooth to a Windows 7/Windows 8 computer. 
  
1)   Open the Control Panel. 
2)   Open Devices and Printers 
3)   Tab to “Add a Device” and press “Enter”. 
4)   Windows searches for devices and displays them in a list. 
5)   Use the Up or Down arrow to navigate to the Voice Sense and press 
“Enter”. 
6)   You are asked to enter the pass code for the device. Enter a 4 digit code 
of your choosing and press Enter. The Voice Sense will then prompt you for 
the same pass code; type it in computer Braille, and press Enter. 
7)   The computer should display the message, "Found new hardware" and 
the final dialog should appear on the computer. The dialog should display 
that the Bluetooth device was successfully set up. It is very important to note 
the Bluetooth COM port as you will need this when setting up your screen 
reader. 

	  	  

13.7.1.3 Using the Voice Sense with Window-Eyes 
	  	  

Use the following steps to connect your HIMS Braille device as a terminal for 
Screen Reader with Window-Eyes from GW Micro.	  

1) Make sure your Voice Sense is powered on, and in Terminal mode.	  

2) Press Control-Backslash to open the Window-Eyes control Panel.	  

3) Arrow down to devices and press “Enter”.	  

4) Arrow down to “Braille displays” and press “Tab” to open the available 
displays list.	  

5) Arrow down to Voice Sense and press “Tab” to get to the ports list.	  
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6) If you are using Bluetooth, please choose the Com Port number that 
matches your Bluetooth connection. If using USB, choose “USB” from the 
ports list.	  

7) Tab to “Activate” and press “Enter”.	  

8) If activation is successful, you have 15 seconds to choose whether or not 
to “keep settings” or “Revert” the settings to the way they were before you 
activated the Voice Sense.	  

9) Tab to “Keep settings” and press “Enter”.	  

10) Tab to “Save Settings” and press “Enter”.	  

11) Tab to “Minimize” and press “Enter” to minimize the Window-Eyes 
Control Panel.	  

	  	  

Note: You may need to restart Window-Eyes for Braille to begin displaying. 
	  

13.7.1.4 Using the Voice Sense with JAWS for Windows 
	  	  

Use the following instructions to set up the Voice Sense as a Braille display 
with the JAWS screen reader from Freedom Scientific: 
1) Make sure Voice Sense is powered on and in Terminal Mode. If you are 
using USB, please connect the unit to the computer via the included USB 
cable.  
2) Navigate to the JAWS Window and press “Alt” to open the menu.  
3) Press “Enter” on the “Options” menu. 
4) Use the Up or Down arrow to navigate to “Braille” and press “Enter”. 
5) Choose HIMS Voice Sense as your Braille device. 
6) Tab to “Advanced” and press “Enter”. 
7) Choose USB as the port if connecting via USB, or the correct Com Port if 
using Bluetooth. 
8) Tab to “OK” and press “Enter”. 
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9) You are prompted that you must restart JAWS for the settings to take 
effect. Restart JAWS for Windows, and Braille should begin displaying. 
 

13.7.1.5 Using Voice Sense as a Braille display with NVDA 
	  	  

Use the following instructions to set up the Voice Sense for use as a Braille 
display with the free NVDA screen reader from NV Access. 
1)   Make sure Voice Sense is powered on and  in Terminal Mode. If you are 
using USB, please connect the device to your computer via the included 
USB cable. 
2)   Press “NVDA key-N” to open the NVDA menu. 
3)   Arrow down to “Preferences” and press “Enter”. 
4)   Arrow down to “Braille Settings” and press “Enter”. 
5)   Choose “HIMS Voice Sense” from the Braille Display combo box. 
6)   Tab to the “Port” combo box and ensure that it is set correctly. (NVDA 
employs automatic port detection, so you should not need to change this 
setting) 
7)   Tab among the various combo boxes to choose options such as output 
and Input tables, cursor options, etc. Use the Up and Down arrows to 
navigate among the choices in each combo box. 
8)   When you have finished selecting your settings, Tab to “OK” and press 
“Enter”. 
  
Note: Make sure the “Save configuration on Exit” box is checked in the 
NVDA menu in order to ensure your settings for the Voice Sense are saved, 
thus the HIMS Braille device will automatically connect each time you use 
NVDA in the future. 

	  	  

13.7.1.6 Using the Voice Sense with System Access. 
Currently, The Voice Sense works with System Access using only a 
Bluetooth connection. To use your Voice Sense as a Braille display with 
System Access, ensure it is powered on, Bluetooth is activated, it is in 
Terminal Mode, and that it has been paired with your PC. When System 
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Access is started, the device is automatically detected, and Braille begins 
displaying. 
	   

13.7.1.7 Using Voice Sense with VoiceOver on the Mac. 
  
To use a Voice Sense as a USB braille display with a Mac running 
VoiceOver, you can simply power on the device, make sure it is in Terminal 
Mode and connect it to the Mac via USB. The unit is immediately recognized 
and VoiceOver output is shown on the Braille display. 
Use the following steps to connect the Voice Sense as a Bluetooth Braille 
display with a Mac running VoiceOver: 
1. Ensure that the unit is powered on, Bluetooth is activated, and it is in 
Terminal Mode. 
2. Press Vo-F8 to open the voiceOver Utility. 
3. Navigate to “Categories” and press Vo-Shift-Down to begin interacting 
with it. 
4. Press B for Braille. 
5. Press Vo-Shift-Up to stop interacting with the Categories group. 
6. Press Vo-Right to “Display”, and press Vo-Space to activate it. 
7. Navigate to “Add”, and press VoSpace to activate. 
8. VoiceOver announces “Searching for Bluetooth devices”. 
9. Navigate to the “Bluetooth devices” list and press Vo-Shift-Down to 
interact with the table. 
10. Navigate to “Voice Sense ” and press Vo-Shift-Up to stop interacting with 
the table. 
11. Navigate to “Remember this device” and press Vo-Space to check the 
box. 
12. Navigate to “select” and press Vo-Space” to activate it. 
13. VoiceOver asks for the pairing code and places you in the edit box. 
14. Enter the pairing code, type a 4 digit code of your choosing and press 
Enter. Voice Sense prompts you for the same pin code; type it in computer 
Braille and press Enter. 
You should hear a chime indicating VoiceOver has connected to your Braille 
device and you should begin seeing VoiceOver output on the Braille display.  
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13.7.1.8 Using the Voice Sense with IOS devices 
	  	  

Use the following instructions to connect your Voice Sense as a Bluetooth 
Braille display with your iPhone, iPad, or iPod.  
  
Note: You must be running IOS 4.2 or higher on your i-device in order to use 
HIMS Braille devices as Bluetooth Braille displays with VoiceOver. These 
instructions refer to the iPhone, however, they apply to all compatible i-
devices: iPhone 3Gs and higher, iPad, and iPod Touch 3G and later. 
1) Make sure your Voice Sense is powered on, Bluetooth is activated, and it 
is in Terminal Mode. 
2) On your iPhone, Navigate to 
Settings/General/Accessibility/VoiceOver/Braille. 
3) If Bluetooth is not activated on the I-Phone, it will prompt you to do this. 
WHEN Bluetooth is activated, the I-Phone searches for devices. 
4) The Voice Sense should appear in the list of available Braille devices. 
5) Double tap the Voice Sense in the Braille devices list. 
6) You are asked for a pin code. Enter a 4 digit code of your choosing  and 
double tap the Pair button. 
  7) the notetaker prompts you for the pin code; type the same pin code you 
entered in to the iPhone, and press Enter. 
You should hear a chime on the iPhone, and the text displayed on the 
iPhone should appear on the Braille display of your Voice Sense. 

	  	  

13.7.1.9 Using the Voice Sense with BrailleBack for Android. 
	  	  

In order to gain Braille access to Android via BrailleBack, you must first 
download and install the application to your Android device from the Google 
Play store. 
Use the following steps to use your Voice Sense as a Braille display with 
BrailleBack. 
  
1. Make sure your Voice Sense is powered on, Bluetooth is activated, and in 
Terminal Mode. 
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2. On your Android device: go to “Settings”. 
3. Select Bluetooth. 
4. Select “Search for devices”. 
5. Select the Voice Sense from the device list. 
6. When requested, enter a 4 digit pairing code of your choosing and select 
the OK button: 
After activating the OK button on the tablet, Voice Sense prompts you for the 
same pin code; type it in computer braille and press Enter. 
7. When the Voice Sense is successfully paired, return to “Settings” on your 
Android device and select “Accessibility”. 
8. Select BrailleBack and enable the checkbox to turn it on. The paired 
Braille display should be recognized and should begin displaying Braille. 
  
 

13.7.2 Terminal Clipboard 
	  

Terminal Clipboard allows you to create and edit text on the notetaker 
before sending it via the Terminal for Screen Reader to the connected 
device. This can be useful in instances like when using VoiceOver on an i-
device, in which characters are translated as they are sent to the IPhone or 
iPad. In this case, if you do not type quickly, characters may be 
mistranslated. For example: if you type “t e l l” and do not type quickly 
enough, VoiceOver could potentially translate this as “thateverylikelike” as, 
if there are pauses in typing, each Braille character can potentially be 
translated to its whole word equivalent. In the same way, editing text is also 
difficult as, any letter or single character Braille contraction, when typed by 
itself is translated as that contraction. So, if you are attempting to type the 
word “talk”, and accidentally type “tall”, when you delete the “l” and type the 
“k” the “k” is translated as “knowledge”. Thus, the text you get is 
“talknowledge”. To truly fix the word, you must erase the entire word and 
type it again. 

Thus, creating/editing text when using your notetaker as a Braille display is 
sometimes a very exact and tedious business. As explained above, the 
Terminal Clipboard allows you to create and edit text on the notetaker, and 
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send the completed text to the connected computer or SmartPhone via the 
Terminal for Screen reader. 

To enter “Terminal Clipboard”, press “Control-FN-I”. The Voice Sense 
announces, “Terminal Clipboard”. Type and edit your text using normal text 
entry and edit commands. In “Terminal Clipboard”, the Braille display and 
keyboard are temporarily disabled from sending/receiving information 
to/from your connected computer or i-device, so that you may use them for 
creating/editing your text. For more information on text entry and editing, 
please see section 5 of this manual on the Word Processor. When you are 
finished typing the text you wish to send to your computer or PDA, press 
“Control-S” and the text is quickly inputted to the device via the Terminal for 
Screen reader, and your Voice Sense returns to sending/receiving 
information to and from the connected device. 

“Terminal Clipboard” can also be useful for transferring text from a 
document or e-mail in your notetaker, to a document or e-mail you are 
creating on your connected computer or SmartPhone. As the “Terminal 
Clipboard” is a standard edit box on the notetaker, you can paste text in to 
it from the notetaker’s clipboard. (see the sections of this manual regarding 
selecting text as it applies to supported programs such as the Word 
Processor, E-mail, Web Browser, etc.) 

To send text on the notetaker’s clipboard to your connected device via the 
Terminal for screen reader, do the following: 

1) While in Terminal Mode, press “Control-FN-I” to activate “Terminal 
Clipboard”. 

2) Press “Control-v” to paste the text from the notetaker’s clipboard to the 
edit box. 

3) Press “Control-S” to send the text to the computer or i-device via the 
Terminal for Screen Reader. 
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13.8 Display Network Status 
 
Using this utility, you can check whether the Voice Sense QWERTY is 
currently connected to the Internet. This utility provides information about the 
current connection type, the current IP of the unit, subnet mask, gateway, 
and MAC address. To check network status, press "Enter" on "Display 
Network Status", or press "n" from the "Utilities" menu. You can also queery 
network status from the "program" menu by pressing "Fn-n".  
When you launch "Display network status", the information about the current 
connection is displayed. If you press “Tab”, the Voice Sense QWERTY 
displays a "Renew" button. If you press “Tab” again, "close" is displayed. If 
you press "shift-tab", the Voice Sense QWERTY moves among these 
elements in the opposite direction.  
 
The first item in the information list (status) indicates whether the Voice 
Sense QWERTY is currently connected to the Internet (online/offline), and if 
so, the current connection type (LAN, Modem, ADSL, or Wireless LAN). The 
next item is the "current IP address", followed by "Subnet mask", and 
"Gateway", and finally "MAC address". You can move among these items by 
pressing “down arrow” or “up arrow”. If the Voice Sense QWERTY is not 
currently connected to the Internet, the status information shows "offline", 
and the IP address, subnet mask, and gateway display 0's.  
 
13.9 Display Power Status 

 
You can activate the "Display power status" function by pressing b or press 
"Enter" on "Display power status" from the "Utilities" menu.  You can queery 
power status from anywhere on the Voice Sense QWERTY by pressing "Fn-
b". When you execute this command, 2 pieces of information are displayed: 
the percentage of charge remaining in the battery, and whether the Voice 
Sense QWERTY is using the AC adapter or the battery to receive power. 
After checking power status, you can exit by pressing "Alt-F4", and you are 
returned to your previous location on the unit.  
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13.10 Format 

 
At times, it may become necessary to reformat the flashdisk in the Voice 
Sense QWERTY.  You can access the "format" function by pressing f from 
the "Utilities" menu. You can launch the “Format” option from anywhere on 
the unit by pressing “Caps Lock-F”. 
When you format the flashdisk, or any disk on the Voice Sense QWERTY, all 
information is erased. Therefore, before you format, you are advised to 
backup any important data if possible. 
 

13.10.1 Formatting the disk 
 
You can format the flashdisk using 2 methods: 
1. Formatting the disk from the "Utilities" menu. 
1) Go to "Format" in the "Utilities" menu. 
2) Press "Enter", and "flashdisk" is focused. 
3) Press "Enter" 
4) You are prompted, "Format flashdisk?" Yes".  
5) Press "Enter" 
6) You are prompted, "All data will be lost. Continue? Yes".  
7) Press "Enter".  
8) The unit announces, "Now formatting flashdisk" and the format is started. 
9) When the format is complete, you are returned to the "Disk" list. 
 
To cancel the format, press "Space", or press "Enter" on "No" in step 4 or 6. 
You can also use this utility to format external storage devices such as SD 
cards or USB drives by choosing them from the disk list and following the 
procedure as described above.  
 
2. Formatting the flashdisk using "Reset". 
 
1) Press and hold "Fn-f".  
2) While holding down "Fn-f", quickly press and release the reset button. 
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3) Continue holding "Fn-f" until the unit announces, "Format start".  
4) When the format completes, the unit reboots and you are placed in the 
"program" menu. 
 
13.11 Set Sleep Timer 

 
YOU can set the sleep timer to turn the Voice Sense QWERTY off after a 
specified amount of time regardless of what you are doing. 
To set the sleep timer, follow these steps: 
1) Open the "Utilities" menu. 
2) Press “up arrow” or “down arrow”, to move to "Sleep timer". 
3) Press "Enter".  
4) Or press "Fn-j" from anywhere on the unit.  
5) You are prompted, "Sleep timer: 0". 
6) Enter the number of minutes for the sleep timer in the edit box. The 
available settings range from 0 to 180. 
7) Press "Enter". 
When the sleep timer is set, even if the device is active, it powers off after 
the specified amount of time. If you set the sleep timer for "5" minutes and 
press "Fn-j" after 2 minutes, "3" is displayed in the edit box, indicating the 
time remaining before the sleep timer powers the unit off.  
 
 
13.12 Upgrade Voice Sense QWERTY Firmware 

 
Using this utility, you can update the Voice Sense QWERTY either via an 
Internet connection or from external media containing the upgrade files. If 
you choose the "Online" method, be sure you have an active Internet 
connection before attempting the upgrade.   
You can launch the “Upgrade firmware” utility by pressing “enter” on 
“Upgrade Voice Sense Firmware” in the “Utilities Menu. Or, you can launch 
the “Upgrade” utility from anywhere on the unit by pressing “caps Lock-U”. 
When you update the Voice Sense QWERTY, all of the settings are returned 
to their default status. Data in the flashdisk should not be affected. However, 
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we recommend you backup your files before updating the Voice Sense 
QWERTY Firmware as unexpected problems can occur. 
 
Note: You cannot cancel the update once it has started. You must not reset 
the unit during an upgrade. You must keep the unit connected to AC power 
throughout the upgrade process. We recommend you do not touch the Voice 
Sense QWERTY while it is updating. It may take up to 30 minutes to update 
the Voice Sense QWERTY, depending on the speed of your Internet 
connection. On completing the installation, the Voice Sense QWERTY 
reboots again to finish the update and places you in the "program" menu. 
 
Also note: the upgrade files are temporarily stored on the flashdisk for 
installation. If you do not have enough memory available on the flashdisk, 
the Voice Sense QWERTY is unable to update until you make room for the 
upgrade files. 
 

13.12.1 Upgrading the Voice Sense QWERTY Firmware Using 
the Internet 

 
To upgrade the Voice Sense QWERTY Firmware via the Internet, follow 
these steps: 
 
1) Make sure you are connected to the Internet and plugged into AC power. 
Press "Enter" on "Upgrade Voice Sense QWERTY Firmware" in the 
"Utilities" menu.  
2) Press "Enter" on "Upgrade: Online". The Voice Sense QWERTY connects 
to the HIMS server, and your current software version is compared to the 
HIMS server version. You are prompted to continue with the upgrade. 
 
3) If you press "Enter" on "No", the upgrade is cancelled. Press "Space" to 
toggle between "Yes" and "No". If you press "Enter" on "Yes", the Voice 
Sense QWERTY begins downloading the upgrade files. If the upgrade fails, 
you may receive the message, "Internet connection is not available. Check 
your cable and try again". To try the upgrade again, press "Alt-F4" to cancel, 
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and activate "Upgrade Voice Sense QWERTY Firmware" again. If the 
connection is successful, the upgrade files are downloaded.    
 
4) After downloading the upgrade files, Voice Sense QWERTY automatically 
starts the upgrade process. Please remember you must not touch the Voice 
Sense QWERTY until the upgrade is complete as pressing keys, resetting, 
or unplugging the unit can interrupt the upgrade process, thus resulting in an 
incomplete installation. When the upgrade is complete, you are returned to 
the "program" menu, and the unit announces, "File manager". 
 
5) After the upgrade is complete, check the software version by pressing 
"Fn-v” while in the "program" menu. 
 

13.12.2 Upgrading the Voice Sense QWERTY Firmware from 
a Disk 

 
To upgrade the Voice Sense QWERTY Firmware from a disk, follow these 
steps: 
 
1) Download the upgrade files from the HIMS, Inc. website. Extract the zip 
file and copy the 2 files contained in it to the root of an external storage 
device such as an SD card or USB thumb drive.  
 
2) Connect the SD card or USB drive to the Voice Sense QWERTY, and be 
sure the Voice Sense QWERTY is connected to AC power. Then, press 
"Enter" on "Upgrade Voice Sense QWERTY Firmware" from the "Utilities" 
menu. 
 
3) "Upgrade: Online" is displayed. Press “down arrow” to go to the "Upgrade: 
Offline" option. Press "Enter".  
 
4) If you are already running the latest version of the software, you are asked 
to continue with the upgrade. If you press "Enter" on "No", the upgrade is 
cancelled. Press "Space" to toggle between "Yes" and "No".  
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5) If you press "Enter" on "Yes", the Voice Sense QWERTY warns you that 
all settings will be set to factory defaults, and again, asks if you would like to 
continue. Press "Enter" on "Yes". 
 
6) The Voice Sense QWERTY starts the upgrade process. Please remember 
you must not touch the Voice Sense QWERTY until the upgrade is complete. 
When the upgrade is complete, you are returned to the "program" menu, and 
"File manager" is displayed. 
 
7) When the upgrade is complete, check the software version by pressing 
"Fn-v" while in the "program" menu. 
 
13.13 Hot keys for Utilities 

 
Calculator: c 
Calculator Clear:Alt-c 
Delete numbers or operators: Backspace 
 
General functions: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Over: FN-/ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
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Memory Functions: 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s 
 
Trigonometric Functions: Ctrl-s 
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-i, i 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h 
 
Logarithm Functions: Ctrl-l 
Natural Logarithm: Ctrl-l, e  
Common Logarithm: Ctrl-l, n 
 
Miscellaneous: 
Copy to Clipboard: Ctrl-c 

Option Settings: Ctrl-o 
Fraction options: Control-/ 
Return formula: Control-r 
 
 
Check date and time: Fn-t 
 
Calendar: l  
Move items 
Move to the previous item: Tab  
Move to the next item: Shift-tab 
 
Navigation keys for date in calendar 
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Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Up arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
 
Stopwatch: w  
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Stop Braille display: Fn-Space 
Restart Braille display: Fn-Space 
Switch between stopwatch and count down timer: “Tab” or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
Display power status: Fn-b 
 
Display network status: Fn-n 
 
 

Format: Hold Fn-f and press and release "Reset" 
 
Set Sleep Timer: Fn-j 
 
Upgrade Voice Sense QWERTY Firmware: u  
Check download information: Space 
Cancel download and exit: Alt-F4 
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14. Using the help menu 
 
The help section consists of various text files that allow you to read about the 
many functions of the Voice Sense QWERTY. The "Help" menu contains the 
following sections: 
 
1. Help Overview 
2. Basic Functions Help 
3. SettingsHelp 
4. File Manager Help 
5. Word Processor Help 
6. Email Help 
7. Media Help 
8. Organizer Help 
9. web Tools Help 
10. Social Networking Help. 
11. Extras Help 
12. Games Help 

13. Utilities Help 
14. Using the Help menu 
15. Using ActiveSync 
16. Command Summary 
17. Command Summary for USB Keyboard 
18. Troubleshooting Guide 
19. Accessories 
20. Information about the Voice Sense QWERTY 
 
The section, "Help overview," gives a physical orientation to the Voice Sense 
QWERTY and an overview of its functionality. To access the help file, press 
“Windows” key to go to the "program" menu, and use “down arrow” 
repeatedly until you locate "Help”. Press "Enter". The first item is "Help 
Overview". Press "Enter" on "Help Overview" to open it. Keys for navigating 
are the same as those in the Word Processor. For a list of navigation keys, 
please see section 16.3.2.  
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As you read the manual on the Voice Sense QWERTY, you can search for 
text in the various sections by pressing "Ctrl-f". Type the text you wish to find, 
and press "Enter". You can find the next occurrence of the particular text you 
searched for by pressing "F3". 
The section, "Basic Functions Help", gives a basic overview of the 
programming and operation of the Voice Sense QWERTY.  
The section, "Settings Help" provides an explanation of how to establish 
Internet and Bluetooth connections, how to set the time and date, and an 
explanation of the "Global Options" and how to use them to configure your 
Voice Sense QWERTY according to your preferences.  
Most of the remaining sections cover each of the functions of the Voice 
Sense QWERTY in detail. To access these help files, press “Windows” key 
to go to the "program" menu, and use “down arrow” repeatedly until you 
locate "Help". Or press the letter h to quickly jump to and open "Help". You 
can open Help from anywhere on the unit by pressing “Windows-H”. 
Use "down arrow” to navigate to the section you wish to read. Press "Enter" 
on your desired section to open it.  
 
The "Commands Summary" section is a quick reference of hot keys for all 
the programs on the Voice Sense QWERTY: useful when you simply want to 
know the keystroke for performing an action without reading the entirety of 
the instructions on a given program. 
The "Information about the Voice Sense QWERTY" section provides the 
copyright and version of the Voice Sense QWERTY, as well as the version 
of Windows CE that the Voice Sense QWERTY is using, the version of the 
Voice Sense QWERTY firmware, and other useful items such as Mac 
address and Key number. When the "information" section is open, you can 
save the information about the Voice Sense QWERTY by pressing "Tab", to 
navigate to the "Save" button and press "Enter". The unit displays 
"Successfully saved", and returns you to the "Save" button.  
The saved file is named "bs-information.txt", and is stored in "flashdisk" for 
easy access. 
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15. Using ActiveSync 
 
15.1 What is ActiveSync? 

 
ActiveSync, or Windows Mobile Device Center as it is called in later versions 
of Windows, is a program that allows mobile devices to connect to a 
personal computer. This program enables file transfer from a personal 
computer to a mobile device and vice versa. This program also facilitates 
synchronization of the calendar and contacts on Voice Sense QWERTY with 
those on Microsoft Outlook. ActiveSync/Windows Mobile Device Center is 
not shipped with the Voice Sense QWERTY. It is available free of charge 
from Microsoft for anyone using a Windows PC. If you would like to use 
ActiveSync, you must download it from the Internet and install it on your 
personal computer. If you are using Windows 7, Windows Mobile Device 
Center is automatically downloaded and installed when a Windows Mobile 
device is connected to the PC. 
 
15.2 Connecting the Voice Sense QWERTY to a PC 

 
To use ActiveSync/Windows Mobile Device Center with the Voice Sense 
QWERTY, you must disable Mass Storage Device Mode before connecting 
to the PC. To do this, press "F10" to open "Global Options". Press "Ctrl-right 
arrow” to jump to the end of the "Global Options" dialog, as Mass Storage 
Device Mode is the last item. If Mass Storage Device Mode is turned on, 
press "Space" to turn it off. Press "Enter" to save the option settings. 
 
Before connecting the Voice Sense QWERTY to your personal computer for 
the first time, make sure that the Voice Sense QWERTY is powered off. 
Once you have ActiveSync installed, connect a USB cable to the USB OTG 
port on the left panel of the Voice Sense QWERTY. Then, connect the other 
end of the USB cable to a USB port on your personal computer. Now, turn 
on the Voice Sense QWERTY. You will hear several sounds. First, on the 
Voice Sense QWERTY, you will hear chimes. Then, on your computer, you 
will hear a "ding-dong" sound indicating the Voice Sense QWERTY is 
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connected to the PC. You will again hear chimes on the Voice Sense 
QWERTY, and then on your computer indicating that each recognizes the 
other as a device for synchronization. 
 
15.3 Setting up the Voice Sense QWERTY in the 
ActiveSync Program 

 
When the PC detects the Voice Sense QWERTY as a Windows Mobile 
device, a screen pops up on your computer prompting you to "Set up a 
Partnership". You can choose "Yes" or "No". If you select "Yes" on this 
screen, the next time you connect the Voice Sense QWERTY to your 
computer, synchronization with Microsoft Outlook will occur automatically. If 
you select "No," the "Set up a Partnership" screen will pop up each time you 
connect the Voice Sense QWERTY to your computer. 
If you want to synchronize the Voice Sense QWERTY with Microsoft Outlook, 
select "Yes," and press the "next" button. Then, you are asked to select a 
name for the mobile device. You can use only _, A-Z, and 0-9 in your device 
name. You cannot use spaces. Once you have entered an appropriate name, 
press "Enter" on the "next" button.  
A list of functions appears on your computer. Each function has a check box 
located next to it. Make sure no check boxes other than the "Contacts" and 
"Calendar" check boxes are checked, as synchronization of Calendar and 
Contacts is all that is currently supported on the Voice Sense QWERTY. You 
may choose to check "Contacts", "Calendar", or both, depending on your 
preference.  After setting your preferences, press "next". A dialog box 
appears displaying, "setup complete”. Tab to the "finish" button and press 
"Enter".  
ActiveSync then looks for changes, and synchronizes with Microsoft Outlook. 
For more information on how to use ActiveSync/Windows Mobile Device 
Center  or Microsoft Outlook, please visit www.microsoft.com. 
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15.4 Transferring Files to the Voice Sense QWERTY 
Via ActiveSync 

 
To transfer files to the Voice Sense QWERTY from your computer, locate the 
file(s) you want to transfer from your PC using Windows Explorer. Select the 
file(s), and press "ctrl-c" on your PC to copy the file(s) to the clipboard. Go to 
the desktop on your computer by pressing "Windows-key-d". Press the letter 
m repeatedly until you reach "My computer". Press "Enter". Again, press the 
letter m repeatedly until you reach "mobile device", and press "Enter". The 
"mobile device" is the Voice Sense QWERTY. When the "mobile device" is 
opened, you are placed in the file list on the Voice Sense QWERTY. One of 
the items in the list is another "my computer" icon. Press the letter m 
repeatedly until you reach "my computer", and press "Enter". Another file list 
opens. In this list, is located a folder called "flashdisk”. This is the same 
"flashdisk" that appears under "File Manager" on your Voice Sense 
QWERTY, and is the internal drive on your notetaker. Press f until you reach 
"flashdisk," and then press "Enter”.  You can paste the file(s) here directly by 
pressing "ctrl-v," or you can paste the file(s) in to one of the folders on the 
flashdisk. 
If you want to copy folders from the Voice Sense QWERTY to your PC via 
ActiveSync, follow the same steps; but copy files from the Voice Sense 
QWERTY, and paste the file(s) into your preferred directory on the PC. 
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16. Command Summary 
 
16.1 Common Combination Keys 
 
Open the program menu: Win key 
Key help mode: Ctrl-ESC 
Run specific program: Win key-”shortcut key” (varies for each program) 
Open the Task Name list: Fn-F10 
Switch to previous program: Alt-Shift-tab 
Switch to next program: Alt-Tab 
Open program specific menu: Alt 
Exit: Alt-F4 
Escape: Esc 
Move to the next control in a dialog box: Tab 
Move to the previous control in a dialog box: Shift-tab 
Move to the previous character: Left arrow 
Move to the next character: Right arrow 
Move to the previous line/item: Up arrow 
Move to the next line/item: Down arrow 
Move to the beginning of line/item: Home 
Move to the end of line/item: End 
Move to the top of a document or to the first item: Ctrl-Home 
Move to the bottom of a document or to the last item: Ctrl-End 
Move to the previous page or to the first item of the previous 32-item group: 
Page up (Fn-Up arrow) 
Move to the next page or to the first item of the next 32-item group: Page 
down (Fn-Down arrow) 
Scroll left: Up scroll button 
Scroll right: Down scroll button 
Move the cursor to specific cell or move to an item: The corresponding 
cursor routing key 
Capital sign: Caps lock 
Read the current item again: Fn-r 
Say current time: Fn-t  
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Display power status: Fn-b 
Open the “global options”: F10 
Online help: F1 
Check software version: Fn-v only in the Voice Sense “program” menu. 
Display network status: fn-n in the Voice Sense “program” menu 
 
Braille display on/off: F4 
Voice on/off: F5 
Increase the voice volume: F6 
Decrease the voice volume: Shift-F6 
Increase the voice rate: F7 
Decrease the voice rate: Shift-F7 
Increase the voice pitch: F8 
Decrease the voice pitch: Shift-F8 
Increase the Main Volume: Windows-F6 
Decrease the Main Volume: Shift-Windows-F6 
Increase the Sub Voice rate: Windows-F7 
Decrease the Sub Voice Rate: Shift-Windows-F7 
 
One-handed mode on/off: Fn-h 
Bluetooth on/off: F9 
Wireless LAN on/off: F11 
Ethernet port on/off: Fn-F11 
 
Scroll voice on/off: Fn-F5 
Select language: Windows-Alt-v 
Select Braille code: Windows-Alt-b 
Select Braille cursor type: Fn-F3 
Select announcement of control information: Fn-F1 
Eight dot mode on/off: Fn-F4 
Open txt help: Win key-F1 while running program 
Edit language attribute: Windows-Alt-I 
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16.2 Quick Launch Commands 
 
Use the following commands to launch their associated applications from 
anywhere on the Voice Sense. 
 
Use the Windows key in combination with each letter to launch the 
following applications: 
Address Manager: A.  
Web Browser: B. 
sense Chat: C. 
DAISY Player: D. 
Email: E. 
File Manager: F. 
Google Talk: G. 
Help: H. 
Twitter: I. 
BookShare Download: K. 
Media Player: M.  
RSS reader : N.  
DropBox: O. 
google Maps: P.  
Quick Browser: Q. 
FM Radio: R. 
Schedule Manager: S. 
Database Manager: T. 
Google search: U.  
Sense Navigation: V. 
Word Processor: W. 
 
Use Caps Lock in combination with each letter to launch the applications 
below: 
Wake up alarm: A. 
Bluetooth Manager: B. 
Calculator: C. 
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Sense Dice game: D. 
Format: F. 
Sense Brain Game: G. 
Setup Internet: I. 
Backup/Restore Personalized Settings: K. 
Calendar: L. 
Menu manager: M. 
Pronunciation Dictionary: P. 
Terminal for Screen Reader: S. 
Set Time & Date: T. 
Upgrade BrailleSense: U. 
Stopwatch: W. 
 
Other Quick Commands: 
Display Time and Date: Fn-T. 
Display Network Status: Fn-N. 
Display Power Status: FN-B. 
Display Compass heading: Fn-Space. 
Change device Name: Control-Win-E. 
Open sleep Timer: Fn-J. 
Open Global options: F10. 
Open Sense Dictionary: Control-Windows-D. 
 
 
16.3 File Manager 
 
16.3.1 Navigation keys for the file list and menu list 
 
Move to previous item: Up arrow or up scroll button 
Move to next item: Down arrow or down scroll button 
Move to the beginning of the list: Ctrl-Home 
Move to the end of the list: Ctrl-End 
 
16.3.2 Navigation Keys for the File List 
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Jump to folder list or file list: Ctrl-Down arrow 
Move between file list and address window: Tab / shift-tab 
Enter selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Jump to the top level of the disk: Shift-Backspace 
 
16.3.3 Keys for Selecting Files and Folders 
 
Select individual item: Space 
Continuous selection: Ctrl-b 
Select all Ctrl-a 
 
16.3.4 Hot Keys for Menu Commands 
 
Open: Ctrl-o  
Open with: Ctrl-h  
Zip: Ctrl-z  
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f  
File conversion: Ctrl-t 
Select all: Ctrl-a  
Sort files by: Ctrl-g 
Set file info: Ctrl-l 
Display only files of type: Ctrl-w  
Search for file: Ctrl-f  
Information: Alt-Enter 
Share Folder on Network: Alt-S 
Unshare Folder on Network: Alt-U 
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Local Security Setting: Alt-P 
Setup Network connection: Alt-e 
Cancel setting of Network connection: Alt-F4 
Share a folder on network: Alt-s 
Remove remote folder on network: Alt-u 
Setup sharing security: Alt-p 
 
16.3.5 EML Viewer 
	  

Open e-mail message: Enter 
Forward: Control-f 
Reply: Control-r 
Close and return to file list: Alt-F4 
 
16.4 Word Processor 
 
16.4.1 Hot Keys for Menu Commands 
 
File Menu Commands: 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Document Settings: Ctrl-e  
Exit: Alt-F4 
 
Word Display View Commands: 
Toggle Word View Display On/off: Control-alt-M 
Read current line on Visual Screen: Alt-Function-S 
Move to First line on Visual Screen: Alt-Home 
Move to Last line on Visual Screen: Alt-End 
Move to Previous line on Visual Screen: Alt-Up arrow 
Move to Next line on Visual Screen: Alt-Down arrow 
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Move cursor to First line of Visual Screen: Alt-Page Up Alt-FN-Up arrow 
Set Highlight color of Current line on Visual Screen: Alt-U 
 
Commands for reading Powerpoint files: 
Move back one slide: Backspace. 
Move forward one slide: Space. 
Bring up slide list: Alt-Shift-S. 
 
Edit Menu Commands: 
 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del or Ctrl-d 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Insert Time: Alt-w 
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
Edit language attribute: Alt-Windows-i 
Set Font: Alt-M 
Toggle Nemeth code on/off: Alt-N. 

 
Go To Commands: 
Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
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Go to previous page: Page up (Fn-Up arrow) 
Go to next page: Page down (Fn-Down arrow) 
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
Read Commands: 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons 
Read status: Fn-/ 
Read selected text in current language: Alt-Windows-r 
 
Layout Commands 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
16.4.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow 
Move to next character: Right arrow 
Move to previous word: Ctrl-Left arrow 
Move to next word: Ctrl-Right arrow 
Move to the beginning of the line: Home 
Move to the end of the line: End 
Move to previous line: Up arrow 
Move to next line: Down arrow 
Move to previous paragraph: Ctrl-Up arrow  
Move to next paragraph: Ctrl-Down arrow 
Move to the beginning of the document: Ctrl-Home 
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Move to the end of the document: Ctrl-End 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
 
16.5 E-mail 
 
16.5.1 Hot keys that are used in the inbox 
 
Open “Accounts manager”: Ctrl-m  
Switch from offline to online mode (IMAP: alt-l 
Check for new mail: Alt-m 
Check for previous mail (IMAP): Alt-e 
Move ot previous account category: Alt-FN-Up arrow 
Move to next account category: Alt-FN-Down arrow 
Move ot previous mailbox: Control-FN-Up arrow 
Move to next mailbox: Control-FN-Down arrow 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Open “set path”: Ctrl-p 
Open “set option”: Ctrl-o 
Open “set spam”: Ctrl-e 
Find: Ctrl-f 
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Find again: F3 
Move to unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” item 
of the “inbox”). 
Delete received e-mail: Del (It is valid only at the “Subject” and “date” item 
in the “inbox”). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
16.5.2 Hot keys for Sending E-Mail Including Reply, Forward, and 
Save in the Mail Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail storage box: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
16.5.3 Hot Keys for Reading E-Mails or Writing an E-Mail Message 

 
Start selection: Ctrl-b 
Select all: Ctrl-a  
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 
“inbox”). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail 
in the “inbox”). 
Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 
Cancel block: ESC 
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16.6 Media 
 
16.6.1 Media Player 

 
16.6.1.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 

Get Tag information: Control-T 
 

Play: Enter, Play button 
Previous track: Alt-Left arrow, Previous button 
Next track: Alt-Right arrow, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow)  
Back 5 track: Alt-Up arrow 
Forward 5 track: Alt-Down arrow 
First track: Ctrl-Home 
Last track: Ctrl-End 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow  
Speed up: Shift-Right arrow 
Slow down: Shift-Left arrow 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow or Ctrl-Down arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
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Delete play list during stop: Del 
 
Open the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 
 
Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
 
16.6.1.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow 
Move to the previous information: Up arrow 
“Pause” when it is play state and “play” when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-right arrow 
Play the previous file: Alt-Left arrow 
Play the last file: Ctrl-Home 
Play the first file: Ctrl-End 



529 
 

Play the fifth file after the current file: Alt-Down arrow 
Play the fifth file before the current file: Alt-Up arrow 
Volume up: Shift-Up arrow 
Volume down: Shift-Right arrow 
Speed up: Shift-Left arrow 
Slow down: Shift-Right arrow  
Change time index: Ctrl-Up arrow or Ctrl-Down arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
Open menu: Alt 
Open help: F1 
Move to “play list” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
16.6.1.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow 
Move to the previous file: Up arrow 
Move to the last file: End  
Move to the first file: Home 
Select/resume current file (while playing, it is used as play/pause): Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: Del 
Play the next file: Alt-Right arrow 
Play the previous file: Alt-Left arrow  
Play the last file: Ctrl-End 
Play the first file: Ctrl-Home 
Play the fifth file after the current file: Ctrl-Down arrow 
Play the fifth file before the current file: Ctrl-Up arrow 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow 
Speed up: Shift-Left arrow 
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Slow down: Shift-Right arrow 
Change time index: Ctrl-Up arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
Open menu: Alt 
Open help: F1 
Move to “playback information” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
16.6.2 FM radio 

 
Open the sets dialog box: Ctrl-e 
Open the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow 
Move to previous frequency: Ctrl-Down arrow 
Auto previous frequency: Ctrl-Left arrow or short press previous button 
Auto next frequency: Ctrl-Right arrow or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow or long press previous button 
Move to next preset: Alt-Right arrow or long press next button 
Registry preset: Ctrl-s or long press record button 
Delete the preset: Delete or long press stop button 
Open the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
Muto off: short press play button or Space 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow 
 
16.6.3 Daisy Player 

 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
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Voice setting: Ctrl-s 
Check the book-info: Alt-Enter 
Exit: Alt-F4 
Play/Pause: Space 
Move to the beginning of document: Home 
Move to the last phrase: End 
Increase the speed: Shift-Right arrow 
Decrease the speed: Shift-Left arrow 
Increase the volume: Shift-Up arrow 
Decrease the volume: Shift-Down arrow 
Move to the next phrase: Ctrl-Right arrow or short press “next” button 
Move to the previous phrase:Ctrl-Left arrow or short press “previous” button 
Move to the next fifth phrase: Ctrl-Down arrow 
Move to the previous fifth phrase: Ctrl-Up arrow 
Move to the next page: Page down (Fn-Up arrow) 
Move to the previous page: Page up (Fn-Down arrow) 
Go to the page: Ctrl-g 
Move up: Alt-Left arrow 
Move down: Alt-Right arrow 
Set to prior level: Alt-Up arrow 
Set to next level: Alt-Down arrow 
Move to the next heading: Ctrl-F6 or long press “next” button 
Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
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16.7 Organizer 
 
16.7.1 Address Manager 

 
16.7.1.1 Move keys for adding an address or in the menu 
 
Move to the previous field or menu item: Left arrow 
Move to the next field or menu item: Right arrow 
Move to the first field or menu item: Home 
Move to the last field or menu item: End 
 
16.7.1.2 Move Keys in the Search Result List 
 
Move to the previous field: Ctrl-Left arrow 
Move to the next field: Ctrl-Right arrow 
Move to the first field: Home 
Move to the last field: End ey 
Move to the previous record: Up arrow 
Move to the next record: Down arrow 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 
 
16.7.1.3 Hot keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
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Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Setting backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o 
 
16.7.1.4 Miscellaneous Hot Keys 
 
Cancel: ESC  
Exit: Alt-F4 
 
16.7.2 Schedule Manager 

 
16.7.2.1 Hot keys for the commands 
 
Move to the next field: Tab  
Move to the previous field: Shift-tab  
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Delete all Schedule: Control-Alt-q 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 
 
16.7.2.2 Move Keys in the Search Result List 
 
1. Move from an appointment to another in the schedule list 
Move to the previous a in the same day: Up arrow 
Move to the next appointment in the same day: Down arrow 
Move to the first appointment in the same day: Home 
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Move to the last appointment in the same day: End 
2. Move from one appointment to another in all the appointments 

registered 
Move to the previous schedule: Ctrl-Left arrow 
Move to the next schedule: Ctrl-Right arrow 
Move to the first schedule: Ctrl-Home 
Move to the last schedule: Ctrl-End 
 
16.7.3 Database Manager 

 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow or down scroll button 
Move to the previous list item: Up arrow or up scroll button 

3. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow 
Move to the previous answer: Backspace or Up arrow 

4. Move in the “list of records found” 
Move to the next record: Down arrow or down scroll button 
Move to the previous record: Up arrow or up scroll button 
Move to the last record: Ctrl-End 
Move to the first record: Ctrl-Home 
Move to the next field: Ctrl-Right arrow 
Move to the previous field: Ctrl-Left arrow 
Move to the last field: End  
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Move to the first field: Home 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 

 
 
16.8 Web tools 
 
16.8.1 Web Browser 

 
16.8.1.1 Hot keys for Menu command 
	  

Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button 
 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow 
Go to the next page: Alt-Right arrow 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
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Go to previous visited link: Alt-Shift-v 
Go to next visited link: Alt-v 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
RSS Feed List: Control-J 
 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
 
16.8.1.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow 
Turn down the volume: Shift-Down arrow 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
16.8.1.3 Hot Keys for Reading Web Pages 
 
Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow 
Select the previous item in the combo box (list box): Alt-Up arrow 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
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Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow 
Move to the next cell: Ctrl-Shift-Right arrow 
Move to the upper cell: Ctrl-Shift-Up arrow 
Move to the lower cell: Ctrl-Shift-Down arrow 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow 
Move to the next cell of the upper level table: Ctrl-Right arrow 
Move to the upper cell of the upper level table: Ctrl-Up arrow 
Move to the lower cell of the upper level table: Ctrl-Down arrow 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 
16.8.2 Quick browser 

File Menu Commands: 
Open URL: Control-u 1-3-6) 
Exit: Alt-F 4 
Read Menu Commands: 
Read from beginning to cursor: Alt-G 
Read from cursor to end: FN-Enter 
 
Edit Menu Commands: 
Open Select Text Window: Control-S 
Start selection: Control-B 
Copy: Contol-C 
Add to clipboard: Control-P 
 
Go To Menu Commands: 
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Go to home page: Alt-H 
Go to the previous page: Alt-Left arrow 
Go to the next page: Alt-Right arrow 
Go to previous heading: Control-F3 
Go to next heading: Control-F 4 
Go to previous text: Control-"F5 
Go to next text: Control-F6 
Refresh: Control-R 
Open the history list: Control-H 
Find: Control-F 
Find again: F3 
 
Favorites Menu Commands: 
Set current as your home page: Alt-S 
Add to favorites: Alt-A 
Favorites list: Control-T 
 
Page Navigation Commands: 
Move between controls 
Move to the previous control: Control-Left arrow 
Move to the next control: Control-Right arrow 
Select the next item in the combo box (list box): Alt-Down arrow 
Select the previous item in the combo box (list box): Alt-Up arrow 
Moving to form fields 
Move to the previous form field: Control-F1 
Move to the next form field: Control-F2 
 
16.8.3 Google Search  
	  
Move to the next control: Tab  
Move to previous control: Shift-Tab 
Choose category or search result: Up or Down Arrow  
Open search result in Browser: Enter 
Exit Google Search: Alt-F4 
 



539 
 

16.8.4 RSS reader 
Receive new Headlines: Control-R 
Import OPML: Control-O 
Export OPML: Control-S 
Download Podcast: Control-D 
Read whole Description: Control-L 
Options: Alt-O 
 
From Category List: 
Insert Category: Control-I 
Delete Category: Delete 
Modify Category: Control-M 
 
From Feed List: 
Search for Feeds: Control-N 
Insert Feed: Control-i 
Delete Feed: Delete 
Modify Feed: Control-M 
Move Feed: Alt-V 
	  

	  

16.9 Social Networking 
 
16.9.1 Twitter 
 
 

Sign Out: Ctrl-g 
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s 
Home Timeline: Ctrl-h  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u 
Mention Timeline: Ctrl-m  
Retweet Of Me: Alt-o  
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List Timeline: Alt-P 
Favorite Timeline: Control-L 
Tweet: Ctrl-t  
Remove Tweet: Delete 
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w 
Find Tweets from the Current Timeline: Control-Alt-F 
Find Again Tweets from Current Timeline: Alt-Shift-F 
List Manager: Control-P 
Add User to List: Control-K 
List User View: Control-J 
List View in Current Tweet: F3 
Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-F4 
Escape: Esc key 
 
Move to the next tweet: Down arrow   
Move to the previous tweet: Up arrow 
Move to the first tweet on the refreshing list: Ctrl-Home 
Move to the last tweet on the refreshing list: Ctrl-End 
Move to the previous 32 list: Fn-Un arrow  
Move to the next 32 list: Fn-Down arrow  
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Move to the previous list: Up arrow 
Move to the next list: Down arrow 
Move to the top of the list: Ctrl-Home/Home 
Move to the bottom the list: Ctrl-End/End 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 

 
16.9.2 Google talk 
 

File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Send File: Alt-f  
Move to Recently Chat: Ctrl-t  
Manage Chat: Ctrl-m  
 
Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
 
Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
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Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
The move keys in Google Talk. 
Move to the previous Contents: Up arrow  
Move to the next Contents: Down arrow 
Move to the previous 32-items of the Contents: Fn-Up arrow 
Move to the next 32-item of the Contents: Fn-Down arrow 
Move to the first item of the Contents: Ctrl-Home 
Move to the last item of the Contents: Ctrl-End 
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16.9.3 Sense Chat 

Chat Window Commands: 
Move among the controls: Tab and Shift-Tab 
Send message: type message and press Enter 
Move among messages in history: Up and Down arrows 
Move to top of list: Control-Home 
Move to bottom of message list: Control-end 
Save conversation: Control-s 
Save conversation under different name: Alt-s 
Start selection: Control-b 
Select all: Control-a 
Copy: Control-c 
Paste: Control-v 
Exit Sense Chat: Alt-F4 
 
Sense Chat Options commands: 
Move among the Controls: Tab and shift-Tab 
Move among items in the settings list: Up and down arrows 
Change the value of a setting: Space 
Save settings: Enter 
Cancel saving settings: Escape or Alt-F4 

 
16.10 Extras 
 
16.10.1 BookShare Download 

Move to next control: Tab 
Move to previous control: Shift-Tab 
Move to Search box: Control-e 
Move to search results: Control-l 
Open download dialog: Control-d 
Open Options dialog: Control-o 
Exit: Alt-F4 
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16.10.2 Google Maps 
Search commands: 
Search for address: Control-f 
Advanced POI Search: Alt-f 
Set as Start Position: Alt-s 
Set as Destination: Alt-d 
Set as Waypoint: Alt-w 
Add to user POI: Alt-u 
Area selection: Alt-z 
 
Set Position Commands: 
Add current position to user POI: Enter 
Set GPS position as Start position: s 
Current position information: Control-i 
 
User POI Commands: 
Manage user POI’s: Control-u 
Save user POI’s: Alt-s 
Load user POI’s: Control-l 
 
Route Commands: 
Create route: Control-r 
View traveled route: Control-h 
Initialize route: Alt-i 
Route information: Control-c 
Direction and distance to destination: Control-d 
 
Options Commands: 
Notice and distance to destination: Control-o 
GPS settings: Control-g 

	  

16.10.3 Drop box 
Open User Information dialog box: Control-I 
Search for File: Control-F 
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File Download: Control-T 
File Upload: Control-U 
File Link: Control-L 
Copy: Control-C 
Cut to Clipboard: Control-X 
Paste: Control-V 
Delete: Delete 
New Folder: Control-N 
Set Login Information: Alt-I 
 
16.11 Games  
	  

16.11.1 Sense Dice Game 
Execute Dice Game: I 
Move to next item: Down arrow 
Move to previous item: Up arrow 
Move to the first item: Control-Home 
Move to the last item: Control-End 
Roll dice: Enter 
Exit: Alt-F4 
 
16.11.2 Sense Brain Game 
Execute Sense Brain game:  A  
Move to next item: Down Arrow 
Move to previous item: Up arrow 
Move to the first item: Control-Home 
Move to the last item: Control-End 
Execute game: Enter 
Exit: Alt-F4 
 
 
16.12 Utilities 
 
16.12.1 Calculator 
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Calculator initialize: Alt-c 
Delete numbers or operators: Backspace 
 
General functions: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Over : FN-/ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s  
 
Trigonometric Function: Ctrl-s  
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h  
 
Logarithm Function: Ctrl-l  
Natural Logarithm: Ctrl-l, e  
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Common Logarithm: Ctrl-l, n  
 
Miscellaneous: 
Convert Unit: Control-U 
Copy to Clipboard: Ctrl-Insert 
Return formula: Control-r 
Fraction options: Control-/ 
Option Settings: Ctrl-o  
Change Braille code: Fn-g 
 
16.12.2 Checking Date and Time 
 
Checking date and time: Fn-t 
 
16.12.3 Calendar 
 
Move to the previous item: Tab  
Move to the next item: Shift-tab  
 
Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Up arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
 
 
16.12.4 Stopwatch 
 
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Stop Braille display: Fn-Space 
Restart Braille display: Fn-Space 
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Switch between stopwatch and Countdown timer: “Tab” or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
16.12.5 Display network status 
 
Display network status: Fn-n 
 
16.12.6 Terminal for Screen reader 
Enter terminal Clipboard: Control-Function-I. 

Send Terminal Clipboard content: Control-S. 

Exit terminal for Screen reader: Alt-X. 

16.12.7 Display power status 
 
Display power status: Fn-b 
 
 
16.12.8 Format 
 
Disk format: Fn-f 
 
16.12.9 Sleep Timer 
 
Set Sleep Timer: Fn-j 
 
16.12.10 Upgrading the Voice Sense Firmware 
 
Check download information: Space 
Cancel download and exit: Alt-F4 
	  

16.13 Settings 
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16.13.1 Setting time and date 
	  

Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Left arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
Move to 1 hour after: Down arrow 
Move to 1 hour before: Up arrow 
Move to 10 minutes after: Ctrl-Right arrow 
Move to 10 minutes before: Ctrl-Left arrow 
Move to 1 minute after: Right arrow 
Move to 1 minute before: Left arrow 
Switch Between a.m. and p.m.: Fn-x 
 
16.13.2 Bluetooth Manager 
 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
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Delete file/folder: Del 
Information: Ctrl-i 
 
16.13.3 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow 
Move to the next item in entry: Down arrow 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
	  

16.13.4 Backup/Restore personalized settings 
 
Move to previous item: Up arrow or up scroll button 
Move to next item: Down arrow or down scroll button 
Move to previous control: Shift-tab  
Move to next control: Tab  
Select/unselect check box: Space 
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17. Command Summary for USB Keyboards 
 
17.1 Common Combination Keys 
 
 
Open the program menu: Win key 
Key help mode: Ctrl-ESC 
Run specific program: Win key-”shortcut key” (varies for each program) 
Open the Task Name list: Fn-F10 
Switch to previous program: Alt-Shift-tab 
Switch to next program: Alt-Tab 
Open program specific menu: Alt 
Exit: Alt-F4 
Escape: Esc 
Move to the next control in a dialog box: Tab 
Move to the previous control in a dialog box: Shift-tab 
Move to the previous character: Left arrow 
Move to the next character: Right arrow 
Move to the previous line/item: Up arrow 
Move to the next line/item: Down arrow 
Move to the beginning of line/item: Home 
Move to the end of line/item: End 
Move to the top of a document or to the first item: Ctrl-Home 
Move to the bottom of a document or to the last item: Ctrl-End 
Move to the previous page or to the first item of the previous 32-item group: 
Page up (Fn-Up arrow) 
Move to the next page or to the first item of the next 32-item group: Page 
down (Fn-Down arrow) 
Scroll left: Up scroll button 
Scroll right: Down scroll button 
Move the cursor to specific cell or move to an item: The corresponding 
cursor routing key 
Capital sign: Caps lock 
Read the current item again: Fn-r 
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Say current time: Fn-t  
Display power status: Fn-b 
Open the “global options”: F10 
Online help: F1 
Check software version: Fn-v only in the Voice Sense “program” menu. 
Display network status: fn-n in the Voice Sense “program” menu 
 
Braille display on/off: F4 
Voice on/off: F5 
Increase the voice volume: F6 
Decrease the voice volume: Shift-F6 
Increase the voice rate: F7 
Decrease the voice rate: Shift-F7 
Increase the voice pitch: F8 
Decrease the voice pitch: Shift-F8 
Increase the Main Volume: Windows-F6 
Decrease the Main Volume: Shift-Windows-F6 
Increase the Sub Voice rate: Windows-F7 
Decrease the Sub Voice Rate: Shift-Windows-F7 
 
One-handed mode on/off: Fn-h 
Bluetooth on/off: F9 
Wireless LAN on/off: F11 
Ethernet port on/off: Fn-F11 
 
Scroll voice on/off: Fn-F5 
Select language: Windows-Alt-v 
Select Braille code: Windows-Alt-b 
Select Braille cursor type: Fn-F3 
Select announcement of control information: Fn-F1 
Eight dot mode on/off: Fn-F4 
Open txt help: Win key-F1 while running program 
Edit language attribute: Windows-Alt-I 
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17.2 Quick Launch Commands 
 
Use the following commands to launch their associated applications from 
anywhere on the Voice Sense. 
 
Use the Windows key in combination with each letter to launch the 
following applications: 
Address Manager: A.  
Web Browser: B. 
sense Chat: C. 
DAISY Player: D. 
Email: E. 
File Manager: F. 
Google Talk: G. 
Help: H. 
Twitter: I. 
BookShare Download: K. 
Media Player: M.  
RSS reader : N.  
DropBox: O. 
google Maps: P.  
Quick Browser: Q. 
FM Radio: R. 
Schedule Manager: S. 
Database Manager: T. 
Google search: U.  
Sense Navigation: V. 
Word Processor: W. 
 
Use Caps Lock in combination with each letter to launch the applications 
below: 
Wake up alarm: A. 
Bluetooth Manager: B. 
Calculator: C. 
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Sense Dice game: D. 
Format: F. 
Sense Brain Game: G. 
Setup Internet: I. 
Backup/Restore Personalized Settings: K. 
Calendar: L. 
Menu manager: M. 
Pronunciation Dictionary: P. 
Terminal for Screen Reader: S. 
Set Time & Date: T. 
Upgrade BrailleSense: U. 
Stopwatch: W. 
 
Other Quick Commands: 
Display Time and Date: Fn-T. 
Display Network Status: Fn-N. 
Display Power Status: FN-B. 
Display Compass heading: Fn-Space. 
Change device Name: Control-Win-E. 
Open sleep Timer: Fn-J. 
Open Global options: F10. 
Open Sense Dictionary: Control-Windows-D. 
 
 
17.3 File Manager 
 
17.3.1 Navigation keys for the file list and menu list 
 
Move to previous item: Up arrow or up scroll button 
Move to next item: Down arrow or down scroll button 
Move to the beginning of the list: Ctrl-Home 
Move to the end of the list: Ctrl-End 
 
17.3.2 Navigation Keys for the File List 
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Jump to folder list or file list: Ctrl-Down arrow 
Move between file list and address window: Tab / shift-tab 
Enter selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Jump to the top level of the disk: Shift-Backspace 
 
17.3.3 Keys for Selecting Files and Folders 
 
Select individual item: Space 
Continuous selection: Ctrl-b 
Select all Ctrl-a 
 
17.3.4 Hot Keys for Menu Commands 
 
Open: Ctrl-o  
Open with: Ctrl-h  
Zip: Ctrl-z  
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f  
File conversion: Ctrl-t 
Select all: Ctrl-a  
Sort files by: Ctrl-g 
Set file info: Ctrl-l 
Display only files of type: Ctrl-w  
Search for file: Ctrl-f  
Information: Alt-Enter 
Share Folder on Network: Alt-S 
Unshare Folder on Network: Alt-U 
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Local Security Setting: Alt-P 
Setup Network connection: Alt-e 
Cancel setting of Network connection: Alt-F4 
Share a folder on network: Alt-s 
Remove remote folder on network: Alt-u 
Setup sharing security: Alt-p 
 
17.3.5 EML Viewer 
	  

Open e-mail message: Enter 
Forward: Control-f 
Reply: Control-r 
Close and return to file list: Alt-F4 
 
17.4 Word Processor 
 
17.4.1 Hot Keys for Menu Commands 
 
File Menu Commands: 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Document Settings: Ctrl-e  
Exit: Alt-F4 
 
Word Display View Commands: 
Toggle Word View Display On/off: Control-alt-M 
Read current line on Visual Screen: Alt-Function-S 
Move to First line on Visual Screen: Alt-Home 
Move to Last line on Visual Screen: Alt-End 
Move to Previous line on Visual Screen: Alt-Up arrow 
Move to Next line on Visual Screen: Alt-Down arrow 
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Move cursor to First line of Visual Screen: Alt-Page Up Alt-FN-Up arrow 
Set Highlight color of Current line on Visual Screen: Alt-U 
 
Commands for reading Powerpoint files: 
Move back one slide: Backspace. 
Move forward one slide: Space. 
Bring up slide list: Alt-Shift-S. 
 
Edit Menu Commands: 
 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del or Ctrl-d 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Insert Time: Alt-w 
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
Edit language attribute: Alt-Windows-i 
Set Font: Alt-M 
Toggle Nemeth code on/off: Alt-N. 

 
Go To Commands: 
Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
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Go to previous page: Page up (Fn-Up arrow) 
Go to next page: Page down (Fn-Down arrow) 
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
Read Commands: 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons 
Read status: Fn-/ 
Read selected text in current language: Alt-Windows-r 
 
Layout Commands 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
17.4.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow 
Move to next character: Right arrow 
Move to previous word: Ctrl-Left arrow 
Move to next word: Ctrl-Right arrow 
Move to the beginning of the line: Home 
Move to the end of the line: End 
Move to previous line: Up arrow 
Move to next line: Down arrow 
Move to previous paragraph: Ctrl-Up arrow  
Move to next paragraph: Ctrl-Down arrow 
Move to the beginning of the document: Ctrl-Home 
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Move to the end of the document: Ctrl-End 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
 
17.5 E-mail 
 
17.5.1 Hot keys that are used in the inbox 
 
Open “Accounts manager”: Ctrl-m  
Switch from offline to online mode (IMAP: alt-l 
Check for new mail: Alt-m 
Check for previous mail (IMAP): Alt-e 
Move ot previous account category: Alt-FN-Up arrow 
Move to next account category: Alt-FN-Down arrow 
Move ot previous mailbox: Control-FN-Up arrow 
Move to next mailbox: Control-FN-Down arrow 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Open “set path”: Ctrl-p 
Open “set option”: Ctrl-o 
Open “set spam”: Ctrl-e 
Find: Ctrl-f 
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Find again: F3 
Move to unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” item 
of the “inbox”). 
Delete received e-mail: Del (It is valid only at the “Subject” and “date” item 
in the “inbox”). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
17.5.2 Hot keys for Sending E-Mail Including Reply, Forward, and 
Save in the Mail Outbox 

 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail storage box: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
17.5.3 Hot Keys for Reading E-Mails or Writing an E-Mail Message 

 
Start selection: Ctrl-b 
Select all: Ctrl-a  
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 
“inbox”). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail 
in the “inbox”). 
Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 
Cancel block: ESC 
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17.6 Media 
 
17.6.1 Media Player 

 
17.6.1.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 
Get Tag information: Control-T 

 
Play: Enter, Play button 
Previous track: Alt-Left arrow, Previous button 
Next track: Alt-Right arrow, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow)  
Back 5 track: Alt-Up arrow 
Forward 5 track: Alt-Down arrow 
First track: Ctrl-Home 
Last track: Ctrl-End 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow  
Speed up: Shift-Right arrow 
Slow down: Shift-Left arrow 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow or Ctrl-Down arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
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Delete play list during stop: Del 
 
Open the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 
 
Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
 
17.6.1.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow 
Move to the previous information: Up arrow 
“Pause” when it is play state and “play” when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-right arrow 
Play the previous file: Alt-Left arrow 
Play the last file: Ctrl-Home 
Play the first file: Ctrl-End 
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Play the fifth file after the current file: Alt-Down arrow 
Play the fifth file before the current file: Alt-Up arrow 
Volume up: Shift-Up arrow 
Volume down: Shift-Right arrow 
Speed up: Shift-Left arrow 
Slow down: Shift-Right arrow  
Change time index: Ctrl-Up arrow or Ctrl-Down arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
Open menu: Alt 
Open help: F1 
Move to “play list” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
17.6.1.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow 
Move to the previous file: Up arrow 
Move to the last file: End  
Move to the first file: Home 
Select/resume current file (while playing, it is used as play/pause): Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: Del 
Play the next file: Alt-Right arrow 
Play the previous file: Alt-Left arrow  
Play the last file: Ctrl-End 
Play the first file: Ctrl-Home 
Play the fifth file after the current file: Ctrl-Down arrow 
Play the fifth file before the current file: Ctrl-Up arrow 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow 
Speed up: Shift-Left arrow 



564 
 

Slow down: Shift-Right arrow 
Change time index: Ctrl-Up arrow 
Move to next position by time index and play: Ctrl-Right arrow 
Move to previous position by time index and play: Ctrl-Left arrow 
Open menu: Alt 
Open help: F1 
Move to “playback information” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
17.6.2 FM radio 

 
Open the sets dialog box: Ctrl-e 
Open the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow 
Move to previous frequency: Ctrl-Down arrow 
Auto previous frequency: Ctrl-Left arrow or short press previous button 
Auto next frequency: Ctrl-Right arrow or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow or long press previous button 
Move to next preset: Alt-Right arrow or long press next button 
Registry preset: Ctrl-s or long press record button 
Delete the preset: Delete or long press stop button 
Open the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
Muto off: short press play button or Space 
Volume up: Shift-Up arrow 
Volume down: Shift-Down arrow 
 
17.6.3 Daisy Player 

 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
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Voice setting: Ctrl-s 
Check the book-info: Alt-Enter 
Exit: Alt-F4 
Play/Pause: Space 
Move to the beginning of document: Home 
Move to the last phrase: End 
Increase the speed: Shift-Right arrow 
Decrease the speed: Shift-Left arrow 
Increase the volume: Shift-Up arrow 
Decrease the volume: Shift-Down arrow 
Move to the next phrase: Ctrl-Right arrow or short press “next” button 
Move to the previous phrase:Ctrl-Left arrow or short press “previous” button 
Move to the next fifth phrase: Ctrl-Down arrow 
Move to the previous fifth phrase: Ctrl-Up arrow 
Move to the next page: Page down (Fn-Up arrow) 
Move to the previous page: Page up (Fn-Down arrow) 
Go to the page: Ctrl-g 
Move up: Alt-Left arrow 
Move down: Alt-Right arrow 
Set to prior level: Alt-Up arrow 
Set to next level: Alt-Down arrow 
Move to the next heading: Ctrl-F6 or long press “next” button 
Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
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17.7 Organizer 
 
17.7.1 Address Manager 

 
17.7.1.1 Move keys for adding an address or in the menu 
 
Move to the previous field or menu item: Left arrow 
Move to the next field or menu item: Right arrow 
Move to the first field or menu item: Home 
Move to the last field or menu item: End 
 
17.7.1.2 Move Keys in the Search Result List 
 
Move to the previous field: Ctrl-Left arrow 
Move to the next field: Ctrl-Right arrow 
Move to the first field: Home 
Move to the last field: End ey 
Move to the previous record: Up arrow 
Move to the next record: Down arrow 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 
 
17.7.1.3 Hot keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
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Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Setting backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o 
 
17.7.1.4 Miscellaneous Hot Keys 
 
Cancel: ESC  
Exit: Alt-F4 
 
17.7.2 Schedule Manager 

 
17.7.2.1 Hot keys for the commands 
 
Move to the next field: Tab  
Move to the previous field: Shift-tab  
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Delete all Schedule: Control-Alt-q 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 
 
17.7.2.2 Move Keys in the Search Result List 
 
3. Move from an appointment to another in the schedule list 
Move to the previous a in the same day: Up arrow 
Move to the next appointment in the same day: Down arrow 
Move to the first appointment in the same day: Home 
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Move to the last appointment in the same day: End 
4. Move from one appointment to another in all the appointments 

registered 
Move to the previous schedule: Ctrl-Left arrow 
Move to the next schedule: Ctrl-Right arrow 
Move to the first schedule: Ctrl-Home 
Move to the last schedule: Ctrl-End 
 
17.7.3 Database Manager 

 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 
5. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

6. Move in a list box 
Move to the next list item: Down arrow or down scroll button 
Move to the previous list item: Up arrow or up scroll button 

7. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow 
Move to the previous answer: Backspace or Up arrow 

8. Move in the “list of records found” 
Move to the next record: Down arrow or down scroll button 
Move to the previous record: Up arrow or up scroll button 
Move to the last record: Ctrl-End 
Move to the first record: Ctrl-Home 
Move to the next field: Ctrl-Right arrow 
Move to the previous field: Ctrl-Left arrow 
Move to the last field: End  
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Move to the first field: Home 
Move to previous same field different record: Left arrow 
Move to next same field different record: Right arrow 

 
 
17.8 Web tools 
 
17.8.1 Web Browser 

 
17.8.1.1 Hot keys for Menu command 
	  

Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button 
 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow 
Go to the next page: Alt-Right arrow 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
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Go to previous visited link: Alt-Shift-v 
Go to next visited link: Alt-v 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
RSS Feed List: Control-J 
 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
 
17.8.1.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow 
Turn down the volume: Shift-Down arrow 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
17.8.1.3 Hot Keys for Reading Web Pages 
 
Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow 
Select the previous item in the combo box (list box): Alt-Up arrow 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
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Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow 
Move to the next cell: Ctrl-Shift-Right arrow 
Move to the upper cell: Ctrl-Shift-Up arrow 
Move to the lower cell: Ctrl-Shift-Down arrow 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow 
Move to the next cell of the upper level table: Ctrl-Right arrow 
Move to the upper cell of the upper level table: Ctrl-Up arrow 
Move to the lower cell of the upper level table: Ctrl-Down arrow 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 
17.8.2 Quick browser 

File Menu Commands: 
Open URL: Control-u 1-3-6) 
Exit: Alt-F 4 
Read Menu Commands: 
Read from beginning to cursor: Alt-G 
Read from cursor to end: FN-Enter 
 
Edit Menu Commands: 
Open Select Text Window: Control-S 
Start selection: Control-B 
Copy: Contol-C 
Add to clipboard: Control-P 
 
Go To Menu Commands: 
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Go to home page: Alt-H 
Go to the previous page: Alt-Left arrow 
Go to the next page: Alt-Right arrow 
Go to previous heading: Control-F3 
Go to next heading: Control-F 4 
Go to previous text: Control-"F5 
Go to next text: Control-F6 
Refresh: Control-R 
Open the history list: Control-H 
Find: Control-F 
Find again: F3 
 
Favorites Menu Commands: 
Set current as your home page: Alt-S 
Add to favorites: Alt-A 
Favorites list: Control-T 
 
Page Navigation Commands: 
Move between controls 
Move to the previous control: Control-Left arrow 
Move to the next control: Control-Right arrow 
Select the next item in the combo box (list box): Alt-Down arrow 
Select the previous item in the combo box (list box): Alt-Up arrow 
Moving to form fields 
Move to the previous form field: Control-F1 
Move to the next form field: Control-F2 
 
17.8.3 Google Search  
	  
Move to the next control: Tab  
Move to previous control: Shift-Tab 
Choose category or search result: Up or Down Arrow  
Open search result in Browser: Enter 
Exit Google Search: Alt-F4 
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17.8.4 RSS reader 
Receive new Headlines: Control-R 
Import OPML: Control-O 
Export OPML: Control-S 
Download Podcast: Control-D 
Read whole Description: Control-L 
Options: Alt-O 
 
From Category List: 
Insert Category: Control-I 
Delete Category: Delete 
Modify Category: Control-M 
 
From Feed List: 
Search for Feeds: Control-N 
Insert Feed: Control-i 
Delete Feed: Delete 
Modify Feed: Control-M 
Move Feed: Alt-V 
	  

	  

17.9 Social Networking 
 
17.9.1 Twitter 
 
 

Sign Out: Ctrl-g 
Personal Information: Ctrl-I  
Save Current Timeline: Alt-s 
Home Timeline: Ctrl-h  
User Timeline: Ctrl-u  
Current User Timeline: Alt-u 
Mention Timeline: Ctrl-m  
Retweet Of Me: Alt-o  
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List Timeline: Alt-P 
Favorite Timeline: Control-L 
Tweet: Ctrl-t  
Remove Tweet: Delete 
Retweet: Ctrl-e  
Reply: Ctrl-y  
Add To Favorite: Ctrl-v  
Favorite List: Ctrl-l  
Send Direct Message: Ctrl-s  
Sent Direct Message: Alt-m  
Received Direct Message: Alt-r  
Follow User: Alt-a  
Following: Alt-l  
Followers: Alt-e  
Global Search: Ctrl-f  
User Search: Alt-f  
Search Word List: Alt-w 
Find Tweets from the Current Timeline: Control-Alt-F 
Find Again Tweets from Current Timeline: Alt-Shift-F 
List Manager: Control-P 
Add User to List: Control-K 
List User View: Control-J 
List View in Current Tweet: F3 
Next List: Ctrl-n  
Refresh: Ctrl-r  
Exit: Alt-F4 
Escape: Esc key 
 
Move to the next tweet: Down arrow   
Move to the previous tweet: Up arrow 
Move to the first tweet on the refreshing list: Ctrl-Home 
Move to the last tweet on the refreshing list: Ctrl-End 
Move to the previous 32 list: Fn-Un arrow  
Move to the next 32 list: Fn-Down arrow  
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Move to the previous list: Up arrow 
Move to the next list: Down arrow 
Move to the top of the list: Ctrl-Home/Home 
Move to the bottom the list: Ctrl-End/End 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 

 
17.9.2 Google talk 
 

File Menu Commands 
Sign out: Ctrl-l  
Export Contact Lists: Alt-x  
Import Contact Lists: Alt-i  
Exit: Alt-F4 
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Send File: Alt-f  
Move to Recently Chat: Ctrl-t  
Manage Chat: Ctrl-m  
 
Contact Menu Commands 
Add Contact: Alt-q  
Delete Contact: Delete 
Block Contact: Alt-b  
Manage Block List: Alt-m  
Contact Information: Ctrl-i  
Manage Contact List: Ctrl-p  
 
Option Menu Commands 
My Status Options: Alt-u  
Action Options: Alt-a  
Alert Options: Alt-o  
Path Options: Alt-p  
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Chat Window Menus 
 
File Menu Commands  
Save Conversation: Alt-s  
Close Chat: Alt-F4 
 
Edit Menu Commands 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Delete  
Paste: Ctrl-v  
Start Selection: Ctrl-b  
Select All: Ctrl-a  
Find: Ctrl-f  
Find Again: F3  
 
Action Menu Commands 
Start Chat: Ctrl-s  
Start Voice Chat: Ctrl-h  
Stop Voice Chat: Esc key 
Send File: Alt-f  
View Contact List: Ctrl-t  
Manage Chat: Ctrl-m 
Move to Previous Chat: Ctrl-Shift-Tab 
Move to Next Chat: Ctrl-Tab 
 
The move keys in Google Talk. 
Move to the previous Contents: Up arrow  
Move to the next Contents: Down arrow 
Move to the previous 32-items of the Contents: Fn-Up arrow 
Move to the next 32-item of the Contents: Fn-Down arrow 
Move to the first item of the Contents: Ctrl-Home 
Move to the last item of the Contents: Ctrl-End 
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17.9.3 Sense Chat 

Chat Window Commands: 
Move among the controls: Tab and Shift-Tab 
Send message: type message and press Enter 
Move among messages in history: Up and Down arrows 
Move to top of list: Control-Home 
Move to bottom of message list: Control-end 
Save conversation: Control-s 
Save conversation under different name: Alt-s 
Start selection: Control-b 
Select all: Control-a 
Copy: Control-c 
Paste: Control-v 
Exit Sense Chat: Alt-F4 
 
Sense Chat Options commands: 
Move among the Controls: Tab and shift-Tab 
Move among items in the settings list: Up and down arrows 
Change the value of a setting: Space 
Save settings: Enter 
Cancel saving settings: Escape or Alt-F4 

 
17.10 Extras 
 
17.10.1 BookShare Download 

Move to next control: Tab 
Move to previous control: Shift-Tab 
Move to Search box: Control-e 
Move to search results: Control-l 
Open download dialog: Control-d 
Open Options dialog: Control-o 
Exit: Alt-F4 
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17.10.2 Google Maps 
Search commands: 
Search for address: Control-f 
Advanced POI Search: Alt-f 
Set as Start Position: Alt-s 
Set as Destination: Alt-d 
Set as Waypoint: Alt-w 
Add to user POI: Alt-u 
Area selection: Alt-z 
 
Set Position Commands: 
Add current position to user POI: Enter 
Set GPS position as Start position: s 
Current position information: Control-i 
 
User POI Commands: 
Manage user POI’s: Control-u 
Save user POI’s: Alt-s 
Load user POI’s: Control-l 
 
Route Commands: 
Create route: Control-r 
View traveled route: Control-h 
Initialize route: Alt-i 
Route information: Control-c 
Direction and distance to destination: Control-d 
 
Options Commands: 
Notice and distance to destination: Control-o 
GPS settings: Control-g 

	  

17.10.3 Drop box 
Open User Information dialog box: Control-I 
Search for File: Control-F 
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File Download: Control-T 
File Upload: Control-U 
File Link: Control-L 
Copy: Control-C 
Cut to Clipboard: Control-X 
Paste: Control-V 
Delete: Delete 
New Folder: Control-N 
Set Login Information: Alt-I 
 
17.11 Games  
	  

17.11.1 Sense Dice Game 
Execute Dice Game: I 
Move to next item: Down arrow 
Move to previous item: Up arrow 
Move to the first item: Control-Home 
Move to the last item: Control-End 
Roll dice: Enter 
Exit: Alt-F4 
 
17.11.2 Sense Brain Game 
Execute Sense Brain game:  A  
Move to next item: Down Arrow 
Move to previous item: Up arrow 
Move to the first item: Control-Home 
Move to the last item: Control-End 
Execute game: Enter 
Exit: Alt-F4 
 
 
17.12 Utilities 
 
17.12.1 Calculator 
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Calculator initialize: Alt-c 
Delete numbers or operators: Backspace 
 
General functions: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Over : FN-/ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s  
 
Trigonometric Function: Ctrl-s  
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h  
 
Logarithm Function: Ctrl-l  
Natural Logarithm: Ctrl-l, e  
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Common Logarithm: Ctrl-l, n  
 
Miscellaneous: 
Convert Unit: Control-U 
Copy to Clipboard: Ctrl-Insert 
Return formula: Control-r 
Fraction options: Control-/ 
Option Settings: Ctrl-o  
Change Braille code: Fn-g 
 
17.12.2 Checking Date and Time 
 
Checking date and time: Fn-t 
 
17.12.3 Calendar 
 
Move to the previous item: Tab  
Move to the next item: Shift-tab  
 
Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Up arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
 
 
17.12.4 Stopwatch 
 
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Stop Braille display: Fn-Space 
Restart Braille display: Fn-Space 
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Switch between stopwatch and Countdown timer: “Tab” or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
17.12.5 Display network status 
 
Display network status: Fn-n 
 
17.12.6 Terminal for Screen reader 
Enter terminal Clipboard: Control-Function-I. 

Send Terminal Clipboard content: Control-S. 

Exit terminal for Screen reader: Alt-X. 

17.12.7 Display power status 
 
Display power status: Fn-b 
 
 
17.12.8 Format 
 
Disk format: Fn-f 
 
17.12.9 Sleep Timer 
 
Set Sleep Timer: Fn-j 
 
17.12.10 Upgrading the Voice Sense Firmware 
 
Check download information: Space 
Cancel download and exit: Alt-F4 
	  

17.13 Settings 
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17.13.1 Setting time and date 
	  

Move to the next day: Right arrow 
Move to the previous day: Left arrow 
Move to the next week: Ctrl-Right arrow 
Move to the previous week: Ctrl-Left arrow 
Move to the next month: Down arrow 
Move to the previous month: Left arrow 
Move to the next year: Ctrl-Down arrow 
Move to the previous year: Ctrl-Up arrow 
Move to 1 hour after: Down arrow 
Move to 1 hour before: Up arrow 
Move to 10 minutes after: Ctrl-Right arrow 
Move to 10 minutes before: Ctrl-Left arrow 
Move to 1 minute after: Right arrow 
Move to 1 minute before: Left arrow 
Switch Between a.m. and p.m.: Fn-x 
 
17.13.2 Bluetooth Manager 
 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 



584 
 

Delete file/folder: Del 
Information: Ctrl-i 
 
17.13.3 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow 
Move to the next item in entry: Down arrow 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
	  

17.13.4 Backup/Restore personalized settings 
 
Move to previous item: Up arrow or up scroll button 
Move to next item: Down arrow or down scroll button 
Move to previous control: Shift-tab  
Move to next control: Tab  
Select/unselect check box: Space 
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18. Troubleshooting Guide 
If you are encountering problems with the Voice Sense QWERTY, please 
take a look at the following suggestions for solving many common problems:  
 
18.1 The Voice Sense QWERTY Will Not Turn On 

 
1. Check to make sure that the battery is inserted in to its compartment 
properly. 
2. If the battery is inserted properly, connect the AC adapter, and plug the 
AC adapter in to an electrical outlet. The battery may need to be charged. 
3. Or, Check the location of the keyboard lock switch. If this switch is placed 
in the "lock" position, the power switch is not functional. 
 
18.2 The Voice Cannot Be Heard 

 
1. Make sure the volume is loud enough to be heard. Press "F6" to raise the 
volume. 
2. Make sure the voice is turned on. Press "F5" to toggle the voice on/off. 
 
18.3 The Voice is Too Fast to Understand 

 
1. Press "Shift-F7" to lower the voice rate. 
 
18.4 The Voice Pitch Is Too Low or Too High to 
Understand 

 
1. Press "Shift-F8" to lower the pitch, or press "F8 to raise the pitch of the 
voice. 
 
18.5 You Don't Know Where You Are 
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1. If you have become disoriented as to your location on the Voice Sense 
QWERTY, and cannot remember where you are, press “Windows” key to 
access the "program" menu. Then, press "Alt-Tab" to switch among the open 
programs. If you are in the Word Processor, pressing "Fn-s" gives you your 
current location in the open document. 
 
18.6 No Internet Connection 

 
1. If you are using a LAN connection, make sure that the Ethernet cable is 
connected and that the Ethernet port is turned on in "Global Options". 
2. If you are using a modem, make sure that the phone line is connected to 
the modem. 
3. If you are using a DSL connection, make sure that the Ethernet cable is 
connected and that the Ethernet port is turned on in "Global Options". 
4. If you are using a Wi-Fi connection, ensure wireless is turned on. Use 
"F11" to toggle wireless on/off.  
 
18.7 Email 

 
1. If you are having trouble downloading email, please contact your Internet 
service provider to make sure that you have the correct POP3/IMAP and 
SMTP settings. 
2. If you cannot send or receive mail, make sure you have an active 
connection to the Internet. 
 
18.8 The Braille display (When connected to 
SyncBraille) Does Not Display Braille 

 
1. If the Braille display (When connected to SyncBraille) does not display 
Braille, make sure that the Braille display (When connected to SyncBraille) is 
turned on. Use "F4" to toggle the Braille display (When connected to 
SyncBraille) on/off. 
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18.9 The Voice Sense QWERTY Does Not Respond 
 
1. If the Voice Sense QWERTY does not respond to keystrokes or 
commands, it may be necessary to reset the unit. To reset the Voice Sense 
QWERTY, press the reset button on the rear panel. Do NOT hold the reset 
button for more than 5 seconds. 
2. If pressing the "Reset" button does not revive the Voice Sense QWERTY, 
you may need to perform a hard reset. Press and hold the "Forward" button 
on the front media panel. (This button is the right-most button in the media 
group and looks like a right arrow.) While holding "Forward", quickly press 
and release the "Reset" button. Continue to hold the "Forward" button until 
the unit revives (this should occur within 30 to 45 seconds).  
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19. Accessories 
 
For information on available accessories for the Voice Sense QWERTY, 
please contact HIMS Inc. You can contact HIMS by e-mail at sales@hims-
inc.com. Or, contact the HIMS Sales department by phone at 888-520-4467. 
You can also visit HIMS on the web at www.hims-inc.com. 
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20. Obtaining Support  
 
If you are having problems with your Voice Sense QWERTY, please contact 
Hims, Inc. technical support. E-mail us at support@hims-inc.com. Or, 
contact the HIMS Technical Support department by phone at 512-837-2000. 
To obtain the most recent documentation, tutorial, and software downloads, 
please visit our website at www.hims-inc.com. Navigate to the "Resource 
Center" and to the Voice Sense QWERTY product page for the most up-to-
date product-related information and software for your Voice Sense 
QWERTY. 
	  

	  


